
Guida introduttiva
a

LibreOffice 3.5



Copyright

Il presente documento è rilasciato sotto Copyright © 2010-2012 dei collaboratori di seguito 
elencati. È possibile distribuire e/o modificare il documento rispettando i termini della GNU General 
Public License (http://www.gnu.org/licenses/gpl.html), versione 3 o successiva o della Creative 
Commons Attribution License (http://creativecommons.org/licenses/by/3.0/), versione 3.0 o 
successiva.

Collaboratori
Jean Hollis Weber Jeremy Cartwright Ron Faile Jr.
Martin Fox Dan Lewis David Michel
Andrew Pitonyak Hazel Russman Peter Schofield
John A Smith Laurent Balland-Poirier

Copertina:
Drew Jensen Christoph Noack Klaus-Jürgen Weghorn
Jean Hollis Weber

Localizzazione
Luca Daghino Marina Latini Diego Maniacco
Valter Mura Paolo Pelloni Gianpiero Zucca

Riconoscimenti
Questo libro è un adattamento ed aggiornamento della Guida introduttiva a OpenOffice.org 3.3. I 
collaboratori di tale Guida sono elencati a pagina 13.

Commenti e suggerimenti
Per commenti o suggerimenti su questo documento rivolgersi a: 
documentation@global.libreoffice.org

Data di pubblicazione e versione del software
Pubblicato il 31 Dicembre 2012. Basato su LibreOffice 3.5.6.

La documentazione per LibreOffice è disponibile all'indirizzo http://www.libreoffice.org/get-
help/documentation

http://www.libreoffice.org/get-help/documentation
http://www.libreoffice.org/get-help/documentation
mailto:documentation@global.libreoffice.org
http://creativecommons.org/licenses/by/3.0/
http://www.gnu.org/licenses/gpl.html


Indice
Copyright.....................................................................................................................................2

Nota per gli utenti Mac.................................................................................................................8

Prefazione.............................................................................................................................9
Destinatari del libro....................................................................................................................10

Contenuto del libro.....................................................................................................................10

Dove ottenere ulteriore aiuto......................................................................................................10

Differenze nelle immagini presenti nel libro................................................................................11

Utilizzo di LibreOffice su Mac.....................................................................................................11

Termini utilizzati.........................................................................................................................12

Autori......................................................................................................................................... 13

Riconoscimenti..........................................................................................................................13

FAQ........................................................................................................................................... 13

Nuove caratteristiche in LibreOffice 3.5.....................................................................................14

Capitolo 1  
Introduzione a LibreOffice................................................................................................17

Cos'è LibreOffice?.....................................................................................................................18

I vantaggi di LibreOffice.............................................................................................................19

Requisiti minimi di sistema.........................................................................................................20

Come ottenere il software..........................................................................................................20

Installazione del software...........................................................................................................20

Estensioni e componenti aggiuntivi............................................................................................20

Avviare LibreOffice.....................................................................................................................21

Componenti della finestra principale..........................................................................................23

Apertura di un nuovo documento...............................................................................................27

Apertura di un documento esistente..........................................................................................28

Salvare un documento...............................................................................................................29

Rinominare ed eliminare file......................................................................................................30

Uso delle finestre di dialogo "Apri" e "Salva Come"...................................................................31

Usare il Navigatore....................................................................................................................32

Annullamento e ripristino delle modifiche...................................................................................33

Chiusura di un documento.........................................................................................................34

Chiusura di LibreOffice..............................................................................................................35

Capitolo 2  
Configurare LibreOffice.org..............................................................................................37

Opzioni comuni a tutti i componenti di LibreOffice.....................................................................38

Opzioni di caricamento e salvataggio dei documenti.................................................................53

Scelta delle impostazioni lingua.................................................................................................59

Opzioni Internet.........................................................................................................................62

Controllo delle funzioni di Correzione automatica di LibreOffice................................................63

Capitolo 3  
Uso di Stili e Modelli..........................................................................................................65

Cos'è un modello?.....................................................................................................................66

Guida introduttiva a LibreOffice 3.5 3



Definizione di stile......................................................................................................................66

Applicare gli stili.........................................................................................................................67

Modificare gli stili.......................................................................................................................69

Creare nuovi stili (personalizzati)...............................................................................................71

Copiare e spostare gli stili..........................................................................................................73

Eliminare gli stili.........................................................................................................................75

Usare un modello per creare un documento..............................................................................75

Creare un modello.....................................................................................................................76

Modificare un modello................................................................................................................78

Aggiunta di modelli ottenuti da altre sorgenti.............................................................................80

Definire un modello predefinito..................................................................................................81

Associazione di un documento a un modello differente.............................................................83

Gestire i modelli.........................................................................................................................84

Stampa di un elenco di stili definiti in un modello o in un documento.........................................85

Esempi di utilizzo dello stile.......................................................................................................86

Capitolo 4  
Guida introduttiva a Writer................................................................................................89

Introduzione a Writer..................................................................................................................90

L'interfaccia di Writer.................................................................................................................90

Cambiare modalità di visualizzazione dei documenti.................................................................93

Spostarsi rapidamente all'interno di un documento....................................................................93

Lavorare con i documenti...........................................................................................................94

Lavorare con il testo..................................................................................................................96

Formattazione del testo...........................................................................................................106

Formattare le pagine................................................................................................................110

Aggiunta di commenti a un documento....................................................................................116

Creazione di un indice generale...............................................................................................117

Creazione di indici analitici e bibliografie..................................................................................117

Lavorare con oggetti grafici......................................................................................................117

Stampa....................................................................................................................................118

Uso della stampa in serie.........................................................................................................118

Memorizzare le modifiche in un documento.............................................................................118

Uso dei campi..........................................................................................................................119

Collegamento a un'altra parte di un documento.......................................................................119

Uso di documenti master.........................................................................................................122

Creazione di formulari..............................................................................................................122

Capitolo 5  
Guida introduttiva a Calc................................................................................................123

Introduzione a Calc..................................................................................................................124

Fogli elettronici, fogli e celle.....................................................................................................124

Componenti della finestra principale di Calc............................................................................124

Aprire e salvare file CSV..........................................................................................................128

Navigare nei fogli elettronici.....................................................................................................130

Selezionare elementi in un singolo foglio o in un intero foglio elettronico.................................134

Lavorare con colonne e righe...................................................................................................136

4 Guida introduttiva a LibreOffice 3.5



Lavorare con i fogli..................................................................................................................137

Viste di Calc.............................................................................................................................141

Introdurre dati utilizzando la tastiera........................................................................................144

Velocizzare l'inserimento dei dati.............................................................................................146

Condivisione di contenuti tra fogli............................................................................................150

Validare il contenuto di una cella..............................................................................................150

Modifica dei dati.......................................................................................................................150

Formattazione dei dati.............................................................................................................152

Formattazione automatica di celle e fogli.................................................................................156

Formattazione dei fogli elettronici utilizzando dei temi.............................................................157

Uso della formattazione condizionale......................................................................................157

Nascondere e mostrare i dati...................................................................................................158

Ordinare i record......................................................................................................................159

Uso di formule e funzioni.........................................................................................................160

Analisi dei dati..........................................................................................................................161

Stampa....................................................................................................................................161

Capitolo 6  
Guida introduttiva a Impress..........................................................................................169

Introduzione a Impress............................................................................................................170

Avviare Impress.......................................................................................................................170

La finestra principale di Impress..............................................................................................171

Vista Area di lavoro..................................................................................................................175

Creazione di una nuova presentazione....................................................................................180

Formattazione di una presentazione........................................................................................184

Aggiungere e formattare il testo...............................................................................................188

Aggiungere immagini, tabelle, grafici e contenuti multimediali.................................................193

Lavorare con pagine master e stili...........................................................................................196

Aggiunta di commenti a una presentazione.............................................................................202

Impostazione della presentazione............................................................................................203

Avviare la presentazione..........................................................................................................204

Capitolo 7  
Guida introduttiva a Draw...............................................................................................207

Introduzione a Draw.................................................................................................................208

Lo spazio di lavoro di Draw......................................................................................................209

Scelta e definizione dei colori...................................................................................................212

Disegnare forme base..............................................................................................................214

Punti di incollaggio e connettori...............................................................................................220

Disegnare forme geometriche..................................................................................................222

Selezionare gli oggetti..............................................................................................................224

Spostare e modificare le dimensioni di un oggetto...................................................................226

Ruotare e inclinare un oggetto.................................................................................................227

Modificare gli oggetti................................................................................................................229

Formattazione del riempimento di un'area...............................................................................233

Usare gli stili............................................................................................................................234

Posizionamento degli oggetti...................................................................................................234

Guida introduttiva a LibreOffice 3.5 5



Applicare effetti speciali...........................................................................................................236

Combinare oggetti multipli.......................................................................................................239

Disporre, allineare e distribuire gli oggetti................................................................................241

Inserire e modificare le immagini.............................................................................................241

Lavorare con oggetti tridimensionali (3D).................................................................................241

Esportare oggetti grafici...........................................................................................................242

Inserire commenti in un disegno..............................................................................................242

Capitolo 8  
Introduzione a Base.........................................................................................................245

Introduzione.............................................................................................................................246

Pianificare un database...........................................................................................................247

Creazione di un nuovo database.............................................................................................248

Creazione delle tabelle di un database....................................................................................249

Creazione di un formulario.......................................................................................................258

Accesso ad altre sorgenti dati..................................................................................................271

Utilizzo delle sorgenti dati in LibreOffice..................................................................................272

Inserimento dei dati tramite formulario.....................................................................................277

Creazione di ricerche...............................................................................................................279

Creazione dei rapporti..............................................................................................................287

Capitolo 9  
Guida introduttiva a Math................................................................................................293

Introduzione a Math.................................................................................................................294

Introduzione.............................................................................................................................294

Inserimento di una formula......................................................................................................296

Layout delle formule.................................................................................................................304

Modificare l'aspetto delle formule.............................................................................................310

Formule nei documenti di Writer..............................................................................................313

Personalizzazione....................................................................................................................316

Comandi di Math – Riferimenti.................................................................................................319

Capitolo 10  
Stampa, esportazione e invio di e-mail..........................................................................321

Introduzione.............................................................................................................................322

Stampa rapida.........................................................................................................................322

Controllo della stampa.............................................................................................................322

Esportazione in PDF................................................................................................................333

Esportazione in altri formati.....................................................................................................338

Inviare documenti come e-mail................................................................................................339

Firma digitale dei documenti....................................................................................................342

Eliminare i dati personali..........................................................................................................343

Capitolo 11  
Immagini, Galleria e Fontwork........................................................................................345

Introduzione.............................................................................................................................346

Aggiunta di immagini a un documento.....................................................................................346

Modificare e posizionare le immagini.......................................................................................350

6 Guida introduttiva a LibreOffice 3.5



Gestione della Galleria di LibreOffice.......................................................................................351

Creare una mappa immagine...................................................................................................354

Uso degli strumenti di disegno di LibreOffice...........................................................................356

Uso di Fontwork.......................................................................................................................358

Capitolo 12  
Creare pagine web...........................................................................................................365

Introduzione.............................................................................................................................366

Collegamenti ipertestuali relativi e assoluti..............................................................................366

Creazione di collegamenti ipertestuali......................................................................................367

Salvare documenti di Writer come pagine web........................................................................371

Creare pagine web utilizzando una procedura guidata............................................................372

Salvare Fogli elettronici di Calc come pagine web...................................................................376

Salvare presentazioni di Impress come pagine web................................................................376

Salvare documenti di Draw come pagine web.........................................................................380

Capitolo 13  
Primi passi con le macro.................................................................................................381

Le prime macro........................................................................................................................382

Creazione di una macro...........................................................................................................388

Qualche volta la registrazione di una macro fallisce................................................................392

Organizzazione delle macro....................................................................................................393

Come eseguire una macro.......................................................................................................398

Estensioni................................................................................................................................402

Scrittura delle macro senza l'utilizzo del registratore................................................................403

Ulteriori informazioni................................................................................................................403

Capitolo 14  
Personalizzare LibreOffice..............................................................................................405

Introduzione.............................................................................................................................406

Personalizzare il contenuto dei menu......................................................................................406

Personalizzare le barre degli strumenti....................................................................................409

Assegnare combinazioni di tasti...............................................................................................413

Assegnare macro agli eventi....................................................................................................416

Aggiunta di funzioni con le estensioni......................................................................................416

Appendice A  
Tasti di scelta rapida........................................................................................................419

Introduzione.............................................................................................................................420

Tasti di scelta rapida generali...................................................................................................421

Definire i tasti di scelta rapida..................................................................................................423

Ulteriori letture.........................................................................................................................423

Appendice B  
Open Source, standard aperti e OpenDocument.........................................................425

Introduzione.............................................................................................................................426

Breve storia di LibreOffice........................................................................................................426

La comunità di LibreOffice.......................................................................................................426

Licenza di LibreOffice..............................................................................................................427

Guida introduttiva a LibreOffice 3.5 7



Che cos'è l'“open source"?......................................................................................................427

Cosa sono gli “standard aperti”?..............................................................................................427

Che cos'è il formato OpenDocument?.....................................................................................428

Formati di file che possono essere elaborati da LibreOffice.....................................................428

Formati di file che possono essere scritti da LibreOffice..........................................................430

Esportazione in altri formati.....................................................................................................432

Indice.................................................................................................................................434

Nota per gli utenti Mac

Alcuni tasti e voci di menu su un Mac sono diversi da quelli utilizzati in ambiente Windows e Linux. 
La tabella che segue fornisce alcune sostituzioni comuni per le istruzioni di questo capitolo. Per un 
elenco più dettagliato, vedere la Guida in linea dell'applicazione.

Windows o Linux Equivalente su Mac Effetto

Strumenti > Opzioni 
selezione del menu

LibreOffice > Preferenze Accesso alle opzioni di configurazione

Pulsante destro del 
mouse

Ctrl+clic Apre un menu contestuale

Ctrl (Control) ⌘ (Comando) Usato con altri tasti

F5 Maiusc+⌘+F5 Apre il Navigatore

F11 ⌘+T Apre la finestra Stili e Formattazione.
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Destinatari del libro

Chiunque desideri imparare velocemente ad utilizzare LibreOffice troverà questo libro prezioso. 
Sia che siate principianti, sia che abbiate familiarità con altre suite per ufficio.

Contenuto del libro

Questo libro introduce i componenti principali di LibreOffice:

• Writer (elaborazione di testi)

• Calc (fogli elettronici)

• Impress (presentazioni)

• Draw (grafica vettoriale)

• Base (database)

• Math (editor di equazioni)

Questo testo tratta anche alcune delle caratteristiche comuni a tutti i componenti, inclusi 
l'installazione e la personalizzazione, gli stili e i modelli, la registrazione di macro, e la stampa. Per 
ulteriori dettagli, guardate le guide utente per i singoli componenti.

Dove ottenere ulteriore aiuto

Questo libro, le altre guide utente di LibreOffice, il sistema di aiuto integrato, e i sistemi di 
assistenza agli utilizzatori presuppongono che da parte vostra vi sia un minimo di familiarità con il 
vostro computer e con funzioni basilari quali l'avvio di un programma, l'apertura ed il salvataggio di 
un file.

Sistema di aiuto
LibreOffice offre un sistema di aiuto vasto ed articolato. È il vostro primo supporto per l'utilizzo di 
LibreOffice.

Per visualizzare la Guida in linea completa, premete il tasto F1 oppure selezionate Guida di 
LibreOffice dal menu di Aiuto. Inoltre, è possibile scegliere di attivare l'identificazione degli 
strumenti, i suggerimenti attivi e l'Assistente di aiuto (da Strumenti > Opzioni > LibreOffice > 
Generale).

Quando l'identificazione degli strumenti è attivata, posizionando il cursore del mouse sull'icona di 
un qualsiasi strumento verrà visualizzata una breve descrizione della sua funzione. Per una 
spiegazione più approfondita, selezionate ?> Cos'è questo? e tenete il puntatore sopra l'icona.

Assistenza gratuita online
La comunità di LibreOffice non sviluppa solo il software, ma offre anche un servizio di supporto 
gratuito fornito da volontari. Vedere la Tabella 1 e questa pagina web: 
http://it.libreoffice.org/supporto/ 

Gli utenti possono ottenere un supporto completo in linea da parte dei membri della comunità 
attraverso le mailing list. Anche altri siti web gestiti da utenti offrono gratuitamente consigli ed 
esercitazioni. Questo forum fornisce il supporto della comunità per LibreOffice e altri programmi: 
http://user.services.openoffice.org/en/forum/ 
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Supporto e formazione a pagamento

In alternativa, è possibile usufruire di servizi di supporto a pagamento. Contratti di assistenza 
possono essere acquistati presso un distributore o da una ditta di consulenza specializzata in 
LibreOffice.

Tabella 1: assistenza gratuita per gli utenti di LibreOffice

Assistenza gratuita per LibreOffice

Domande frequenti
Risposte alle Domande frequenti
http://www.libreoffice.org/get-help/faq/
http://wiki.documentfoundation.org/Faq

Documentazione
Guide utente, istruzioni, e altra documentazione. 
http://it.libreoffice.org/supporto/documentazione/
https://wiki.documentfoundation.org/Documentation/Publications 

Mailing list
Il supporto gratuito della comunità è offerto da una rete di utilizzatori 
esperti.
http://it.libreoffice.org/supporto/mailing-list/

Supporto 
Internazionale

Il sito web di LibreOffice nella vostra lingua.
http://www.libreoffice.org/international-sites/

Mailing list internazionali
http://wiki.documentfoundation.org/Local_Mailing_Lists

Accesso facilitato
Informazioni relative all'accesso facilitato. 
http://it.libreoffice.org/supporto/accessibilita/

Differenze nelle immagini presenti nel libro

LibreOffice funziona su sistemi operativi Windows, Linux, e Mac OS X, ciascuno dei quali ha 
diverse versioni e può essere personalizzato dagli utenti (tipo di carattere, colori, temi, gestori di 
finestre).

Le immagini in questo libro sono tratte da computer e sistemi operativi diversi. Alcune immagini 
saranno quindi leggermente diverse da ciò che vedete sul vostro computer.

Utilizzo di LibreOffice su Mac

Alcuni tasti e voci di menu su un Mac sono diversi da quelli utilizzati in ambiente Windows e Linux. 
La tabella che segue fornisce alcune sostituzioni comuni per le istruzioni di questo capitolo. Per un 
elenco più dettagliato, vedere la Guida in linea dell'applicazione.

Windows o Linux Equivalente su Mac Effetto

Strumenti > Opzioni 
selezione del menu

LibreOffice > Preferenze Accesso alle opzioni di configurazione

Pulsante destro del 
mouse

Ctrl+clic Apre un menu contestuale

Ctrl (Control) ⌘ (Comando) Usato con altri tasti
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F5 Maiusc+⌘+F5 Aprite il Navigatore

F11 ⌘+T Aprite la finestra Stili e formattazione.

Termini utilizzati

I termini utilizzati in LibreOffice per la maggior parte dell'interfaccia utente (la parte del programma 
che vedete e utilizzate, a differenza del codice dietro le quinte che lo rende funzionante) sono gli 
stessi come per molti altri programmi.

Una finestra di dialogo è un tipo speciale di finestra. Il suo scopo è quello di informarvi di qualcosa, 
o richiedervi un'immissione, oppure entrambe le cose. Vi fornisce dei controlli da utilizzare per 
indicare come eseguire un'azione. I nomi tecnici per i controlli più comuni sono mostrati in Figura 
1; non viene invece mostrata la casella di riepilogo (dalla quale selezionate un elemento). Nella 
maggior parte dei casi in questo libro non si usano termini tecnici, ma può essere utile conoscerli 
perché si possono ritrovare frequentemente nella Guida in linea e in altre guide e manuali.

Figura 1: finestra di dialogo con i controlli più comuni:
1 = Pagina a schede (strettamente parlando non si tratta di un controllo)
2 = Pulsanti Radio (permettono una singola scelta esclusiva)
3 = Casella di controllo (permette scelte multiple)
4 = Casella numerica (fate clic sulle frecce su e giù per modificare il numero 
mostrato nella casella di testo adiacente, oppure digitate nella casella di testo)
5 = Miniatura o anteprima
6 = Menu a tendina dal quale selezionare una voce
7 = Pulsanti
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Generalmente, potete interagire solo con la finestra di dialogo (e non con il documento stesso) fino 
a quando la finestra di dialogo rimane aperta. Quando chiudete la finestra di dialogo dopo l'uso 
(normalmente, facendo clic su OK oppure su un altro pulsante, le vostre modifiche vengono 
salvate e la finestra di dialogo viene chiusa), potete di nuovo lavorare con il vostro documento.

Alcune finestre di dialogo possono rimanere aperte mentre lavorate, quindi potete spostarvi avanti 
e indietro tra la finestra di dialogo e il vostro documento. Un esempio di questo tipo è la finestra di 
dialogo Cerca e Sostituisci.

Autori

Questo libro è stato scritto dai volontari della comunità di LibreOffice. I guadagni derivanti dalla 
vendita dell'edizione stampata saranno utilizzati a favore della comunità.

Riconoscimenti

Questo libro è un adattamento della Guida introduttiva a OpenOffice.org 3.3. I collaboratori di 
quella Guida sono:

Jean Hollis Weber Michele Zarri Magnus Adielsson
Thomas Astleitner Richard Barnes Agnes Belzunce 
Chris Bonde Nicole Cairns Daniel Carrera
JiHui Choi Richard Detwiler Alexander Noël Dunne
Laurent Duperval Spencer E. Harpe Regina Henschel
Peter Hillier-Brook Richard Holt John Kane
Rachel Kartch Stefan A. Keel Jared Kobos
Michael Kotsarinis Peter Kupfer Ian Laurenson
Dan Lewis Alan Madden Michel Pinquier
Andrew Pitonyak Carol Roberts Iain Roberts
Hazel Russman Gary Schnabl Robert Scott
Joe Sellman Janet Swisher Jim Taylor
Alex Thurgood Barbara M. Tobias Claire Wood
Linda Worthington 

FAQ

Licenza di LibreOffice
LibreOffice è distribuito sotto la Lesser General Public License (LGPL), approvata dall'Open 
Source Initiative (OSI). La licenza LGPL è consultabile sul sito web di LibreOffice all'indirizzo: 
http://www.libreoffice.org/download/license/ 

È possibile distribuire LibreOffice a chiunque?
Sì.

Su quanti computer è possibile installarlo?
Su tutti quelli che volete.

È possibile venderlo?
Sì.
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È possibile usare LibreOffice in un ambiente di lavoro?
Sì.

LibreOffice è disponibile nella mia lingua?
LibreOffice è stato tradotto (localizzato) in più di 40 lingue, quindi la vostra lingua è 
probabilmente supportata. Inoltre sono disponibili oltre 70 dizionari di correzione ortografica, 
sillabazione, e di sinonimi per le lingue e anche per i dialetti per i quali non è ancora disponibile 
un'interfaccia localizzata. I dizionari sono disponibili sul sito web di LibreOffice all'indirizzo: 
www.libreoffice.org.

Come riuscite a fare tutto questo gratis?
LibreOffice è sviluppato e mantenuto da volontari ed è sostenuto da diverse organizzazioni.

Sto scrivendo un'applicazione software, È possibile usare il codice sorgente di LibreOffice 
nel mio programma?

Potete usarlo, in conformità con i limiti della licenza LGPL. Per leggere la licenza, visitate il sito: 
http://www.libreoffice.org/download/license/ 

Perché è necessario avere Java per poter avviare LibreOffice.org? È scritto in Java?
LibreOffice non è scritto in Java; è scritto in linguaggio C++. Java è uno dei numerosi linguaggi 
che è possibile usare per ampliare il software. Il Java JDK/JRE è necessario solo per alcune 
funzioni. La più importante è il motore di database relazionale HSQLDB.

Nota: Java è disponibile senza costi aggiuntivi. Se non volete utilizzare Java, potrete 
comunque usare quasi tutte le caratteristiche di LibreOffice.

Come si può contribuire a LibreOffice?
Potete contribuire allo sviluppo e al supporto degli utenti di LibreOffice in molti modi, senza 
necessariamente essere un programmatore. Per cominciare, date uno sguardo alla pagina 
web: http://www.documentfoundation.org/contribution/

È possibile distribuire il file PDF di questa Guida, o stamparla e venderne delle copie?
Sì, fintantoché vengono rispettati i requisiti di una delle licenze citate nella dichiarazione di 
copyright all'inizio di questa Guida. Non è necessario richiedere un permesso speciale. Inoltre, 
richiediamo che condividiate con il progetto parte dei profitti che ottenete dalla vendita delle 
Guide, in considerazione di tutto il lavoro svolto per produrle.

Nuove caratteristiche in LibreOffice 3.5

Per un elenco dettagliato delle nuove funzionalità, consultate http://www.libreoffice.org/download/3-5-new-
features-and-fixes/. Di seguito alcune delle caratteristiche.

Generale
• LibreOffice controlla la presenza di aggiornamenti automaticamente a intervalli definiti 

dall'utente e permette lo scaricamento manuale della versione più recente.

• Filtro d'importazione per documenti Microsoft Visio.

• Selettore di colore (Strumenti > Opzioni > Colori, clic su Modifica) riscritto per una 
maggiore usabilità.

• Le impostazioni del colore dell'applicazione (Strumenti > Opzioni > Aspetto) ora hanno 
un'anteprima dei colori corretta per i colori automatici.
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• Barre degli strumenti sensibili al contesto spostate in basso per evitare che ricoprano parti 
importanti del documento.

• La finestra di dialogo Inserisci Filmati e Suoni mostra ora una casella di controllo Collega, 
che consente di incorporare file multimediali in documenti basati sul pacchetto ODF.

Writer
• Migliore gestione d'intestazione e piè di pagina: è ora più facile aggiungere intestazione o piè 

di pagina; la modifica o l'eliminazione può essere effettuata velocemente, senza aprire la 
formattazione dello Stile di Pagina.

• Controllo grammaticale incorporato nuovo e più veloce, per l'Inglese e diverse altre lingue. 
La finestra di dialogo del controllo grammaticale è stata rielaborata per mostrare meglio 
l'aiuto in caso di errori.

• Aggiornamento del conteggio parole durante la digitazione.

• Font hinting (sfumatura dei pixel dei caratteri) migliorato per una qualità elevata dei 
documenti.

• Correzioni del layout, inclusa la numerazione durante l'importazione di file DOC, DOCX, e 
RTF, per compatibilità del layout con Microsoft Word e tabulazioni che rientrano all'interno 
dei margini.

• Gli indici generati automaticamente ora contengono per impostazione predefinita 
collegamenti ipertestuali alle pagine relative.

• Supporto per esportazione/importazione di commenti nei documenti Office Open XML 
(*.docx).

• Correzione del posizionamento per la stampa di etichette.

• Introdotte diverse nuove funzionalità tipografiche.

Calc
• Nuova barra di inserimento multi-linea.

• Supporto per 10,000 fogli e prestazioni migliorate per diverse operazioni sui fogli.

• Nuova opzione per specificare il numero iniziale di fogli di lavoro nei nuovi documenti.

• Nuove Funzioni di Calc BITAND, BITOR, BITXOR, BITRSHIFT, e BITLSHIFT, SEC, CSC, 
SECH e CSCH, come dichiarato nella specifica ODF 1.2.

• La finestra a comparsa Filtro Automatico è stata ridisegnata per un migliore aspetto visivo e 
per permettere selezioni multiple.

• Ridisegnate tutte le finestre di dialogo dei nomi delle aree per lavorare meglio con i nomi 
delle aree locali e rendere più facile l'utilizzo delle finestre di dialogo.

• Numero illimitato di regole per la formattazione condizionata.

Impress / Draw
• Avvio di Impress senza procedura guidata per impostazione predefinita.

• Archi ellittici importati e rappresentati correttamente.

• Gestione migliore dell'elenco delle animazioni personalizzate.

• Gestione migliore dell'esportazione in PDF per le diapositive nascoste.

• Supporto migliore per l'importazione di Smart Art.

• La tavolozza standard include alcuni nuovi tipi di fine linea.
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• Importazione di forme personalizzate notevolmente migliorata; corretti diversi errori e 
aggiunte nuove implementazioni predefinite.

Math
• Nuovo simbolo  "non esiste".∄

• Supporto per esportazione e importazione di formule di Math in documenti Office Open 
XML (docx).

• Nuovi simboli per la teoria dei Giochi.

Base
• Integrazione del driver nativo PostgreSQL (per le versioni 8.4+).

• Correzione di numerosi errori.
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Cos'è LibreOffice?

LibreOffice è una suite gratuita di produttività per ufficio, completa di tutte le funzioni. Il suo formato 
file nativo è OpenDocument, un formato standard aperto che è in corso di adozione da parte di 
autorità governative mondiali come formato di file richiesto per la pubblicazione e accettazione dei 
documenti. LibreOffice è anche in grado di aprire e salvare documenti in molti altri formati, 
compresi quelli utilizzati da varie versioni di Microsoft Office.

LibreOffice comprende i seguenti componenti.

Writer (elaborazione di testi)
Writer è uno strumento ricco di funzioni per la creazione di lettere, libri, relazioni, bollettini, depliant 
e altri documenti. È possibile inserire grafici e oggetti di altri componenti nei documenti Writer. Con 
Writer è possibile esportare file nei formati HTML, XHTML, XML, Adobe Portable Document 
Format (PDF) e Microsoft Word di diverse versioni. Permette inoltre di collegarsi al vostro client di 
posta elettronica.

Calc (foglio elettronico)
Calc dispone di tutte le funzionalità avanzate per l'analisi, la creazione di diagrammi e scelte 
decisionali di un programma di calcolo avanzato. Dispone, tra l'altro, di oltre 300 funzioni per 
calcoli finanziari, statistici e matematici. Il Gestore di scenari fornisce analisi del tipo "what if" (cosa 
succede se). Con Calc è possibile generare grafici bi e tridimensionali che possono essere 
integrati in altri documenti di LibreOffice. È anche possibile aprire e lavorare con fogli di calcolo in 
formato Microsoft Excel e salvarli nel formato originale Excel. Calc è in grado di esportare i fogli 
elettronici anche nei formati Adobe PDF e HTML.

Impress (presentazioni)
Impress fornisce tutti i più comuni strumenti di presentazione multimediale quali effetti speciali, 
animazione e strumenti di disegno. È integrato con le funzioni grafiche avanzate dei componenti 
Draw e Math di LibreOffice. Le presentazioni possono essere ulteriormente migliorate con speciali 
effetti di testo ottenibili con Fontwork e contributi audio e video. Impress è compatibile con il 
formato Microsoft PowerPoint ed è anche in grado di salvare le vostre presentazioni in numerosi 
formati grafici, compreso Macromedia Flash (SWF).

Draw (grafica vettoriale)
Draw è uno strumento per il disegno vettoriale in grado di creare qualsiasi cosa, da semplici 
diagrammi o diagrammi di flusso fino alla grafica 3-D. La funzione Smart Connectors permette di 
definire punti di connessione personalizzati. Con Draw potete creare disegni da utilizzare in 
qualsiasi altro componente di LibreOffice e nuove clipart da aggiungere alla Galleria. Draw è in 
grado di importare immagini dai formati più comuni e salvarle in oltre 20 formati compresi PNG, 
HTML, PDF e Flash.

Base (database)
Base offre tutti gli strumenti necessari per lavorare con i database tramite un'interfaccia utente 
semplice ed intuitiva. Base rende possibile creare e modificare formulari, rapporti, query, tabelle, 
viste e relazioni, in modo da poter gestire un database relazionale esattamente come con i più 
comuni applicativi per la gestione di database. Base presenta molte nuove caratteristiche quali la 
possibilità di analizzare e modificare relazioni da una vista diagramma. Base integra HSQLDB 
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quale motore standard di database relazionale. Il programma può anche elaborare database in 
formato dBASE, Microsoft Access, MySQL, Oracle o qualsiasi altro database compatibile con 
ODBC o JDBC. Base fornisce il supporto per un sottoinsieme del linguaggio SQL ANSI-92.

Math (formule)
Math è il programma di LibreOffice per formule o equazioni. Può essere usato per creare equazioni 
complesse contenenti simboli o caratteri non disponibili nelle serie di caratteri standard. Anche se 
usato normalmente per creare formule in altri documenti, come file di Writer e Impress, Math è 
utilizzabile anche come strumento indipendente. Con Math è possibile salvare le formule nel 
formato standard Mathematical Markup Language (MathML) e inserirle in pagine web e altri 
documenti non creati da LibreOffice.

I vantaggi di LibreOffice

Ecco alcuni dei vantaggi di LibreOffice rispetto ad altre suite per ufficio:

• Nessun costo di licenza. LibreOffice è liberamente utilizzabile e distribuibile da chiunque 
senza alcun costo.. Molte caratteristiche, disponibili come add-on opzionali a pagamento in 
altre suite per ufficio (come l'esportazione in formato PDF), sono invece disponibili 
gratuitamente in LibreOffice. Nessun costo nascosto attuale o futuro.

• Open source.Grazie alle licenze Open Source di LibreOffice è possibile distribuire, copiare 
e modificare il software come si desidera.

• Multipiattaforma. LibreOffice funziona su numerose architetture hardware e sistemi 
operativi diversi quali Microsoft Windows, Mac OS X e Linux.

• Ampio supporto linguistico. L'interfaccia utente di LibreOffice è disponibile in oltre 40 
lingue e il progetto LibreOffice mette a disposizione correttori ortografici e di sillabazione e 
dizionari per oltre 70 lingue e dialetti. LibreOffice offre anche supporto sia per le lingue con 
disposizione di testo complesso (CTL) sia per lingue con scrittura da destra a sinistra 
(RTL), quali Urdu, Ebraico e Arabo.

• Interfaccia utente condivisa. L'interfaccia utente semplice ed intuitiva comune a tutti i 
componenti rende il loro utilizzo semplice da apprendere e padroneggiare.

• Integrazione. I componenti di LibreOffice sono ben integrati tra loro.

– Tutti i componenti condividono un correttore ortografico e altri strumenti comuni, 
utilizzabili in modo omogeneo in tutta la suite. Ad esempio, gli strumenti per il disegno 
disponibili in Writer sono gli stessi presenti in Calc e, con funzionalità simili ma più 
avanzate, in Impress e Draw.

– Non è necessario sapere quale applicazione è stata utilizzata per creare un 
particolare file. A titolo di esempio, potete aprire un file Draw da Writer.

• Granularità. Di solito, la modifica di un'opzione si riflette su tutti i componenti. In ogni caso, 
le opzioni di LibreOffice possono essere configurate a livello di componente o addirittura a 
livello di singolo documento.

• Compatibilità dei file. Oltre ai propri formati nativi OpenDocument, LibreOffice include 
funzionalità di esportazione nei formati PDF e Flash, nonché il supporto per aprire e 
salvare file in molti formati comuni inclusi Microsoft Office, HTML, XML, WordPerfect e 
Lotus 1-2-3. Un'estensione (inclusa) consente di importare e modificare alcuni tipi di file 
PDF.
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• Nessun vincolo esclusivo con il produttore. LibreOffice usa OpenDocument, un 
formato file XML (eXtensible Markup Language) sviluppato come standard di settore da 
OASIS (Organization for the Advancement of Structured Information Standards). Tali file 
sono facilmente decomprimibili e leggibili con un qualsiasi elaboratore di testo e la loro 
struttura è aperta e liberamente consultabile.

• Tutti hanno voce in capitolo. Migliorie, eliminazione di bug e date di rilascio sono 
coordinati dalla comunità. Anche voi potete entrare a far parte della comunità e contribuire 
allo sviluppo del prodotto che utilizzate.

Maggiori informazioni riguardo a LibreOffice e The Document Foundation sono reperibili presso i 
rispettivi siti web http://www.libreoffice.org/ e http://www.documentfoundation.org/.

Requisiti minimi di sistema

LibreOffice 3.5 richiede uno dei seguenti sistemi operativi:

• Microsoft Windows 2000 (Service Pack 4 o superiore), XP, Vista, Windows 7, o Windows 
8

• GNU/Linux Kernel versione 2.6.18, glibc2 v2.5 o superiore, e gtk v2.10.4 o superiore

• Mac OS X 10.4 (Tiger) o superiore

Per il processo d'installazione sono richiesti privilegi di amministratore.

Alcune funzionalità di LibreOffice (le procedure guidate e il motore di database HSQLDB) 
richiedono che Java Runtime Environment (JRE) sia installato sul vostro computer. Sebbene 
LibreOffice funzioni senza supporto Java, alcune funzionalità non saranno disponibili.

Per un elenco più dettagliato dei requisiti, vi rimandiamo al sito web di LibreOffice, 
http://www.libreoffice.org/get-help/system-requirements/.

Come ottenere il software

Il software può essere scaricato dal seguente indirizzo: http://www.libreoffice.org/. Il software può 
anche essere scaricato utilizzando un programma Peer-to-Peer, ad esempio BitTorrent, dallo 
stesso indirizzo.

Gli utenti Linux troveranno LibreOffice incluso in molte delle più recenti distribuzioni Linux; Ubuntu 
è solo un esempio.

Installazione del software

Le informazioni relative a installazione e impostazioni di LibreOffice sui vari sistemi operativi 
supportati sono fornite a questo indirizzo: http://www.libreoffice.org/get-help/installation/.

Estensioni e componenti aggiuntivi

Sono disponibili estensioni e componenti aggiuntivi per ottimizzare LibreOffice. Il programma è 
fornito con diverse estensioni installate e altre sono disponibili nell'archivio ufficiale delle 
estensioni, 
http://extensions.libreoffice.org/. Vedete il Capitolo 14 (Personalizzazione di LibreOffice) per 
maggiori informazioni sulle modalità d'installazione.
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Avviare LibreOffice

Il modo più comune di lanciare un qualsiasi componente di LibreOffice è utilizzare il menu di 
sistema, il menu standard dal quale viene avviata la maggior parte delle applicazioni. In Windows, 
si chiama menu di Avvio (o di Start). In GNOME, è denominato menu delle Applicazioni. In KDE è 
identificato dal logo KDE. In Mac OS X, è il menu delle Applicazioni.

Quando LibreOffice è stato installato sul vostro computer, nella maggior parte dei casi, è stata 
aggiunta al menu di sistema una voce di menu per ogni componente. Il nome e la posizione di 
queste voci del menu dipendono dal sistema operativo e dall'interfaccia grafica.

Avvio da un documento esistente
Potete avviare LibreOffice facendo doppio clic sul nome del file di un documento ODF 
(OpenDocument Format) in un file manager come Windows Explorer. Così facendo si avvierà il 
corrispondente componente di LibreOffice e il documento verrà caricato.

Nota per gli utenti Windows
Se avete associato i file di Microsoft Office con LibreOffice, facendo doppio clic su di un file *.doc 
(Word) si avvierà l'applicativo Writer; analogamente, un doppio clic su file *.xls (Excel) o *.ppt 
(PowerPoint) avvierà Calc o Impress, rispettivamente.

In mancanza di associazione dei tipi di file, il doppio clic su un *.doc aprirà Microsoft Word (se 
installato sul vostro computer), i file *.xls verranno aperti da Excel e i file *.ppt con PowerPoint.

Potete usare un altro metodo per aprire i file Microsoft Office in LibreOffice e salvarli in quei formati 
da LibreOffice. Vedere “Apertura di un documento esistente” a pagina 28 per maggiori 
informazioni.

Uso di QuickStart in Windows
QuickStart è un'icona che viene posta sulla barra delle applicazioni all'avvio di Windows. Indica 
che LibreOffice è stato caricato ed è pronto per essere usato. (Quickstart carica la libreria dei file 
*.DLL necessari a LibreOffice, riducendo il tempo di avvio dei componenti di LibreOffice). Se 
Quickstart è disabilitato, vedere “Come riattivare QuickStart” per abilitarlo.

Uso dell'icona QuickStart
Fate clic con il tasto destro sull'icona Quickstart nella barra di sistema per aprire un menu a 
comparsa (Figura 2), dal quale potrete aprire un nuovo documento, aprire la finestra di dialogo 
Modelli e Documenti, oppure scegliere un documento esistente da aprire. Un doppio clic sull'icona 
di QuickStart permette anche di aprire la finestra di dialogo Modelli e documenti.
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Figura 2: menu a comparsa di 
Quickstart in Windows

Come disattivare QuickStart
Per chiudere il QuickStart, fate clic con il tasto destro sull'icona nella barra delle applicazioni, poi 
fate clic su Termina QuickStart sul menu a comparsa. QuickStart verrà caricato nuovamente al 
riavvio del computer.

Per impedire che LibreOffice venga caricato all'avvio del computer, deselezionate la voce Apri 
LibreOffice all'avvio del sistema dal menu a comparsa. Questa procedura può essere 
opportuna, ad esempio, se il computer dispone di poca memoria.

Come riattivare QuickStart
Se Quickstart è stato disattivato, potete riattivarlo mettendo il segno di spunta alla casella di 
controllo Carica LibreOffice all'avvio del sistema presente in Strumenti > Opzioni > 
LibreOffice > Memoria.

Uso di Quickstart in Linux e Mac OS X
LibreOffice per Linux ha un Quickstart simile per aspetto e funzionalità a quello precedentemente 
descritto per Windows. La casella di controllo nella pagina Memoria è denominata Attiva 
QuickStart nell'area di notifica. Se non avete questa casella di controllo, il modulo Quickstart 
non è installato sul vostro sistema.

Mac OS X fornisce una funzionalità simile attraverso il menu a comparsa del dock.
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Componenti della finestra principale

La finestra principale, a parte qualche dettaglio, è simile per tutti i componenti di LibreOffice. Vi 
rimandiamo ai capitoli di questo libro relativi a Writer, Calc, Draw e Impress per le descrizioni di 
questi dettagli.

Le caratteristiche comuni comprendono la barra dei menu, la barra strumenti standard, la barra 
degli strumenti di formattazione nella parte superiore della finestra, e la barra di stato nella parte 
inferiore.

Barra dei menu
La barra dei menu si trova nella parte superiore della finestra di LibreOffice , appena al di sotto 
della barra del Titolo. Quando scegliete uno dei menu elencati di seguito, viene visualizzato un 
sottomenu con ulteriori opzioni.

• Il menu File contiene comandi applicabili a tutto il documento, quali Apri, Salva e Esporta in 
formato PDF.

• Il menu Modifica contiene comandi per modificare il documento come Annulla: xxx (dove 
xxx è il comando per annullare) e Trova e Sostituisci. Inoltre, comprende comandi per 
tagliare, copiare e incollare parti del vostro documento opportunamente selezionate.

• Visualizza include comandi che agiscono sulla visualizzazione del documento, quali lo 
Zoom e Layout web.

• Inserisci comprende comandi per inserire elementi nel vostro documento, quali Riga di 
intestazione, Piè di pagina ed Immagini.

• Formato contiene comandi, come Stili e Formattazione e Correzione Automatica, per 
formattare il layout del vostro documento.

• Tabella riporta tutti i comandi necessari per inserire e modificare una tabella in un 
documento di testo.

• Strumenti comprende funzioni come Ortografia e Grammatica, Personalizza e Opzioni.

• Finestra ha i comandi che agiscono sul contenuto dello schermo.

• Aiuto contiene collegamenti alla Guida di LibreOffice, Cos'è questo?, e informazioni sul 
programma.

Barre degli strumenti
LibreOffice dispone di diverse barre degli strumenti: agganciate (o ancorate), mobili e separabili. 
Le barre strumenti agganciate possono essere spostate su lati diversi dello schermo o trasformate 
in barre mobili; allo stesso modo è possibile agganciare le barre mobili.

La barra degli strumenti ancorata, presente nella parte più alta, appena sotto la barra Menu, è 
chiamata barra strumenti Standard. Essa è identica per tutte le applicazioni di LibreOffice.

La seconda barra in alto è la barra di Formattazione. È sensibile al contesto; cioè, mostra gli 
strumenti  relativi alla posizione del cursore o della selezione. Per esempio, se il cursore si trova su 
di una parte grafica del documento, la barra di Formattazione fornisce strumenti per modificare 
oggetti grafici; se il cursore è posizionato su testo, gli strumenti offerti sono adeguati alla 
formattazione di testi.

Come visualizzare o nascondere barre di strumenti
Per visualizzare o nascondere le barre degli strumenti, selezionate Visualizza > Barre degli 
strumenti, quindi fate clic sul nome della barra che appare nell'elenco. Una barra degli strumenti 
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attiva mostra un segno di spunta accanto al nome. Le barre strumenti separabili non sono elencate 
nel menu Visualizza.

Sottomenu e barre strumenti separabili
Le barre strumenti marcate con un piccolo triangolo sulla destra permettono di visualizzare un 
sottomenu, barre strumenti separabili, e altri modi per selezionare singole voci, a seconda del tipo 
d'icona.

La Figura 3 mostra una barra strumenti separabile appartenente alla barra strumenti Disegno.

Le barre strumenti separabili posso essere mobili o ancorate lungo un bordo dello schermo o in 
una delle aree previste per le barre degli strumenti. Per spostare una barra strumenti separabile, 
trascinatela dalla barra del titolo, come indicato in Figura 5.

Figura 3: esempio di barra strumenti separabile

Spostamento delle barre di strumenti
Per spostare una barra strumenti ancorata, posizionate il puntatore del mouse sulla maniglia della 
barra (la piccola barra verticale a sinistra della barra strumenti), tenete premuto il pulsante sinistro 
del mouse, trascinate la barra degli strumenti nella nuova posizione e rilasciate il pulsante del 
mouse (Figura 4). Per spostare una barra strumenti mobile, fate clic sulla sua barra del titolo e 
trascinatela nella nuova posizione (Figura 5).

Figura 4: spostamento di una barra 
strumenti agganciata
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Figura 5: spostamento di una barra strumenti mobile

Barre strumenti mobili
LibreOffice include diverse altre barre strumenti sensibili al contesto, che vengono visualizzate in 
modo predefinito come barre mobili in base alla posizione del cursore o la selezione. Ad esempio, 
quando il cursore è in una tabella, viene visualizzata una barra strumenti mobile detta Tabella, e 
quando il cursore è in un elenco numerato o puntato, appare la barra strumenti Elenchi Puntati e 
Numerati. Se lo desiderate, potete ancorare queste barre strumenti in alto, in basso o lateralmente 
alla finestra (vedere “Spostamento delle barre di strumenti” menzionato in precedenza).

Aggancio/separazione di finestre e barre degli strumenti
Le barre strumenti e alcune finestre, quali Navigatore e Stili e formattazione, sono agganciabili. È 
possibile spostarle, ridimensionarle o ancorarle ad un lato.

Per ancorare una finestra o barra strumenti, tenete premuto il tasto Ctrl e fate doppio clic sulla 
cornice della finestra mobile (o in un' area vuota contigua alle icone nella parte superiore della 
finestra mobile) per ancorarla nella sua ultima posizione.

Figura 6: Ctrl+clic per ancorare o 
disancorare

Per disancorare una finestra, tenete premuto il tasto Ctrl e fate doppio clic sulla cornice (o in un' 
area vuota contigua alle icone nella parte superiore) della finestra ancorata.

Personalizzazione delle barre degli strumenti
Le barre degli strumenti possono essere personalizzate in diversi modi, inclusa la scelta delle 
icone da visualizzare e il loro posizionamento. È anche possibile aggiungere icone e creare nuove 
barre strumenti seguendo le procedure descritte al Capitolo 14.

Per accedere alle opzioni di personalizzazione di una barra strumenti, fate clic destro tra le icone 
sulla barra strumenti. Apparirà un menu. 

Per mostrare o nascondere le icone definite per la barra strumenti selezionata, scegliete Pulsanti 
Visibili dal menu a discesa. Le icone visibili sono indicate da una linea di contorno (Figura 7) o da 
un segno di spunta di fianco all'icona, a seconda del sistema operativo. Fate clic sulle icone per 
nasconderle o mostrarle sulla barra strumenti.
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Figura 7: selezione delle icone visibili della barra strumenti

Menu contestuali (clic destro)
Con un clic del pulsante destro su di un paragrafo, un elemento grafico o altri oggetti, è possibile 
accedere rapidamente a molte funzioni del menu. Ciò farà aprire un menu contestuale. Spesso il 
menu contestuale è il modo più facile e veloce di raggiungere una funzione. In caso d'incertezza 
circa il menu o barra strumenti in cui cercare una certa funzione, è spesso possibile trovarla 
semplicemente con un clic destro del mouse.

Barra di stato
La barra di stato è posizionata nella parte inferiore dello spazio di lavoro. Fornisce informazioni sul 
documento e i modi più convenienti per modificarne rapidamente alcune caratteristiche. È simile in 
Writer, Calc, Impress e Draw, anche se ogni componente include alcuni elementi specifici.

Figura 8: parte sinistra della barra di stato in Writer

Figura 9: parte destra della barra di stato in Writer

Di seguito sono descritti gli elementi comuni della barra di stato.

Pagina, foglio o numero di diapositiva
Mostra la pagina, il foglio o il numero della diapositiva corrente e il numero totale di pagine, 
fogli o diapositive del documento. Fate doppio clic in questo campo per aprire il Navigatore. 
Altri usi di questo campo dipendono dal componente.

Stile pagina o modello di diapositiva
Mostra lo stile della pagina corrente o il modello della diapositiva. Per modificare lo stile della 
pagina o il modello della diapositiva corrente, fate doppio clic su questo campo.
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Modifiche non salvate
Qui appare un'icona se le modifiche apportate al documento non sono state salvate.

Firma digitale
Se il documento è stato firmato digitalmente, viene mostrata un'icona qui. È possibile fare 
doppio clic sull'icona per visualizzare il certificato.

Informazioni sull'oggetto
Visualizza le informazioni relative alla posizione del cursore o l'elemento selezionato del 
documento. Il doppio clic in quest'area apre una finestra di dialogo relativa.

Cursore dello zoom e percentuale
Per modificare l'ingrandimento della visualizzazione, trascinate il cursore dello Zoom, o fate clic 
sui segni + e –, oppure ancora fate clic con il pulsante destro del mouse sul livello percentuale 
di zoom per far apparire un elenco di valori fra i quali scegliere.

Il doppio clic sul livello percentuale d'ingrandimento apre la finestra di dialogo Zoom e Layout 
visualizzazione.

Apertura di un nuovo documento

In LibreOffice potete aprire un nuovo documento in vari modi.

Quando LibreOffice è aperto senza che sia però aperto alcun documento (per esempio se chiudete 
tutti i documenti aperti ma lasciate il programma in esecuzione), viene visualizzato il Centro di 
Avvio. Fate clic sulle icone per aprire un nuovo documento di tipo corrispondente, oppure fate clic 
sull'icona Modelli per aprire un nuovo documento strutturato sulla base di un modello esistente.

Potete anche avviare un nuovo documento in uno dei modi seguenti:

• Utilizzate File > Nuovo e scegliete il tipo di documento.

• Usate la freccia accanto al pulsante Nuovo della barra degli strumenti principale. Scegliete 
il tipo di documento da creare dal menu a comparsa.

• Premete Ctrl+N sulla tastiera.

• Usate File > Procedure guidate per alcuni particolari tipi di documenti.

Se un documento è già aperto in LibreOffice, il nuovo documento si apre in una nuova finestra.
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Figura 10: Centro di Avvio di LibreOffice

Apertura di un documento esistente

Quando non vi sono documenti aperti, il Centro di Avvio fornisce un'icona per l'apertura di un 
documento esistente o la selezione da un elenco di documenti elaborati di recente.

Un documento esistente può essere aperto anche in uno dei modi seguenti:

• Selezionate File > Apri.

• Fate clic sul pulsante Apri sulla barra degli strumenti principale.

• Premete Ctrl+O sulla tastiera.

In ciascun caso appare la finestra di dialogo "Apri". Scegliete il file desiderato, poi fate clic su Apri. 
Se LibreOffice ha già un documento aperto, il secondo documento si apre in una nuova finestra.

Nella finestra di dialogo "Apri", è possibile ridurre l'elenco dei file scegliendo il tipo di file cercato. 
Ad esempio, se scegliete Documenti di testo come tipo di file, vedrete solo i documenti apribili 
con Writer (comprendenti le estensioni .odt, .doc, .txt); se scegliete Foglio elettronico, 
vedrete le estensioni .ods, .xls, e altri file apribili con Calc.
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Un documento esistente in formato OpenDocument può anche essere aperto facendo doppio clic 
sulla sua icona presente sul desktop o in un gestore di file come Windows Explorer.

Se avete associato i formati file di Microsoft Office con LibreOffice, potete aprire anch'essi con il 
doppio clic.

Nota
Con Microsoft Windows potete usare le finestre di dialogo di LibreOffice “Apri" e 
"Salva Come" o quelle fornite da Microsoft Windows. Vedere “Uso delle finestre di 
dialogo "Apri" e "Salva Come"” a pagina 31.

Salvare un documento

Per salvare un nuovo documento, effettuate una delle seguenti operazioni:

• Premete Ctrl+S.

• Selezionate File > Salva dalla barra dei menu.

• Fate clic sul pulsante Salva presente sulla barra strumenti principale.

Quando viene visualizzata la finestra di dialogo Salva Come, inserite il nome del file, verificate il 
tipo di file (se necessario), e fate clic su Salva.

Per salvare un documento aperto con il nome corrente, selezionate File > Salva. Questo causerà 
la sovrascrittura dell'ultima versione del file salvata precedentemente.

Protezione con password
Per proteggere un documento privo di password, usate l'opzione della finestra di dialogo Salva 
Come per immettere una password.

1) Nella finestra di dialogo "Salva Come", selezionate l'opzione Salva con password, e 
quindi fate clic su Salva. Visualizzerete una richiesta di conferma (Figura 11).

2) Digitate la stessa password in entrambi i campi, quindi fate clic su OK. Se le due digitazioni 
coincidono esattamente, il documento viene salvato con password di protezione. Se le 
password non coincidono, riceverete un messaggio di errore. Chiudete la finestra del 
messaggio per tornare a quella del dialogo Imposta Password e immettete nuovamente la 
password.

Attenzione LibreOffice usa un meccanismo di criptazione molto sicuro che rende quasi 
impossibile recuperare il contenuto di un documento, nel caso venga smarrita la 
password.
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Figura 11: inserimento di una password per un 
documento

Writer e Calc forniscono un secondo livello di protezione, il quale consente che un file possa 
essere visualizzato ma non modificato senza una password; cioè, il file viene aperto in modalità di 
sola lettura.

Per proteggere un documento da modifiche:

1) Selezionate Altre Opzioni dalla finestra di dialogo Imposta Password.

2) Inserite la password nel campo Inserisci la password per modificare. Ripetete la password 
nel campo Conferma password. Fate clic su OK.

Modifica della password di un documento
Quando un documento è protetto da password, potete modificarne la password mentre il 
documento è aperto. Scegliete File > Proprietà > Generale e fate clic sul pulsante Modifica 
Password.

Salvataggio automatico di un documento
È possibile impostare LibreOffice perché effettui il salvataggio dei file in modo automatico. Il 
salvataggio automatico, così come quello manuale, sovrascrive la versione del file dell'ultimo 
salvataggio precedente. Per impostare il salvataggio automatico:

1) Selezionate Strumenti > Opzioni > Carica/Salva > Generale.

2) Selezionate Salva informazioni di ripristino automatico ogni e impostate l'intervallo di 
tempo.

Rinominare ed eliminare file

Potete rinominare o eliminare file all'interno delle finestre di dialogo di LibreOffice, proprio come 
avviene utilizzando il vostro consueto file manager. Tuttavia, non potete copiare o incollare file 
all'interno delle finestre di dialogo.
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Uso delle finestre di dialogo "Apri" e "Salva Come"

Potete scegliere se usare le finestre di dialogo Apri e Salva Come di LibreOffice o quelle messe a 
disposizione dal vostro sistema operativo.

Per visualizzare o modificare il tipo di finestra di dialogo usata da LibreOffice:

1) Selezionate Strumenti > Opzioni > LibreOffice > Generale.

2) Selezionate l'opzione Usa le finestre di dialogo di LibreOffice.

Questa sezione descrive le finestre di dialogo "Apri" e "Salva Come" di LibreOffice. La Figura 12 
mostra il dialogo "Salva Come"; la finestra di dialogo "Apri" è simile.

Figura 12: la finestra di dialogo "Salva Come" di LibreOffice

I tre pulsanti in alto a destra delle finestre di dialogo "Apri" e "Salva Come" di LibreOffice sono, da 
sinistra:

• Sali Di Un Livello nella gerarchia delle cartelle. Fate clic e tenete premuto questo pulsante 
per un secondo per visualizzare un elenco di cartelle di livello più alto; per andare in una 
delle cartelle dell'elenco, spostate il puntatore del mouse sul suo nome e rilasciate il 
pulsante del mouse.

• Crea Nuova Cartella.

• Directory Predefinita.

Per i documenti LibreOffice salvati in più versioni, usate il menu a tendina Versione per 
selezionare la versione di apertura desiderata in modalità di sola lettura. I documenti Microsoft 
Office possono essere aperti solamente nella versione corrente.

Usate il campo Tipo file per specificare il tipo di file da aprire o il formato del file da salvare.

L'opzione di sola lettura nella finestra di dialogo "Apri" apre il file solo per la lettura e la stampa. Di 
conseguenza, gran parte degli strumenti scompaiono, e gran parte delle opzioni dei menu sono 
disabilitate. Un pulsante Modifica File viene visualizzato sulla barra strumenti Standard per 
l'apertura del file da modificare.
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È possibile aprire file dal Web digitando un URL nel campo Nome file della finestra di dialogo 
"Apri".

Usare il Navigatore

Il Navigatore elenca gli oggetti contenuti in un documento, raggruppati per categoria. Per esempio, 
nell'ambito di Writer il Navigatore mostra Intestazioni, Tabelle, Cornici, Commenti, Grafica, 
Segnalibri, e altri oggetti, come indicato in Figura 13. Nell'ambito di Calc mostra Fogli, Nomi delle 
Aree, Aree Database, Grafica, Elementi di disegno e altri oggetti. In Impress e Draw il Navigatore 
mostra Diapositive, Immagini ed altri oggetti.

Per aprire il Navigatore, fate clic sull'icona corrispondente  sulla barra degli strumenti Standard 
o premete F5, oppure selezionate Visualizza > Navigatore sulla barra dei menu.

È possibile ancorare il Navigatore su entrambi i lati della finestra principale di LibreOffice o 
lasciarlo mobile (vedere “Aggancio/separazione di finestre e barre degli strumenti“ a pagina 25).

Fate clic sul marcatore (+ o triangolo) da una delle categorie per visualizzare l'elenco degli oggetti 
in quella categoria.

Per nascondere l'elenco delle categorie e visualizzare solo le barre degli strumenti nella parte 

superiore, fate clic sull'icona Casella di riepilogo . Fate un nuovo clic sulla stessa icona per 
visualizzare la casella di riepilogo.

Figura 13: il Navigatore
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Il Navigatore offre anche diversi modi pratici per spostarsi in un documento e trovare elementi al 
suo interno:

• Se una categoria elenca tutti gli elementi in essa contenuti, è sufficiente un doppio clic su 
un elemento qualsiasi per andare direttamente alla posizione in cui l'elemento si trova 
all'interno del documento.

È più facile reperire gli Oggetti se avete assegnato loro un nome al momento della 
creazione, invece di mantenere le definizioni preimpostate di LibreOffice "grafica1", 
"grafica2", "Tabella1", "Tabella2", e così via—che potrebbero non corrispondere alla 
posizione dell'oggetto nel documento.

Se desiderate solo vedere il contenuto di una determinata categoria, evidenziatela e fate 

clic sull'icona Vista del Contenuto . Gli oggetti di quella sola categoria resteranno 
visualizzati fino ad un nuovo clic sulla sua icona.

• Fate clic sull'icona Navigazione  (seconda icona da sinistra in cima al Navigatore) 
per visualizzare la barra di Navigazione. Qui è possibile scegliere una delle categorie e 
usare le icone Precedente e Successivo per spostarsi da un elemento al successivo. Ciò 
è particolarmente utile per cercare oggetti quali segnalibri e indici, altrimenti difficili da 
vedere.

I nomi delle icone (mostrati nella descrizione comandi) cambiano per corrispondere alla 
categoria selezionata; ad esempio, Prossimo Disegno o Prossimo Segnalibro.

• Per andare direttamente ad una certa pagina del documento, digitatene il numero nella 
casella nella parte superiore del Navigatore.

Figura 14: barra di Navigazione

Un po' di sperimentazione con le altre icone sarà sufficiente per apprendere le loro funzioni. Alcuni 
impieghi particolari in Writer e negli altri singoli componenti sono descritti nei capitoli ad essi 
dedicati.

Annullamento e ripristino delle modifiche

Per annullare la modifica più recente premete Ctrl+Z, o fate clic sull'icona Annulla  sulla barra 
degli strumenti Standard, oppure scegliete Modifica > Annulla dalla barra menu.

Il menu Modifica mostra l'ultima modifica effettuata che può essere annullata (vedere sotto un 
esempio per Writer).
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Figura 15: Modifica > Annulla l'ultima 
operazione

Fate clic sul piccolo triangolo a destra dell'icona Annulla per ottenere un elenco di tutte le 
modifiche che possono essere annullate. È possibile selezionare più azioni e annullarle 
contemporaneamente.

Figura 16: elenco di operazioni che possono 
essere annullate

Dopo che le modifiche sono state annullate, la funzione Ripristina diventa attiva. Per ripristinare 
una modifica, selezionate Modifica > Ripristina, o premete Ctrl+Y oppure fate clic sull'icona 

Ripristina . Come con la funzione Annulla, fate clic sul triangolo a destra dell'icona per 
visualizzare un elenco delle modifiche che possono essere ripristinate.

Per variare il numero di modifiche ricordate da LibreOffice, selezionate Strumenti > Opzioni > 
LibreOffice > Memoria e nella sezione Annulla cambiate il numero di operazioni. Ricordate che 
obbligare LibreOffice a ricordare più modifiche comporta l'uso di più memoria.

Chiusura di un documento

Per chiudere un documento, selezionate File > Chiudi.

È anche possibile chiudere un documento facendo clic sul pulsante Chiudi nella finestra del 
documento stesso. Questo pulsante ha l'aspetto di una X come indicato in Figura 17. Nel vostro 
sistema operativo potrebbe essere in una posizione diversa.

Figura 17: icone di chiusura

Se vi sono più finestre di LibreOffice aperte, ciascuna di esse ha l'aspetto simile all'esempio 
mostrato a sinistra in Figura 17. La chiusura di questa finestra lascia le altre finestre di LibreOffice 
aperte.
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Se una sola finestra di LibreOffice è aperta, l'aspetto è simile all'esempio indicato a destra in 
Figura 17. Notate a destra la x piccola (se nel tema di sistema le X di chiusura sono a destra nelle 
finestre, la x piccola si troverà sotto la X grande). Facendo clic sulla x piccola si chiude il 
documento ma LibreOffice rimane aperto. Facendo clic sulla X grande LibreOffice si chiude 
completamente.

Se il documento non è stato salvato dopo l'ultima modifica, appare una finestra con una notifica 
all'utente. Scegliete se salvare o scartare le modifiche apportate.

• Salva: Il documento viene salvato e poi chiuso.

• Chiudi senza salvare: Il documento viene chiuso e tutte le modifiche successive all'ultimo 
salvataggio vanno perse.

• Cancella: Non succede nulla e si ritorna al documento.

Attenzione
Non salvare il documento può far perdere le modifiche recenti o, addirittura l'intero 
file.

Chiusura di LibreOffice

Per chiudere LibreOffice completamente, scegliete File > Esci, o chiudete l'ultimo documento 
aperto come descritto sopra in “Chiusura di un documento”.

Se tutti i documenti sono stati salvati, LibreOffice si chiude immediatamente. Nel caso un qualsiasi 
documento sia stato modificato ma non salvato, appare uno specifico messaggio di avviso. 
Seguite la procedura riportata in “Chiusura di un documento” per salvare o scartare le modifiche 
apportate.
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Capitolo 2  
Configurare LibreOffice.org
Scegliere le opzioni adatte al vostro lavoro



Opzioni comuni a tutti i componenti di LibreOffice

Questa sezione tratta alcune delle impostazioni comuni a tutti i componenti di LibreOffice. Per 
informazioni sulle impostazioni non discusse in questa sezione, si veda l'aiuto in linea.

Fate clic su Strumenti > Opzioni. L'elenco nella parte sinistra della finestra varia a seconda del 
componente di LibreOffice aperto. Le illustrazioni di questo capitolo mostrano l'elenco che appare 
quando è aperto un documento di Writer.

Fate clic sul marcatore (+ o triangolo) vicino a LibreOffice sul lato sinistro. Appare un elenco di 
pagine. Selezionando un elemento dell'elenco apparirà, sul lato destro della finestra di dialogo, la 
pagina relativa.

Figura 18: Opzioni - LibreOffice

Nota
Il pulsante Ripristina (non mostrato nell'illustrazione; posizionato in basso a destra 
nella finestra di dialogo Opzioni) ha lo stesso effetto in tutte le pagine della finestra 
Opzioni. Reimposta le opzioni sui valori presenti all'apertura di LibreOffice.

Dati utente
Siccome LibreOffice utilizza il nome o le iniziali salvati nella pagina LibreOffice – Dati Utente per 
diverse cose, incluse le proprietà del documento (informazioni relative alla creazione e all'ultima 
modifica) e il nome dell'autore di annotazioni e modifiche, assicuratevi di inserire in questa pagina 
le informazioni corrette.

Compilate il modulo (mostrato in Figura 19), oppure correggete o cancellate eventuali informazioni 
sbagliate.

Se state utilizzando una versione di LibreOffice diversa da quella Inglese (US English), alcune 
etichette dei campi potrebbero essere diverse da quelle mostrate nelle illustrazioni.
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Figura 19: inserimento dei dati personali

Generale
Di seguito vengono descritte le opzioni nella pagina LibreOffice – Generale.

Figura 20: impostazione delle opzioni generali di LibreOffice

Guida - Suggerimenti
Se i Suggerimenti sono abilitati, mantenendo il puntatore del mouse su un'icona o un campo, 
senza fare clic, apparirà una brevissima descrizione del comando relativo.

Guida - Guida attiva
Se la Guida attiva è abilitata, mantenendo il puntatore del mouse su un'icona, un comando di 
menu o un campo di una finestra, appare una breve descrizione della loro funzione.

Help Agent
Per disabilitare l'Help Agent (simile all'Assistente di Microsoft Office), deselezionate l'opzione. 
Per ripristinare il comportamento predefinito, fate clic su Ripristina Help Agent.

Capitolo 2  Configurare LibreOffice.org 39



Finestre di dialogo Apri/Salva – Utilizza finestre di dialogo LibreOffice
Per utilizzare le finestre standard Apri e Salva del vostro sistema operativo, deselezionate 
l'opzione Utilizza finestre di dialogo LibreOffice. Se l'opzione è selezionata, verranno usate 
le finestre Apri e Salva fornite da LibreOffice. Per maggiori dettagli sulle finestre Apri e Salva di 
LibreOffice, si veda il Capitolo 1 (Introduzione a LibreOffice). Questo testo utilizza le finestre di 
dialogo "Apri" e "Salva" di LibreOffice nelle illustrazioni.

Finestre di dialogo Apri/Salva - Mostra prima le finestre di dialogo ODMA DMS
(Solo per Windows) Se il client GroupWise è installato sul vostro computer, selezionando 
questa opzione LibreOffice vi permetterà di aprire o salvare documenti in GroupWise. Se il 
client GroupWise non è installato, questa opzione non ha effetto.

Finestre di dialogo di stampa – Utilizza finestre di dialogo LibreOffice
(Solo per Mac) Per utilizzare le finestre di dialogo standard per la stampa del vostro sistema 
operativo, deselezionate l'opzione Utilizza finestre di dialogo LibreOffice. Se l'opzione è 
selezionata, verranno usate le finestre di dialogo per la Stampa fornite da LibreOffice. Questo 
testo utilizza le finestre di dialogo per la Stampa di LibreOffice nelle illustrazioni.

Stato del documento – Dopo la stampa cambia lo stato in “documento modificato”
Se l'opzione è attiva, dopo la stampa di un documento, la data di stampa viene salvata nelle 
proprietà del documento come un cambiamento e, alla chiusura, verrà chiesto di salvare il 
documento anche se questo non ha subito modifiche.

Stato del documento – Permette di salvare i documenti anche quando il documento non è 
stato modificato

Normalmente se un documento non è stato modificato, l'opzione di menu File > Salva e l'icona 
Salva sulla barra degli strumenti Standard sono disabilitate e la combinazione di tasti di scelta 
rapida Ctrl+S non ha effetto. Selezionate questa opzione per permettere il salvataggio dei 
documenti anche se non sono stati modificati.

Anno (due cifre)
Specifica come sono interpretati gli anni espressi con due cifre. Ad esempio, se il valore è 
impostato su 1930, inserendo nel documento la data 01/01/30 o posteriore, questa viene 
interpretata come 01/01/1930 o posteriore. Una data "precedente" è interpretata come relativa 
al secolo successivo; ovvero, 01/01/20 è interpretata come 01/01/2020.

Abilita le funzionalità sperimentali (instabile)
Per provare due funzionalità sperimentali di LibreOffice, la modifica di formule in-linea e la 
registrazione di macro, selezionate questa opzione.

Memoria principale
Le opzioni della pagina LibreOffice – Memoria principale controllano l'utilizzo della memoria del 
computer e la memoria richiesta da parte di LibreOffice. Prima di modificarle, tenete in 
considerazione i seguenti fattori:

• Una memoria maggiore può rendere LibreOffice più comodo e veloce (ad esempio, 
ricordare più livelli per la funzione Annulla richiede più memoria); per contro, la minor 
quantità di memoria rimanente potrebbe causare problemi durante l'utilizzo di altre 
applicazioni.

• Se i vostri documenti contengono molti oggetti come le immagini, oppure gli oggetti sono di 
grosse dimensioni, le prestazioni di LibreOffice potrebbero migliorare se aumentate la 
memoria per LibreOffice o la memoria per oggetto. Se vi accorgete che in un documento 
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che contiene molti oggetti questi sembrano scomparire, aumentate il numero di oggetti 
nella cache. (Gli oggetti sono comunque nel file anche se non li potete vedere a schermo).

Figura 21: le opzioni di Memoria per le applicazioni LibreOffice

• Per caricare Quickstart (un'icona sul desktop o nel vassoio di sistema) all'avvio del 
computer, selezionate l'opzione in fondo alla finestra. In questo modo LibreOffice si aprirà 
più velocemente, ma impegnerà parte della memoria anche quando non viene utilizzato. 
Questa opzione (detta Abilita Quickstart nell'area di notifica su Linux) non è disponibile 
per Mac OS X e per i sistemi operativi nei quali il modulo Quickstart non è stato installato.

Vista
Le opzioni della pagina LibreOffice – Vista riguardano l'aspetto e il comportamento della finestra 
dei documenti. Di seguito sono descritte alcune di queste opzioni. Potete impostarle come 
preferite.

Figura 22: le opzioni di Vista per le applicazioni LibreOffice
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Interfaccia utente – Scala
Se il testo nei file della Guida o nei menu dell'interfaccia utente di LibreOffice è troppo piccolo o 
troppo grande, è possibile modificarlo specificando un fattore di scala. La modifica di questo 
valore può dare risultati imprevisti, a seconda dei caratteri disponibili per lo schermo nel vostro 
sistema operativo. Comunque, non ha alcun effetto sulle dimensioni dei caratteri del testo nei 
vostri documenti.

Interfaccia utente – Dimensione e stile icona
La prima opzione specifica la dimensione delle icone sulla barra degli strumenti (Automatica, 
piccola o grande). L'opzione Automatico usa l'impostazione della dimensione delle icone del 
vostro sistema operativo. La seconda opzione specifica lo stile delle icone (tema); in questo 
caso l'opzione Automatico usa un tipo di icone compatibile con il vostro sistema operativo e la 
vostra impostazione del desktop: ad esempio, KDE o Gnome in Linux.

Interfaccia utente – Usa i caratteri di sistema per l'interfaccia
Se preferite usare il carattere di sistema (il carattere predefinito del computer e del sistema 
operativo) per l'interfaccia utente, invece del carattere fornito da LibreOffice, selezionate 
questa opzione.

Interfaccia utente – Eliminazione effetto scalettatura (antialiasing)
(Non disponibile in Windows; non mostrato in Figura 22.) Selezionate questa opzione per 
smorzare l'aspetto del testo sul monitor. Inserite la più piccola dimensione del carattere, a 
partire dalla quale verrà applicata l'eliminazione dell'effetto scalettatura.

Menu – icone nei menu
Rende visibili sia le icone che le parole nei menu.

Elenchi dei caratteri - Mostra anteprima dei caratteri
Selezionando questa opzione l'elenco dei caratteri appare come in  Figura 23, a sinistra, con i 
nomi dei caratteri scritti con il carattere stesso; se non selezionate l'opzione, l'elenco dei 
caratteri mostra soltanto i nomi dei caratteri, non il loro aspetto (Figura 23, a destra). I caratteri 
elencati sono quelli installati sul vostro sistema.

I caratteri che sono regolati per l'utilizzo con una scrittura specifica, come l'Arabo, l'Ebraico, il 
Malayalam, e così via, ora mostrano una ulteriore anteprima di un testo di esempio nella 
scrittura di destinazione.
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Figura 23: elenco dei caratteri (sinistra) con anteprima; (destra) senza anteprima

Elenchi di caratteri - Mostra tipi di carattere selezionati
Se selezionate questa opzione, gli ultimi cinque caratteri utilizzati nel documento vengono 
mostrati in cima all'elenco dei caratteri. Diversamente i caratteri vengono mostrati in ordine 
alfabetico.

Risultato immagine – Usa accelerazione hardware
Accesso diretto alle funzionalità hardware della scheda video per migliorare la visualizzazione 
a schermo. Non supportato su tutti i sistemi operativi e distribuzioni di LibreOffice.

Risultato immagine – Utilizza antialiasing
Abilita e disabilita l'antialiasing, che rende la visualizzazione della maggior parte degli oggetti 
grafici più smorzata e meno artefatta. Non supportato su tutti i sistemi operativi e distribuzioni 
di LibreOffice.

Suggerimento
Premete Maiusc+Ctrl +R per ripristinare o aggiornare la vista del documento 
attivo.

Posizionamento del mouse
Specifica se e come il puntatore del mouse verrà posizionato nelle nuove finestre di dialogo.

Tasto medio del mouse
Definisce la funzione del tasto medio del mouse.

• Scorrimento automatico – il trascinamento, mentre si preme il tasto medio del mouse, fa 
scorrere la visualizzazione.

• Incolla Appunti – la pressione del tasto medio del mouse inserisce il contenuto degli 
“appunti di selezione” nella posizione del cursore.

Gli “Appunti di selezione” sono indipendenti dai normali appunti che utilizzate tramite Modifica 
> Copia/Taglia/Incolla o i loro rispettivi tasti di scelta rapida. Gli appunti e gli “Appunti di 
selezione” possono avere allo stesso tempo contenuti differenti.
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Funzione Appunti Appunti di selezione

Copia del contenuto Modifica > Copia Ctrl+C Seleziona testo, tabella, o oggetto.

Incollare contenuto Modifica > Incolla Ctrl+V 
incolla alla posizione del 
cursore.

Facendo clic con il tasto medio del 
mouse si incolla il contenuto alla 
posizione del puntatore del mouse.

Copia in un altro 
documento

Nessun effetto sui contenuti 
degli appunti.

L'ultima selezione contrassegnata è il 
contenuto degli appunti di selezione.

Selezione – Trasparenza
Determina l'aspetto del testo o immagine selezionati, che appaiono su uno sfondo 
ombreggiato. Per rendere più o meno scuro lo sfondo ombreggiato, aumentate o diminuite le 
impostazioni della Trasparenza.

Se preferite che la selezione appaia in colore invertito (tipicamente testo bianco su sfondo 
nero), deselezionate questa opzione.

Opzioni stampa
Sulla pagina LibreOffice – Stampa, impostate le opzioni di stampa adatte alla vostra stampante e 
ai vostri consueti metodi di stampa.

Figura 24: opzioni generali di stampa per tutti i componenti di LibreOffice

Nella sezione Avvertenze di stampa, nella parte bassa della pagina, potete decidere se ricevere un 
avviso nel caso in cui le dimensioni o l'orientamento della carta indicati nel documento non 
corrispondano alle dimensioni o all'orientamento disponibili per la vostra stampante. Attivare 
queste opzioni può risultare molto utile, in particolare nel caso in cui si lavori con documenti 
prodotti in paesi con formati standard di carta differenti.
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Suggerimento
Se le stampe non sono ben posizionate nella pagina o sono troncate in alto, in 
basso o ai lati, o se la stampante si rifiuta di stampare, probabilmente è un 
problema di incompatibilità di dimensioni.

Percorsi
Sulla pagina LibreOffice – Percorsi potete cambiare la posizione dei file relativi o utilizzati da 
LibreOffice in base alla vostra situazione lavorativa. Ad esempio, in Windows potreste voler salvare 
in maniera predefinita i documenti in una cartella diversa da Documenti.

Per apportare modifiche, scegliete una voce dall'elenco visualizzato in Figura 25 e fate clic su 
Modifica. Nella finestra Seleziona percorso (non riportata; potrebbe anche essere chiamata 
Modifica Percorsi), aggiungete o eliminate le cartelle secondo necessità, e poi fate clic su OK per 
tornare alla finestra Opzioni. Notate che per alcune voci possono essere elencati almeno due 
percorsi: uno porta a una cartella condivisa (che potrebbe trovarsi in rete) e uno ad una cartella 
personale (di solito sul computer dell'utente).

Suggerimento
Potete utilizzare le voci nella pagina LibreOffice – Percorsi per compilare un 
elenco di file, ad esempio quelli contenenti il Testo automatico, che dovete 
salvare o copiare su un altro computer.

Figura 25: i percorsi dei file utilizzati da LibreOffice

Colori
Nella pagina LibreOffice – Colori potete specificare i colori da usare nei documenti di LibreOffice. 
Potete selezionare un colore da una tavolozza, modificare un colore già presente e definire nuovi 
colori. Questi colori sono salvati nella vostra tavola dei colori e sono quindi disponibili in tutti i 
componenti di LibreOffice.
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Figura 26: definizione dei colori da utilizzare nella tavolozza di LibreOffice

Per modificare un colore:

1) Selezionate il colore da modificare dall'elenco o dalla tavola dei colori.

2) Inserite i nuovi valori che definiscono il colore. Per indicare il vostro colore potete scegliere 
il sistema RGB (Red, Green, Blue - Rosso, Verde, Blu) oppure il sistema CMYK (Cyan, 
Magenta, Yellow, Black - Ciano, Magenta, Giallo Nero). I colori modificati appaiono nel più 
basso tra i due riquadri di anteprima del colore, nella parte alta della pagina.

3) Modificate il Nome come richiesto.

4) Fate clic sul pulsante Modifica. Il colore appena definito è ora elencato nella tavola dei 
colori.

Alternativamente, fate clic sul pulsante Modifica per aprire la finestra di dialogo Selettore di 
Colore, mostrato in Figura 27. Qui potete selezionare un colore dalla finestra sulla sinistra, oppure 
potete inserire dei valori di vostra scelta sulla destra, per RGB, CMYK, o HSB (Hue, Saturation and 
Brightness - Tono, Saturazione e Luminosità).

La finestra del colore sulla sinistra è collegata direttamente con i campi di inserimento del colore 
sulla destra; quando scegliete un colore nella finestra, i numeri cambiano di conseguenza. Il 
campo di colore in basso a sinistra mostra il valore del colore selezionato sulla sinistra e il valore 
correntemente impostato nei campi relativi al valore del colore sulla destra.

Cambiate i componenti del colore secondo necessità e fate clic su OK per uscire dalla finestra. Il 
colore appena definito ora appare nel più basso dei riquadri di anteprima del colore mostrati in 
Figura 26. Digitate un nome per questo colore nel riquadro Nome, quindi fate clic sul pulsante 
Aggiungi. Un piccolo riquadro con il nuovo colore viene aggiunto alla tavola dei colori.

Un altro modo per definire o modificare i colori è tramite la pagina Colori della finestra di dialogo 
Area, dove potete anche salvare e caricare tavolozze, una funzionalità che non è possibile qui. In 
Calc, create un oggetto di disegno temporaneo e usate il menu contestuale di tale oggetto per 
aprire la finestra di dialogo Area. Se caricate una tavolozza in uno dei componenti di LibreOffice, 
questa sarà attiva solo per quel componente; gli altri componenti manterranno le proprie tavolozze.
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Figura 27: modifica dei colori

Tipi di carattere
Potete stabilire un sostituto per ogni carattere presente nei documenti. Se ricevete un documento 
contenente caratteri non installati nel vostro sistema, LibreOffice li sostituirà. Potete specificare un 
carattere diverso da quello scelto dal programma.

Figura 28: sostituzione di un carattere

Nella pagina LibreOffice – Tipi di carattere:

1) Selezionate l'opzione Applica tabella di sostituzione.
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2) Selezionate o digitate il nome del carattere da sostituire nel riquadro Tipo di carattere. (Se 
sul sistema non è presente un determinato carattere, questo non appare nel menu a 
tendina, perciò dovrete digitarne il nome).

3) Nella casella Sostituisci con, scegliete un carattere adatto dal menu a tendina dei 
caratteri installati sul computer.

4) Il simbolo di spunta a destra della casella Sostituisci con diventa verde. Premetelo. 
Appare una riga di informazioni nel riquadro grande sotto i riquadri di selezione. 
Selezionate Sempre per sostituire il carattere, anche se il carattere originale è installato sul 
vostro sistema. Selezionate Solo schermo per sostituire il carattere solo a schermo e mai 
per la stampa. I risultati della combinazione di queste selezioni sono mostrati nella Tabella 
2.

5) Nella sezione nella parte bassa della pagina, potete cambiare il tipo e la dimensione del 
carattere usato per visualizzare codice sorgente come HTML e Basic (nelle macro).

Tabella 2: azioni di sostituzione nel cambiamento del carattere

Casella 
sempre

Casella solo 
schermo

Azione di sostituzione

spuntata bianca Sostituzione del carattere a schermo e nella stampa, che il 
carattere sia installato o meno.

spuntata spuntata Sostituzione del carattere solo a schermo, che il carattere sia 
installato o meno.

bianca spuntata Sostituzione del carattere solo a schermo, ma solo se il carattere 
non è disponibile.

bianca bianca Sostituzione del carattere a schermo e nella stampa, ma solo se il 
carattere non è disponibile.

Sicurezza
Nella pagina LibreOffice – Sicurezza potete stabilire le opzioni di sicurezza per il salvataggio dei 
documenti e il caricamento di quei documenti che contengono macro.
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Figura 29: opzioni di sicurezza per il caricamento e il salvataggio di documenti

Opzioni di sicurezza e avvisi
Se registrate le modifiche, salvate versioni multiple, o includete informazioni nascoste o note 
nei vostri documenti, e desiderate che alcuni dei destinatari non vedano queste informazioni, 
potete impostare degli avvisi per ricordarvi di rimuovere tali informazioni, oppure potete fare in 
modo che LibreOffice cancelli automaticamente alcune informazioni. Notate che (a meno che 
siano state rimosse) molte di queste informazioni sono conservate in un file, che sia nel 
formato predefinito di LibreOffice OpenDocument, o che sia stato salvato in altri formati, incluso 
PDF.

Fate clic sul pulsante Opzioni per aprire una finestra di dialogo separata con scelte specifiche 
(Figura 30).

Sicurezza delle macro
Fate clic sul pulsante Sicurezza delle macro per aprire la finestra di dialogo Sicurezza delle 
macro (qui non riportata), dove potete impostare il livello di sicurezza per l'esecuzione delle 
macro e specificare le fonti affidabili.

Opzioni di sicurezza e avvisi
Le seguenti opzioni si trovano nella finestra di dialogo Opzioni di sicurezza e avvisi (Figura 30).

Rimuovi le informazioni personali al salvataggio
Selezionate questa opzione per rimuovere sempre i dati dell'utente dalle proprietà del file 
quando salvate il file. Per rimuovere manualmente le informazioni personali da documenti 
specifici, deselezionate questa opzione e utilizzate poi il pulsante Cancella sotto File > 
Proprietà > Generale.

Ctrl-clic necessario per l'apertura dei collegamenti
Il comportamento predefinito in LibreOffice richiede il Ctrl+clic su un collegamento ipertestuale 
per aprire il documento collegato. Molte persone trovano più facile la creazione e la modifica di 
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documenti se clic involontari sui collegamenti non attivano i collegamenti stessi. Per fare in 
modo che LibreOffice attivi i collegamenti ipertestuali con un semplice clic, deselezionate 
questa opzione.

Le altre opzioni in questa finestra di dialogo dovrebbero essere autoesplicative.

Figura 30: finestra di dialogo Opzioni di sicurezza e avvisi

Aspetto
La scrittura, la modifica e (specialmente) il layout di pagina risultano spesso facilitati dalla 
possibilità di vedere i margini di pagina (i bordi del testo), i bordi di tabelle e sezioni (nei documenti 
di Writer), interruzioni di pagina in Calc, griglie in Draw o Writer, e altre funzionalità. Inoltre, 
potreste volere colori diversi da quelli predefiniti di LibreOffice per elementi come indicatori di nota 
od ombreggiature dei campi.

Nella pagina LibreOffice – Aspetto (Figura 31), potete specificare quali elementi rendere visibili e 
con quali colori.

• Per mostrare o nascondere elementi come i margini di testo, selezionate o deselezionate le 
opzioni vicine ai nomi degli elementi.

• Per cambiare il colore predefinito degli elementi, selezionate un colore dall'elenco a tendina 
relativo agli elementi nella colonna Impostazione colori.

• Per salvare le modifiche apportate come schema colori, fate clic su Salva, digitate un 
nome nel campo Nome dello schema colori; quindi fate clic su OK.
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Figura 31: mostrare o nascondere i margini del testo, il contorno di un oggetto e 
di una tabella

Accesso facilitato
Le opzioni di Accesso facilitato includono la gestione di animazioni grafiche o testuali, della durata 
di visualizzazione dei suggerimenti, di alcune opzioni per la visualizzazione in alto contrasto e del 
cambiamento dei caratteri dell'interfaccia utente di LibreOffice.

Il supporto per l'accesso facilitato si appoggia alla tecnologia Java per le comunicazioni con 
strumenti di tecnologia assistiva di Sun Microsystems. Si veda “Java“ di seguito. L'opzione 
Strumenti per il supporto con tecnologia assistiva non viene mostrata in tutte le installazioni di 
LibreOffice. Si veda Funzioni di accesso facilitato in LibreOffice nella Guida per altre informazioni e 
requisiti.

Selezionate o deselezionate le opzioni secondo necessità.

Figura 32: opzioni di Accesso facilitato
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Java
Se installate o aggiornate un Java Runtime Environment (JRE) dopo l'installazione di LibreOffice, o 
se avete più di un JRE installato, potete usare la pagina LibreOffice – Opzioni Java per selezionare 
il JRE da usare.

Se siete amministratori di sistema, programmatori o comunque persone che personalizzano 
installazioni JRE, potete usare le pagine Parametri e Classpath (accessibili dalla pagina Java) per 
specificare queste informazioni.

Se nella pagina non appare nulla, aspettate qualche minuto affinché LibreOffice possa cercare i 
JRE sul disco rigido.

Se LibreOffice trova uno o più JRE, li mostrerà nella pagina. Potete quindi selezionare l'opzione 
Usa un ambiente Java runtime e (se necessario) scegliere uno dei JRE elencati.

Figura 33: scegliere un ambiente runtime Java

Aggiornamento Online
Nella pagina LibreOffice – Aggiornamento online (Figura 34), potete scegliere se e con che 
frequenza il programma debba controllare il sito web di LibreOffice per cercare eventuali 
aggiornamenti. Se l'opzione Controlla aggiornamenti automaticamente è selezionata, appare 
un'icona sul lato destro della barra dei menu quando un aggiornamento è disponibile. Fate clic su 
questa icona per aprire una finestra di dialogo in cui potrete scegliere di scaricare l'aggiornamento.

Se l'opzione Scarica aggiornamenti automaticamente è selezionata, il download inizia quando 
fate clic sull'icona. Per cambiare la destinazione del download, fate clic sul pulsante Cambia e 
selezionate la cartella desiderata nella finestra di esplorazione file.
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Figura 34: aggiornamento online

Opzioni di caricamento e salvataggio dei documenti

Potete impostare le opzioni di salvataggio e caricamento secondo le vostre necessità.

Se la finestra Opzioni non è aperta, fate clic su Strumenti > Opzioni. Fate clic sul segno di 
espansione (+ o triangolo) alla sinistra di Carica/Salva.

Figura 35: opzioni di caricamento e salvataggio

Opzioni generali di caricamento e salvataggio
La maggior parte delle voci nella pagina Carica/salva - Generale saranno familiari agli utenti di 
altre suite per ufficio. Di seguito sono descritti alcuni elementi di particolare interesse.
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Figura 36: opzioni Carica/salva

Carica le impostazioni personalizzate insieme al documento
Un documento di LibreOffice contiene determinate impostazioni che vengono lette dal sistema 
dell'utente. Durante il salvataggio, queste impostazioni vengono salvate con il documento.

Selezionando questa opzione, durante il caricamento del documento, esso ignora le 
impostazioni salvate, in favore di quelle sul vostro computer.

Anche se non selezionate questa opzione, alcune impostazioni vengono prese dalla 
installazione del vostro LibreOffice:

• Impostazioni disponibili in File > Stampa > Opzioni

• Nome del Fax

• Opzioni di spaziatura per paragrafi che precedono tabelle di testo

• Informazioni sull'aggiornamento automatico per collegamenti, funzioni di campo e 
grafici

• Informazioni riguardanti l'utilizzo di formati di caratteri Asiatici.

Le seguenti impostazioni sono sempre caricate insieme al documento, anche se questa 
opzione non è selezionata:

• Sorgente dati collegata al documento e sua visualizzazione.

Se disattivate l'opzione, le impostazioni personalizzate dell'utente non prevalgono sulle 
impostazioni del documento. Ad esempio, la scelta (nelle opzioni per LibreOffice Writer) della 
modalità di aggiornamento dei collegamenti è influenzata dall'opzione Carica le impostazioni 
personalizzate insieme al documento.

Carica le impostazioni della stampante insieme al documento
Se abilitata, le impostazioni della stampante verranno caricate con il documento. Ciò potrebbe 
fare in modo che un documento venga stampato su una stampante distante (magari in una 
impostazione di ufficio), se non modificate la stampante manualmente nella finestra di dialogo 
Stampa. Se disabilitata, per stampare il documento verrà usata la stampante predefinita. Le 
impostazioni della stampante corrente verranno salvate con il documento anche se questa 
opzione non è selezionata.
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Modifica le proprietà prima di salvare
Se selezionate questa opzione, la prima volta che salvate un documento (oppure ogni volta 
che usate Salva con nome) apparirà la finestra Proprietà, a suggerirvi di inserire le 
informazioni relative al file.

Crea sempre copia di backup
Salva la versione precedente di un documento come copia di backup quando salvate un 
documento. Quando LibreOffice crea una copia di backup, quella precedente viene rimpiazzata 
da quella nuova. La copia di backup ha estensione .BAK.

Salva informazioni di Ripristino Automatico ogni __ Minuti 
Scegliere se abilitare il Ripristino Automatico e la frequenza con cui vengono salvate le 
informazioni usate dal processo di Ripristino Automatico.

Il Ripristino Automatico in LibreOffice salva le informazioni necessarie al ripristino dei 
documenti aperti in caso di un crash. Se questa opzione è attiva, sarà più facile recuperare un 
documento dopo un blocco del sistema.

Salvare URL relativi al file system / internet
Usate questa opzione per selezionare il comportamento predefinito per l'indirizzamento relativo 
degli URL nel file system e su Internet. L'indirizzamento relativo è possibile solo se il 
documento sorgente e il documento a cui si fa riferimento sono entrambi sulla stessa unità.

Un indirizzo relativo inizia sempre dalla cartella in cui si trova il documento corrente. Di contro, 
un indirizzo assoluto inizia sempre da una cartella radice. La tabella seguente mostra la 
differenza di sintassi tra riferimento relativo e assoluto:

Esempi File system Internet

relativo ../immagini/img.jpg ../immagini/img.jpg

assoluto file:///c|/lavoro/immagini/img.jpg http://mioserver.com/lavoro/immagini/img.j
pg

Se scegliete di salvare in modo relativo, i riferimenti a immagini o altri oggetti incorporati nel 
documento verranno salvati relativamente alla posizione nel file system. In questo caso, non 
ha importanza dove sia registrata la struttura di cartelle a cui si fa riferimento. I file verranno 
trovati a prescindere dalla posizione, fintantoché il riferimento rimane sulla stessa unità o 
volume. Questo è importante se desiderate rendere il documento disponibile ad altri computer 
che potrebbero avere una struttura di cartelle, una unità o nomi di volume completamente 
differenti. Si consiglia anche di salvare relativamente se desiderate creare una struttura di 
cartelle su un server Internet.

Se preferite salvare in modo assoluto, tutti i riferimenti ad altri file saranno anche definiti come 
assoluti, basati sulla rispettiva unità, volume o cartella radice. Il vantaggio è che il documento 
contenente i riferimenti può essere spostato in altre cartelle, e i riferimenti rimangono validi.

Formato file predefinito e impostazioni ODF
Versione del formato ODF. LibreOffice per impostazione predefinita salva i documenti nel 
Formato OpenDocument (ODF) versione 1.2 Esteso. Se da un lato ciò permette una 
funzionalità migliorata, dall'altro lato potrebbero esserci problemi di compatibilità con le versioni 
precedenti. Quando un file salvato in ODF 1.2 Esteso viene aperto con un editor che utilizza 
versioni precedenti di ODF, 1.0/1.1, alcune delle caratteristiche avanzate potrebbero perdersi. 
Due esempi notevoli sono i riferimenti incrociati alle intestazioni e la formattazione degli elenchi 
numerati. Se intendete condividere documenti con persone che utilizzano editor che fanno uso 
di versioni più vecchie di ODF, salvate il documento usando la versione ODF 1.0/1.1.
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Ottimizzazione dimensioni per il formato ODF. I documenti di LibreOffice sono file XML. Se 
selezionate questa opzione, LibreOffice scrive i dati XML senza rientri né interruzioni di linea. 
Se volete leggere i file XML in un editor di testo in un formato strutturato, disattivate l'opzione.

Tipo di documento. Se condividete abitualmente documenti con utenti di Microsoft Office, 
potreste voler modificare l'attributo per documenti di testo Salva sempre come con uno dei 
formati di Microsoft Office. Le versioni attuali di Microsoft Office possono aprire file ODF, quindi 
ciò potrebbe non essere più necessario. Le versioni attuali di Microsoft Office possono aprire 
file ODF, quindi ciò potrebbe non essere più necessario.

Nota
Sebbene LibreOffice possa aprire e salvare file nei formati .docx e .xlsx creati da 
Microsoft Office 2007 e 2010, non può ancora salvare nel formato .pptx. Questa 
funzionalità è prevista per un futuro rilascio.

Proprietà VBA
Nella pagina Carica/Salva – Proprietà VBA, potete stabilire se mantenere le macro nei documenti 
Microsoft Office aperti da LibreOffice.

Figura 37: opzioni Carica/Salva Proprietà 
VBA

Se scegliete Carica il codice Basic, potete modificare le macro in LibreOffice. Il codice modificato 
viene salvato in un documento ODF ma non viene mantenuto se salvate in un formato Microsoft 
Office.

Se scegliete Salva codice Basic originale, le macro non funzioneranno in LibreOffice ma 
saranno mantenute immutate se si salva il file nel formato Microsoft Office.

Se state importando un file di Microsoft Word o Excel contenente codice VBA, potete selezionare 
l'opzione Codice eseguibile. Dal momento che normalmente il codice viene mantenuto ma reso 
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inattivo (se lo controllate con l'IDE StarBasic noterete che è tutto commentato), con questa 
opzione il codice è pronto per essere eseguito.

Salva codice Basic originale ha precedenza su Carica codice Basic. Se entrambe le opzioni 
sono selezionate e modificate il codice disabilitato in LibreOffice, il codice originale Microsoft Basic 
verrà salvato quando si salva in un formato Microsoft Office.

Per eliminare qualsiasi possibile virus collegato a macro dai documenti Microsoft Office, 
deselezionate Salva codice Basic originale. Il documento verrà salvato senza il codice Microsoft 
Basic.

Microsoft Office
Nella pagina Carica/Salva – Microsoft Office, potete stabilire cosa fare quando si importano ed 
esportano oggetti OLE di Microsoft Office (che siano collegati o integrati oppure documenti come 
fogli elettronici o equazioni).

Selezionate l'opzione nella colonna [C] per convertire gli oggetti OLE Microsoft nei corrispondenti 
OLE LibreOffice quando caricate un documento Microsoft in LibreOffice (ricordate: "C" sta per 
"carica").

Selezionate l'opzione nella colonna [S] per convertire gli oggetti OLE LibreOffice nei corrispondenti 
OLE Microsoft quando salvate un documento in formato Microsoft (ricordate: "S" sta per "salva").

Figura 38: opzioni Carica/salva Microsoft Office

Compatibilità HTML opzioni Carica/Salva
Le scelte fatte nella pagina Carica/Salva – Compatibilità HTML influiscono sia sulle pagine HTML 
importate in LibreOffice che su quelle esportate. Si veda documenti HTML; 
importazione/esportazione nella guida per maggiori informazioni.
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Figura 39: opzioni di compatibilità HTML

Dimensioni carattere
Usate questi campi per definire le rispettive dimensioni carattere per i tag HTML, da <font 
size=1> fino a <font size=7>, se vengono utilizzati nelle pagine HTML. (Molte pagine non 
utilizzano più questi tag.)

Importa - Usa l'area geografica 'Inglese (USA)' per i numeri
Nell'importazione di numeri da una pagina HTML, i caratteri separatori dei decimali e delle 
migliaia differiscono a seconda dell'area geografica della pagina HTML. Gli appunti, comunque, 
non contengono informazioni sull'area geografica. Se questa opzione non è selezionata, i 
numeri saranno interpretati secondo l'Impostazione locale della Lingua in Strumenti > 
Opzioni > Impostazioni Lingua > Lingue (si veda pagina 59). Se questa opzione è 
selezionata, i numeri saranno interpretati secondo l'area geografica Inglese (USA).

Importa - Importa Tag HTML sconosciuti come campi
Selezionate questa opzione se desiderate che i tag che non sono riconosciuti da LibreOffice 
vengano importati come campi. Per un tag di apertura, verrà creato un campo HTML_ON con il 
valore del nome del tag. Per un tag di chiusura, verrà creato un HTML_OFF. Questi campi 
verranno convertiti in tag durante l'esportazione HTML.

Importa - Ignora impostazioni font
Selezionate questa opzione per fare sì che LibreOffice ignori tutte le impostazioni delle font 
nell'importazione. Verranno utilizzate le font definite nello stile della pagina HTML.

Esporta
Per ottimizzare l'esportazione HTML, selezionate un browser oppure lo standard HTML dal 
riquadro Esporta. Se è selezionato LibreOffice Writer, vengono esportate istruzioni specifiche 
di LibreOffice Writer.

Esporta - LibreOffice Basic
Selezionate questa opzione per includere le macro (script) di LibreOffice Basic 
nell'esportazione al formato HTML. Dovete attivare questa opzione prima di creare la macro di 
LibreOffice Basic; altrimenti lo script non verrà inserito. Le macro di LibreOffice Basic devono 
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essere situate nell'intestazione del documento HTML. Una volta creata la macro nell'IDE di 
LibreOffice Basic, questa apparirà nel sorgente pagina del documento HTML, nell'intestazione.

Se desiderate che le macro vengano eseguite automaticamente quando il documento HTML 
viene aperto, scegliete Strumenti > Personalizza > Eventi. Si veda il Capitolo 13 
(Introduzione alle Macro) per ulteriori informazioni.

Esporta - Mostra avviso
Quando l'opzione LibreOffice Basic (si veda sopra) non è selezionata, l'opzione Mostra 
avviso diviene disponibile. Se l'opzione Mostra avviso è selezionata, durante l'esportazione in 
HTML verrà mostrato un avvertimento per ricordare che le macro di LibreOffice Basic andranno 
perdute.

Esporta - Layout di stampa
Selezionate questa opzione per esportare anche il layout di stampa del documento attivo. Il 
filtro HTML supporta CSS2 (Fogli di stile a cascata di livello 2) per la stampa dei documenti. 
Queste funzionalità sono effettive solo se viene attivata l'esportazione del layout di stampa.

Esporta - Copia immagini locali in internet
Selezionate questa opzione per fare l'upload automatico delle immagini inserite nel documento 
su un server Internet tramite FTP.

Esporta - Set di caratteri
Selezionate il set di caratteri appropriato per l'esportazione.

Scelta delle impostazioni lingua

Ci sono diverse opzioni per personalizzare le impostazioni della lingua in LibreOffice:
• Installare i dizionari necessari
• Cambiare le impostazioni locali e della lingua
• Modificare le opzioni del controllo ortografico

Installazione dei dizionari
LibreOffice installa automaticamente diversi dizionari con il programma. Per aggiungere altri 
dizionari, assicuratevi di essere connessi a Internet, poi usate Strumenti > Lingua > Ulteriori 
dizionari in linea. LibreOffice aprirà il vostro browser web predefinito su una pagina contenente 
collegamenti a dizionari aggiuntivi che potete installare. Seguite le istruzioni per selezionare e 
installare quelli che desiderate.

Impostazioni locali e della lingua
Potete modificare alcuni dettagli delle impostazioni locali e della lingua usate da LibreOffice per 
tutti i documenti o per documenti specifici.

Nella finestra di dialogo Opzioni, fate clic su Impostazioni lingua > Lingue.
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Figura 40: opzioni di impostazione della lingua

Sul lato destro della pagina Impostazioni Lingua – Lingue, modificate a vostro piacimento 
Interfaccia utente, Impostazione locale, Valuta predefinita, e Lingue predefinite per i documenti. 
Nell'esempio, l'Italiano (Italia) è stato scelto per tutte le impostazioni a disposizione.

Figura 41: opzioni della lingua

Se volete far valere le impostazioni della lingua solo per il documento in uso, invece che per tutti i 
nuovi documenti, selezionate l'opzione Solo per il documento attuale.

Se necessario, selezionate le opzioni per abilitare il supporto per le lingue asiatiche (cinese, 
giapponese e coreano) e per le lingue CTL - Complex Text Layout (disposizione testo complessa) 
come urdu, thai, ebraico e arabo. Se scegliete entrambe le opzioni, alla successiva apertura di 
questa finestra di dialogo, ci saranno ulteriori opzioni in Impostazioni lingua, come mostrato sotto. 
Queste opzioni (Opzioni di ricerca per il giapponese, Layout asiatico, e Disposizione testo 
complesso) non sono descritte in questo testo.
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Figura 42: ulteriori pagine disponibili quando vengono selezionate le opzioni per il supporto 
linguistico avanzato

Opzioni per il controllo ortografico
Per scegliere le opzioni di controllo ortografico, fate clic su Impostazioni lingua > Linguistica. 
Nella sezione Opzioni della pagina (Figura 43), scegliete le impostazioni che ritenete utili.

Figura 43: impostazioni per le lingue, i dizionari e il controllo ortografico

Alcune considerazioni:

• Se non volete il controllo ortografico mentre scrivete, deselezionate Controllo ortografico 
durante la digitazione e spuntate Nascondi sottolineatura errori. (La seconda voce si 
trova più in basso nell'elenco delle Opzioni).

• Se desiderate il controllo grammaticale mentre scrivete, anche il Controllo ortografico 
durante la digitazione deve essere abilitato.

• Se usate un dizionario personalizzato che comprende parole scritte interamente in 
maiuscolo o contenenti numeri (ad esempio, AS/400), selezionate Controlla parole 
maiuscole e Controlla parole con numeri.

• L'opzione Controlla aree speciali riguarda il controllo ortografico di intestazioni, piè di 
pagina, cornici e tabelle.
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Qui potete inoltre controllare quali dizionari personalizzati siano attivi come predefiniti, oltre ad 
aggiungere o rimuovere dizionari installati dall'utente, premendo i pulsanti Nuovo o Elimina. I 
dizionari installati dal sistema non possono essere rimossi.

Opzioni Internet

La pagina di opzioni Internet serve a definire i motori di ricerca e salvare le impostazioni proxy da 
usare con LibreOffice.

Se usate un browser Mozilla (come Firefox) su Windows o Linux, potete abilitare il plugin per il 
Browser, in modo che il browser possa aprire i file LibreOffice, stamparli, salvarli e usarli in altri 
modi.

Se state usando un sistema operativo basato su Unix o Linux (incluso Mac OS X), è disponibile 
una ulteriore pagina per le opzioni E-mail, dove potete specificare il programma e-mail da usare 
quando inviate il documento corrente come e-mail. Vedere Figura 44. Sotto Windows viene 
sempre utilizzato il programma e-mail predefinito del sistema operativo.

Figura 44: opzioni internet, con la pagina E-mail disponibile per gli utenti Linux.

Le installazioni per Windows e Linux includono per impostazione predefinita anche l'estensione 
Wiki Publisher. Selezionate MediaWiki nelle opzioni Internet, quindi fate clic sul pulsante Aggiungi 
per aprire la finestra di dialogo mostrata in Figura 45. Qui potete indicare un indirizzo (URL) e le 
informazioni di login per un wiki. Potete aggiungere diversi wiki all'elenco.

Figura 45: specificare un account per un server MediaWiki
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Controllo delle funzioni di Correzione automatica di LibreOffice

Molti trovano fastidiose alcune o tutte le funzioni di Correzione automatica di LibreOffice, poiché 
cambiano quello che scrivete contro la vostra volontà. Molti altri trovano utili alcune delle funzioni 
di Correzione automatica; se è il vostro caso, selezionate le opzioni adatte. Ma se trovate 
modifiche inspiegabili nel documento, è possibile che la causa sia proprio da attribuire alla 
Correzione automatica.

Per aprire la finestra di dialogo Correzione automatica, fate clic su Strumenti> Opzioni di 
correzione automatica (Questa voce è disponibile solo se c'è un documento aperto).

In Writer, la finestra presenta 5 schede, come mostrato in Figura 46. In altri componenti di 
LibreOffice, la finestra di dialogo ha solo quattro schede. Potete trovare maggiori dettagli nelle 
guide dei componenti.

Figura 46: la finestra di dialogo Correzione automatica in Writer, con le cinque schede e 
alcune delle scelte disponibili sulla scheda Opzioni
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Cos'è un modello?

Un modello è un documento che si usa per creare altri documenti. Per esempio, potete creare un 
modello per rapporti di affari che presenti il logo della vostra ditta nella prima pagina. I nuovi 
documenti creati da questo modello avranno tutti il logo della ditta nella prima pagina.

I modelli possono contenere qualsiasi cosa si possa trovare nei normali documenti, come testo, 
grafici, stili, informazioni di configurazione specifiche definite dall'utente come unità di misura, 
lingua, stampante predefinita, barre degli strumenti e menu personalizzati.

Tutti i documenti in LibreOffice sono basati su modelli. Potete creare un modello specifico per 
qualsiasi tipo di documento (testo, foglio elettronico, disegno, presentazione). Se non specificate 
un modello in fase di creazione di un nuovo documento, questo si baserà sul modello predefinito 
per quel tipo di documento. Se non avete specificato un modello predefinito, LibreOffice usa il 
modello vuoto per quel tipo di documento che è stato installato con il programma. Vedere “Definire 
un modello predefinito” a pagina 81 per maggiori informazioni.

Definizione di stile

Uno stile è un insieme di formati che si possono applicare a pagine, testi, cornici, e altri elementi 
selezionati in un documento per modificare rapidamente il loro aspetto. Quando si applica uno 
stile, si applica contemporaneamente un intero gruppo di formati.

Molti formattano manualmente i paragrafi, le parole, le tabelle, i layout di pagina e altre parti dei 
loro documenti ignorando gli stili. Questi utenti sono abituati a redigere documenti considerandone 
le caratteristiche fisiche. Ad esempio, potreste specificare tipo e dimensione dei caratteri e ogni 
formattazione come grassetto o corsivo.

Gli stili sono attributi logici. Grazie agli stili, non è più necessario selezionare, ad esempio, 
“Dimensione dei caratteri 14pt, Times New Roman, Grassetto, Centrato”, ma sarà sufficiente 
scegliere lo stile “Titolo”, precedentemente impostato con le caratteristiche desiderate. In altre 
parole, l'utilizzo degli stili sposta l'enfasi dall'aspetto esteriore del testo (o della pagina, o di 
qualsiasi altro elemento) a ciò che il testo stesso rappresenta.

Gli stili consentono di migliorare la coerenza nel documento. Inoltre, rendono più agevole 
l'esecuzione di modifiche globali della formattazione. È possibile, ad esempio, cambiare il rientro di 
tutti i paragrafi o modificare il tipo di carattere utilizzato per tutti i titoli. Nel caso di documenti 
lunghi, queste operazioni potrebbero rivelarsi proibitive. Gli stili le rendono più semplici.

Inoltre, gli stili vengono utilizzati da LibreOffice per eseguire numerose procedure che non risultano 
visibili agli utenti. Ad esempio, gli stili dei titoli (o altri stili specificati) consentono a Writer di 
compilare gli indici. Alcuni esempi comuni di utilizzo dello stile sono forniti in “Esempi di utilizzo 
dello stile” a pagina 86.

LibreOffice supporta i seguenti stili:

• Gli Stili di pagina includono margini, intestazioni e piè di pagina, bordi e sfondi. In Calc, gli 
stili di pagina includono anche la sequenza di stampa dei fogli.

• Gli Stili di paragrafo controllano tutte le caratteristiche dell'aspetto del paragrafo, come 
l'allineamento del testo, le tabulazioni, la spaziatura delle linee e i bordi, e possono 
includere la formattazione dei caratteri.

• Gli Stili di carattere si applicano al testo selezionato all'interno di un paragrafo, modificando 
il tipo di carattere e la dimensione del testo, o i formati grassetto e corsivo.

• Gli Stili di cornice vengono utilizzati per formattare cornici grafiche o di testo, impostando la 
disposizione del testo, bordi, sfondi e colonne.
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• Gli Stili di elenco consentono di applicare un allineamento, una numerazione o dei punti, e 
caratteri simili agli elenchi puntati o numerati.

• Gli Stili di cella contengono tipo di carattere, allineamento, bordi, sfondo, formati dei numeri 
(ad esempio, valuta, data o numero) e protezione delle celle.

• Gli Stili grafici nei disegni e nelle presentazioni consentono di impostare linee, 
riempimento, ombreggiatura, trasparenza, tipo di carattere, connettori, quotatura, ed altri 
attributi.

• Gli Stili di presentazione contengono le caratteristiche dei caratteri, rientri di testo, 
spaziatura, allineamento e tabulazioni.

Nei vari componenti di LibreOffice sono disponibili stili differenti, come elencati nella Tabella 3.

LibreOffice viene fornito con numerosi stili predefiniti. È possibile usare gli stili disponibili, 
modificarli, o crearne di nuovi, come descritto in questo capitolo.

Tabella 3: stili disponibili nei componenti di LibreOffice

Tipo di Stile Writer Calc Draw Impress

Pagina X X

Paragrafo X

Carattere X

Cornice X

Elenco X

Cella X

Presentazione X X

Grafico (compreso negli 
stili di cornice)

X X

Applicare gli stili

Gli stili di formato possono essere selezionati in vari modi in LibreOffice.

Uso della finestra Stili e Formattazione

1) Fate clic sull'icona Stili e Formattazione  situata a sinistra sulla  barra di formattazione, 
oppure fate clic su Formato > Stili e formattazione, oppure ancora premete F11. La 
finestra Stili e Formattazione visualizza i tipi di stile disponibili per il componente di 
LibreOffice che state utilizzando. La Figura 47 mostra la finestra Stili e Formattazione di 
Writer, in cui sono visibili gli Stili di pagina.

È possibile spostare la finestra nella posizione desiderata oppure ancorarla ai lati dello 
schermo. Per eseguire quest'ultima operazione, mantenete premuto il tasto Ctrl mentre fate 
clic sulla barra del titolo e quindi trascinate la finestra nella posizione in cui desiderate 
ancorarla.

2) Per visualizzare l'elenco degli stili di una determinata categoria, fate clic su una delle icone 
in alto a sinistra nella finestra Stili e Formattazione.
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3) Per applicare uno stile esistente (ad esclusione degli stili di carattere), posizionate il 
cursore nel punto di inserimento desiderato all'interno di un paragrafo, di una cornice o di 
una pagina e quindi fate doppio clic sul nome di uno degli stili in elenco. Per applicare uno 
stile di carattere, selezionate prima i caratteri da modificare.

Suggerimento

Nella parte inferiore della finestra Stili e Formattazione vi è un elenco a 
scomparsa. In Figura 47 la finestra mostra la voce Automatico, ovvero l'elenco 
comprende solo gli stili applicati automaticamente da LibreOffice. È possibile 
visualizzare tutti gli stili oppure soltanto alcuni gruppi, ad esempio gli stili 
personalizzati (Stili utente).

Figura 47: la finestra Stili e Formattazione di Writer con gli stili di paragrafo

Uso del modo Riempimento
Potete utilizzare Riempimento per applicare uno stile a più aree differenti velocemente senza 
dover ritornare alla finestra Stili e Formattazione e fare doppio clic ogni volta. Questo metodo è 
particolarmente utile quando dovete formattare con lo stesso stile più paragrafi non consecutivi 
oppure varie celle o altri elementi.

1) Aprite la finestra Stili e Formattazione e selezionate lo stile che desiderate applicare.

2) Fate clic sull'icona Modo riempimento .

3) Per applicare uno stile di paragrafo, pagina o cornice, passate il mouse sul paragrafo, 
pagina o cornice e fate clic. Per applicare uno stile di carattere, mantenete premuto il 
pulsante del mouse durante la selezione dei caratteri da modificare; anche un clic su una 
parola applica lo stile di carattere per quella parola. Ripetete il passo 3 fino ad aver 
effettuato tutte le modifiche per quello stile.

4) Per disattivare il Modo riempimento, fate di nuovo clic sull'icona Modo riempimento 
oppure premete il tasto Esc.

Attenzione Se il Modo riempimento è attivo, è sufficiente fare clic con il pulsante destro del 
mouse in un punto qualsiasi del documento per annullare l'ultima operazione di 
riempimento eseguita. Prestate attenzione a non premere accidentalmente il 
pulsante destro del mouse per evitare di annullare operazioni corrette.
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Uso dell'elenco Applica Stile
Se avete utilizzato uno stile almeno una volta, il suo nome apparirà nell'elenco Applica stile situato 
a sinistra sulla barra di Formattazione, accanto all'icona Stili e Formattazione.

È possibile aprire l'elenco e selezionare con un solo clic del mouse lo stile desiderato, oppure è 
possibile utilizzare i tasti freccia verso l'alto e verso il basso per scorrere l'elenco e quindi premere 
Invio per applicare lo stile evidenziato.

Suggerimento
Selezionate Extra... nella parte bassa dell'elenco Applica Stile per aprire la 
finestra Stili e Formattazione.

Figura 48: l'elenco Applica stile sulla barra di 
Formattazione

Uso dei tasti di scelta rapida
Alcuni tasti di scelta rapida per applicare gli stili sono predefiniti. Per esempio, in Writer Ctrl+0 
applica lo stile Corpo del testo, Ctrl+1 applica lo stile Intestazione 1, e Ctrl+2 applica lo stile 
Intestazione 2. È possibile modificare i tasti assegnati e crearne di nuovi; vedere il Capitolo 14 
(Personalizzazione di LibreOffice) per istruzioni.

Attenzione
La formattazione manuale (anche detta formattazione diretta) ha precedenza sugli 
stili, e non è possibile eliminare la formattazione manuale applicando ad essa uno 
stile.

Per rimuovere la formattazione manuale, selezionate il testo, fate clic con il pulsante 
destro, e scegliete Cancella la formattazione diretta dal menu a comparsa.

Modificare gli stili

È possibile modificare gli stili di LibreOffice (sia predefiniti che personalizzati) in diversi modi:

• Modifica di uno stile tramite la finestra di dialogo Stile

• Aggiornamento di uno stile da una selezione

• Uso dell'Aggiornamento Automatico (solo per gli stili di paragrafo e cornice)
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• Caricamento o copia di stili da un altro documento o modello

Suggerimento
Ogni modifica apportata ad uno stile avrà effetto solo sul documento corrente. 
Per cambiare gli stili in più documenti, è necessario modificare il modello, 
oppure copiare gli stili negli altri documenti, come descritto a pagina 73.

Modifica di uno stile tramite la finestra di dialogo Stile
Per modificare uno stile esistente utilizzando la finestra di dialogo Stile, fate clic con il pulsante 
destro del mouse sullo stile desiderato nella finestra Stili e Formattazione e selezionate Modifica 
dal menu a comparsa.

Il contenuto della finestra visualizzata dipende dal tipo di stile selezionato. Ogni finestra di dialogo 
Stile è infatti composta da più schede. Per ulteriori dettagli, potete consultare i capitoli dedicati agli 
stili nelle guide utente.

Aggiornamento di uno stile da una selezione
Per aggiornare uno stile a partire da una selezione:

1) Aprite la finestra Stili e Formattazione.

2) All'interno del documento corrente, selezionate l'elemento il cui formato verrà utilizzato 
come stile.

Attenzione Assicuratevi che vi siano proprietà univoche in questo paragrafo. Ad esempio, se 
sono presenti due differenti dimensioni o stili di carattere, quella particolare 
proprietà rimarrà la stessa, tale e quale a prima.

3) Nella finestra Stili e Formattazione, selezionate lo stile da aggiornare con un solo clic del 
mouse, fate clic sulla freccia accanto all'icona Nuovo stile dalla selezione e quindi 
scegliete Aggiorna stile.
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Figura 49: aggiornamento di uno stile da una 
selezione

Aggiornamento Automatico
L'Aggiornamento Automatico si applica solo agli stili di paragrafo e cornice. Se l'opzione Aggiorna 
automaticamente è selezionata nella scheda Gestione, all'interno delle finestre di dialogo dello stile 
di paragrafo o dello stile di cornice, lo stile si aggiornerà automaticamente se si applica una 
formattazione diretta a un paragrafo o a una cornice usando tale stile nel vostro documento.

Suggerimento
Se siete abituati a modificare manualmente gli stili nei vostri documenti, 
assicuratevi che l'Aggiornamento Automatico non sia abilitato.

Aggiornamento di uno stile da un documento o da un modello
È possibile aggiornare gli stili copiandoli o caricandoli da un modello o da un altro documento. 
Vedere “Copiare e spostare gli stili” a pagina 73.

Creare nuovi stili (personalizzati)

È possibile aggiungere nuovi stili a quelli esistenti. Questa operazione può essere eseguita in due 
modi diversi:

• Creazione di un nuovo stile tramite la finestra di dialogo Stile

• Creazione di un nuovo stile da una selezione

Creazione di un nuovo stile tramite la finestra di dialogo Stile
Per creare un nuovo stile utilizzando la finestra di dialogo Stile, fate clic con il pulsante destro del 
mouse all'interno della finestra Stili e Formattazione e quindi selezionate Nuovo dal menu a 
comparsa.
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Se desiderate collegare il nuovo stile a uno esistente, selezionate quest'ultimo e quindi fate clic 
con il pulsante destro del mouse e scegliete la voce Nuovo.

Se due stili sono collegati tra loro e si modifica lo stile di base (cambiando, ad esempio, il tipo di 
carattere da Times a Helvetica), verranno modificati anche tutti gli stili associati. Alcune volte 
questo è esattamente quello che si desidera, ma è possibile che questo tipo di modifica non 
corrisponda sempre alle vostre intenzioni. È consigliabile valutare preventivamente l'opportunità di 
collegare gli stili.

Le finestre di dialogo e le opzioni disponibili sono le medesime utilizzate per definire i nuovi stili e 
modificare quelli esistenti. Per ulteriori dettagli, potete consultare i capitoli dedicati agli stili nelle 
guide utente.

Creazione di un nuovo stile da una selezione
È possibile creare un nuovo stile copiando un formato manuale esistente. Il nuovo stile viene 
applicato soltanto al documento attuale e non viene salvato nel modello di documento.

1) Aprite la finestra Stili e Formattazione e scegliete lo stile che desiderate creare.

2) All'interno del documento corrente, selezionate l'elemento che volete salvare come stile.

3) Nella finestra Stili e Formattazione, fate clic sull'icona Nuovo stile dalla selezione.

4) Nella finestra di dialogo Crea stile, digitate un nome per il nuovo stile. L'elenco mostra i 
nomi degli stili personalizzati esistenti per la tipologia selezionata. Fate clic su OK per 
salvare il nuovo stile.

Figura 50: assegnazione di un nome a un nuovo stile 
creato da una selezione

Creazione di uno stile mediante trascinamento
È possibile creare un nuovo stile trascinando il testo selezionato nella finestra Stilista.

Writer
Selezionate una porzione di testo e trascinatela nella finestra Stili e Formattazione. Se è attiva 
l'opzione Stili di paragrafo, lo stile del paragrafo prescelto verrà aggiunto all'elenco. Se è attiva 
l'opzione Stili di carattere, lo stile dei caratteri compresi nella selezione verrà aggiunto 
all'elenco.

Calc
Trascinate nella finestra Stili e Formattazione la cella selezionata per creare stili di celle.
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Draw/Impress
Selezionate gli oggetti grafici desiderati e trascinateli sulla finestra Stili e Formattazione per 
creare nuovi stili grafici.

Copiare e spostare gli stili

Esistono due modi diversi per copiare o spostare uno stile da un modello o da un documento a un 
altro modello o documento:

• Uso della finestra di dialogo Gestione dei modelli

• Caricare uno stile da un modello o da un documento

Uso della finestra di dialogo Gestione dei modelli
Per copiare o spostare gli stili utilizzando la finestra di dialogo Gestione dei modelli:

1) Fate clic su File > Modelli > Gestisci.

2) Nella finestra Gestione dei modelli (Figura 51), impostate gli elenchi in basso per Modelli o 
Documenti, secondo le necessità. L'impostazione predefinita prevede Modelli a sinistra e 
Documenti a destra.

Figura 51: scegliere di copiare gli stili da un documento invece che da un modello

Suggerimento
Per copiare degli stili da un file non aperto, fate clic sul pulsante File. Quando 
ritornate a questa finestra di dialogo, entrambi gli elenchi mostreranno sia il file 
selezionato sia tutti i documenti correntemente aperti.

3) Aprite le cartelle e cercate i modelli di origine e di destinazione di vostra scelta. Fate doppio 
clic sul nome del modello o del documento desiderato e poi sull'icona Stili per visualizzare 
l'elenco dei singoli stili di formattazione (Figura 52).

4) Per copiare uno stile, mantenete premuto il tasto Ctrl mentre trascinate il nome dello stile 
prescelto da un elenco all'altro.
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Attenzione Se non tenete premuto il tasto Ctrl mentre trascinate, lo stile verrà spostato da un 
elenco all'altro invece che copiato. Lo stile selezionato verrà eliminato dall'elenco di 
partenza.

5) Ripetete le operazioni descritte per ogni stile che desiderate copiare. Se il modello o il 
documento di destinazione contiene numerosi stili, può essere necessario scorrere l'elenco 
verso il basso per visualizzare le modifiche. Una volta che avete terminato, fate clic su 
Chiudi.

Figura 52: copiare uno stile da un documento all'altro

Caricare uno stile da un modello o da un documento
È possibile copiare gli stili di formattazione caricandoli da un modello o da un altro documento:

1) Aprite il documento in cui desiderate copiare gli stili.

2) Nella finestra Stili e Formattazione, fate clic sulla freccia accanto all'icona Nuovo stile 
dalla selezione, quindi selezionate la voce Carica stili (vedere Figura 49).

3) Nella finestra di dialogo Carica stili (Figura 53), trovate e selezionate il modello da cui 
copiare gli stili di formattazione.

Figura 53: copiare stili da un modello in un documento aperto
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4) Selezionate le categorie di stili da copiare. Selezionate l'opzione Sovrascrivi se desiderate 
che gli stili copiati sostituiscano eventuali stili con lo stesso nome presenti nel documento 
di destinazione.

5) Fate clic su OK per copiare gli stili. Non vedrete alcuna modifica sullo schermo.

Nota
Per copiare gli stili da un altro documento, fate clic sul pulsante Da file e nella 
finestra visualizzata selezionate il documento desiderato.

Attenzione
Se il vostro documento ha un indice, e se avete utilizzato stili personalizzati per le 
intestazioni, i livelli di intestazione associati con livelli struttura (in Strumenti > 
Numerazione capitolo) torneranno alle impostazioni predefinite dell'Intestazione 1, 
Intestazione 2, e così via quando si caricano gli stili in questo modo. Dovrete 
modificarli nuovamente per ritornare ai vostri stili di intestazione personalizzati.

Eliminare gli stili

Non è possibile rimuovere da un documento o da un modello nessuno degli stili di formattazione 
predefiniti di LibreOffice, nemmeno se inutilizzati.

È comunque possibile eliminare gli stili personalizzati; ma prima di eseguire questa operazione, 
occorre verificare che lo stile da rimuovere non sia in uso nel documento corrente. Se uno stile non 
desiderato è in uso, lo si dovrà sostituire con un altro.

Per eliminare gli stili indesiderati, visualizzate la finestra Stili e Formattazione, fate clic con il 
pulsante destro del mouse sugli stili da rimuovere (uno alla volta) e quindi selezionate Elimina dal 
menu a comparsa.

Se lo stile selezionato è attualmente in uso, apparirà un messaggio di avvertimento.

Attenzione Assicuratevi che lo stile non sia utilizzato prima di eliminarlo. Altrimenti tutti gli 
elementi formattati con quello stile ritorneranno allo stile predefinito e manterranno 
la loro formattazione come formattazione manuale.

Se lo stile selezionato non è in uso, apparirà un messaggio di conferma; fate clic su Sì per 
eliminare lo stile.

Usare un modello per creare un documento

Usare un modello per creare un documento:

1) Dal menu principale, scegliete File > Nuovo > Modelli e Documenti. Si apre la finestra di 
dialogo Modelli e documenti.

2) Nel riquadro a sinistra, fate clic sull'icona Modelli se non è già selezionata. Nel riquadro 
centrale appare un elenco di cartelle di modelli.

3) Fate doppio clic sulla cartella che contiene il modello che volete usare. Nel riquadro 
centrale appare un elenco di tutti i modelli contenuti nella cartella (come mostrato in Figura 
54).

4) Selezionate il modello che volete usare. Potete vedere l'anteprima del modello selezionato 
oppure visualizzare le proprietà del modello:
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• Per vedere l'anteprima del modello, fate clic sull'icona Anteprima . Un'anteprima 
del modello appare nel riquadro sulla destra.

• Per visualizzare le proprietà del modello, fate clic sull'icona Proprietà . Le 
proprietà del modello appaiono nel riquadro sulla destra.

5) Fate clic su Apri. La finestra di dialogo Modelli e Documenti si chiude e in LibreOffice si 
apre un nuovo documento basato sul modello selezionato. Potete quindi modificare e 
salvare il nuovo documento nello stesso modo in cui modificate qualsiasi altro documento.

Figura 54: finestra di dialogo Modelli e Documenti

Creare un modello

Potete creare modelli personali in due modi: da un documento o utilizzando una procedura 
guidata.

Creare un modello da un documento
Per creare un modello da un documento:

1) Aprite un documento, nuovo o già esistente, del tipo per cui volete creare un modello 
(testo, foglio elettronico, disegno, presentazione).

2) Aggiungete il contenuto e gli stili che preferite.

3) Dal menu principale, scegliete File > Modelli > Salva. Si apre la finestra di dialogo Modelli.
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Figura 55: salvare un nuovo modello

4) Nel campo Nuovo modello digitate un nome per il nuovo modello.

5) Nell'elenco Categorie, fate clic sulla categoria alla quale volete assegnare il modello. La 
categoria scelta non ha effetto sul modello; è semplicemente la cartella in cui salvate il 
modello. Scegliendo una categoria appropriata, sarà più facile trovare il modello quando 
vorrete utilizzarlo. Per esempio, potreste salvare modelli di Impress sotto la categoria 
Presentazioni.

Per ulteriori informazioni sulle cartelle di modelli, vedere "Gestire i modelli" a pagina 84.
6) Fate clic su OK per salvare il nuovo modello.

Ogni impostazione che può essere aggiunta o modificata in un documento può essere salvata in 
un modello. Per esempio, di seguito è riportato un elenco (non completo) delle impostazioni che 
possono essere incluse in documenti Writer e poi salvate come modello per un uso successivo:

• Impostazioni di stampa: scelta della stampante, pagina singola o fronte/retro, dimensione 
carta, e così via

• Stili usati, ovvero gli stili carattere, pagina, cornice, numerazione e paragrafo.

• Formato e impostazioni relativi a indici, tabelle, bibliografie, indici generali.

I modelli possono anche contenere testo predefinito, evitandovi di doverlo digitare ogni volta che 
create un nuovo documento. Per esempio, un modello di lettera potrebbe contenere il vostro 
nome, indirizzo e formula di saluto.

Nei modelli è anche possibile salvare le personalizzazioni del menu e della barra degli strumenti; 
vedere il Capitolo 14 (Personalizzazione di LibreOffice) per ulteriori informazioni.

creare un modello usando una procedura guidata
Potete usare delle procedure guidate per creare modelli di lettere, fax, agende, presentazioni e 
pagine Web.

Ad esempio, la procedura guidata Fax vi guida attraverso le seguenti scelte:

• Tipo di fax (commerciale o personale)

• Elementi del documento come la data, l'oggetto (per i fax commerciali), formula di saluto e 
formula di chiusura

• Opzioni per le informazioni sul mittente e sul destinatario (fax commerciali)

• Testo da includere nel piè di pagina (fax commerciali)
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Per creare un modello usando una procedura guidata:

1) Dal menu principale, scegliete File > Procedure guidate > [tipo di modello richiesto].

Figura 56: creare un modello usando una procedura guidata

2) Seguite le istruzioni sulle pagine della procedura guidata. Questa procedura è leggermente 
diversa per ciascun tipo di modello, ma il formato è molto simile.

3) Nell'ultima sezione della procedura guidata, potete specificare il nome e la posizione di 
salvataggio del modello. La posizione predefinita è la cartella dei modelli personali, ma è 
possibile scegliere una posizione diversa.

4) Infine, avete la possibilità di creare un nuovo documento immediatamente a partire dal 
modello, o di modificare manualmente il modello stesso. Per i futuri documenti, potete 
riutilizzare il modello creato con la procedura guidata, nello stesso modo con cui usate gli 
altri modelli.

Modificare un modello

Potete modificare il contenuto e gli stili di un modello, e poi, se volete, riapplicare gli stili del 
modello ai documenti creati a partire da quel modello. (Notate che è possibile riapplicare solo gli 
stili. Non potete riapplicare i contenuti).

Per modificare un modello:

1) Dal menu principale, scegliete File > Modelli > Modifica. Si apre una finestra standard di 
esplorazione file.

2) Selezionate e aprite il modello che volete modificare.

3) Modificate il modello nello stesso modo con cui modificate un qualsiasi altro documento. 
Per salvare le modifiche, scegliete File > Salva dal menu principale.

Aggiornare un documento a partire da un modello modificato
La prossima volta che aprirete un documento creato da un modello modificato, apparirà il seguente 
messaggio.
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Figura 57: messaggio di aggiornamento stili

Fate clic su Aggiorna gli stili per applicare al documento gli stili del modello modificato. Fate clic 
su Mantieni i vecchi stili se non volete applicare al documento gli stili del modello modificato 

(leggete però l'avviso sotto riportato).

Attenzione

Se scegliete Mantieni i vecchi stili nel riquadro mostrato in Figura 57, questo 
messaggio non apparirà più la volta successiva che aprirete il documento, dopo 
aver modificato il modello su cui si basa. Non avrete un'altra opportunità di 
aggiornare gli stili dal modello, sebbene sia possibile utilizzare la macro nella nota 
sottostante per riabilitare tale funzionalità.

Se state usando Writer, potete anche fare uso dell'estensione Template Changer 
(vedere pagina 83) per riattivare il modello.

Nota

Per riabilitare l'aggiornamento da un modello:
1) Fate clic su Strumenti > Macro > Organizza Macro > LibreOffice Basic. 

Selezionate il documento dall'elenco, fate clic sul segno di espansione (+ o 
triangolo), e selezionate Standard. Se di fianco alla voce Standard vedete un 
segno di espansione, fate clic su di esso e selezionate un modulo.

2) Se è attivo, fate clic sul sul pulsante Modifica. Se invece il pulsante Modifica 
non è attivo, fate clic su Nuovo.

3) Nella finestra Basic, inserite quanto segue:
Sub FixDocV3 
' set UpdateFromTemplate 
 oDocSettings = ThisComponent.createInstance( _ 
  "com.sun.star.document.Settings" ) 
 oDocSettings.UpdateFromTemplate = True 
End Sub 'FixDocV3

4) Fate clic sull'icona Esegui programma BASIC, quindi chiudete la finestra 
Basic.

5) Salvate il documento.

La prossima volta che aprirete questo documento, verrà richiesto di aggiornare gli 
stili dal modello modificato.
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Aggiunta di modelli ottenuti da altre sorgenti

Potete scaricare modelli per LibreOffice da diverse fonti, incluso l'archivio ufficiale dei modelli, 
all'indirizzo http://templates.libreoffice.org/, e installarli sul vostro computer. Su altri siti web 
potreste trovare collezioni di modelli pacchettizzate in file con estensione (.OXT). Questi vengono 
installati in modo leggermente diverso, come descritto sotto.

Installare singoli modelli
Per installare singoli modelli:

1) Scaricate il modello e salvatelo sul vostro computer.

2) Importate il modello in una cartella dei modelli seguendo le istruzioni in “Importare un 
modello“ a pagina 85.

Suggerimento

(Per utenti avanzati) Se conoscete la posizione delle cartelle dei modelli di 
LibreOffice, potete copiarvi manualmente i nuovi modelli. La posizione varia a 
seconda del sistema operativo presente sul computer. Per sapere dove 
vengono salvate le cartelle dei modelli sul vostro computer, vedete Strumenti > 
Opzioni > LibreOffice > Percorsi.

Installare collezioni di modelli
Il Gestore Estensioni offre un modo semplice per installare collezioni di modelli che sono stati 
pacchettizzati come estensioni. Seguite questi passaggi:

1) Scaricate il pacchetto contenente l'estensione (file .OXT) e salvatelo sul vostro computer.

2) In LibreOffice, selezionate Strumenti > Gestione Estensioni dalla barra dei menu. Nella 
finestra di dialogo Gestore Estensioni (Figura 58), fate clic su Aggiungi per aprire una 
finestra di esplorazione file.

3) Trovate e selezionate il pacchetto di modelli che volete installare e fate clic su Apri. Si 
avvia l'installazione del pacchetto. È possibile che vi venga richiesto di accettare un 
contratto di licenza.

4) Quando l'installazione del pacchetto è completata, i modelli saranno utilizzabili attraverso 
File > Nuovo > Modelli e Documenti e l'estensione sarà elencata nel Gestore Estensioni.
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Figura 58: pacchetto dei modelli appena aggiunto

Consultate il Capitolo 14 (Personalizzazione di LibreOffice) per maggiori informazioni riguardo al 
Gestore Estensioni.

Definire un modello predefinito

Se create un documento scegliendo File > Nuovo > Documento di Testo (oppure Foglio 
elettronico, Presentazione, o Disegno) dal menu principale, LibreOffice crea il documento dal 
modello predefinito per quel tipo di documento. È tuttavia possibile impostare come predefinito un 
modello personalizzato. In seguito potrete sempre ripristinare l'impostazione predefinita.

Nota per 
utenti 

Windows

Forse sapete che Microsoft Word utilizza un file normal.docm come modello 
predefinito e sapete anche come rigenerarlo.

LibreOffice non fa uso di un simile file come modello predefinito; le “impostazioni di 
fabbrica” sono inserite all'interno del software.

Capitolo 3  Uso di Stili e Modelli 81



Impostare un modello personalizzato come predefinito
Potete impostare qualsiasi modello come predefinito, purché sia in una delle cartelle presenti nella 
finestra di dialogo Gestione dei modelli.

Per impostare un modello personalizzato come predefinito:

1) Dal menu principale, scegliete File > Modelli > Gestisci. Si apre la finestra di dialogo 
Gestione dei modelli.

2) Nel riquadro a sinistra, selezionate la cartella che contiene il modello che volete impostare 
come predefinito, quindi selezionate il modello.

3) Fate clic sul pulsante Comandi e scegliete Imposta come modello predefinito dal menu 
a comparsa.

La prossima volta che create un documento da File > Nuovo, il documento verrà creato a partire 
da questo modello.

Figura 59: impostazione di un modello predefinito usando la finestra di dialogo Gestione dei 
modelli

Sebbene molte importanti impostazioni possano essere cambiate nella finestra di dialogo Opzioni 
(vedere il Capitolo 2), ad esempio i caratteri e le dimensioni di pagina predefiniti, impostazioni più 
avanzate (come i margini di pagina) possono essere modificate solo sostituendo il modello 
predefinito con uno nuovo.

Ripristinare il modello predefinito
Per ripristinare il modello predefinito di LibreOffice come modello predefinito per un tipo di 
documento:

1) Nella finestra di dialogo Gestione dei modelli, fate clic su una cartella qualsiasi nel riquadro 
di sinistra.

2) Fate clic sul pulsante Comandi e scegliete Ripristina modello predefinito dal menu a 
comparsa. Questo comando non compare se non è stato precedentemente impostato 
come predefinito un modello personalizzato, come descritto nella sezione precedente.
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La prossima volta che create un documento da File > Nuovo, il documento verrà creato dal 
modello predefinito per quel tipo di documento.

Associazione di un documento a un modello differente

A volte potreste volere associare un documento con un modello differente, o forse state lavorando 
con un documento che non si basa su un modello.

Uno dei maggiori vantaggi dell'utilizzo dei modelli è la facilità di aggiornamento degli stili in più di 
un documento, come descritto a pagina 78. Se aggiornate gli stili caricando nuove impostazioni di 
stili da un modello differente (come descritto a pagina 74), il documento non sarà associato con il 
modello dal quale avete caricato gli stili—quindi non potete utilizzare questo metodo. Ciò che 
dovete fare è associare il documento con il modello differente.

Questa operazione può essere eseguita in due modi diversi. In entrambi i casi, per ottenere i 
migliori risultati i nomi degli stili dovrebbero essere gli stessi nel documento esistente e nel nuovo 
modello. Altrimenti, dovrete utilizzare Modifica > Trova e Sostituisci per sostituire i vecchi stili 
con quelli nuovi. Consultate il Capitolo 4 (Guida introduttiva a Writer) per maggiori informazioni 
riguardo alla sostituzione degli stili utilizzando Trova e sostituisci.

Metodo 1
Questo metodo include qualsiasi disegno e formulazione (come le note legali) esistente nel nuovo 
modello, così come gli stili. Se non desiderate questo materiale, dovete cancellarlo.

1) Selezionate File > Nuovo > Modelli e documenti. Scegliete il modello che desiderate. Se 
il modello comprende testo o disegni non desiderati, cancellateli.

2) Aprite il documento che volete modificare. (Si aprirà in una nuova finestra.) Premete Ctrl+A 
per selezionare tutto il documento. Copiate nel documento vuoto creato nella fase 1.

3) Aggiornate l'indice, se esistente. Salvate il file.

Metodo 2 (solo per Writer)
Questo metodo non include disegno o testo dal nuovo modello, eccetto ciò che si trova nelle 
intestazioni e nei piè di pagina; semplicemente vengono inclusi gli stili dal nuovo modello e viene 
stabilita una associazione tra il modello e il documento.

1) Aprite il documento di cui volete modificare il modello. Scegliete File > Modelli > Assegna 
modello (a questo documento).

2) Nella finestra Scegli modello, trovate e selezionate il modello richiesto e fate clic su Apri.

3) Salvate il documento. Se ora guardate in File > Proprietà, vedrete il nuovo modello 
elencato nella parte bassa della scheda Generale.

Nota

Se in Writer non vedete Assegna modello (a questo documento) oppure 
Assegna modello (alla cartella) sotto File > Modelli, dovrete scaricare 
l'estensione Template Changer da http://extensions.libreoffice.org/ e installarla 
come descritto a pagina 80. Quindi chiudete e riaprite LibreOffice per attivare 
l'estensione.

In Calc, Impress, e Draw, quando l'estensione è installata, è disponibile soltanto la 
scelta Assegna modello (alla cartella).
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Gestire i modelli

LibreOffice può usare solo i modelli che si trovano nelle cartelle dei modelli di LibreOffice. Potete 
creare nuove cartelle di modelli LibreOffice e usarle per gestire i vostri modelli. Per esempio, è 
possibile avere una cartella per i modelli di rapporti e un'altra per i modelli di lettere. Potete inoltre 
importare ed esportare i modelli.

Per cominciare, scegliete File > Modelli > Gestisci dal menu principale per aprire la finestra di 
dialogo Gestione dei modelli (Figura 52 a pagina 74).

Nota
Tutte le azioni eseguite con il pulsante Comandi nella finestra Gestione dei modelli 
possono essere eseguite facendo clic con il tasto destro del mouse sui modelli o 
sulle cartelle.

Suggerimento

La posizione delle cartelle dei modelli di LibreOffice varia a seconda del sistema 
operativo presente sul computer. Per sapere dove vengono salvate le cartelle 
dei modelli sul vostro computer, vedete Strumenti > Opzioni > LibreOffice > 
Percorsi.

Creare una cartella di modelli
Per creare una cartella di modelli:

1) Nella finestra di dialogo Gestione dei modelli, fate clic su una cartella qualsiasi.

2) Fate clic sul pulsante Comandi e scegliete Nuovo dal menu a comparsa. Appare una 
nuova cartella denominata Senza nome.

3) Digitate un nome per la nuova cartella, e poi premete Invio. LibreOffice salva la cartella con 
il nome assegnato.

Eliminare una cartella di modelli
Non è possibile eliminare cartelle di modelli fornite con LibreOffice o installate usando la Gestione 
estensioni; potete solo cancellare cartelle di modelli da voi create.

Per eliminare una cartella di modelli da voi creata:

1) Nella finestra di dialogo Gestione dei modelli, selezionate la cartella che volete eliminare.

2) Fate clic sul pulsante Comandi e scegliete Elimina dal menu a comparsa. Appare una 
finestra di dialogo in cui si chiede conferma dell'eliminazione. Fate clic su Sì.

Spostare un modello
Per spostare un modello da una cartella di modelli in un'altra:

1) Nella finestra di dialogo Gestione dei modelli, fate doppio clic sulla cartella che contiene il 
modello che volete spostare.

2) Fate clic sul modello che volete spostare e trascinatelo nella cartella desiderata. Se non 
avete i permessi per eliminare modelli dalla cartella di origine, questa operazione copierà il 
modello invece di spostarlo.
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Eliminare un modello
Non è possibile eliminare modelli forniti con LibreOffice o installati utilizzando la Gestione 
estensioni; potete solo cancellare modelli da voi creati o importati.

Per eliminare un modello:

1) Nella finestra di dialogo Gestione dei modelli, fate doppio clic sulla cartella che contiene il 
modello che volete eliminare.

2) Fate clic sul modello che volete eliminare.

3) Fate clic sul pulsante Comandi e scegliete Elimina dal menu a comparsa. Appare una 
finestra di dialogo in cui si chiede conferma dell'eliminazione. Fate clic su Sì.

Importare un modello
Se il modello che volete usare si trova in una posizione diversa, dovete importarlo in una cartella di 
modelli LibreOffice.

Per importare un modello in una cartella di modelli:

1) Nella finestra di dialogo Gestione dei modelli, selezionate la cartella in cui volete importare 
il modello.

2) Fate clic sul pulsante Comandi e scegliete Importa modello dal menu a comparsa. Si 
apre una finestra standard di esplorazione file.

3) Trovate e selezionate il modello che volete importare e fate clic su Apri. La finestra di 
esplorazione file si chiude e il modello appare nella cartella selezionata.

4) Se volete, digitate un nuovo nome per il modello e poi premete il tasto Invio.

Esportare un modello
Per esportare un modello da una cartella di modelli in un'altra posizione:

1) Nella finestra di dialogo Gestione dei modelli, fate doppio clic sulla cartella che contiene il 
modello che volete esportare. Sotto il nome della cartella appare un elenco dei modelli 
contenuti in quella cartella.

2) Fate clic sul modello che volete esportare.

3) Fate clic sul pulsante Comandi e scegliete Esporta modello dal menu a comparsa. Si 
apre la finestra Salva con nome.

4) Trovate la cartella in cui volete esportare il modello e fate clic su Salva.

Stampa di un elenco di stili definiti in un modello o in un 
documento

Per stampare un elenco di stili definiti in un modello:

1) Nella finestra di dialogo Gestione dei modelli, fate doppio clic sulla cartella che contiene il 
modello.

2) Fate doppio clic sul modello desiderato. Al di sotto apparirà Stili. Fate clic su Stili per 
selezionarlo.

3) Fate clic sul pulsante Comandi e scegliete Stampa dal menu a comparsa. Si apre la 
finestra di dialogo Stampa. Potete quindi stampare in un file o sulla vostra solita stampante. 
Per ulteriori informazioni sulla finestra di dialogo Stampa, vedere il Capitolo 10.
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Figura 60: stampa di un elenco di stili in un modello

Suggerimento
Per stampare un elenco di stili in un documento, fate doppio clic sul nome del 
documento nella colonna centrale per visualizzare Stili, e quindi usate Comandi 
> Stampa.

Esempi di utilizzo dello stile

I seguenti esempi di utilizzo comune di stili di pagina e paragrafo sono presi da Writer. Vi sono 
molti altri modi di usare gli stili; consultate le guide dei vari componenti per dettagli.

Definire una prima pagina differente per un documento
Diversi documenti, come lettere e rapporti, hanno una prima pagina che è differente dalle altre 
pagine nel documento. Per esempio, la prima pagina di una carta intestata tipicamente presenta 
una intestazione differente, oppure la prima pagina di un rapporto potrebbe non avere intestazione 
o piè di pagina, mentre le altre pagine potrebbero averli. Con LibreOffice, potete definire lo stile di 
pagina per la prima pagina e specificare lo stile, da applicare automaticamente, per le pagine 
successive.

Come esempio, è possibile utilizzare gli stili di pagina Prima pagina e Predefinito che sono forniti 
con LibreOffice. La Figura 61 mostra ciò che vogliamo ottenere: la prima pagina deve essere 
seguita dalla pagina predefinita, e tutte le pagine successive devono avere lo stile di pagina 
Predefinito. Potete trovare dettagli al riguardo nel Capitolo 4 (Formattazione delle pagine) nella 
Guida a Writer.

86 Guida introduttiva a LibreOffice 3.5



Figura 61: flusso di stili di pagina

Dividere un documento in capitoli
In modo simile, potete dividere un documento in capitoli. Ciascun capitolo potrebbe iniziare con lo 
stile Prima pagina, le pagine successive potrebbero utilizzare lo stile di pagina Predefinito, come 
sopra. Alla fine del capitolo, inserite una interruzione di pagina manuale e specificate che la pagina 
successiva deve avere lo stile Prima pagina per iniziare il capitolo successivo, come mostrato in 
Figura 62.

Figura 62: dividere un documento in capitoli utilizzando stili di pagina

Modifica dell'orientamento di pagina all'interno di un documento
Un documento di Writer può contenere pagine orientate diversamente. Una situazione comune è 
quella di avere una pagina orizzontale nel mezzo del documento, mentre le altre pagine hanno 
orientamento verticale. Ciò si può ottenere anche con interruzioni di pagina e stili di pagina.

Intestazioni differenti nelle pagine destre e sinistre
Gli stili di pagina possono essere impostati in modo da avere le pagine rivolte a destra e sinistra 
rispecchiate oppure rivolte solo a destra (le prime pagine dei capitoli sono spesso definite come 
pagine destre solamente) oppure rivolte solo a sinistra. Quando inserite una intestazione su uno 
stile di pagina impostato per pagine rispecchiate o per pagine destre-e-sinistre, potete fare in modo 
che i contenuti dell'intestazione siano i medesimi su tutte le pagine o siano diversi sulle pagine 
destre e sinistre. Per esempio, potete inserire il numero di pagina sul bordo di sinistra delle pagine 
sinistre e sul bordo di destra delle pagine destre, il titolo del documento solo sulla pagina di destra, 
o fare altri cambiamenti.
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Controllare le interruzioni di pagina in modo automatico
Writer fa scorrere automaticamente il testo da una pagina a quella successiva. Se non vi 
aggradano le impostazioni predefinite, potete modificarle. Per esempio, è possibile fare in modo 
che un paragrafo inizi su una nuova pagina o colonna e specificare lo stile della nuova pagina. Un 
utilizzo tipico è per i titoli di capitolo che desiderate inizino sempre su una nuova pagina di destra 
(numerata dispari).

Indice automatico
Per compilare un indice automatico, applicate prima gli stili alle intestazioni che desiderate 
compaiano nell'elenco dell'indice, quindi utilizzate Strumenti > Numerazione capitolo per 
impostare l'associazione corretta tra stili e livelli nell'indice. Vedete il Capitolo 4 per maggiori 
informazioni.

Definire una sequenza di stili
Potete impostare uno stile di paragrafo in modo che premendo Invio alla fine di quel paragrafo, il 
paragrafo successivo abbia automaticamente lo stile che desiderate sia applicato a quel paragrafo. 
Per esempio, potreste definire un paragrafo Intestazione 1 in modo che sia seguito da un 
paragrafo Corpo del testo. Un esempio più complesso potrebbe essere: Titolo seguito da Autore 
seguito da Estratto seguito da Intestazione 1 seguito da Corpo del testo. Impostando queste 
sequenze, potete evitare di applicare gli stili manualmente nella maggior parte dei casi.
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Capitolo 4  
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Introduzione a Writer

Writer è l'elaboratore di testi di LibreOffice. Oltre a tutte le tradizionali funzionalità degli elaboratori 
di testi (controllo ortografico, sinonimi, sillabazione, correzione automatica, funzione "trova e 
sostituisci", generazione automatica di indici e indici analitici, stampa in serie e altre), Writer offre 
queste importanti funzionalità:

• Modelli e stili (vedere Capitolo 3)

• Modalità di layout di pagina, incluse cornici, colonne e tabelle

• Incorporamento o collegamento di immagini, fogli elettronici e altri oggetti

• Strumenti di disegno integrati

• Documenti master—per unire un insieme di documenti in un solo documento

• Annotazione delle modifiche durante le revisioni

• Integrazione con database, incluso database bibliografico

• Esportazione in formato PDF, inclusi i segnalibri (vedi Capitolo 10)

• E molto altro ancora

Queste funzioni sono illustrate in dettaglio nella Guida a Writer.

L'interfaccia di Writer

La Figura 63 mostra l'area di lavoro principale di Writer. Menu e barre degli strumenti sono descritti 
nel Capitolo 1 (Introduzione a LibreOffice).

In questo capitolo sono trattate anche altre funzionalità dell'interfaccia di Writer.

Figura 63: l'area di lavoro di Writer nella vista Layout di stampa
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Barra di stato
La barra di stato di Writer fornisce informazioni sul documento e comodi strumenti per cambiarne 
alcune caratteristiche.

Figura 64: parte sinistra della barra di stato

Numero di pagina
Mostra il numero della pagina corrente, il numero sequenziale della pagina corrente (se 
diverso) e il numero totale di pagine del documento. Ad esempio, se avete reimpostato la 
numerazione assegnando il numero 1 alla terza pagina, il suo numero di pagina sarà 1 mentre 
il suo numero sequenziale sarà 3.

Se è stato definito qualche segnalibro nel documento, facendo clic con il tasto destro su questo 
campo verrà mostrato un elenco dei segnalibri; fate clic su quello desiderato.

Per spostarsi ad una specifica pagina nel documento, fate doppio clic su questo campo. Si 
aprirà la finestra del Navigatore. Fate clic sul campo del Numero di Pagina, digitate il numero 
sequenziale della pagina desiderata, e premete Invio.

Stile della pagina
Mostra lo stile della pagina corrente. Per applicare uno stile diverso alla pagina, fate clic con il 
tasto destro su questo campo. Verrà mostrato un elenco di stili di pagina; fate clic su quello 
desiderato.

Per modificare lo stile di pagina corrente, fate doppio clic su questo campo. Verrà mostrata la 
finestra di dialogo Stile di pagina.

Linguaggio
Mostra la lingua applicata al testo selezionato.

Fate clic per aprire un menu dove è possibile scegliere una lingua diversa per il testo 
selezionato o per il paragrafo in cui si trova il cursore. È possibile scegliere Nessuna (Non 
eseguire controllo ortografico) per escludere il testo dal controllo ortografico oppure 
scegliere Extra... per aprire la finestra di dialogo Carattere.

Modalità di inserimento
Fare clic per passare alternativamente alle modalità di digitazione Inserimento e 
Sovrascrittura.n

Modalità di selezione
Fate clic per passare alternativamente alle modalità di selezione STD (Standard), EST 
(Estesa), AGG (Aggiuntiva) e BLK (Blocco). La modalità EST è analoga alla selezione ottenuta 
dalla combinazione di tasti Maiusc+clic premuta durante la selezione del testo. Vedere 
“Lavorare con il testo” a pagina 96 per maggiori informazioni sulle modalità AGG e BLK.

Modifiche non salvate

Questa icona  sostituisce l'icona predefinita se le modifiche apportate al documento non 
sono state salvate.
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Figura 65: parte destra della barra di stato

Firma digitale
Se il documento è stato firmato digitalmente, viene mostrata un'icona qui. È possibile fare 
doppio clic sull'icona per visualizzare il certificato.

Informazioni sulla sezione o sull'oggetto
Quando il cursore si trova su una sezione, intestazione, sulla voce di un elenco, o quando un 
oggetto (come un'immagine o una tabella) è selezionato, in questo campo compaiono le 
informazioni corrispondenti. Il doppio clic in quest'area apre una finestra di dialogo relativa. Per 
maggiori dettagli, consultare la guida in linea o la Guida a Writer.

Layout di visualizzazione
Fate clic sulle icone per impostare il layout di visualizzazione pagina singola, fianco a fianco e 
libro. L'effetto cambia a seconda della larghezza della finestra e del fattore di zoom in uso. Il 
documento può essere modificato in qualsiasi layout di visualizzazione.

Figura 66: layout di visualizzazione: pagina singola, fianco a fianco, 
libro.

Zoom
Per modificare l'ingrandimento della visualizzazione, trascinate il cursore dello Zoom, o cliccate 
sui segni + e – , o con il pulsante destro del mouse sul livello percentuale di zoom per fare 
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apparire un elenco di valori fra i quali scegliere. Il numero di pagine visibili nella finestra del 
documento è influenzato sia dal layout di visualizzazione scelto, sia dal livello di zoom.

Cambiare modalità di visualizzazione dei documenti

Writer offre diversi modi di visualizzare un documento: Layout di stampa, Layout Web e Schermo 
intero. Per scegliere queste ed altre modalità, usate il menu Visualizza e fate clic sulla 
visualizzazione desiderata. (Nella modalità Schermo intero, premete il tasto Esc per tornare alle 
modalità Layout di stampa o Layout web.)

In modalità Layout di stampa è possibile utilizzare sia il cursore di Zoom che le icone di layout di 
visualizzazione sulla barra di stato. Nella modalità Layout Web è possibile utilizzare solo il cursore 
di Zoom.

È inoltre possibile selezionare Visualizza > Zoom dalla barra dei menu per aprire la finestra di 
dialogo Zoom e Layout visualizzazione, in cui è possibile impostare le opzioni analogamente alla 
Barra di stato. Molte delle opzioni non sono disponibili nella modalità Layout Web.

Figura 67: opzioni Zoom e Layout di visualizzazione.

Spostarsi rapidamente all'interno di un documento

Oltre alle funzionalità di navigazione della Barra di stato (descritte sopra), è possibile utilizzare la 
finestra di dialogo Navigatore e la barra degli strumenti di navigazione, come descritto nel Capitolo 
1 (Introduzione a LibreOffice).

In Writer, è possibile far comparire la barra degli strumenti di navigazione facendo clic sulla piccola 
icona Navigazione posta vicino all'angolo in basso a destra della finestra, sotto la barra di 
scorrimento verticale, come mostrato in Figura 68.
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Figura 68: icone di navigazione

La barra degli strumenti di navigazione (Figura 69) mostra le icone corrispondenti a tutte le 
tipologie di oggetti presenti nel Navigatore, più alcune altre (ad esempio, i risultati di un comando 
Trova).

Figura 69: barra di Navigazione

Fate clic su un'icona per selezionare la tipologia di oggetto corrispondente. In questo modo le 
icone Precedente e Successivo (nel Navigatore, nella barra degli strumenti di navigazione e nella 
barra di scorrimento) porteranno all'oggetto precedente o successivo della tipologia selezionata. 
Ciò è particolarmente utile per trovare elementi che possono essere difficili da individuare nel 
testo, come ad esempio le voci di un indice. I nomi delle icone (mostrati nei suggerimenti) 
cambiano a seconda della tipologia di oggetto selezionata; ad esempio, Immagine successiva, 
Segnalibro successivo, o Continua a cercare in avanti.

Per ulteriori utilizzi del Navigatore in Writer, consultare la Guida a Writer.

Lavorare con i documenti

Il Capitolo 1 (Introduzione a LibreOffice) contiene istruzioni su come creare nuovi documenti, aprire 
documenti esistenti, salvare documenti e proteggerli con password. Il Capitolo 3 (Uso di Stili e 
Modelli) illustra come creare un documento da un modello.

Salvataggio di file nel formato Microsoft Word
Se dovete scambiare documenti con utenti di Microsoft Word che non hanno piacere o non sono in 
grado di ricevere file *.odt, potete salvare i documenti come file Microsoft Word.

1) Importante—Salvate prima il vostro documento nel formato file usato da LibreOffice Writer 
(.odt). Altrimenti qualunque modifica sia stata fatta dopo l'ultimo salvataggio, sarà salvata 
solamente nella versione Microsoft Word del documento.

2) Quindi scegliete File > Salva con nome. Nella finestra di dialogo Salva con nome, 
selezionate, nel menu a comparsa Tipo di file (oppure Salva come tipo), il tipo di formato 
Word che desiderate. Fate clic su Salva.
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Figura 70: salvataggio di documenti nel formato Microsoft Word

Da questo punto in poi, tutte le modifiche attuate nel documento verranno salvate solo nel nuovo 
documento. Infatti, modificando il nome ed il tipo di file, avete creato un nuovo documento. Se 
volete ritornare alla versione .odt del vostro documento, dovrete aprirlo nuovamente.

Attenzione Se utilizzate un formato Microsoft Word, si consiglia di utilizzare il formato .doc 
invece del formato .docx. Salvando prima nel formato .odt avrete la possibilità di 
ripristinare il documento se il ricevente dovesse sperimentare problemi con il 
formato Microsoft.
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Suggerimento

Per fare in modo che Writer salvi i documenti in maniera predefinita nel formato 
file di Microsoft Word, selezionate Strumenti > Opzioni > Carica/Salva > 
Generale. Nella sezione chiamata Formato file predefinito e impostazioni ODF, 
sotto Tipo documento, selezionate Documento di testo, quindi sotto Salva 
sempre come, selezionate il vostro formato file preferito.

Lavorare con il testo

In Writer, il modo di lavorare con il testo (selezionare, copiare, incollare, spostare) è simile ad altri 
programmi. LibreOffice dispone anche di alcuni modi utili per selezionare elementi che non sono 
tra loro vicini, selezionare una porzione verticale di testo e incollare testo senza formattazione.

Selezione di elementi non consecutivi
Per selezionare elementi non consecutivi usando il mouse (come mostrato nella Figura 71):

1) Selezionate la prima porzione del testo.

2) Tenete premuto il tasto Ctrl e selezionate il pezzo di testo successivo con il mouse.

3) Ripetete la procedura tutte le volte che serve.

Ora è possibile lavorare con il testo selezionato (copiarlo, cancellarlo, modificarne lo stile o altro).

Nota
Gli utenti Macintosh devono premere il tasto Command quando le istruzioni in 
questo capitolo indicano di usare il tasto Ctrl.

Figura 71: selezionare elementi non consecutivi

Per selezionare elementi non consecutivi usando la tastiera:

1) Selezionate la prima porzione di testo. (Per maggiori informazioni sull'uso della tastiera per 
la selezione del testo, si veda l'argomento “Navigazione e selezione del testo con la 
tastiera” nella Guida in linea).
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2) Premete Maiusc+F8. In questo modo Writer passa in modalità “AGG”. La scritta AGG 
compare nella barra di stato, sostituendo STD.

3) Usate i tasti freccia per spostarvi all'inizio della successiva porzione di testo da selezionare. 
Tenete premuto il tasto Maiusc e selezionate la successiva porzione di testo.

4) Ripetete la procedura tutte le volte che serve.

A questo punto è possibile lavorare sul testo selezionato.

Premete Esc per uscire da questa modalità.

Selezione di una porzione verticale di testo
Utilizzando la modalità di selezione a blocchi è possibile selezionare una porzione verticale, o 
"colonna", di testo che sia separato da spazi o tabulazioni (ad esempio testo incollato da e-mail, 
listati di programmi, etc.). Per passare alla modalità di selezione a blocchi, usate il comando 
Modifica > Modo selezione > Area blocco , oppure premete Ctrl+F8, oppure fate clic più volte su 
STD nella barra di stato fino a cambiarlo in BLK.

Ora è possibile evidenziare la selezione, utilizzando il mouse o la tastiera, come mostrato sotto.

Figura 72: selezione di una porzione verticale di 
testo

Tagliare, copiare e incollare testo
Il modo in cui si taglia e copia testo con Writer è simile a quello usato in altre applicazioni. Per 
queste operazioni potete usare il mouse o la tastiera. Potete copiare o spostare testo in un 
documento, o tra documenti, trascinando o usando le selezioni tramite i menu, le icone, o i tasti di 
scelta rapida. Potete anche copiare testo da altre fonti come pagine Web e incollarlo in un 
documento di Writer.

Per spostare (trascinare e rilasciare) il testo selezionato usando il mouse, fate clic, trascinatelo 
nella nuova posizione e rilasciatelo. Per copiare il testo selezionato, tenete premuto il tasto Ctrl 
mentre trascinate. Il testo mantiene la formattazione precedente al trascinamento.

Per spostare (tagliare e incollare) il testo selezionato, usate Ctrl+X per tagliare il testo, inserite il 
cursore nella posizione in cui volete incollare e usate Ctrl+V per incollare. Alternativamente, usate 
le icone sulla barra degli strumenti Standard.

Quando incollate il testo, il risultato dipende dalla fonte del testo e da come viene incollato. Se fate 
clic sull'icona Incolla, viene mantenuta qualsiasi formattazione del testo (come grassetto o 
corsivo). Il testo incollato da siti Web e altre fonti potrebbe anche essere posizionato in cornici o 
tabelle. Se non gradite i risultati, fate clic sull'icona Annulla o premete Ctrl+Z.
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Per fare in modo che il testo incollato abbia la stessa formattazione del testo circostante:

• Scegliete Modifica > Incolla speciale, oppure

• fate clic sul triangolo a destra dell'icona Incolla , oppure

• fate clic sull'icona Incolla senza rilasciare il pulsante del mouse.

Selezionate quindi Testo non formattato dal menu che appare.

Le possibilità di scelta del menu Incolla speciale cambiano a seconda dell'origine e della 
formattazione del testo (o altro oggetto) da incollare. Vedere Figura 73 per un esempio con appunti 
contenenti del testo.

Figura 73: menu Incolla speciale

Ricerca, sostituzione e formattazione di testo
In Writer esistono due modi per trovare del testo in un documento: la barra degli strumenti Cerca 
per la ricerca veloce e la finestra di dialogo Cerca e sostituisci. Nella finestra di dialogo è possibile:

• Cercare e sostituire parole e frasi

• Usare caratteri jolly e espressioni regolari per una ricerca più accurata

• Cercare e sostituire formattazioni specifiche

• Cercare e sostituire stili di paragrafo

Uso della barra degli strumenti Cerca
Se la barra degli strumenti Cerca non è visibile, potete renderla visibile scegliendo Visualizza > 
Barre degli strumenti > Cerca dalla barra menu o premendo Ctrl+F. La barra degli strumenti 
Cerca viene mostrata agganciata nella parte bassa della finestra di LibreOffice (sopra la barra di 
Stato) in Figura 74, ma potete renderla mobile o agganciarla in altra posizione. Per maggiori 
informazioni sulle barre mobili e agganciate, vedere il Capitolo 1 (Introduzione a LibreOffice).

Figura 74: barra degli strumenti Cerca in posizione agganciata

Per utilizzare la barra degli strumenti Cerca, fate clic nella casella e digitate il testo da cercare, 
quindi premete Invio per trovare l'occorrenza successiva del termine inserito. Fate clic sui pulsanti 
Trova successivo o Trova precedente secondo necessità.
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Uso della finestra di dialogo Cerca e sostituisci
Per visualizzare la finestra di dialogo Cerca e sostituisci (Figura 75), usate i tasti di scelta rapida 
Ctrl+Alt+F oppure scegliete Modifica > Trova e sostituisci dalla barra menu. È possibile fare clic 
sul pulsante Altre opzioni per espandere la finestra di dialogo; il medesimo pulsante cambierà in 
Meno opzioni.

Per usare la finestra di dialogo Cerca e sostituisci:

1) Digitate il testo che volete cercare nel campo Cerca.

2) Per sostituire il testo trovato con uno diverso, digitate il nuovo testo nella casella 
Sostituisci con.

3) È possibile selezionare varie opzioni come la corrispondenza esatta, solo parole intere, o la 
ricerca di parole simili.

4) Quando i parametri di ricerca sono stati impostati, fate clic su Cerca. Per sostituire il testo 
trovato, fate clic su Sostituisci.

Per maggiori informazioni sull'utilizzo di Cerca e sostituisci, vedere la Guida a Writer.

Suggerimento
Se fate clic su Cerca tutto, LibreOffice selezionerà tutte le occorrenze della 
ricerca nel documento. Allo stesso modo, se fate clic su Sostituisci tutto, 
LibreOffice sostituirà tutte le occorrenze.

Attenzione La funzione Sostituisci tutto deve essere utilizzata con cautela; altrimenti, si 
possono verificare errori talora divertenti o imbarazzanti. Potrebbe essere 
necessaria una ricerca manuale, parola per parola, per eliminare un errore 
commesso con Sostituisci tutto.
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Figura 75: finestra di dialogo Cerca e sostituisci ampliata

Inserimento di caratteri speciali
Un carattere che non si trova nella tastiera standard italiana è un carattere speciale. Per esempio, 
© ¾ æ ç ñ ö ø ¢ sono tutti caratteri speciali. Per inserire un carattere speciale:

1) Posizionate il cursore nel punto in cui volete inserire il carattere speciale.

2) Scegliete Inserisci > Caratteri speciali per aprire la finestra di dialogo Caratteri speciali.

3) Selezionate i caratteri che volete inserire (da qualsiasi tipo di carattere o insieme parziale 
di caratteri), nel giusto ordine, poi fate clic su OK. I caratteri selezionati sono mostrati nella 
parte inferiore sinistra della finestra di dialogo. Quando si seleziona un carattere, questo è 
visibile nella parte inferiore destra, insieme al suo codice numerico.

Nota
Tipi di carattere diversi includono differenti caratteri speciali. Se non trovate un 
particolare carattere speciale, provate a selezionare un tipo di Carattere diverso.
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Figura 76: finestra di dialogo Caratteri speciali, dove potete inserire caratteri speciali

Inserire trattini (dashes - in italiano detti anche lineette), spazi non 
divisibili e trattini (hyphens - in italiano detti anche tratti d'unione)
Per evitare che due parole vengano separate alla fine di una linea, premete Ctrl+Maiusc mentre 
digitate lo spazio tra le due parole.

Nei casi in cui non desiderate che il trattino (tratto d'unione) appaia alla fine di una linea, ad 
esempio in un numero come 123-4567, potete premere Maiusc+Ctrl+segno meno per inserire un 
trattino (tratto d'unione) non divisibile.

Per inserire trattini (o lineette) enne e emme, potete usare l'opzione Sostituisci trattini sulla scheda 
Opzioni sotto Strumenti > Opzioni di correzione automatica. Questa opzione sostituisce due 
trattini (tratti d'unione), in certe condizioni, con il corrispondente trattino (lineetta).n

– è un trattino corto (lineetta enne); cioè, un trattino della larghezza della lettera “n” nel 
carattere che state usando. Digitate almeno un carattere, uno spazio, uno o due trattini 
(tratti d'unione), un altro spazio, e almeno un'altra lettera. Il trattino o i trattini (tratti 
d'unione) verranno sostituiti dal trattino corto (lineetta enne).

— è un trattino lungo (lineetta emme); cioè, un trattino della larghezza della lettera “m” nel 
carattere che state usando. Digitate almeno un carattere, due trattini (tratti d'unione), e 
almeno un altro carattere. I due trattini (tratti d'unione) verranno sostituiti da un trattino 
lungo (lineetta emme).

Vedere l'Aiuto per maggiori dettagli. Per ulteriori metodi di inserimento dei trattini, consultare la 
Guida a Writer.

Impostazione delle tabulazioni e dell'indentazione
Il righello orizzontale mostra sia le tabulazioni standard sia quelle definite dall'utente. Le 
impostazioni della tabulazione influiscono sul rientro di interi paragrafi (usando le icone Aumenta 
rientro e Riduci rientro sulla barra degli strumenti Formattazione) così come sul rientro di parti di 
un paragrafo (premendo il tasto Tab sulla tastiera).

L'utilizzo della spaziatura di tabulazione predefinita può causare problemi di formattazione se 
condividete documenti con altre persone. Se usate la spaziatura di tabulazione predefinita e poi 
inviate il documento a qualcuno che ha scelto una differente spaziatura di tabulazione predefinita, 
il materiale tabulato cambierà, prendendo le impostazioni dell'altra persona. Invece di utilizzare le 
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impostazioni predefinite, definite delle impostazioni personalizzate, come descritto in questa 
sezione.

Per definire i rientri e le impostazioni di tabulazione per uno o più paragrafi selezionati, fate doppio 
clic su una parte del righello al di fuori delle icone di rientro sinistra e destra per aprire la scheda 
Paragrafo della finestra di dialogo Paragrafo. Fate doppio clic in qualsiasi punto tra le icone di 
rientro sinistra e destra sul righello per aprire la scheda Tabulazione della finestra di dialogo 
Paragrafo.

Una migliore strategia è quella di definire le tabulazioni per lo stile di paragrafo. Per avere maggiori 
informazioni vedere i Capitoli 6 e 7 nella Guida a Writer.

Suggerimento
Si sconsiglia l'utilizzo delle tabulazioni per distanziare materiale su una pagina. A 
seconda di ciò che si deve fare, una tabella solitamente è una scelta migliore.

Modificare l'intervallo di tabulazione predefinito

Nota
Qualsiasi modifica alle impostazioni predefinite della tabulazione avrà effetto sulle 
tabulazioni predefinite esistenti in qualsiasi documento aprirete in seguito, così 
come sulle tabulazioni che inserirete dopo aver fatto la modifica.

Per impostare le unità di misura e la spaziatura degli intervalli di tabulazione predefiniti, andate in 
Strumenti > Opzioni > LibreOffice Writer > Generale.

Figura 77: scegliere l'intervallo di tabulazione predefinito

Potete anche impostare o modificare le unità di misura per i righelli nel documento corrente 
facendo clic con il pulsante destro sul righello per aprire un elenco delle unità di misura. Fate clic 
su una di esse per cambiare l'unità di misura del righello. L'impostazione selezionata viene 
applicata solo a quel righello.

Figura 78: modificare l'unità di misura di un righello
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Controllo ortografico e grammaticale
Writer dispone di un correttore ortografico che può essere usato in due modi.

Il Controllo automatico controlla ogni parola quando viene digitata e visualizza una linea 
rossa ondulata sotto tutte le parole errate. Quando la parola viene corretta la linea 
scompare.

Per eseguire un controllo ortografico separato di un intero documento (o di una porzione di 
testo selezionato), fate clic sul pulsante Ortografia e grammatica. In questo modo viene 
eseguito il controllo ortografico sul documento o sul testo selezionato e, nel caso vengano 
rilevati degli errori, essi verranno segnalati nella finestra di dialogo Controllo ortografico.

Vi sono altre funzioni del correttore ortografico:

• Fate clic con il tasto destro su una parola con una sottolineatura ondulata per visualizzare 
un menu contestuale. Selezionando una delle parole suggerite dal menu, questa sostituirà 
la parola errata. Di seguito sono descritte altre opzioni del menu.

• Potete cambiare la lingua del dizionario (ad esempio Spagnolo, Francese o Tedesco) nella 
finestra di dialogo Controllo ortografico.

• Potete aggiungere parole al dizionario. Fate clic su Aggiungi nella finestra di dialogo 
Controllo ortografico e selezionate il dizionario a cui desiderate aggiungere la nuova 
parola.

• Fate clic sul pulsante delle Opzioni nella finestra di dialogo Controllo ortografico per aprire 
una finestra di dialogo simile a quella che potete vedere selezionando Strumenti > 
Opzioni > Impostazioni della lingua > Linguistica descritta nel Capitolo 2. In tale finestra 
potete scegliere se controllare parole maiuscole e con i numeri, potete gestire dizionari 
personalizzati, cioè, aggiungere o rimuovere dizionari e parole in un dizionario.

• Nella scheda Carattere della finestra di dialogo Stile di paragrafo, è possibile impostare i 
paragrafi che devono essere controllati in una specifica lingua (differente dal resto del 
documento). Vedere il Capitolo 7 (Lavorare con gli stili) nella Guida a Writer per maggiori 
informazioni.

Writer include un correttore grammaticale (LightProof), accessibile da Strumenti > Ortografia e 
grammatica.

Utilizzo degli strumenti per la lingua integrati
Writer dispone di strumenti che possono facilitare il lavoro nel caso di utilizzo di più lingue nello 
stesso documento o di creazione di documenti in lingue diverse.

Il vantaggio principale del modificare la lingua per un testo selezionato è che ciò consente l'utilizzo 
del dizionario appropriato per il controllo ortografico. Inoltre, modificare la lingua consente di 
impostare le versioni locali di Correzione automatica, sinonimi e sillabazione.

È inoltre possibile impostare a Nessuno (Non controllare l'ortografia) la lingua di un paragrafo o 
di un gruppo di caratteri. Questa opzione è particolarmente utile se inserite del testo come indirizzi 
web o parti di un linguaggio di programmazione che non desiderate controllare.

Specificare la lingua negli stili di carattere e paragrafo è il metodo preferito, in quanto gli stili 
permettono un maggior livello di controllo e rendono la modifica della lingua più veloce. Nella 
scheda Carattere della finestra di dialogo Stile di paragrafo, potete specificare che determinati 
paragrafi siano controllati in una lingua diversa dalla lingua del resto del documento. Vedere il 
Capitolo 7 (Lavorare con gli stili) nella Guida a Writer per informazioni su come gestire le 
impostazioni di lingua in uno stile.
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È anche possibile impostare la lingua per l'intero documento, per singoli paragrafi, o persino per 
singole parole e caratteri, da Strumenti > Lingua sulla barra dei menu.

Un altro modo per cambiare la lingua di un intero documento è l'utilizzo di Strumenti > Opzioni > 
Impostazioni della lingua > Lingue. Nella sezione Lingue predefinite per i documenti, potete 
scegliere una lingua differente per tutto il testo che non è esplicitamente contrassegnato come una 
lingua differente.

Il controllo ortografico è disponibile solo per le lingue in elenco con il simbolo . Se il simbolo 
non compare a fianco della lingua desiderata, è possibile installare il dizionario aggiuntivo 
scegliendo Strumenti > Lingua > Ulteriori dizionari in linea.

La barra di stato mostra la lingua associata al controllo ortografico vicino allo stile di pagina in uso.

Uso della Correzione automatica
La funzione Correzione automatica si basa su una lunga lista di comuni errori di ortografia e di 
digitazione, che vengono corretti automaticamente. Ad esempio, “é” verrà cambiato con “è”.

La Correzione automatica è attiva quando Writer viene installato. Per disattivarla, togliete il segno 
di spunta in Formato > Correzione automatica > Durante la digitazione.

Scegliete Strumenti > Opzioni di correzione automatica per aprire la finestra di dialogo 
Correzione automatica. In tale finestra è possibile definire quali stringhe di testo sono da 
correggere e in che modo. Nella maggior parte dei casi, le impostazioni standard sono adeguate.

Per impedire a Writer di correggere un particolare modo di digitare una parola, andate alla scheda 
Sostituzione, evidenziate la coppia di parole, e fate clic su Elimina.

Per aggiungere nuove voci all'elenco, digitatele nei campi Sostituisci e Con sulla scheda 
Sostituzione, e fate clic su Nuovo.

Esaminate le diverse schede della finestra di dialogo per la vasta gamma di altre opzioni disponibili 
per l'uso della Correzione automatica.

Suggerimento
La Correzione automatica può essere usata per l'inserimento rapido di caratteri 
speciali. Per esempio, (c) verrà automaticamente corretto in ©. È possibile 
aggiungere dei caratteri speciali personali.

Uso del completamento delle parole
Quando la funzione Completamento delle parole è attiva, Writer cerca di capire quale parola si sta 
digitando e propone di completarla. Per accettare il suggerimento premere Invio, Altrimenti, 
continuate a digitare.

Per disattivare il Completamento delle parole, selezionate Strumenti > Opzioni di correzione 
automatica > Completamento parola e deselezionate Attiva completamento parole.

È possibile personalizzare la funzione Completamento parola dalla pagina Completamento parola 
della finestra di dialogo Correzione automatica:

• Aggiungere (accodare) automaticamente uno spazio dopo ogni parola accettata.

• Mostrare la parola suggerita in una piccola casella di testo (che appare sopra la parola), 
invece di completare il testo che si sta digitando.
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• Raccogliere parole mentre si lavora ad un documento, e poi salvarle per un utilizzo 
successivo in altri documenti oppure selezionare l'opzione per rimuoverle dall'elenco 
quando si chiude il documento.

• Cambiare il numero massimo di parole memorizzate per il Completamento parole e la 
lunghezza minima delle parole da memorizzare.

• Cancellare specifiche voci dall'elenco del Completamento parole.

• Cambiare il tasto che accetta una voce suggerita - le opzioni sono Freccia destra, Fine, 
Invio e Barra spaziatrice.

Nota
Il Completamento automatico delle parole funziona a partire dalla seconda volta in 
cui si digita la parola nel documento.

Uso del Testo automatico
La funzione Testo Automatico permette di salvare testo, tabelle, immagini e altri elementi per un 
uso successivo ed assegnarli ad una combinazione di tasti per poterli recuperare facilmente. Ad 
esempio, invece di digitare “Gestione studenti” ogni volta che si usa tale frase, dopo aver 
impostato una voce apposita per il Testo automatico, è possibile digitare solo “gs” e premere il 
tasto F3 per inserire tali parole.

La funzione Testo automatico è particolarmente utile quando è assegnata a campi. Vedere il 
Capitolo 14 (Lavorare con i comandi di campo) nella Guida a Writer per ulteriori informazioni.

Creazione di Testo automatico
Per salvare del testo come Testo automatico:

1) Digitate il testo nel documento.

2) Selezionate il testo.

3) Scegliete Modifica > Testo automatico (oppure premete Ctrl+F3).

4) Nella finestra di dialogo Testo automatico, digitate un nome per il Testo automatico nella 
casella Nome. Writer propone una scorciatoia di una lettera, che però può essere 
cambiata.

5) Nel riquadro più ampio sulla sinistra, scegliete la categoria per la voce di Testo automatico, 
ad esempio Testo automatico personale.

6) Fate clic sul pulsante Testo automatico a destra e selezionate Nuovo (solo testo) dal 
menu.

7) Fate clic su Chiudi per tornare al documento.

Suggerimento
Se la sola opzione sotto il pulsante Testo automatico è Importa, non si è 
introdotto un nome per il Testo automatico o non vi è un testo selezionato nel 
documento.

Inserimento di Testo automatico
Per inserire Testo automatico, digitate la scelta rapida e premete F3.
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Formattazione del testo

Si consiglia l'utilizzo degli stili
Gli stili sono fondamentali per usare Writer. Gli stili permettono di formattare i documenti in modo 
semplice e coerente, e di modificare facilmente la formattazione. Uno stile è un insieme di opzioni 
di formattazione con uno specifico nome. Quando si applica uno stile, si applica 
contemporaneamente un intero gruppo di formati. Inoltre, gli stili vengono utilizzati da LibreOffice 
per eseguire numerose procedure che non risultano visibili agli utenti. Ad esempio, gli stili dei titoli 
(o altri stili specificati) consentono a Writer di compilare gli indici.

Attenzione
La formattazione manuale (anche detta formattazione diretta) ha precedenza sugli 
stili, e non è possibile eliminare la formattazione manuale applicando ad essa uno 
stile.

Per rimuovere la formattazione manuale, selezionate il testo, fate clic con il pulsante 
destro, e scegliete Cancella la formattazione diretta dal menu a comparsa.

Writer definisce diversi tipi di stili, per diversi tipi di elementi: caratteri, paragrafi, pagine, cornici ed 
elenchi. Vedere il Capitolo 3 (Uso di Stili e Modelli) in questa guida e i Capitoli 6 e 7 nella Guida a 
Writer.

Formattare i paragrafi
È possibile applicare molti tipi di formattazione ai paragrafi usando i pulsanti presenti nella barra 
degli strumenti di Formattazione. La Figura 79 mostra la barra di Formattazione come una barra 
mobile, personalizzata per mostrare solo le icone per la formattazione dei paragrafi. L'aspetto delle 
icone può variare a seconda del sistema operativo e della scelta dello stile e della dimensione 
delle icone attraverso il comando Strumenti > Opzioni > LibreOffice > Vista.

1 Apre la finestra Stili e 
formattazione.

5 Allinea a destra 10 Numerazione On/Off
6 Giustificato 11 Elenco puntato On/Off

2 Applica stile 7 Interlinea: 1 12 Riduci rientro
3 Allinea a sinistra 8 Interlinea: 1.5 13 Aumenta il rientro
4 Centrato 9 Interlinea: 2 14 Finestra di dialogo Paragrafo

Figura 79: la barra di Formattazione, con le icone per la formattazione dei paragrafi

Formattare i caratteri
I caratteri possono essere formattati in diversi modi con i pulsanti della barra di Formattazione. La 
Figura 80 mostra la barra di Formattazione, personalizzata per mostrare solo le icone per la 
formattazione dei caratteri.
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L'aspetto delle icone può variare a seconda del sistema operativo e della scelta dello stile e della 
dimensione delle icone attraverso il comando Strumenti > Opzioni > LibreOffice > Vista.

1 Apre la finestra Stili e 
formattazione.

6 Corsivo 12 Colore carattere

7 Sottolineato 13 Evidenziato

2 Applica stile 8 Apice 14 Colore di sfondo

3 Nome carattere 9 Pedice 15 Apre la finestra di dialogo Carattere

4 Dimensione carattere 10 Ingrandisci carattere

5 Grassetto 11 Riduci carattere

Figura 80: barra di Formattazione, con le icone per la formattazione dei caratteri

Suggerimento

Per rimuovere la formattazione manuale, selezionate il testo, e scegliete 
Formato > Cancella formattazione diretta dalla barra dei menu, oppure fate 
clic con il pulsante destro e scegliete Cancella formattazione diretta dal menu 
contestuale, o utilizzate Ctrl+M dalla tastiera.

Formattazione automatica
È possibile impostare Writer in modo da formattare parti di un documento in modo automatico, in 
base alle scelte fatte nella scheda Opzioni della finestra di dialogo Correzione automatica 
(Strumenti > Opzioni di correzione automatica).

Suggerimento
Nel caso di modifiche impreviste nella formattazione del vostro documento, 
questo è il primo posto dove andare a ricercarne la causa.

La Guida in Linea descrive ciascuna di queste scelte e come attivare la formattazione automatica. 
Alcune variazioni non desiderate o inaspettate della formattazione comprendono:

• Linee orizzontali. Se si digitano tre o più trattini (tratti d'unione) (---), trattini bassi (___) e 
segni di uguale (===) su una linea e poi si preme Invio, il paragrafo verrà sostituito da una 
linea orizzontale della larghezza della pagina. In realtà, questa linea è il margine inferiore 
del paragrafo precedente.

• Elenchi puntati e numerati. Quando si digita, all'inizio di un paragrafo, un trattino (tratto 
d'unione) (-), un asterisco (*) o il segno più (+), seguito da uno spazio o da una 
tabulazione, viene creato un elenco puntato. Quando si digita, all'inizio di un paragrafo, un 
numero seguito da un punto (.), quindi da uno spazio o da una tabulazione, viene creato un 
elenco numerato. La numerazione automatica viene applicata solamente per quei paragrafi 
formattati con gli stili di paragrafo Predefinito, Corpo del testo o Rientro corpo del testo.

Per abilitare o disabilitare la formattazione automatica, scegliete Formato > Correzione 
automatica e selezionate o deselezionate le voci in elenco.
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Creazione di elenchi numerati o puntati
È possibile creare elenchi numerati o puntati in diversi modi:

• Usando la formattazione automatica, come descritto sopra.

• Usando gli stili per gli elenchi (numerazione), come descritto nei Capitoli 6 (Introduzione 
agli Stili) e 7 (Lavorare con gli Stili) della Guida a Writer.

• Usando le icone Numerazione e Elenco puntato sulla barra di formattazione (vedere 
Figura 79): selezionate i paragrafi dell'elenco, quindi fate clic sull'icona appropriata sulla 
barra degli strumenti.

Nota
Digitare prima le vostre informazioni e poi applicare Elenchi numerati/puntati, 
oppure usarli mentre si sta digitando è una scelta personale.

Uso della Barra elenchi puntati e numerati
È possibile creare elenchi annidati (dove, cioè, una o più voci di un elenco presentano un 
sottoelenco, come in una struttura) attraverso i pulsanti presenti nella barra Elenchi puntati e 
numerati (Figura 81). È possibile muovere le voci in alto o in basso nell'elenco, creare 
sottoparagrafi, e anche cambiare lo stile degli elenchi puntati. Per vedere la relativa barra degli 
strumenti usate Visualizza > Barre degli strumenti > Elenchi puntati e numerati. 

L'aspetto delle icone può variare a seconda del sistema operativo e della scelta dello stile e della 
dimensione delle icone attraverso il comando Strumenti > Opzioni > LibreOffice > Vista.

Nota
Se la numerazione o i punti vengono applicati automaticamente in un modo che 
trovate inadatto, potete disabilitarli temporaneamente deselezionando Formato > 
Correzione automatica > Durante la digitazione.

1 Elenco puntato On/Off 6 Un livello superiore con 
sottoparagrafi

10 Sposta verso il basso
2 Numerazione On/Off 11 Sposta in alto con sottopunti
3 Numerazione Off 7 Un livello inferiore con 

sottoparagrafi
12 Sposta in basso con sottopunti

4 Un livello superiore 8 Inserisci voce senza numero 13 Ricomincia numerazione
5 Un livello inferiore 9 Sposta verso l'alto 14 Elenchi puntati e numerati

Figura 81: barra degli strumenti elenchi puntati e numerati
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Sillabazione
Avete diverse possibilità riguardo alla sillabazione: fare in modo che Writer la esegua 
automaticamente (utilizzando i dizionari di sillabazione integrati), inserire separatori condizionali 
manualmente dove necessario, oppure non eseguirla affatto.

Sillabazione automatica
Per attivare o disattivare la sillabazione automatica 
delle parole:

1) Premete F11 (⌘+T su Mac) per aprire la 
finestra di dialogo Stili e formattazione.

2) Nella scheda Stili di paragrafo (Figura 82), 
fate clic con il tasto destro su Predefinito e 
selezionate Modifica.

3) Nella finestra di dialogo Stile di paragrafo 
(Figura 83), andate alla scheda Flusso di  
testo.

4) Sotto Sillabazione, selezionate o 
deselezionate l'opzione Automatico. Fate 
clic su OK per salvare.

Figura 83: attivare la sillabazione automatica

Nota

L'attivazione della sillabazione per lo stile di paragrafo Predefinito influisce su tutti 
gli altri stili di paragrafo basati sullo stile Predefinito. È possibile variare la 
sillabazione in ciascun stile di formato, in modo da disattivarla; per esempio, 
potreste voler escludere la sillabazione nelle intestazioni. Ciò non ha effetto sugli 
stili che non si basano sullo stile Predefinito. Vedere la Guida a Writer Capitolo 3 
(Uso di stili e modelli) per maggiori informazioni sugli stili basati su altri stili.

È anche possibile impostare le scelte di sillabazione mediante Strumenti > Opzioni > 
Impostazioni della lingua > Linguistica. In Opzioni, nella parte bassa della finestra di dialogo, 
scorrete verso il basso fino a trovare le impostazioni per la sillabazione.
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Figura 84: opzioni di impostazione della sillabazione

Per modificare il numero minimo di caratteri per la sillabazione, il numero minimo di caratteri prima 
di una interruzione di riga, oppure il numero minimo di caratteri dopo una interruzione di riga, 
selezionate l'elemento, quindi fate clic sul pulsante Modifica nella sezione Opzioni.

Le opzioni di sillabazione impostate nel dialogo Linguistica sono effettive solo se la sillabazione è 
stata attivata attraverso gli stili di paragrafo.

Sillabazione manuale
Per sillabare manualmente le parole, non usate un trattino (tratto d'unione) normale, che rimarrà 
visibile anche se la parola non si trova più alla fine di una riga, in caso doveste aggiungere o 
rimuovere del testo oppure modificare i margini o la dimensione del carattere. Usate invece un 
separatore condizionale, che è visibile solo quando necessario.

Per inserire un separatore condizionale all'interno di una parola, fate clic dove desiderate appaia il 
trattino e premete Ctrl+trattino (tratto d'unione). La parola verrà sillabata in questa posizione 
quando essa si trova a fine riga, anche se la sillabazione automatica per questo paragrafo è 
disattivata.

Formattare le pagine

Writer offre diverse modalità di controllo del layout di pagina: stili di pagina, colonne, cornici, 
tabelle, e sezioni. Per maggiori informazioni, si veda il Capitolo 4 (Formattazione delle pagine) 
nella Guida a Writer.

Suggerimento

Impostare il layout di pagina è in genere più facile se si mostrano i contorni di 
testo, oggetti, tabelle, e sezioni in Strumenti > Opzioni > LibreOffice > 
Aspetto, e i marcatori di fine paragrafo, le tabulazioni, le interruzioni, e le altre 
voci in Strumenti > Opzioni > LibreOffice Writer > Formattazione.

Scelta del metodo di layout
La scelta migliore per il tipo di layout dipende da come il documento deve apparire e da che tipo di 
informazioni contiene. Presentiamo di seguito alcuni esempi.
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Per un libro simile a questa guida utente, con una 
colonna di testo, con alcune figure senza testo al 
loro interno, e con altre figure con testo descrittivo, 
usate gli stili di pagina per il layout di base, e le 
tabelle in cui incorporare le figure con testo 
descrittivo quando necessario.

Per un indice o un tipo di documento in due 
colonne, con il testo che procede dalla colonna di 
sinistra a quella di destra e quindi sulla pagina 
successiva, tutto di seguito (noto anche come testo 
a "colonne serpeggianti"), usate uno stile pagina 
basato su due colonne. Se si desidera che il titolo 
del documento in prima pagina occupi l'intera 
larghezza della pagina, lo si inserisca in una 
sezione a colonna singola.

Per una newsletter con un layout complesso, con 
due o tre colonne per pagina, e alcuni articoli che 
iniziano in una pagina e riprendono in qualche punto 
diverse pagine più avanti, usate uno stile di pagina 
per il layout di base. Inserite gli articoli in cornici 
collegate, ancorando le immagini a posizioni fisse, 
se necessario.
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Per un documento con termini e traduzioni che 
devono apparire di fianco gli uni alle altre, usate una 
tabella per mantenere l'allineamento, in modo da 
poter digitare in entrambe le “colonne”.

Creazione di intestazioni e piè di pagina
Un'intestazione è un'area collocata nella parte superiore della pagina. Un piè di pagina è situato 
invece nella parte inferiore della pagina. Le informazioni come i numeri di pagina inserite in 
un'intestazione o in un piè di pagina sono visualizzate in ogni pagina del documento con quello 
stile di pagina.

Inserimento di una intestazione oppure un piè di pagina
Per inserire una intestazione potete:

• Scegliere Inserisci > Riga d'intestazione > Stile predefinito (o lo stile di pagina, se non è 
quello predefinito), oppure

• Passate il mouse sulla parte alta dell'area del testo fino a quando non compare il 
contrassegno dell'Intestazione (Figura 85), quindi fate clic sul +.

Figura 85: contrassegno dell'intestazione sopra l'area del testo

Dopo la creazione dell'intestazione, una freccia in basso compare sul contrassegno 
dell'intestazione. Fate clic su questa freccia per mostrare un menu a comparsa con alcune opzioni 
per lavorare sull'intestazione (Figura 86).
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Figura 86: il menu dell'intestazione

Per formattare un'intestazione, potete usare la voce di menu mostrata in Figura 86 oppure 
Formato > Pagina > Riga d'intestazione. Entrambi i metodi vi portano alla stessa scheda della 
finestra di dialogo Stile di pagina.

Inserimento dei contenuti in intestazioni e piè di pagina
Nelle intestazioni e piè di pagina si inseriscono spesso ulteriori informazioni, come il titolo del 
documento e del capitolo. Il modo migliore è inserirli come comandi di campo. In questo modo, se 
si attuano delle modifiche, le intestazioni e i piè di pagina saranno aggiornati automaticamente. 
Ecco un esempio molto comune.

Per inserire il titolo del documento nell'intestazione:

1) Scegliete File > Proprietà > Descrizione e digitate il titolo per il documento.

2) Aggiungete un'intestazione (Inserisci > Riga di intestazione > Predefinito).

3) Portate il cursore all'interno della riga d'intestazione della pagina.

4) Scegliete Inserisci > Comando di campo > Titolo. Il titolo appare su uno sfondo grigio 
(che non verrà mostrato durante la stampa e che può essere disattivato).

5) Per modificare il titolo per tutto il documento, ritornate in File > Proprietà > Descrizione.

L'argomento dei comandi di campo viene trattato in dettaglio nel Capitolo 14 (Lavorare con i 
comandi di campo) nella Guida a Writer.

Per avere maggiori dettagli sulle intestazioni e sui piè di pagina, vedere i Capitoli 4 (Formattare le 
pagine) e 6 (Introduzione agli Stili) della Guida a Writer.

Numerazione delle pagine
Per fare in modo che le pagine vengano numerate automaticamente:

1) Inserite un'intestazione o un piè di pagina, come descritto nel paragrafo “Creazione di 
intestazioni e piè di pagina", più sopra.

2) Posizionate il cursore nell'intestazione o nel piè di pagina dove volete che appaia il numero 
di pagina e scegliete Inserisci > Comandi di campo > Numero di pagina.

Inclusione del numero totale di pagine
Per includere il numero complessivo di pagine (come in “pagina 1 di 12”):

1) Digitate la parola “pagina” e uno spazio, quindi inserite il numero di pagina seguendo le 
indicazioni riportate sopra.
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2) Premete la barra spaziatrice una volta, digitate la parola “di” e poi un altro spazio, quindi 
scegliete Inserisci > Comando di campo > Numero di pagine.

Nota

Il comando di campo Numero di pagine inserisce il numero totale di pagine nel 
documento, come mostrato nella scheda Statistiche della finestra delle Proprietà 
del documento (File > Proprietà). Se si ricomincia la numerazione pagine in 
qualsiasi punto del documento, il numero complessivo delle pagine può non 
essere quello che si desidera. Per avere maggiori informazioni vedere il Capitolo 4 
(Formattazione delle pagine) nella Guida a Writer.

Riavvio della numerazione delle pagine
Talora si può voler riavviare la numerazione delle pagine da 1, ad esempio nella pagina successiva 
a quella del titolo o del sommario. Inoltre, molti documenti hanno una parte iniziale (la prefazione, 
o l'indice) numerata con numeri romani e la parte principale numerata con numeri arabi, partendo 
da 1.

È possibile riavviare la numerazione delle pagine in due modi.

Metodo 1:

1) Posizionate il cursore nel primo paragrafo della nuova pagina.

2) Scegliete Formato > Paragrafo.

3) Sulla scheda Flusso di testo della finestra di dialogo Paragrafo, selezionate Interruzioni.

4) Selezionate Inserisci e poi Con stile di pagina e specificate lo stile di pagina da usare.

5) Specificate il numero di pagina da cui iniziare e infine fate clic su OK.

Suggerimento

Il Metodo 1 è anche utile per numerare la prima pagina di un documento con un 
numero di pagina superiore ad 1. Per esempio, si supponga di scrivere un libro, 
in cui ogni capitolo è salvato in un file a parte. Il Capitolo 1 potrebbe iniziare con 
la pagina 1, ma il Capitolo 2 potrebbe iniziare con la pagina 25 e il Capitolo 3 
con la pagina 51.

Metodo 2:

1) Inserisci > Interruzione manuale.

2) L'opzione Interruzione pagina è selezionata automaticamente, nella finestra di dialogo 
Inserisci interruzione (Figura 87).

3) Scegliete lo Stile di pagina richiesto.

4) Selezionate Cambia numero pagina.

5) Specificate il numero di pagina da cui iniziare e infine fate clic su OK.
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Figura 87: ricominciare la numerazione pagine dopo un'interruzione 
di pagina manuale

Modifica dei margini di pagina
È possibile modificare i margini di pagina in due modi:

• Usando i righelli pagina – metodo rapido e facile, ma non molto preciso

• Usando la finestra di dialogo Stile di pagina – in cui è possibile definire i margini con una 
precisione di due decimali

Nota

Se si cambiano i margini con i righelli, le nuove impostazioni modificano anche lo 
stile di pagina e compaiono nella finestra di dialogo Stile di pagina una volta che la 
riaprite.

Siccome la modifica influisce sullo stile di pagina, la modifica dei margini verrà 
applicata a tutte le pagine che utilizzano quello stile.

Per cambiare i margini usando i righelli:

1) Le parti grigie dei righelli sono i margini. Posizionate il cursore sulla linea tra l'area grigia e 
quella bianca. Il puntatore del mouse cambia forma e diventa una freccia a doppia punta.

2) Tenete premuto il pulsante sinistro del mouse e trascinate il mouse in modo da spostare il 
margine dove desiderate.

Figura 88: spostare i margini

Attenzione Le piccole frecce sul righello sono usate per definire i rientri dei paragrafi. Spesso si 
trovano nella stessa posizione dei margini di pagina. Fate quindi attenzione a 
spostare i contrassegni dei margini e non le frecce.
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Per cambiare i margini usando la finestra di dialogo Stile di pagina:

1) Fate clic destro in un punto qualsiasi nella pagina e selezionate Pagina dal menu a 
comparsa.

2) Nella scheda Pagina della finestra di dialogo, digitate le distanze desiderate nei campi dei 
Margini.

Aggiunta di commenti a un documento

Autori e revisori spesso utilizzano i commenti (precedentemente chiamati “annotazioni”) per 
scambiare idee, chiedere suggerimenti, o contrassegnare elementi che necessitano di attenzione.

Per inserire un commento nel testo, portate il cursore nella posizione a cui si riferisce il commento 
e scegliete Inserisci > Commento oppure premete Ctrl+Alt+C. Il punto di inserimento del 
commento viene collegato tramite una linea punteggiata ad uno spazio nel margine destro della 
pagina, dove è possibile digitare il testo della nota. In calce al commento vengono aggiunti 
automaticamente il nome dell'autore, oltre all'indicazione di giorno e ora dell'inserimento. La Figura
89 illustra un esempio di un testo con commenti inseriti da due diversi autori.

Figura 89: esempio di commenti

Scegliete Strumenti > Opzioni > Dati utente per configurare o modificare il nome che desiderate 
venga mostrato come autore dei commenti.

Se al documento lavora più di una persona, ad ogni autore viene associato automaticamente un 
diverso colore di sfondo per i commenti.

Il clic destro su una nota fa comparire un menu che consente di eliminare: il commento corrente, 
tutti i commenti dello stesso autore o tutti i commenti presenti nel documento. Inoltre, da questo 
menu è possibile applicare alcune formattazioni di base al testo del commento. Il tipo, la 
dimensione e l'allineamento del carattere possono essere modificati anche dal menu principale.

Per spostarvi da un commento all'altro, aprite il Navigatore (F5), espandete la sezione Commenti e 
fate clic sul testo del commento; in questo modo il cursore si sposterà sul punto di inserimento del 
commento all'interno del documento. Fate clic destro sul commento per modificarlo o eliminarlo 
velocemente.

Potete anche spostarvi tra i commenti utilizzando la tastiera. Premete Ctrl+Alt+Pag giù per passare 
al commento successivo, e Ctrl+Alt+Pag su per spostarvi a quello precedente.
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Creazione di un indice generale

Writer consente la creazione di indici generali a partire dalle intestazioni presenti nel documento, 
attraverso la funzionalità Indici. Prima di iniziare, assicuratevi di aver assegnato alle intestazioni 
degli stili appropriati. Per esempio, è possibile utilizzare lo stile Intestazione 1 per i titoli dei capitoli 
e lo stile Intestazione 2 e Intestazione 3 per i sottotitoli.

Anche se Writer consente una ampia personalizzazione degli indici, spesso sono sufficienti le 
impostazioni predefinite. È possibile creare facilmente un indice generale:

1) Nella creazione di un documento, utilizzate i seguenti stili di paragrafo per i diversi livelli di 
intestazione (come ad esempio titoli di capitoli e di sezioni): Intestazione 1, Intestazione 2, 
Intestazione 3, e così via. L'indice sarà costruito sulla base di questi.

2) Posizionate il cursore nel punto in cui volete inserire l'indice.

3) Scegliete Inserisci > Indici > Indici.

4) Nella finestra di dialogo Inserisci indice non modificate alcuna impostazione. Fate clic su 
OK.

Se successivamente viene aggiunto o eliminato del testo (facendo spostare uno o più titoli in 
pagine diverse), o vengono aggiunti, eliminati o modificati dei titoli, l'indice generale deve essere 
aggiornato.

Per eseguire questa operazione:

1) Posizionate il cursore all'interno dell'indice.

2) Fate clic destro e scegliete Aggiorna indice/tabella dal menu a comparsa.

Nota
Se non riuscite a posizionare il cursore all'interno dell'indice, scegliete Strumenti > 
Opzioni > LibreOffice Writer > Formattazione, quindi spuntate Permetti nella 
sezione Cursore in aree protette.

È possibile personalizzare un indice generale in qualsiasi momento. Fate clic destro ovunque 
all'interno dell'indice e selezionate Modifica indice/tabella dal menu a comparsa. Il Capitolo 12 
(Indici generali, indici analitici e bibliografie) della Guida a Writer descrive in dettaglio tutte le 
personalizzazioni possibili.

Creazione di indici analitici e bibliografie

Gli indici analitici e le bibliografie funzionano in maniera analoga agli indici generali. Il Capitolo 12 
(Indici generali, indici analitici e bibliografie) della Guida a Writer descrive in dettaglio la procedura 
da utilizzare.

Writer consente di creare indici alfabetici, indici per illustrazioni, tabelle, oggetti, o persino di creare 
un proprio indice personalizzato. Per esempio, potreste voler creare un indice contenente solo i 
nomi scientifici delle specie menzionate nel testo, e un indice separato che contenga solo i nomi 
comuni delle specie. Prima di creare qualsiasi tipo di indice, è necessario inserire le voci dell'indice 
all'interno del documento.

Lavorare con oggetti grafici

In Writer ci sono tre tipologie principali di oggetti grafici:

• File immagine, che includono foto, disegni, immagini scansionate, etc.
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• Diagrammi creati con gli strumenti di disegno di LibreOffice

• Grafici creati utilizzando l'apposito componente Chart di LibreOffice.

Vedere il Capitolo 11 (Immagini, Galleria e Fontwork) in questa guida e il Capitolo 8 (Lavorare con 
oggetti grafici) nella Guida a Writer.

Stampa

Vedere il Capitolo 10 (Stampa, esportazione e invio di e-mail) in questa guida e il Capitolo 5 
(Stampa, esportazione, fax e invio di e-mail) nella Guida a Writer per dettagli sull'anteprima delle 
pagine prima della stampa, sulla selezione delle opzioni di stampa, stampa in bianco e nero su 
stampante a colori, stampa di depliant, e altre funzionalità di stampa.

Uso della stampa in serie

Writer fornisce funzionalità molto utili per creare e stampare:

• Copie multiple di un documento da spedire ad un elenco di destinatari

• Etichette contenenti indirizzi

• Buste

Tutte queste funzionalità utilizzano una sorgente dati registrata (un foglio elettronico o un database 
contenenti nomi, indirizzi ed altre informazioni). Il Capitolo 11 (Uso della stampa in serie) della 
Guida a Writer descrive il processo nel dettaglio.

Memorizzare le modifiche in un documento

Esistono diversi modi per rilevare le modifiche apportate a un documento.

1) Apportate le modifiche a una copia del documento (memorizzato in una cartella differente, 
o con un differente nome, o ambedue), poi usate Writer per combinare i due file e mostrare 
le differenze. Scegliete Modifica > Confronta documento. Questo metodo è 
particolarmente utile se siete gli unici a lavorare sul documento, in quanto si evitano 
l'aumento delle dimensioni del file e l'utilizzo di metodi più complessi.

2) Salvate le versioni che sono memorizzate come parti del file originale. Tuttavia, questo 
metodo può causare dei problemi con documenti di dimensioni e complessità rilevanti, 
specialmente se si salvano diverse versioni. Dunque, potendo scegliere, evitate questa 
alternativa.

3) Usare gli indicatori di modifica di Writer (spesso denominati “linee rosse” o “marcatura di 
revisione”) per mostrare dove è stato aggiunto o cancellato materiale, o modificata la 
formattazione. Scegliete Modifica > Modifiche > Registra. In seguito, chiunque può 
revisionare il documento e accettare o rifiutare qualsiasi modifica. Fate clic con il pulsante 
destro su una singola modifica e scegliete Accetta modifica o Rifiuta modifica dal menu 
a comparsa, oppure scegliete Modifica > Modifiche > Accetta o Rifiuta per visualizzare 
l'elenco dei cambiamenti e accettarli o rifiutarli. Queste funzioni sono illustrate in dettaglio 
nella Guida a Writer.

Suggerimento
Non tutte le modifiche vengono memorizzate. Per esempio, il cambiamento di 
una tabulazione da allineamento sinistro ad allineamento destro e le modifiche 
nelle formule (equazioni) o in immagini collegate non vengono memorizzate.
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Uso dei campi

I campi costituiscono una funzionalità molto utile di Writer. Vengono utilizzati per inserire 
informazioni variabili (come ad esempio la data attuale o il numero di pagine) all'interno di un 
documento, o proprietà come il nome del file, l'autore o la data dell'ultimo aggiornamento. I campi 
sono la base dei riferimenti incrociati (vedi sotto); numerazione automatica di figure, tabelle, titoli e 
altri elementi, e un gran numero di altre funzioni impossibili da elencare qui. Vedere il Capitolo 14 
(Lavorare con i comandi di campo) nella Guida a Writer per ulteriori informazioni.

Collegamento a un'altra parte di un documento

Può risultare difficile mantenere aggiornati dei riferimenti incrociati ad altre parti del documento, se 
riorganizzate l'ordine degli argomenti, aggiungete o eliminate del materiale, o riformulate 
un'intestazione. Writer offre due modi per assicurare che i riferimenti siano aggiornati, inserendo 
collegamenti ad altre parti dello stesso documento o a un altro documento:

• Collegamenti ipertestuali (Hyperlinks)

• Riferimenti incrociati

I due metodi hanno lo stesso risultato se fate Ctrl+clic sul collegamento quando il documento è 
aperto in Writer: venite direttamente portati all'elemento relativo al riferimento incrociato. Vi sono, 
comunque, anche alcune differenze:

• Il testo in un collegamento ipertestuale non si aggiorna automaticamente se modificate il 
testo dell'elemento collegato (sebbene sia possibile modificarlo manualmente), mentre in 
un riferimento incrociato il testo modificato si aggiorna automaticamente.

• Usando un collegamento ipertestuale, non avete possibilità di scelta riguardo al contenuto 
del collegamento (ad esempio testo o numero di pagina), mentre usando un riferimento 
incrociato, avete diverse possibilità di scelta, inclusi i segnalibri.

• Per collegare un oggetto, ad esempio un'immagine, e fare in modo che il collegamento 
mostri un testo significativo, come Figura 6, dovrete dare a tale oggetto un nome 
significativo (invece di un nome standard come Immagine6), o usare la finestra di dialogo 
Collegamento ipertestuale per modificare il testo visibile. Di contro, i riferimenti incrociati 
alle immagini con didascalie mostrano automaticamente un testo significativo, e avete 
diverse opzioni di scelta per il nome.

• Se salvate un documento di Writer in HTML, i collegamenti ipertestuali, a differenza dei 
riferimenti incrociati, rimangono attivi. (Entrambi rimangono attivi se il documento viene 
esportato in PDF.)

Utilizzo dei collegamenti ipertestuali
Il metodo più facile per inserire un collegamento ipertestuale a un'altra parte dello stesso 
documento è quello di utilizzare il Navigatore:

1) Aprite il documento contenente gli elementi per i quali desiderate creare un riferimento 
incrociato.

2) Aprite il Navigatore facendo clic sulla sua icona, scegliendo Visualizza > Navigatore, o 
premendo F5.

3) Fate clic sulla freccia vicino all'icona Modo trascinamento, e scegliete Inserisci come 
collegamento ipertestuale.

4) Nell'elenco nella parte bassa del Navigatore, selezionate il documento contenente 
l'elemento per il quale desiderate creare un riferimento incrociato.
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5) Nell'elenco del Navigatore, selezionate l'elemento che volete inserire come collegamento 
ipertestuale.

6) Trascinate l'elemento nel punto in cui desiderate inserire il collegamento ipertestuale nel 
documento. Il nome dell'elemento viene inserito nel documento come un collegamento 
ipertestuale attivo.

Figura 90: inserimento di un collegamento ipertestuale 
usando il Navigatore

Potete anche utilizzare la finestra di dialogo Collegamento ipertestuale per inserire e modificare 
collegamenti all'interno e tra documenti. Vedere il Capitolo 12 (Creare pagine web).

Uso dei riferimenti incrociati
Può risultare difficile mantenere aggiornati dei riferimenti ad altre parti del documento, poiché può 
capitare di riformulare una intestazione, di aggiungere o eliminare una figura, riorganizzare 
argomenti, etc. Se si sostituisce ogni riferimento incrociato inserito nel documento con un 
riferimento automatico, quando i campi vengono aggiornati tutti i riferimenti verranno modificati di 
conseguenza. La scheda Riferimenti incrociati nella finestra di dialogo Comandi di campo elenca 
alcuni elementi, come ad esempio intestazioni, segnalibri, figure, tabelle, ed altri elementi numerati 
come i passi di una procedura. Potete anche creare dei riferimenti personalizzati; vedere 
“Impostare riferimenti” nel Capitolo 14 (Lavorare con i comandi di campo) nella Guida a Writer per 
istruzioni.

Per inserire un riferimento incrociato ad una intestazione, figura, segnalibro, o altro elemento:

1) Posizionate il cursore nel punto in cui volete inserire il riferimento incrociato.

2) Se la finestra di dialogo Comandi di campo non è aperta, fate clic su Inserisci > 
Riferimento incrociato. Nella scheda Riferimenti incrociati (Figura 91), all'interno 
dell'elenco Tipo di campo, selezionate il tipo di elemento a cui collegare il riferimento (ad 
esempio, Intestazioni o Figura). È possibile mantenere aperta questa scheda e inserire 
diversi riferimenti incrociati.

3) Fate clic sull'elemento desiderato nell'elenco Selezione, che mostra tutti gli elementi del 
tipo selezionato. Nell'elenco Inserisci riferimento a, selezionate il riferimento desiderato. 
L'elenco varia a seconda del Tipo di campo. Le opzioni più utilizzate sono Riferimento (per 
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inserire tutto il testo di un'intestazione o di una didascalia), Numero e categoria (per 
inserire un numero di figura preceduto dalla parola Figura o Tabella, ma senza il testo della 
didascalia), Numero (per inserire solo il numero della figura o tabella, senza le parole 
“Figura” o “Tabella”), oppure Pagina (per inserire il numero della pagina in cui si trova il 
testo a cui si fa riferimento). Fate clic su Inserisci.

Figura 91: la scheda Riferimenti incrociati della finestra di dialogo Comandi di 
campo

Uso dei segnalibri
La finestra Navigatore elenca i segnalibri, consentendo di accedervi con un semplice clic del 
mouse. È possibile inserire sia riferimenti incrociati che collegamenti ipertestuali ai segnalibri, 
come descritto sopra.

1) Selezionate il testo a cui volete collegare un segnalibro. Fate clic su Inserisci > 
Segnalibro.

2) Nella finestra di dialogo Inserisci segnalibro, l'area più grande mostra tutti i segnalibri 
inseriti in precedenza. Nell'area superiore, digitate un nome per il segnalibro e fate clic su 
OK.

Capitolo 4  Guida introduttiva a Writer 121



Figura 92: inserimento di un segnalibro

Uso di documenti master

I documenti master sono generalmente utilizzati per produrre documenti corposi come un libro, 
una tesi o una lunga relazione; oppure si possono utilizzare se persone diverse lavorano 
contemporaneamente su capitoli o parti diverse di un documento, per evitare che tutti debbano 
condividere lo stesso file. Un documento master unisce documenti di testo diversi in un unico 
documento più grande, uniformando la formattazione, l'indice generale, la bibliografia, l'indice 
analitico, e altre tabelle o elenchi.

Naturalmente Writer consente di lavorare con i documenti master. Questi possono comunque 
sembrare ostici finché non si familiarizza con il loro utilizzo. Vedere il Capitolo 13 (Lavorare con i 
documenti master) della Guida a Writer.

Creazione di formulari

Un normale documento di testo mostra informazioni come una lettera, un rapporto, o un depliant 
ad esempio. Tipicamente, la modifica è concessa per tutto il documento o non è concessa affatto. 
Un formulario contiene alcune sezioni che non possono essere modificate, e altre create 
appositamente per una modifica da parte del lettore. Un questionario, ad esempio, contiene 
un'introduzione e delle domande (che non cambiano), e degli spazi nei quali il lettore può inserire 
le sue risposte.

Ci sono diversi possibili utilizzi per un formulario:

• Creare un semplice documento che deve essere completato dal destinatario, come ad 
esempio un questionario da spedire ad un gruppo di persone che poi lo restituiranno 
compilato.

• Collegare il formulario ad un database o ad una sorgente dati in modo da consentire ad un 
utente di inserirvi le informazioni. Ad esempio, un addetto alla ricezione di ordini potrebbe 
utilizzare un formulario per inserire in un database le informazioni relative agli ordini.

• Visualizzare le informazioni contenute in un database o in una sorgente dati. Ad esempio, 
un bibliotecario potrebbe utilizzare un formulario per recuperare le informazioni sui libri.

Writer consente di inserire informazioni in un formulario in diversi modi, quali ad esempio caselle di 
controllo, pulsanti di scelta, campi di testo e caselle combinate. Vedere il Capitolo 15 (Uso dei 
formulari in Writer) della Guida a Writer per maggiori dettagli.
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Introduzione a Calc

Calc è il componente per fogli elettronici di LibreOffice. Potete inserire dei dati (normalmente 
numerici) in un foglio elettronico e poi manipolarli per ottenere determinati risultati.

Altrimenti, potete inserire i dati e usare Calc nella modalità "What if..." (Cosa succede se...), 
cambiando alcuni dati e osservando i risultati senza dover riscrivere l'intero foglio elettronico.

Altre funzionalità fornite da Calc includono:

• Funzioni, che possono essere utilizzate per creare formule per eseguire calcoli complessi 
sui dati

• Funzioni di database, per disporre, salvare, e filtrare i dati

• Grafici dinamici; un ampio insieme di grafici 2D e 3D

• Macro, per la registrazione ed esecuzione di compiti ripetitivi

• Possibilità di aprire, modificare, e salvare fogli elettronici di Microsoft Excel

• Importazione ed esportazione di fogli elettronici in formati multipli, inclusi HTML, CSV, PDF, 
e PostScript

Nota

Se volete utilizzare le macro scritte in Microsoft Excel usando il codice VBA per le 
macro in LibreOffice, dovrete prima modificare il codice nell'editor IDE Basic di 
LibreOffice. Vedere il Capitolo 13 (Primi passi con le macro) in questa guida e il 
Capitolo 12 nella Guida a Calc.

Fogli elettronici, fogli e celle

Calc lavora con documenti chiamati fogli elettronici. I fogli elettronici consistono di un certo numero 
di singoli fogli, ognuno contenente delle celle disposte in righe e colonne. Una particolare cella è 
identificata dal suo numero di riga e lettera di colonna.

Le celle contengono i singoli elementi - testo, numeri, formule, ecc. - che costituiscono i dati da 
visualizzare e manipolare.

Ciascun foglio elettronico può avere molti fogli, e ciascun foglio molte singole celle. In Calc 3.3, 
ogni foglio può avere un massimo di 1,048,576 righe e 1024 colonne.

Componenti della finestra principale di Calc

Quando Calc viene avviato, la finestra principale appare come in Figura 93.

Barra del titolo
La barra del titolo, nella parte superiore della finestra, mostra il nome del foglio elettronico 
attualmente in uso. Se il foglio elettronico è appena stato creato, il suo nome sarà Senza nome X, 
dove X è un numero. Quando salvate un foglio elettronico per la prima volta, vi sarà richiesto di 
inserire un nome di vostra scelta.
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Barra dei menu
Sotto la barra del Titolo c'è la barra dei menu. Facendo clic su una delle voci, viene visualizzato un 
sottomenu con ulteriori opzioni. La barra dei Menu può essere modificata, come spiegato nel 
Capitolo 14 (Personalizzare LibreOffice).

Figura 93: componenti della finestra di Calc

Barre degli strumenti
Sotto la barra del Menu vi sono tre barre predefinite: la barra degli strumenti Standard, quella di 
Formattazione, e quella di calcolo.

Le icone (pulsanti) in queste barre forniscono una vasta gamma di funzioni e comandi comuni. 
Potete anche modificare queste barre, come spiegato nel Capitolo 14 (Personalizzare LibreOffice).

Nella barra degli strumenti di formattazione, i tre riquadri sulla sinistra sono i menu a discesa 
Applica Stile, Nome del carattere, e Dimensione del carattere. Essi mostrano l'impostazione 
corrente per la cella o area selezionata. (L'elenco Applica Stile potrebbe non essere visibile per 
impostazione predefinita.) Fate clic sulla freccia verso il basso a destra di ogni riquadro per aprire 
l'elenco.
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Figura 94: gli elenchi Applica Stile, Nome del carattere e Dimensione del carattere

barra di calcolo
Alla sinistra della Barra di calcolo vi è un piccolo riquadro di testo, chiamato Casella del nome, 
contenente una combinazione di una lettera e un numero, ad esempio D7. Questa combinazione, 
detta riferimento della cella, è relativa alla lettera della colonna e al numero della riga della cella 
selezionata.

Alla destra della casella del nome si trovano i pulsanti Creazione guidata funzione, Somma, e 
Funzione.

Facendo clic sul pulsante Creazione guidata funzione si apre una finestra di dialogo in cui è 
possibile cercare tra le funzioni disponibili elencate. Ciò può tornare molto utile, in quanto essa 
mostra anche come sono formattate le funzioni.

Figura 95: barra di calcolo

In un foglio elettronico il termine funzione non si riferisce solo a funzioni matematiche, ma include 
anche altri tipi di funzione. Vedere il Capitolo 7 della Guida a Calc per maggiori dettagli.

Facendo clic sul pulsante Somma viene inserita una formula nella cella corrente, che somma i 
numeri nelle celle al di sopra della cella corrente. Se non vi sono numeri al di sopra della cella 
corrente, nella formula della Somma verranno inserite le celle alla sua sinistra.

Facendo clic sul pulsante Funzione viene inserito un segno di uguale (=) nella cella selezionata e 
nella Riga di digitazione, abilitando la cella per l'inserimento di una formula.

Introducendo nuovi dati in una cella, i pulsanti Somma e Funzione vengono sostituiti dai pulsanti 

Annulla e Accetta .
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I contenuti della cella corrente (dati, formule, o funzioni) vengono mostrati nella Riga di 
digitazione, che costituisce la parte restante della Barra di calcolo. Potete modificare i contenuti 
della cella corrente nella Riga di digitazione o nella cella stessa. Per attuare le modifiche nella Riga 
di digitazione, fate clic nella Riga, ed effettuate le modifiche. Per attuare le modifiche direttamente 
nella cella, fateci clic sopra due volte.

Singole celle
La sezione principale dello schermo mostra le celle disposte a griglia, con ciascuna cella 
posizionata all'intersezione di una colonna e di una riga.

Sopra le colonne e alla sinistra delle righe vi sono una serie di caselle grigie contenenti lettere e 
numeri. Si tratta delle intestazioni delle colonne e delle righe. Le colonne cominciano con la lettera 
A e proseguono verso destra, mentre le righe cominciano con il numero 1 e proseguono verso il 
basso.

Le intestazioni di colonna e riga formano i riferimenti di cella che appaiono nel riquadro Casella del 
nome, nella Barra di calcolo (Figura 95). Queste intestazioni possono essere disattivate 
selezionando Visualizza > Intestazioni riga/colonna.

Schede dei fogli
Alla base della griglia delle celle potete vedere le schede dei fogli. Queste schede permettono 
l'accesso a ciascun singolo foglio; la scheda del foglio visibile (attivo) è di colore bianco. Potete 
scegliere i colori per le varie schede dei fogli facendo clic con il tasto destro sullo spazio, 
selezionando Colore scheda, e scegliendo poi un colore dalla tavolozza.

Facendo clic su un'altra scheda si visualizza il foglio relativo, e la sua scheda diventa di colore 
bianco. Potete selezionare più schede contemporaneamente tenendo premuto Ctrl mentre fate clic 
sui nomi.

Figura 96: scelta del colore di una scheda
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Barra di stato
Nella parte più bassa della finestra di Calc è presente la barra di stato, che fornisce informazioni 
sul foglio elettronico e comodi strumenti per cambiarne alcune caratteristiche. La maggior parte dei 
campi sono simili a quelli di altri componenti di LibreOffice; vedere il Capitolo 1 (Introduzione a 
LibreOffice) in questa guida e il Capitolo 1 (Introduzione a Calc) nella Guida a Calc.

Figura 97: parte sinistra della barra di stato di Calc

Figura 98: parte destra della barra di stato di Calc

Aprire e salvare file CSV

Il Capitolo 1 (Introduzione a LibreOffice) contiene istruzioni su come creare nuovi documenti di 
Calc, aprire documenti esistenti e salvare documenti.

Per quanto riguarda Calc, un caso a parte è quello relativo all'apertura e al salvataggio di file con 
valori separati da virgola (comma separated values - CSV), che sono file di testo che contengono 
le celle facenti parte di un singolo foglio. Ogni linea in un file CSV rappresenta una riga in un foglio 
elettronico. Virgola, punto e virgola, o altri caratteri vengono utilizzati per separare le celle. Il testo 
viene inserito tra virgolette, i numeri invece senza le virgolette.

Apertura di un file CSV
Per aprire un file CSV in Calc:

1) Scegliete File > Apri.

2) Localizzate il file CSV che desiderate aprire.

3) Se il file ha estensione *.csv, selezionate il file e fate clic su Apri.

4) Se il file ha un'altra estensione (ad esempio *.txt), selezionate il file, selezionate Testo CSV 
(*csv;*txt;*xls) nel riquadro Tipo di file (dovrete scorrere il menu per trovare la voce 
corretta) e poi fate clic su Apri.

5) Nella finestra di dialogo Importazione testo (Figura 99), selezionate le Opzioni di 
separazione per dividere il testo nel file in colonne.

Potete vedere l'anteprima dell'impaginazione dei dati importati nella parte bassa della 
finestra di dialogo. Fate clic destro su una colonna nell'anteprima per impostare il formato o 
per nascondere la colonna.
Se il file CSV usa un carattere separatore di testo non incluso nell'elenco dei Separatori di 
testo, fate clic nel riquadro Separatore di testo, e digitate il carattere.

6) Fate clic su OK per aprire il file.
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Figura 99: finestra di dialogo Importazione testo, con la virgola (,) selezionata come separatore e 
virgolette (“) come separatore di testo

Salvataggio come file CSV
Per salvare un foglio elettronico come file CSV:

1) Scegliete File > Salva con nome.

2) Nel riquadro Nome file digitate un nome per il file.

3) Nell'elenco Tipo di file, selezionate Testo CSV (.csv) e fate clic su Salva.

Potreste vedere una finestra con la notifica mostrata sotto. Fate clic su Mantieni il formato 
corrente.
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4) Nella finestra di dialogo Esportazione file di testo, selezionate le opzioni che desiderate e 
poi fate clic su OK.

Figura 100: scelta delle opzioni nell'esportazione a Testo CSV

Navigare nei fogli elettronici

Calc offre diversi modi per navigare in un foglio elettronico da cella a cella e da foglio a foglio. In 
generale potete fare uso del metodo che preferite.

Andare in una cella specifica

Usare il mouse
Posizionate il puntatore del mouse sopra la cella e fate clic.

Usare un riferimento cella
Fate clic sul piccolo pulsante con un triangolo rovesciato posto sulla destra della Casella del 
nome (Figura 95). Si evidenzierà il riferimento alla cella attuale. Digitate il riferimento della cella 
in cui volete andare e premete Invio. Oppure fate clic direttamente nella Casella del nome, 
cancellate il riferimento presente e digitate quello desiderato, premete poi Invio.
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Usare il Navigatore

Per aprire il Navigatore, fate clic sulla sua icona  sulla barra degli strumenti Standard, o 
premete F5, oppure scegliete Visualizza > Navigatore sulla barra dei Menu, oppure ancora 
fate doppio-clic sul numero sequenziale di foglio  sulla barra di Stato. Digitate il 
riferimento di cella nei due campi in alto, Colonna e Riga, e premete Invio. Nella Figura 101 il 
Navigatore seleziona la cella A7.

È possibile ancorare il Navigatore su entrambi i lati della finestra principale di Calc o lasciarlo 
mobile. (Per ancorare o rendere mobile il Navigatore, tenete premuto il tasto Ctrl e fate doppio 
clic in un'area vuota vicino alle icone nella finestra di dialogo del Navigatore.)

Figura 101: il Navigatore in Calc

Il Navigatore mostra un elenco di tutti gli oggetti contenuti in un documento, raggruppati per 
categoria. Se di fianco ad una categoria è presente un indicatore (segno più o freccia), esiste 
almeno un oggetto di quel tipo. Per aprire una categoria e vedere l'elenco delle voci presenti, 
fate clic sull'indicatore.

Per nascondere l'elenco delle categorie e mostrare solamente le icone in alto, fate clic 

sull'icona Contenuti . Fate clic sulla medesima icona per mostrare nuovamente l'elenco.

Spostarsi da una cella all'altra
Nel foglio elettronico una cella normalmente ha un bordo nero. Questo bordo indica la selezione (si 
veda la Figura 102). Se è selezionato un gruppo di celle, queste sono evidenziate in blu chiaro, e 
la cella selezionata ha un bordo nero.

Usare il mouse
Per spostare la selezione utilizzando il mouse, è sufficiente spostare il puntatore del mouse 
sulla cella da selezionare e fare clic. Questo sposta la selezione sulla nuova cella. Questo 
metodo è utile soprattutto quando le due celle sono molto distanti tra loro.
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Figura 102: selezione di una cella (a sinistra) e di un gruppo di celle (a destra)

Usare i tasti Tab e Invio
• Per impostazione predefinita, premendo Invio o Maiusc+Invio la selezione si sposta, 

rispettivamente, in basso o in alto.

• Premendo Tab o Maiusc+Tab la selezione si sposta, rispettivamente, a destra o a sinistra.

Usare le frecce
Premendo le frecce sulla tastiera, la selezione si sposta nella direzione indicata.

Usare i tasti Inizio, Fine, Pag su e Pag giù
• Il tasto Inizio sposta la selezione all'inizio della riga.

• Il tasto Fine sposta la selezione alla colonna contenente dati più a destra.

• Il tasto Pag giù sposta la visualizzazione più in basso di una videata e il tasto Pag su la 
sposta di una videata in alto.

• La combinazione di Ctrl e Alt con Inizio, Fine, Pag giù, Pag su o le frecce sposta la 
selezione in altri modi. Vedere la Guida in linea o l'Appendice A, tasti di scelta rapida, nella 
Guida a Calc per maggiori dettagli.

Suggerimento
Utilizzate una delle quattro combinazioni Alt+freccia per ridimensionare una 
cella.

Personalizzare il tasto Invio
È possibile impostare la direzione nella quale viene spostata la selezione premendo il tasto Invio, 
selezionando Strumenti > Opzioni > LibreOffice Calc > Generale.

Le quattro possibili direzioni in cui si muove il tasto Invio sono mostrate nella parte destra della 
Figura 103. La selezione può essere spostata in basso, a destra, in alto, o a sinistra. In base al file 
usato o al tipo di dati che vengono immessi, può tornare utile impostare una direzione differente.

Il tasto Invio può anche essere usato per entrare ed uscire dal modo modifica. Utilizzate le prime 
due opzioni sotto la voce Impostazioni di immissione in Figura 103 per modificare le impostazioni 
del tasto Invio.
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Figura 103: personalizzare l'effetto del tasto Invio

Spostarsi da un foglio all'altro
Ciascun singolo foglio di un foglio elettronico è indipendente dagli altri, anche se può essere 
collegato con riferimenti ad un altro. Potete navigare tra i diversi fogli di un foglio elettronico in tre 
modi.

Usare il Navigatore
Quando il Navigatore è aperto (Figura 101), facendo doppio-clic su uno qualsiasi dei fogli 
elencati si seleziona il foglio stesso.

Usare la tastiera
Premendo Ctrl+Pag Giù ci si sposta a destra di un foglio e premendo Ctrl+Pag Su di un foglio a 
sinistra.

Usare il mouse
Facendo clic su una delle schede dei fogli alla base del foglio elettronico, si seleziona il relativo 
foglio.

Se avete numerosi fogli, alcune delle schede dei fogli potrebbero essere nascoste dietro la 
barra di scorrimento orizzontale alla base dello schermo. In questo caso, potete usare i quattro 
pulsanti a sinistra delle schede dei fogli per poterli vedere. La Figura 104 mostra come fare.

Figura 104: frecce delle schede dei fogli

Notate che nella figura i fogli non sono numerati in ordine. La numerazione dei fogli è arbitraria; 
potete denominare i fogli a vostro piacimento.

Nota
Le frecce delle schede dei fogli, visibili in Figura 104, compaiono solo se ci sono 
delle schede nascoste dalla barra di scorrimento orizzontale. Altrimenti esse 
appaiono grigie come in Figura 93.
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Selezionare elementi in un singolo foglio o in un intero foglio 
elettronico

Selezionare celle
Le celle possono essere selezionate in diverse combinazioni e quantità.

Singola cella
Fate clic nella cella. Il risultato sarà simile a quello mostrato nella parte sinistra della Figura 102. 
Potete verificare la selezione guardando la Casella del nome.

Intervallo di celle contigue
Potete selezionare un intervallo di celle usando la tastiera o il mouse.

Per selezionare un intervallo di celle trascinando il mouse:

1) Fate clic in una cella.

2) Tenete premuto il pulsante sinistro del mouse.

3) Muovete il mouse.

4) Dopo aver evidenziato il blocco di celle desiderato, rilasciate il pulsante sinistro del mouse.

Per selezionare un intervallo di celle senza trascinare il mouse:

1) Fate clic nella cella che si troverà ad uno degli angoli dell'intervallo di celle.

2) Portate il mouse all'angolo opposto dell'intervallo desiderato.

3) Tenendo premuto il tasto Maiusc fate clic.

Per selezionare un intervallo di celle senza usare il mouse:

1) Selezionate la cella che si troverà ad uno degli angoli dell'intervallo di celle.

2) Tenendo premuto il tasto Maiusc, usate le frecce per selezionare il resto dell'intervallo.

Tutti questi metodi daranno un risultato simile a quanto si vede nel lato destro dellaFigura 102.

Suggerimento

Potete selezionare un intervallo di celle anche usando direttamente la Casella 
del nome. Fateci clic come descritto in "Usare un riferimento cella” a pagina 
130. Per selezionare un intervallo di celle, inserite il riferimento della cella 
superiore sinistra, seguito dai due punti (:) e dal riferimento della cella inferiore 
destra. Ad esempio, per selezionare l'intervallo da A3 a C6, si deve digitare 
A3:C6.

Intervallo di celle non contigue

1) Selezionate la cella o l'intervallo di celle usando uno dei metodi precedenti.

2) Portate il puntatore del mouse all'inizio dell'intervallo successivo o sulla cella successiva.

3) Tenete premuto il tasto Ctrl e fate clic, oppure fate clic e trascinate per selezionare un 
intervallo.

4) Ripetete l'operazione se necessario.
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Selezionare colonne e righe
Potete selezionare rapidamente intere colonne e righe in LibreOffice.

Singola colonna o riga
Per selezionare una singola colonna, fate clic sulla lettera identificativa della colonna (si veda la 
Figura 93).

Per selezionare una singola riga, fate clic sul numero identificativo della riga.

Colonne o righe multiple
Per selezionare più colonne o righe contigue:

1) Fate clic sulla prima colonna o riga del gruppo.

2) Tenete premuto il tasto Maiusc.

3) Fate clic sull'ultima colonna o riga del gruppo.

Per selezionare più colonne o righe non contigue:

1) Fate clic sulla prima colonna o riga del gruppo.

2) Tenete premuto il tasto Ctrl.

3) Fate clic su tutte le successive colonne o righe tenendo premuto il tasto Ctrl.

Intero foglio
Per selezionare l'intero foglio, fate clic sul piccolo rettangolo posto tra l'intestazione della colonna A 
e l'intestazione della riga 1.

Figura 105: il riquadro Seleziona tutto

Potete selezionare l'intero foglio anche premendo Ctrl+A.

Selezionare fogli
Potete selezionare uno o più fogli. A volte può essere utile selezionare più fogli se si vogliono 
apportare modifiche a tutti i fogli selezionati contemporaneamente.

Foglio singolo
Fate clic sulla scheda del foglio che desiderate selezionare. La scheda del foglio attivo diventa 
bianca.

Fogli multipli contigui
Per selezionare fogli multipli contigui:

1) Fate clic sulla scheda del primo foglio.

2) Spostate il puntatore del mouse sopra la scheda dell'ultimo foglio.

3) Tenete premuto il tasto Maiusc e fate clic sulla scheda del foglio.
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Tutte le schede comprese tra questi due fogli diventeranno bianche. Ogni azione compiuta d'ora in 
poi avrà effetto su tutti i fogli evidenziati.

Fogli multipli non contigui
Per selezionare fogli multipli non contigui:

1) Fate clic sulla scheda del primo foglio.

2) Spostate il puntatore del mouse sopra la scheda del secondo foglio.

3) Tenete premuto il tasto Ctrl e fate clic sulla scheda del foglio.

4) Ripetete l'operazione se necessario.

Le schede selezionate diventeranno bianche. Ogni azione compiuta d'ora in poi avrà effetto su tutti 
i fogli evidenziati.

Tutti i fogli
Fate clic con il pulsante destro su una qualsiasi delle schede dei fogli e scegliete Seleziona tutti i 
fogli dal menu a comparsa.

Lavorare con colonne e righe

Inserire colonne e righe
Potete inserire colonne e righe singolarmente o in gruppi.

Nota

Quando inserite una nuova colonna, questa è inserita a sinistra della colonna 
evidenziata. Quando inserite una nuova riga, questa è inserita al di sopra della 
riga evidenziata.

Le celle nelle nuove colonne o righe sono formattate come le corrispondenti celle 
nella colonna o riga prima (o alla sinistra) della quale viene inserita la nuova 
colonna o riga.

Singola colonna o riga
Usare il menu Inserisci:

1) Selezionate la cella, colonna o riga dove volete venga inserita la nuova colonna o riga.

2) Scegliete Inserisci > Colonne o Inserisci > Righe.

Usare il mouse:

1) Selezionate la cella, colonna o riga dove volete venga inserita la nuova colonna o riga.

2) Fate clic sull'intestazione della colonna o riga con il pulsante destro.

3) Scegliete Inserisci Righe o Inserisci Colonne.

Colonne o righe multiple
Potete inserire più colonne o righe contemporaneamente anziché inserirne una alla volta.

1) Evidenziate le colonne o righe necessarie facendo clic sulla prima e trascinando fino a 
ottenerne il numero richiesto.

2) Procedete come per inserire una singola colonna o riga. Il numero specificato di 
righe/colonne verrà inserito al di sopra o alla sinistra della prima che avete selezionato.
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Eliminare colonne e righe
Potete eliminare colonne e righe singolarmente o in gruppi.

Singola colonna o riga
Potete eliminare una singola colonna o riga solo usando il mouse:

1) Selezionate la colonna o riga da eliminare.

2) Fate clic sull'intestazione della colonna o riga con il pulsante destro.

3) Selezionate Elimina colonne o Elimina righe dal menu a comparsa.

Colonne o righe multiple
Potete eliminare più colonne o righe contemporaneamente anziché eliminarne una alla volta.

1) Evidenziate le colonne o righe necessarie facendo clic sulla prima e trascinando fino a 
ottenerne il numero richiesto.

2) Procedete come per eliminare una singola colonna o riga.

Lavorare con i fogli

Come per tutti gli elementi di Calc, i fogli possono essere inseriti, copiati, spostati, cancellati e 
rinominati.

Inserire nuovi fogli
Ci sono diversi modi per inserire un nuovo foglio. Il metodo più veloce è quello di fare clic sul 

pulsante Aggiungi foglio  alla destra delle schede dei fogli. Se non vedete questo pulsante, 
trascinate la barra di separazione di fianco alle schede verso destra, per fare spazio e rendere il 
pulsante visibile. Questo pulsante inserisce un nuovo foglio in quel punto, senza aprire la finestra 
di dialogo Inserisci foglio.

Utilizzate uno degli altri metodi per inserire più di un foglio, per rinominare il foglio, o per inserire il 
foglio in qualche altro punto nella sequenza. Il primo passo per questi metodi è la selezione del 
foglio che sarà affiancato dal nuovo foglio. Poi potete ricorrere a ognuna delle seguenti opzioni.

• Scegliete Inserisci > Foglio dalla barra dei menu.

• Fate clic sulla scheda di un foglio con il pulsante destro e scegliete Inserisci foglio.

• Fate clic in un punto vuoto in fondo alla linea delle schede dei fogli.

Figura 106: creare un nuovo foglio
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Tutti questi metodi fanno aprire la finestra di dialogo Inserisci foglio (Figura 107). Qui potete 
decidere se inserire il nuovo foglio prima o dopo quello selezionato e quanti fogli inserire. Se volete 
inserire un solo foglio, è possibile dare ad esso un nome.

Figura 107: la finestra di dialogo Inserisci foglio

Spostare e copiare fogli
Potete spostare o copiare fogli all'interno del medesimo foglio elettronico sia usando il mouse 
(trascinare e rilasciare - drag and drop) sia tramite una finestra di dialogo. Il drag and drop non 
funziona se desiderate spostare o copiare un foglio su un diverso foglio elettronico; per questo 
dovrete invece fare uso della finestra di dialogo.

Usare il mouse
Per spostare un foglio in una posizione differente, all'interno dello stesso foglio elettronico, fate clic 
sulla scheda del foglio e trascinatela a sinistra o destra. Due piccoli triangoli indicano dove verrà 
rilasciato il foglio (vedere Figura 108). Il puntatore del mouse (non mostrato nell'illustrazione) 
potrebbe cambiare per includere un indicatore; il simbolo dell'indicatore varia a seconda del 
sistema operativo.

Figura 108: trascinare un foglio per 
effettuarne lo spostamento
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Per copiare un foglio, all'interno dello stesso foglio elettronico, tenete premuto il tasto Ctrl (tasto 
Opzione su Mac) mentre fate clic sulla scheda del foglio e la trascinate. Il puntatore del mouse 
potrebbe cambiare per includere un segno più o un altro indicatore; il simbolo varia a seconda del 
sistema operativo.

Usare una finestra di dialogo
La finestra di dialogo Sposta/Copia offre la possibilità di specificare esattamente, durante lo 
spostamento o la copia, la posizione in cui desiderate inserire il foglio (nello stesso o in un altro 
documento) e il nuovo nome del foglio.

Nota
Quando spostate o copiate dei fogli tra differenti fogli elettronici, assicuratevi che 
entrambi i documenti siano aperti.

Seguite questi passaggi:

1) Nel documento corrente, fate clic con il pulsante destro sulla scheda del foglio che 
desiderate spostare o copiare.

2) Selezionate Sposta/Copia Foglio dal menu contestuale.

3) Nella finestra di dialogo Sposta/copia foglio (Figura 109):

• Selezionate l'azione: Sposta o Copia.

• In documento: selezionate il documento in cui volete posizionare il foglio. Per 
impostazione predefinita, il campo mostrerà il documento corrente. Se avete un altro 
foglio elettronico aperto, il suo nome apparirà nel menu a tendina, insieme a -nuovo 
documento-.

• Prima del foglio: selezionate la posizione all'interno del documento di destinazione.

• Nuovo nome: potete rinominare il foglio che state spostando o assegnare un nome 
differente al foglio copiato. Se non digitate un nome per un foglio copiato, Calc ne 
creerà automaticamente uno.

4) Una volta terminato, fate clic su OK.

Attenzione

Se scegliete -nuovo documento- come posizione, verrà creato un nuovo foglio 
elettronico. Ciò potrebbe causare conflitti con formule collegate ad altri fogli nella 
precedente posizione. Se spostate un foglio accidentalmente, potete risolvere 
spostando o copiando il foglio alla sua posizione originale.

Tale operazione può essere effettuata anche in caso di spostamento ad altri 
documenti esistenti.
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Figura 109: finestra di dialogo Sposta/copia foglio

Eliminare fogli
Potete eliminare i fogli singolarmente o in gruppi.

Foglio singolo
Fate clic con il tasto destro sulla scheda del foglio che volete eliminare e scegliete Elimina 
foglio dal menu a comparsa, o scegliete Modifica > Foglio > Elimina dalla barra dei menu.

Fogli multipli
Per eliminare fogli multipli, selezionateli come descritto in precedenza, poi fate clic con il tasto 
destro su una delle schede e selezionate Elimina Foglio dal menu a comparsa, oppure 
scegliete Modifica > Foglio > Elimina dalla barra dei menu.

Rinominare i fogli
Il nome predefinito per un nuovo foglio è FoglioX, dove X è un numero. Questa soluzione è 
efficace per fogli elettronici di pochi fogli, ma diventa complicata quando sono presenti molti fogli.

Per dare ad un foglio un nome più significativo, potete:

• Digitare un nome nell'apposito riquadro quando create il foglio, oppure

• Fare clic sulla scheda del foglio con il tasto destro e scegliere Rinomina foglio dal menu a 
comparsa; quindi sostituire il nome esistente con uno di vostra scelta.

• Fare doppio clic su una scheda di un foglio per fare comparire la finestra di dialogo 
Rinomina foglio.
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Nota

I nomi dei fogli devono iniziare con una lettera o un numero. A parte il primo 
carattere del nome del foglio, i caratteri permessi includono lettere, numeri, spazi, 
e caratteri sottolineati. Se si cerca di rinominare un foglio con un nome non valido 
apparirà un messaggio di errore.

Viste di Calc

Usare lo zoom
Usate la funzione zoom per modificare la visualizzazione e mostrare più o meno celle nella 
finestra. Per maggiori informazioni sullo zoom, consultate il Capitolo 1 (Introduzione a LibreOffice) 
in questa guida.

Fissare righe e colonne
Potete fissare un certo numero di righe in cima al foglio o un certo numero di colonne all'estremo 
sinistro del foglio, o entrambe le cose. In questo modo quando fate scorrere il foglio, le colonne e 
le righe fissate restano visibili.

La Figura 110 mostra alcune righe e colonne fissate. La spessa linea orizzontale tra le righe 3 e 14 
e la spessa linea verticale tra le colonne C e H denotano le aree fissate. Le righe dalla 4 alla 13 e 
le colonne dalla D alla G sono state fatte scorrere fuori dalla pagina. Dato che le prime tre righe e 
colonne sono state fissate, sono rimaste visibili.

Figura 110: righe e colonne fissate

Potete impostare il punto di fissaggio su una riga, una colonna, o su entrambe, come mostrato 
nella Figura 110.

Fissare singole righe e colonne

1) Fate clic sull'intestazione della riga (o della colonna) sopra cui (o alla cui sinistra) volete 
impostare il punto di fissaggio.

2) Selezionate Finestra > Fissa. Apparirà una linea nera, ad indicare il punto in cui è stato 
posto il fissaggio.
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Fissare una riga e una colonna

1) Fate clic nella cella che si trova subito sotto la riga o subito a destra della colonna che 
volete fissare.

2) Selezionate Finestra > Fissa. Appariranno sullo schermo due linee nere: una orizzontale 
sopra la cella ed una verticale alla sua sinistra. Ora, quando fate scorrere il foglio, tutto ciò 
che si trova sopra e alla sinistra di queste linee rimane visibile.

Sbloccare
Per sbloccare righe e colonne, selezionate Finestra > Fissa. Il segno di spunta di fianco a Fissa 
scomparirà.

Dividere lo schermo
Un altro modo per cambiare la visualizzazione del foglio è la divisione della finestra (o divisione 
dello schermo. Lo schermo può essere suddiviso orizzontalmente, verticalmente o in entrambi i 
modi. In questo modo potete avere fino a quattro diverse parti del foglio visibili 
contemporaneamente.

A cosa vi può servire? Immaginate di avere un foglio elettronico molto grande, con una cella 
contenente un numero utilizzato da tre formule in altrettante celle. Usando la divisione dello 
schermo, potete posizionare la cella contenente il numero in una sezione e ognuna delle celle con 
le formule nelle altre sezioni. Potete quindi modificare il numero nella cella e vedere come influisce 
su ciascuna formula.

Figura 111: esempio di divisione dello schermo

Dividere lo schermo orizzontalmente
Per dividere lo schermo orizzontalmente:

1) Portate il puntatore del mouse nella barra di scorrimento verticale alla destra dello 
schermo, sopra il pulsante con un piccolo triangolo che si trova in alto. Subito sopra questo 
pulsante si trova una spessa linea nera.
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Figura 112: barra di divisione dello schermo 
nella barra di scorrimento verticale

2) Portate il puntatore del mouse su questa linea, che diventerà una linea con due frecce.

Figura 113: barra di divisione 
dello schermo nella barra di 
scorrimento verticale con il 
cursore

3) Tenete premuto il pulsante sinistro del mouse. Apparirà una linea grigia che attraversa la 
pagina. Muovete il mouse in basso per trascinare la linea.

4) Rilasciate il pulsante del mouse e lo schermo si dividerà in due parti, ognuna con la propria 
barra di scorrimento verticale. Potete scorrere la parte inferiore e quella superiore in modo 
indipendente.

Notate che nella Figura 111, i valori Beta e A0 si trovano nella parte superiore della finestra mentre 
gli altri calcoli sono nella parte inferiore. In questo modo potete apportare modifiche ai valori Beta e 
A0 e osservarne le modifiche ai calcoli nella metà inferiore della finestra.

Suggerimento
Potete anche dividere lo schermo usando un comando del menu. Fate clic nella 
cella che si trova subito sotto e alla destra del punto nel quale volete dividere lo 
schermo, e scegliete Finestra > Dividi.

Dividere lo schermo verticalmente
Per dividere lo schermo verticalmente:

1) Portate il puntatore del mouse nella barra di scorrimento orizzontale in fondo allo schermo, 
sopra il pulsante con un piccolo triangolo che si trova a destra. Subito a destra di questo 
pulsante è presente una spessa linea nera.
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Figura 114: barra di divisione dello schermo 
nella barra di scorrimento orizzontale

2) Portate il puntatore del mouse su questa linea, che diventerà una linea con due frecce.

3) Tenendo premuto il pulsante sinistro del mouse apparirà una linea grigia che attraversa la 
pagina. Muovete il mouse a sinistra per trascinare la linea.

4) Rilasciate il pulsante e lo schermo si dividerà in due parti, ognuna con la propria barra di 
scorrimento orizzontale. Potete scorrere la parte sinistra e destra della finestra in modo 
indipendente.

Eliminare la vista divisa
Per rimuovere la divisione dello schermo, usate uno dei metodi seguenti:

• Fate doppio clic su ciascuna linea di divisione.

• Fate clic sulle linee di divisione e trascinatele al loro posto in fondo alle barre di 
scorrimento.

• Scegliete Finestra > Dividi per rimuovere tutte le linee di divisione contemporaneamente.

Introdurre dati utilizzando la tastiera

La maggior parte dei dati può essere inserita in Calc utilizzando la tastiera.

Introdurre numeri
Selezionate la cella e digitate il numero usando i tasti numerici sulla fila superiore della tastiera o il 
tastierino numerico.

Per introdurre un numero negativo, digitate il segno meno (–) davanti al numero oppure 
racchiudetelo tra parentesi, ad esempio così: (1234).

Per impostazione predefinita, i numeri sono allineati a destra e quelli negativi sono preceduti dal 
segno meno.

Nota
Se viene inserito in una cella un numero che inizia per 0, Calc toglierà lo zero 
iniziale (ad esempio 01234 diventa 1234).

Per inserire un numero mantenendo lo 0 iniziale, fate clic con il pulsante destro sulla cella e 
scegliete Formatta celle > Numeri. Nella finestra di dialogo Formatta celle, sotto Opzioni 
selezionate il numero richiesto di Zeri iniziali.

Il numero selezionato per gli zeri iniziali deve essere maggiore di uno rispetto alle cifre che 
compongono il numero. Ad esempio, se il numero è 1234, il numero inserito per lo zero iniziale 
sarà 5.
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Figura 115: regolazione degli zeri iniziali

Introdurre testo
Selezionate la cella e digitate il testo. Per impostazione predefinita, il testo è allineato a sinistra.

Introdurre numeri come testo

Per mantenere uno zero iniziale un numero può essere inserito come testo  inserendo un 
apostrofo prima del numero, in questo modo: '01481.

I dati verranno considerati come testo da Calc e visualizzati esattamente come inseriti. 
Generalmente, le formule considereranno l'inserimento come uno zero e le funzioni lo ignoreranno. 
Prestate attenzione che la cella contenente il numero non sia utilizzata da una formula.

Nota

Se si utilizzano i doppi apici (virgolette), questi rimangono visibili nella cella.

Per scegliere il tipo di apostrofo, usate Strumenti > Opzioni di correzione 
automatica > Virgolette tipografiche. La scelta del tipo di virgolette vale sia per 
Calc che per Writer.

Introdurre date e orari
Selezionate la cella e digitate la data o l'orario. Potete separare gli elementi della data con una 
barra (/) o con un trattino (-) oppure inserire del testo (15 ottobre 10). Calc riconosce diversi formati 
di data. Potete separare gli elementi dell'orario con i due punti (10:43:45).
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Disattivare le modifiche automatiche
Calc applica automaticamente diverse modifiche durante l'inserimento dei dati, a meno che non 
disattiviate tali modifiche. Potete anche annullare immediatamente qualsiasi modifica automatica 
con Ctrl+Z.

Modifiche di autocorrezione
La correzione automatica degli errori di digitazione, la sostituzione delle virgolette semplici con 
le virgolette tipografiche, e l'inizio del contenuto della cella con lettera maiuscola sono 
controllati tramite Strumenti > Opzioni di correzione automatica. Andate alle schede 
Virgolette tipografiche, Opzioni, o Sostituzione per disattivare le caratteristiche non desiderate. 
Nella scheda Sostituzione, potete anche eliminare coppie di parole che non volete e 
aggiungerne di nuove.

Digitazione automatica
Quando digitate in una cella, Calc suggerisce automaticamente la digitazione che combacia 
con quelle che si trovano nella medesima colonna. Per attivare e disattivare la Digitazione 
automatica, inserite o eliminate la spunta da Strumenti > Contenuti Celle > Digitazione 
automatica.

Conversione automatica della data
Calc converte automaticamente alcune voci in date. Per fare in modo che una voce inserita, 
simile ad una data, venga interpretata come testo, digitate un apostrofo all'inizio della voce. 
L'apostrofo non viene mostrata nella cella.

Velocizzare l'inserimento dei dati

L'inserimento dei dati in un foglio elettronico può essere un procedimento molto lungo, ma Calc 
fornisce diversi strumenti per velocizzare il lavoro.

La possibilità più elementare è quella di trascinare dati da una cella all'altra con il mouse. Calc 
include anche diversi altri strumenti per automatizzare il processo di inserimento, in particolar 
modo quando si ha a che fare con dati ripetitivi. Tra questi figurano lo strumento Riempimento, le 
liste di selezione, e la possibilità di inserire dati in più fogli dello stesso documento.

Utilizzare lo strumento riempimento sulle celle
Essenzialmente, lo strumento Riempimento è un modo per duplicare contenuti esistenti. 
Selezionate la cella da copiare, poi trascinate nella direzione desiderata, tenendo premuto il 
pulsante del mouse (oppure fate clic sull'ultima cella che volete riempire tenendo premuto il tasto 
Maiusc), poi selezionate Modifica > Compila e la direzione nella quale volete copiare: verso l'alto, 
il basso, a sinistra oppure a destra.

Attenzione Le scelte non disponibili sono mostrate in grigio, ma è possibile scegliere la 
direzione opposta a quella desiderata, e questo può causare la sovrascrittura 
accidentale di alcune celle.

Suggerimento

Un metodo più rapido per riempire le celle consiste nell'afferrare la "maniglia" 
nell'angolo della cella in basso a destra e trascinarla nella direzione nella quale 
si vuole copiare. Se la cella contiene un numero, verrà creata una serie. Se la 
cella contiene testo, il medesimo testo verrà copiato nella direzione scelta.
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Figura 116: utilizzare lo strumento Riempimento

Utilizzo di una serie di riempimento
Un modo più complesso di usare lo strumento Riempimento consiste nell'usare una serie. Gli 
elenchi predefiniti comprendono i giorni della settimana ed i mesi, in forma estesa e abbreviata, ma 
è possibile anche creare elenchi personalizzati.

Capitolo 5  Guida introduttiva a Calc 147

Figura 117: il risultato della 
selezione della serie di 
riempimento mostrata nella 
Figura 118



Per aggiungere una serie di riempimento ad un foglio elettronico, selezionate le celle da riempire, 
scegliete Modifica > Compila > Serie. Nella finestra di dialogo Serie (Figura 118), selezionate 
Riempimento automatico come Tipo di serie, ed inserite come Valore iniziale un elemento di una 
delle serie definite. Le celle selezionate verranno quindi riempite in sequenza con gli altri elementi 
della serie, ricominciando dall'inizio di questa quando ne viene raggiunto il fondo.

Figura 118: specificare l'inizio di una serie di riempimento (il risultato è visibile nella Figura 117)

Potete usare Modifica > Compila > Serie anche per impostare una serie di numeri inserendo il 
valore iniziale, quello finale e l'incremento. Ad esempio, inserendo 1 come valore iniziale e 7 come 
valore finale con un incremento di 2, si otterrà la sequenza 1, 3, 5, 7.

In tutti questi casi, lo strumento Riempimento crea un collegamento solo momentaneo tra le celle. 
Una volta riempite, le celle non hanno alcuna connessione tra di loro.

Definizione di una serie di riempimento
Per definire una serie personalizzata:

1) Andate su Strumenti > Opzioni > LibreOffice Calc > Ordina elenchi. Questa finestra di 
dialogo mostra le serie esistenti nella casella Elenchi, e il contenuto dell'elenco selezionato 
nella casella Voci.

Figura 119: serie di riempimento predefinite

2) Fate clic su Nuovo. Il contenuto della casella Voci viene sgombrato.
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3) Scrivete la serie per il nuovo elenco nella casella Voci (una voce per riga). Fate clic su 
Aggiungi. Il nuovo elenco apparirà nella casella Elenchi.

4) Fate clic su OK nella parte bassa della finestra di dialogo per salvare il nuovo elenco.

Figura 120: definizione di una nuova serie di riempimento

Usare gli elenchi di selezione
Gli elenchi di selezione sono disponibili solo per il testo, ed è possibile usare solo il testo che è già 
stato inserito nella stessa colonna.

Per usare un un elenco di selezione, selezionate una cella vuota e premete Ctrl+D. Apparirà un 
elenco a tendina contenente tutte le stringhe di testo inserite nella colonna corrente, e tutte le 
stringhe formattate come testo. Fate clic sulla voce desiderata.

Figura 121: usare un elenco di 
selezione
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Condivisione di contenuti tra fogli

Potrebbe essere necessario inserire gli stessi dati nella stessa cella su fogli diversi, ad esempio 
per preparare elenchi standard per un gruppo di individui o organizzazioni. Invece di inserire 
l'elenco su ogni foglio separatamente, è possibile inserirlo su tutti i fogli allo stesso tempo. Per fare 
ciò, selezionate tutti i fogli (modifica > Foglio > Seleziona), dopodiché inserite le informazioni in 
quello corrente.

Attenzione Questo sistema sovrascrive ogni dato presente nelle celle di destinazione sugli 
altri fogli—senza nessun avviso. Per questa ragione, una volta finito, accertatevi di 
deselezionare tutti i fogli tranne quello che desiderate modificare. (Ctrl+clic sulla 
scheda di un foglio per selezionare o deselezionare il foglio.)

Validare il contenuto di una cella

Creando fogli elettronici per altre persone, potreste volervi assicurare che i dati inseriti siano validi 
o appropriati per la cella. Potete anche usare la validazione nel vostro lavoro come guida per 
l'inserimento di dati complessi o usati di rado.

Le serie di riempimento e gli elenchi di selezione possono gestire alcuni tipi di dati, ma sono limitati 
a informazioni predefinite. Per validare nuovi dati inseriti da un utente, selezionate una cella e 
usate Dati > Validità per definire il tipo di contenuti che possono essere inseriti in tale cella. Ad 
esempio, una cella potrebbe richiedere una data o un numero intero, senza caratteri alfabetici o 
punti decimali; oppure potrebbe richiedere l'inserimento obbligatorio di dati.

A seconda delle impostazioni di validazione, lo strumento permette anche di definire l'intervallo di 
contenuti che possono essere inseriti e fornisce messaggi di aiuto che spiegano le regole di 
contenuto impostate per la cella e cosa dovrebbero fare gli utenti quando inseriscono contenuti 
non validi. Potete anche impostare le celle in modo che i contenuti non validi vengano rifiutati, che 
vengano accettati mostrando un avvertimento, oppure in modo che venga avviata una macro 
quando viene inserito un errore.

Vedere il Capitolo 2 (Inserimento, modifica e formattazione dei dati) nella Guida a Calc per 
maggiori informazioni.

Modifica dei dati

La modifica dei dati viene eseguita pressapoco allo stesso modo del loro inserimento. Il primo 
passo consiste nel selezionare la cella contenente i dati da modificare.

Eliminare dati da una cella
I dati possono essere cancellati da una cella in diversi modi.

Rimozione dei soli dati
È possibile rimuovere soltanto i dati da una cella senza cancellarne la formattazione. Fate clic 
nella cella per selezionarla, quindi premete il tasto Canc.

Rimozione dei dati e della formattazione
È possibile rimuovere i dati e la formattazione di una cella allo stesso tempo. Premete il tasto 
Backspace (oppure fate clic con il pulsante destro e scegliete Elimina contenuti, o ancora 
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usate Modifica > Elimina contenuti) per aprire la finestra di dialogo Elimina contenuti. Da 
questa finestra, è possibile eliminare diversi tipi di contenuto della cella. Per eliminare tutto in 
una cella (contenuti e formattazione), spuntate Cancella tutto.

Figura 122: finestra di dialogo Elimina 
contenuti

Sostituire tutti i dati in una cella
Per rimuovere i dati ed inserirne di nuovi, semplicemente scrivete sopra i vecchi dati. I nuovi dati 
manterranno la formattazione originaria.

Cambiare parte dei dati in una cella
A volte è necessario cambiare solo in parte il contenuto di una cella; ad esempio se la frase 
"Marco corre“ si trova in una cella e deve essere modificata in "Marco corre veloce" è sovente utile 
effettuare la modifica senza eliminare prima i precedenti contenuti della cella.

Il procedimento è simile a quello descritto sopra, ma è necessario posizionare il cursore dentro la 
cella. Questa operazione può essere eseguita in due modi diversi.

Usare la tastiera
Dopo avere selezionato la cella desiderata, premete il tasto F2 e il cursore verrà posizionato in 
fondo alla cella. A questo punto usate le frecce per fare scorrere il cursore lungo il testo nella 
cella.

Usare il mouse
Usando il mouse, è possibile fare doppio clic sulla cella desiderata (per selezionarla e 
posizionarvi il cursore per modificare il contenuto), oppure fare clic per selezionare la cella, 
spostare il cursore in alto sulla riga di digitazione e fare clic per farvi apparire il cursore per 
scrivere.
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Formattazione dei dati

I dati in Calc possono essere formattati in diversi modi. La formattazione può essere modificata 
come parte dello stile di cella, in modo da venire applicata automaticamente, oppure può essere 
applicata alla cella in modo manuale. Alcuni aspetti della formattazione possono essere modificati 
utilizzando le icone della barra degli strumenti. Per avere maggiore controllo e più opzioni, 
selezionate la cella o le celle desiderate, fate clic con il tasto destro, e selezionate Formatta celle. 
Tutte le opzioni di formattazione sono esaminate in seguito.

Nota
Tutte le impostazioni esaminate in questa sezione possono essere configurate 
anche come parte di uno stile di cella. Vedere il Capitolo 4 della Guida a Calc per 
maggiori informazioni.

Formattazione di linee di testo multiple
È possibile inserire più righe in una singola cella usando lo scorrimento automatico oppure le 
interruzioni manuali di riga. Ognuno di questi metodi è utile in situazioni diverse.

Usare lo scorrimento automatico
Per impostare il testo in modo che vada a capo alla fine della cella, fate clic su quest'ultima con il 
tasto destro e selezionate Formatta Celle (oppure selezionate Formato > Celle dalla barra dei 
menu, oppure premete Ctrl+1). Nella scheda Allineamento (Figura 123), sotto la voce Proprietà, 
selezionate Scorrimento testo automatico e fate clic su OK. I risultati sono mostrati nella Figura 
124.

Figura 123: finestra di dialogo Formatta celle > Scheda Allineamento
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Figura 124: scorrimento testo automatico

Usare interruzioni di riga manuali
Per inserire un'interruzione di riga manuale durante l'inserimento del testo in una cella, premete 
Ctrl+Invio. Questo metodo non funziona con il cursore nella riga di digitazione. In fase di modifica 
del testo, per prima cosa fate doppio clic nella cella, e dopo un clic singolo nella posizione in cui 
desiderate interrompere la riga.

Quando viene inserita una interruzione di riga manuale, la larghezza della cella non cambia. La 
Figura 125 mostra il risultato di due interruzioni di riga manuali dopo la prima riga di testo. 

Figura 125: cella con interruzioni di riga manuali

Restringere il testo per adattarlo alla cella
Le dimensioni carattere dei dati in una cella possono essere regolate automaticamente per 
adattarsi alla cella. Per fare ciò, selezionate l'opzione Adatta alle dimensioni della cella nella 
finestra di dialogo Formatta celle (Figura 123).  La Figura 126 mostra il risultato.

Figura 126: restringere il testo per adattarlo alle celle
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Formattazione dei numeri
È possibile impostare diversi formati dei dati numerici nelle celle, utilizzando le icone della barra 
degli strumenti di Formattazione. Selezionate la cella, quindi fate clic sull'icona appropriata.

Figura 127: icone di formato numero Da sinistra a destra: valuta, 
percentuale, data, esponenziale, standard, aggiungi una cifra decimale, togli  
una cifra decimale.

Per un maggiore controllo o per selezionare altri formati numerici, potete usare la scheda Numeri 
(Figura 128) della finestra di dialogo Formatta celle per:

• Impostare per i dati una delle tipologie presenti nell'elenco Categoria.

• Decidere il numero di posizioni decimali e di zeri iniziali.

• Impostare un codice di formato personalizzato.

L'impostazione della lingua controlla la localizzazione dei vari formati, come quello della data, e il 
contrassegno della valuta.

Figura 128: Formatta Celle > Numeri

Formattazione del tipo di carattere
Per scegliere rapidamente il carattere usato in una cella selezionatela, poi fate clic sulla freccia a 
destra della casella Nome del carattere sulla barra di Formattazione e selezionate un carattere 
dall'elenco.
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Suggerimento

Per scegliere se mostrare i nomi dei caratteri con il loro carattere o in testo 
semplice, andate in Strumenti > Opzioni > LibreOffice > Vista e selezionate o 
deselezionate l'opzione Mostra anteprima dei caratteri nella sezione Elenchi di 
caratteri. Per maggiori informazioni, vedere il Capitolo 2 (Configurare 
LibreOffice).

Per scegliere le dimensioni del carattere, fate clic sulla freccia 
accanto alla casella Dimensione sulla barra di Formattazione. Per 
altre impostazioni di formato, potete usare le icone Grassetto, 
Corsivo o Sottolineato.

Per scegliere il colore del carattere, fate clic sulla freccia accanto 
all'icona Colore carattere per mostrare la tavola dei colori. Fate clic 
sul colore desiderato.

(Per definire dei colori personalizzati, usate Strumenti > Opzioni > 
LibreOffice > Colori. Vedere il Capitolo 2).

Per specificare la lingua della cella (utile perché ciò permette la 
coesistenza e la correzione ortografica corretta di lingue diverse 
nello stesso documento), usate la scheda Carattere della finestra di 
dialogo Formatta celle. Usate la scheda Effetti carattere per 
impostare altre caratteristiche del carattere. Vedere il Capitolo 4 
(Uso di stili e modelli in Calc) nella Guida a Calc per maggiori 
informazioni.

Formattazione dei bordi della cella
Per aggiungere un bordo a una cella (o a un gruppo di celle selezionate), fate clic sull'icona Bordi 
sulla barra di Formattazione, e selezionate una delle opzioni mostrate nella tavolozza.

Per scegliere rapidamente stile e colore del bordo della cella, fate clic sulle freccette accanto alle 
icone Stile linea e Colore linea cornice sulla barra di Formattazione. In entrambi i casi verrà 
mostrata una tavolozza di scelta.

Per avere un maggiore controllo, includendo la spaziatura tra il bordo cella ed il testo, usate la 
scheda Bordo della finestra di dialogo Formatta celle. Qui potete inoltre impostare 
un'ombreggiatura. Vedere il Capitolo 4 (Uso di stili e modelli in Calc) nella Guida a Calc per 
dettagli.

Nota

Le proprietà del bordo vengono applicate ad una cella, e possono essere cambiate 
solo se si sta modificando quella cella. Ad esempio, se la cella C3 ha un bordo 
superiore (che visivamente corrisponderebbe ad un bordo inferiore della cella C2), 
quel bordo può essere rimosso solo selezionando C3. Non può essere rimosso in 
C2.

Formattazione dello sfondo della cella
Per scegliere rapidamente un colore di sfondo per una cella, fate clic sulla piccola freccia accanto 
all'icona Colore di sfondo sulla barra di Formattazione. Si aprirà una tavola dei colori, simile alla 
tavola di Colore carattere.

Capitolo 5  Guida introduttiva a Calc 155



(Per definire dei colori personalizzati, usate Strumenti > Opzioni > LibreOffice > Colori. Vedere il 
Capitolo 2 per maggiori informazioni.)

Potete anche usare la scheda Sfondo della finestra di dialogo Formatta celle. Vedere il Capitolo 4 
(Uso di stili e modelli in Calc) nella Guida a Calc per dettagli.

Formattazione automatica di celle e fogli

Potete usare la funzionalità Formattazione automatica per applicare rapidamente una serie di 
formati di cella ad un foglio intero oppure ad un intervallo di celle selezionato.

1) Selezionate le celle che desiderate formattare, includendo le intestazioni di riga e di 
colonna.

2) Scegliete Formato > Formattazione automatica.

Nota
La funzionalità Formattazione automatica può essere applicata solamente se 
l'insieme di celle selezionate contiene almeno 3 colonne e 3 righe ed include le 
intestazioni di riga e colonna.

3) Per selezionare quali proprietà (formato numero, tipo di carattere, allineamento, bordo, 
modello, adatta larghezza/altezza) includere in una Formattazione automatica, fate clic su 
Più. Selezionate o deselezionate le opzioni necessarie.

4) Fate clic su OK.

Se il colore del contenuto della cella non cambia, scegliete Visualizza > Evidenziazione valori 
dalla barra dei menu.

Figura 129: scelta di una Formattazione automatica

Definizione di una nuova Formattazione Automatica
È possibile definire una nuova Formattazione Automatica che sia disponibile per tutti i fogli 
elettronici.

1) Formattate un foglio (nello stile desiderato per la nuova Formattazione Automatica).
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2) Scegliete Modifica > Seleziona tutto.

3) Scegliete Formato > Formattazione automatica. Il pulsante Aggiungi adesso è attivo.

4) Fate clic su Aggiungi.

5) Nella casella Nome della finestra di dialogo Aggiungi formattazione automatica, scrivete un 
nome significativo per il nuovo formato.

6) Fate clic su OK per salvare. Il nuovo formato adesso è disponibile nell'elenco Formato 
della finestra di dialogo Formattazione automatica.

Formattazione dei fogli elettronici utilizzando dei temi

Calc è dotato di un set predefinito di temi di formattazione che è possibile applicare ai fogli 
elettronici.

Non è possibile aggiungere dei temi, e non è possibile modificarli. Potete comunque modificarne 
gli stili dopo averli applicati ad un foglio elettronico.

Per applicare un tema ad un foglio elettronico:

1) Fate clic sull'icona Selezione tema nella barra Strumenti. Se la barra non è visibile, potete 
mostrarla usando Visualizza > Barre degli strumenti > Strumenti.

Appare la finestra di dialogo Selezione tema. Questa finestra elenca i temi disponibili per 
l'intero foglio elettronico.

2) Nella finestra di dialogo Selezione tema, selezionate il tema che volete applicare al foglio 
elettronico.

Appena viene selezionato un tema, alcune delle proprietà degli stili personalizzati vengono 
applicate al foglio elettronico corrente e sono subito visibili.

3) Fate clic su OK. Se volete, potete ora andare alla finestra Stili e formattazione per 
modificare stili specifici. Queste modifiche non cambiano il tema; cambiano soltanto 
l'aspetto del foglio elettronico corrente.

Uso della formattazione condizionale

Potete impostare il formato delle celle in modo che cambi a seconda delle condizioni che 
specificate. Ad esempio, in una tabella contenente dei numeri, potete mostrare tutti i valori al di 
sopra di un valore medio in verde e tutti quelli al di sotto in rosso.

La Formattazione condizionale dipende dall'uso degli stili, e la funzionalità di Calcolo automatico 
(Strumenti > Contenuti celle > Calcolo automatico) deve essere abilitata. Vedere il Capitolo 2 
(Inserimento, modifica e formattazione dei dati), nella Guida a Calc per dettagli.
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Nascondere e mostrare i dati

Quando degli elementi vengono nascosti, non sono visibili e non possono essere stampati, ma 
possono comunque venire selezionati per la copia selezionando gli elementi circostanti. Ad 
esempio, se la colonna B è nascosta, viene copiata selezionando le colonne A e C. Quando si ha 
di nuovo bisogno di un elemento nascosto, si può invertire la procedura e mostrarlo di nuovo.

Per nascondere o mostrare fogli, righe e colonne, usate le opzioni sul menu Formato oppure il 
menu contestuale che appare facendo clic con il pulsante destro. Ad esempio, per nascondere una 
riga, selezionatela e poi scegliete Formato > Riga > Nascondi (oppure fate clic con il pulsante 
destro sulla sua intestazione e scegliete Nascondi).

Per nascondere o mostrare le celle selezionate, andate in Formato > Celle nella barra dei menu 
(oppure fate clic con il pulsante destro e selezionate Formatta celle). Nella finestra di dialogo 
Formatta celle, selezionate la scheda Protezione celle.

Figura 130: nascondere o mostrare celle

Comandi di strutturazione dei gruppi
Se dovete nascondere e mostrare più volte le stesse celle, potete semplificare il procedimento 
creando dei gruppi, i quali aggiungono una serie di controlli per nascondere e mostrare le celle del 
gruppo in modo veloce e sempre disponibile.

Se i contenuti delle celle seguono uno schema regolare, come ad esempio quattro celle seguite da 
un totale, potete usare Dati > Raggruppa e struttura > Struttura automatica e Calc aggiungerà 
dei controlli di struttura basati su tale schema. Altrimenti, potete impostare dei gruppi manualmente 
selezionando le celle da raggruppare e poi scegliendo Dati > Raggruppa e struttura > Gruppo. 
Nella finestra di dialogo Raggruppa, potete scegliere se raggruppare le celle selezionate in base 
alle righe oppure in base alle colonne.

Quando questa finestra viene chiusa, i controlli della struttura dei gruppi vengono visualizzati tra 
l'intestazione della riga o della colonna ed il bordo della finestra. I controlli hanno una struttura ad 
albero apparentemente simile a quella di un gestore di file, che può essere nascosta selezionando 
Dati > Raggruppa e struttura > Nascondi dettaglio. Sono intesi per l'uso a video, e non 
vengono stampati.
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Figura 131: controlli di definizione dei gruppi

I controlli base di struttura hanno dei segni più o meno all'estremità del gruppo per nascondere o 
mostrare le celle. Tuttavia, se i gruppi vengono annidati, i controlli hanno pulsanti numerati per 
nascondere i differenti livelli.

Se un gruppo non vi serve più, portate il cursore del mouse sopra una delle sue celle e selezionate 
Dati > Raggruppa e struttura > Separa. Per rimuovere tutti i gruppi su un foglio, selezionate Dati 
> Raggruppa e struttura > Rimuovi.

Filtrare le celle visibili
Un filtro è una lista di requisiti necessari perché ciò che viene inserito venga mostrato. Potete 
impostare tre tipi di filtri dal sottomenu Dati > Filtro.

Il Filtro automatico aggiunge alla prima riga della colonna un elenco a discesa contenente i filtri 
usati più di frequente. Sono comodi e veloci e  sono utili sia con il testo che con i numeri, in quanto 
l'elenco include ogni voce univoca nelle celle selezionate.

In aggiunta ad ogni voce univoca, i filtri automatici includono la possibilità di mostrare tutte le voci, i 
10 valori numerici più alti, e tutte le celle vuote o quelle non vuote, così come un filtro standard. I  
filtri automatici sono comunque piuttosto limitati. In particolare, non permettono espressioni 
standard, per cui non potete usarli per visualizzare contenuti che sono simili ma non identici.

I Filtri Standard sono più complessi di quelli automatici. È possibile impostare fino a tre condizioni 
come filtro, combinandole tra loro con gli operatori E e O. I filtri standard sono utili soprattutto per i 
numeri, sebbene alcuni degli operatori condizionali, come = e < > possano essere utilizzati anche 
con il testo.

Altri operatori condizionali per i filtri standard includono opzioni per mostrare il valore maggiore o il 
minore, oppure una percentuale di questi. Utili di per sé, i filtri standard portano un ulteriore valore 
aggiunto quando vengono utilizzati per meglio definire i filtri automatici.

I Filtri speciali hanno una struttura simile a quella dei filtri standard. I filtri speciali si differenziano 
dai precedenti in quanto non sono limitati a tre condizioni, ed i loro criteri non vengono inseriti in 
una finestra. Essi vengono invece inseriti in un'area vuota di un foglio, e dopo vengono importati 
tramite lo strumento filtro speciale per utilizzarli.

Ordinare i record

L'ordinamento dispone le celle visibili in ordine sulla tabella. In Calc potete ordinare i dati 
utilizzando fino a tre criteri, applicati in sequenza gerarchica. L'ordinamento è utile quando state 

Capitolo 5  Guida introduttiva a Calc 159



cercando un particolare elemento, e diviene ancora più potente se utilizzato dopo avere filtrato i 
dati.

Inoltre, è spesso utile quando si aggiungono nuove informazioni. Quando una lista è lunga, 
solitamente è più facile aggiungere i nuovi dati in fondo al foglio, piuttosto che aggiungere delle 
righe là dove è necessario. Dopo avere aggiunto i nuovi dati, potete riordinarli per aggiornare il 
foglio.

Evidenziate le celle da ordinare, quindi selezionate Dati > Ordina per aprire la finestra di dialogo 
Ordina (oppure fate clic sui pulsanti Ordina in modo crescente o Ordina in modo decrescente sulla 
barra degli strumenti). Tramite la finestra di dialogo, potete ordinare le celle selezionate usando 
fino a tre colonne, sia in ordine ascendente (A-Z, 1-9) che discendente (Z-A, 9-1).

Sulla scheda Opzioni della finestra di dialogo Ordina, potete scegliere le seguenti opzioni:

Maiuscole/minuscole
In caso di due voci altrimenti identiche, la voce con una lettera maiuscola sarà posizionata 
prima di una voce con una minuscola nella stessa posizione.

Area contenente intestazioni di colonne
Non include l'intestazione della colonna nel riordino.

Includi i formati
La formattazione di una cella viene spostata insieme al suo contenuto. Se la formattazione 
viene usata per distinguere diversi tipi di celle, includete questa opzione.

Copia risultati ordinamento in
Imposta un indirizzo nel foglio elettronico in cui copiare i risultati del riordino. Nel caso venga 
specificato un intervallo con un numero insufficiente di celle libere, verranno aggiunte nuove 
celle. Se l'intervallo contiene celle non vuote, l'operazione si interrompe.

Ordinamento personalizzato
Selezionate la casella, dopodiché scegliete uno degli ordinamenti definiti in Strumenti > 
Opzioni > LibreOffice Calc > Ordina elenchi dal menu a discesa.

Direzione
Stabilisce se vengono ordinate le righe oppure le colonne. L'impostazione predefinita è 
ordinare per colonne, a meno che le celle selezionate non siano in una singola colonna.

Uso di formule e funzioni

Oltre a numeri e testo, nel vostro foglio elettronico potreste avere bisogno di altro. Spesso i 
contenuti di una cella dipendono dai contenuti di altre celle. Le formule sono equazioni che fanno 
uso di numeri e variabili per ottenere un risultato. Le variabili sono posizioni di celle che 
contengono i dati necessari per l'equazione.

Una funzione è un calcolo predefinito inserito in una cella per aiutarvi ad analizzare o manipolare i 
dati. Tutto ciò che dovete fare è aggiungere gli argomenti, e il calcolo verrà eseguito 
automaticamente. Le funzioni vi aiutano a creare le formule necessarie per ottenere i risultati 
desiderati.

Fate riferimento al Capitolo 7 della Guida a Calc per maggiori informazioni.
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Analisi dei dati

Calc include diversi strumenti per l'analisi delle informazioni presenti nei vostri fogli elettronici, dalle 
funzionalità per copiare e riutilizzare i dati, alla creazione automatica dei subtotali, al variare le 
informazioni per aiutarvi a trovare le risposte di cui avete bisogno. Questi strumenti sono suddivisi 
tra i menu Strumenti e Dati.

Uno degli strumenti più utili è la Tabella Pivot (chiamata DataPilot in Calc 3.3). Si tratta di uno 
strumento che consente di combinare, confrontare e analizzare grandi quantità di dati. Usando una 
Tabella Pivot, potete visualizzare diversi riepiloghi dei dati sorgente, nonché visualizzare i dettagli 
relativi ad aree di interesse e creare specifici rapporti, sia che voi siate un principiante, sia che 
siate un utente esperto. Fate riferimento al Capitolo 8 della Guida a Calc per maggiori informazioni.

Altre opzioni di analisi includono:

Consolidamento
Dati > Consolida offre un modo per combinare dati da due o più aree di celle in una nuova 
area mentre si fa uso di una delle varie funzioni disponibili (come Somma o Media).

Subtotali
Potete usare Dati > Subtotali per calcolare i subtotali per più colonne (fino a un massimo di 
tre).

Scenari
Da Strumenti > Scenari potete aprire una finestra di dialogo per verificare le "ipotesi di 
calcolo", ad esempio tassi d'interesse differenti su un prestito.

Ricerca valore destinazione
Usate Strumenti > Ricerca valore destinazione se conoscete il risultato desiderato, ma avete 
bisogno di trovare i valori che producono tale risultato.

Risolutore
Strumenti > Risolutore è simile allo strumento di Ricerca valore destinazione, ma potete 
utilizzare più di una variabile. Il Risolutore è disegnato per minimizzare o massimizzare il 
risultato secondo un insieme di regole da voi definite.

Tali opzioni sono trattate nel Capitolo 9 della Guida a Calc.

Stampa

La gestione della stampa in Calc è analoga a quella degli altri componenti di LibreOffice (vedere il 
Capitolo 10), ma alcuni dettagli sono differenti, specialmente riguardo alla preparazione alla 
stampa.

Utilizzo delle aree di stampa
Le aree di stampa hanno molteplici utilizzi, inclusa la stampa di una specifica parte dei dati oppure 
di righe o colonne selezionate su ogni pagina. Per ulteriori dettagli sull'uso delle aree di stampa, si 
veda il Capitolo 6 (Stampa, esportazione e invio di e-mail) della Guida a Calc.
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Definire un'area di stampa
Per definire una nuova area di stampa o modificarne una esistente:

1) Evidenziate l'intervallo di celle comprese nell'area di stampa.

2) Scegliete Formato > Aree di stampa > Definisci.

Sullo schermo appaiono le linee di interruzione di pagina.

Suggerimento
Potete controllare l'area di stampa usando File > Anteprima di stampa. 
LibreOffice visualizzerà solo le celle comprese nell'area di stampa.

Aggiunta all'area di stampa
Dopo aver definito un'area di stampa, potete aggiungervi altre celle. Ciò permette di stampare più 
aree dello stesso foglio separate tra loro, invece di stampare il foglio intero. Dopo aver definito 
un'area di stampa:

1) Evidenziate l'intervallo di celle da aggiungere all'area di stampa.

2) Scegliete Formato > Aree di stampa > Aggiungi. In tal modo verranno aggiunte all'area 
di stampa le ulteriori celle.

Sullo schermo non saranno più presenti le linee di interruzione di pagina.

Nota
L'area di stampa addizionale verrà stampata in una pagina separata, anche se 
entrambe le aree si trovano sul medesimo foglio.

Eliminare un'area di stampa
Potreste avere bisogno di rimuovere un'area di stampa già definita, ad esempio se in seguito 
dovete stampare l'intero foglio.

Scegliete Formato > Aree di stampa > Rimuovi. Verranno così eliminate tutte le aree di stampa 
definite nel foglio. Dopo aver rimosso l'area di stampa, sullo schermo appaiono le linee di 
interruzione di pagina predefinite.

Modificare un'area di stampa
In qualsiasi momento, potete modificare direttamente l'area di stampa, ad esempio per rimuovere 
o ridimensionare una parte dell'area di stampa. Scegliete Formato > Aree di stampa > Modifica.

Impostare l'ordine delle pagine, i dettagli e la scala
Per selezionare l'ordine delle pagine, i dettagli e la scala con cui stampare:

1) Scegliete Formato > Pagina dal menu principale.

2) Nella finestra di dialogo Stile di pagina (Figura 132), selezionate la scheda Foglio.

3) Impostate le vostre preferenze e fate clic su OK.

Sequenza pagine
Quando un foglio viene stampato su più di una pagina, potete selezionare in che sequenza 
verranno stampate le pagine. Questa funzione è particolarmente utile nel caso di un documento di 
grosse dimensioni; ad esempio, controllare l'ordine di stampa può farvi risparmiare tempo se avete 
intenzione di ordinare il documento in un certo modo. Di seguito sono mostrate le due opzioni 
disponibili.

162 Guida introduttiva a LibreOffice 3.5



Dall'alto in basso, poi a destra

Da sinistra a destra, poi in basso

Figura 132: la scheda Foglio della finestra di dialogo Stile di pagina

Dettagli
Potete specificare quali dettagli stampare. Questi dettagli includono:

• Intestazioni di riga e di colonna

• Griglia—stampa i bordi di una cella come una griglia

• Commenti—stampa i commenti inseriti nel foglio elettronico su una pagina separata, 
insieme al riferimento di cella corrispondente

• Oggetti/immagini

• Diagrammi

• Oggetti di disegno

• Formula—stampa le formule contenute nelle celle, invece dei risultati

• Valori zero—stampa le celle con valore zero
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Nota

Ricordate che, poiché le opzioni di stampa sono parte delle proprietà della pagina, 
esse sono anche parte delle proprietà dello stile di pagina. Quindi è possibile 
impostare differenti stili di pagina per cambiare rapidamente le proprietà di stampa 
dei fogli presenti nel foglio elettronico.

Scala
Potete usare le opzioni di scala per controllare il numero di pagine su cui i dati verranno stampati. 
Questo può essere utile qualora si vogliano stampare grandi quantità di dati in modo compatto, 
oppure se desiderate ingrandire il testo per facilitarne la lettura.

• Riduci/ingrandisci stampa—applica una scala maggiore o minore alla stampa. Ad esempio, 
un foglio che venisse normalmente stampato su quattro pagine (due in larghezza e due in 
altezza), con una scalatura del 50% potrebbe venire stampato su una sola pagina 
(essendo dimezzate sia l'altezza che la larghezza).

• Numero massimo di pagine—definisce esattamente quante pagine occuperà la stampa. 
Questa opzione può solo ridurre la dimensione di stampa. Per aumentare la dimensione di 
stampa, occorre usare l'opzione Riduci/ingrandisci stampa.

• Adatta area di stampa a larghezza/altezza—definisce quanto sarà alta e larga, in pagine, 
l'area di stampa.

Stampare righe o colonne in ogni pagina
Se un foglio viene stampato su più pagine, potete impostare determinate righe o colonne in modo 
che si ripetano su tutte le pagine.

Ad esempio, se le prime due righe e la colonna A del foglio devono essere stampate su tutte le 
pagine, fate come indicato di seguito:

1) Scegliete Formato > Aree di stampa > Modifica. Nella finestra di dialogo Modifica aree di 
stampa, inserite le righe nella casella di inserimento sotto Riga da ripetere. Ad esempio, 
per ripetere le righe 1 e 2, scrivete $1:$2. Ciò modifica automaticamente Riga da ripetere  
da - nessuna -  a - definito dall'utente -.

Figura 133: specificare le righe da ripetere

2) Per ripetere le colonne, digitatele nella casella di inserimento sotto Colonne da ripetere. Ad 
esempio, per ripetere la colonna A, digitate $A. Nell'elenco Colonna da ripetere, 
- nessuna - cambia in - definito dall'utente -.

3) Fate clic su OK.

Nota
Non è necessario selezionare l'intera area delle righe da ripetere; è sufficiente 
selezionare una cella per ogni riga.
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Interruzioni di pagina
Anche se definire un'area di stampa può essere uno strumento efficace, a volte potrebbe rendersi 
necessario modificare manualmente la stampa di Calc. Per fare ciò, potete usare una interruzione 
di pagina manuale. Un'interruzione di pagina manuale contribuisce a fare sì che i vostri dati 
vengano stampati correttamente. Potete inserire un'interruzione orizzontale di pagina sopra la cella 
attiva, oppure un'interruzione verticale alla sua sinistra.

Inserire un'interruzione di pagina
Per inserire una interruzione di pagina:

1) Spostatevi nella cella dove avrà inizio la pagina.

2) Selezionate Inserisci > Interruzione di pagina manuale.

3) Selezionate Interruzione riga oppure Interruzione colonna in base alle vostre esigenze.

Adesso l'interruzione è impostata.

Interruzione riga
Selezionando Interruzione riga verrà creata un'interruzione di pagina sopra la cella selezionata. 
Ad esempio, se la cella attiva è la H15, l'interruzione verrà creata tra le righe 14 e 15.

Interruzione colonna
Selezionando Interruzione colonna verrà creata un'interruzione di pagina alla sinistra della cella 
selezionata. Ad esempio, se la cella attiva è la H15, l'interruzione verrà creata tra le colonne G 
ed H.

Suggerimento
Per vedere più facilmente le interruzioni di pagina sullo schermo, potete 
cambiare il loro colore. Scegliete Strumenti > Opzioni > LibreOffice > 
Aspetto e scorrete verso il basso, fino alla sezione Foglio elettronico.

Eliminare un'interruzione di pagina
Per eliminare un 'interruzione di pagina:

1) Posizionatevi in una cella accanto all'interruzione che volete rimuovere.

2) Selezionate Modifica > Elimina interruzione di pagina manuale.

3) Selezionate Interruzione riga oppure Interruzione colonna in base alle vostre necessità.

L'interruzione viene rimossa.

Nota

Nella stessa pagina possono esistere più interruzioni manuali, sia di riga che di 
colonna. Nel caso vogliate rimuoverle, dovete toglierle una ad una. Questo a volte 
può causare confusione, in quanto, in presenza di una interruzione di colonna 
nella pagina, andando in Modifica > Interruzione di pagina manuale, 
l'interruzione di colonna potrebbe essere mostrata in grigio.

Per rimuovere l'interruzione, dovete trovarvi nella cella ad essa adiacente. Ad 
esempio, se avete impostato l'interruzione di colonna dalla casella H15, non 
potrete rimuoverla dalla cella D15. Potrete comunque rimuoverla da qualsiasi cella 
della colonna H.
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Intestazioni e piè di pagina
Intestazioni e piè di pagina sono parti di testo predefinite che vengono stampate alla sommità ed in 
fondo al foglio, fuori dall'area della pagina. Le intestazioni vengono impostate allo  stesso modo dei 
piè di pagina.

Intestazioni e piè di pagina sono riferiti ad uno stile di pagina. Potete definire più stili di pagina per 
un foglio elettronico e assegnare stili diversi a fogli diversi. Per ulteriori informazioni sugli stili di 
pagina, consultate il Capitolo 4 (Uso di stili e modelli) della Guida a Calc.

Impostare una intestazione o un piè di pagina
Per impostare una intestazione oppure un piè di pagina:

1) Andate al foglio nel quale volete impostare l'intestazione o il piè di pagina. Scegliete 
Formato > Pagina.

2) Nella finestra di dialogo Stile di pagina, selezionate la scheda Riga d'intestazione (o Piè di 
pagina). Vedete la Figura 134.

3) Selezionate l'opzione Attiva riga d'intestazione.

Da qui potete anche impostare margini, altezza e spaziatura per l'intestazione o il piè di pagina. 
Potete spuntare la casella Adatta altezza dinamicamente per fare sì che l'altezza 
dell'intestazione o del piè di pagina venga adattata automaticamente.

Margine
Modificando la dimensione del margine destro o sinistro si determina la distanza 
dell'intestazione o del piè di pagina dal bordo della pagina.

Spaziatura
La spaziatura influisce sullo spazio che intercorre tra la pagina e l'intestazione o il piè di 
pagina. Quindi, se la distanza è impostata a 1 cm, ci sarà un centimetro di distanza tra 
l'intestazione o il piè di pagina e la pagina stessa.

Altezza
L'altezza influisce sulla dimensione dell'intestazione o del piè di pagina.

Figura 134: finestra di dialogo Riga d'intestazione
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Aspetto dell'intestazione e del piè di pagina
Per modificare l'aspetto dell'intestazione o del piè di pagina, fate clic sul pulsante Extra nella 
finestra di dialogo dell'intestazione. In tal modo si apre la finestra di dialogo Bordo/Sfondo (Figura 
135).

Da questa finestra di dialogo potete impostare lo sfondo ed il bordo dell'intestazione e del piè di 
pagina. Per ulteriori informazioni consultate il Capitolo 4 (Uso di stili e modelli) della Guida a Calc.

Figura 135: Intestazione/Piè di pagina - Bordo/Sfondo

Impostare il contenuto dell'intestazione o del piè di pagina
L'intestazione o il piè di pagina di un foglio elettronico di Calc ha tre colonne per il testo. Ogni 
colonna può avere contenuti differenti.

Per impostare i contenuti dell'intestazione o del piè di pagina, fate clic sul pulsante Modifica nella 
finestra di dialogo Riga d'intestazione o Piè di pagina mostrata in Figura 135 per aprire la finestra 
di dialogo mostrata in Figura 136.
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Figura 136: modifica dei contenuti dell'intestazione o del piè di pagina

Aree
Ogni area nell'intestazione o nel piè di pagina è indipendente e può contenere differenti 
informazioni.

Intestazione
Potete scegliere da una serie di possibilità predefinite nell'elenco a tendina, oppure inserire 
un'intestazione personalizzata utilizzando i pulsanti sotto le caselle delle aree. (Per formattare 
un piè di pagina, le opzioni sono le stesse.)

Intestazione personalizzata
Fate clic nell'area (Sinistra, Centro, Destra) che volete configurare, ed usate i pulsanti per 
aggiungere elementi o modificare gli attributi del testo.

Apre la finestra di dialogo Attributi di testo.

Inserisce il numero totale di pagine.

Inserisce il campo Nome del file.

Inserisce il campo Data.

Inserisce il campo Nome foglio.

Inserisce il campo Ora.

Inserisce il numero di pagina corrente.
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Introduzione a Impress

Impress è il programma di presentazioni (presentazioni di diapositive) incluso in LibreOffice. Con 
Impress potete creare diapositive contenenti molti elementi diversi, come testo, elenchi puntati e 
numerati, tabelle, diagrammi, e un'ampia varietà di oggetti grafici come clip art, disegni e 
fotografie. Inoltre Impress include il controllo ortografico, i sinonimi, stili di testo, e stili di sfondo.

Questo capitolo comprende istruzioni, schermate, e consigli utili per guidarvi attraverso l'ambiente 
di Impress nel corso della progettazione delle vostre presentazioni. Sebbene nel capitolo si faccia 
più volte riferimento a progetti impegnativi, le spiegazioni per crearli si trovano nella Guida a 
Impress. Raccomandiamo di usare la Guida a Impress come fonte di informazioni se avete già 
esperienza su come creare una presentazione di diapositive.

L'uso di Impress per una presentazione che non sia di livello estremamente semplice richiede la 
conoscenza degli elementi che possono essere contenuti nelle diapositive. Le diapositive 
contenenti testo utilizzano gli stili per determinare l'aspetto del testo. La creazione di disegni in 
Impress avviene in modo simile alla creazione di disegni nel programma Draw, incluso in 
LibreOffice. Per questa ragione è consigliabile consultare anche il Capitolo 3 (Uso di stili e modelli) 
e il Capitolo 7 (Guida introduttiva a Draw) in questo manuale. Potete inoltre vedere la Guida a 
Draw per maggiori dettagli su come utilizzare gli strumenti di disegno.

Avviare Impress

Potete avviare Impress in diversi modi:

• Dal Centro di Avvio di LibreOffice, se nessun altro componente è già aperto, fate clic sul 
pulsante Presentazione.

• Dal menu di sistema, il menu standard dal quale vengono avviate la maggior parte delle 
applicazione. In Windows, si chiama menu di Avvio (o di Start). In Gnome, è denominato 
menu delle Applicazioni. In KDE è identificato dal logo KDE. In Mac OS X, è il menu delle 
Applicazioni. I dettagli variano in base al sistema operativo; vedere il Capitolo 1 
(Introduzione a LibreOffice).

• In Windows, potete selezionare Presentazione nel Quickstart di LibreOffice. [Funzioni simili 
sono presenti in Mac e Linux; vedere il Capitolo 1 (Introduzione a LibreOffice)].

• Da qualsiasi componente aperto di LibreOffice. Fate clic sul triangolo a destra dell'icona 
Nuovo sulla barra degli strumenti principale e selezionate Presentazione dal menu a 
comparsa o scegliete File > Nuovo > Presentazione dalla barra dei menu.

Nota

Una volta che LibreOffice è stato installato sul vostro computer, nella maggior parte 
dei casi, una voce di menu per ogni componente è stata aggiunta al menu di 
sistema. Il nome e la posizione di queste voci del menu dipendono dal sistema 
operativo e dall'interfaccia grafica.

Quando avviate Impress per la prima volta, viene mostrata la Procedura guidata per la 
Presentazione. Qui potete scegliere tra le seguenti opzioni:

• Presentazione vuota, che creerà un documento vuoto

• Da modello, che è una presentazione disegnata con un modello di vostra scelta

• Apri una presentazione esistente

• Fate clic su Crea per aprire la finestra principale di Impress.
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Per istruzioni dettagliate riguardo all'utilizzo della Procedura guidata Presentazione, vedere 
“Creazione di una nuova presentazione” a pagina 180.

Se preferite non utilizzare la Procedura guidata Presentazione in futuro, potete selezionare Non 
mostrare questa Procedura guidata di nuovo. Potete abilitare nuovamente la Procedura guidata in 
seguito sotto Strumenti > Opzioni > LibreOffice Impress > Generale > Nuovo documento, 
selezionando l'opzione Inizia con procedura guidata.

La finestra principale di Impress

La finestra principale di Impress (Figura 137) si compone di tre parti: il riquadro Diapositive, l'area 
di lavoro, e il pannello delle Attività. Inoltre, diverse barre degli strumenti possono essere 
visualizzate o nascoste durante la creazione della presentazione.

Figura 137: finestra principale di Impress; gli ovali indicano i contrassegni Nascondi/Mostra

Suggerimento

Potete chiudere il riquadro Diapositive o il pannello delle Attività facendo clic 
sulla X nell'angolo destro superiore del pannello o scegliendo Visualizza > 
Riquadro diapositiva o Visualizza > Pannello delle attività per deselezionare 
il pannello. Per riaprire un pannello, scegliete nuovamente Visualizza > 
Riquadro diapositiva o Visualizza > Pannello delle attività.

Potete anche massimizzare l'area di lavoro facendo clic sui contrassegni 
Nascondi/Mostra che si trovano a metà delle linee di separazione verticali 
(indicate dagli ovali in Figura 137). Usando i contrassegni Nascondi/Mostra i 
pannelli Diapositive e Attività vengono nascosti, senza essere chiusi. Per 
ripristinare il pannello, fate nuovamente clic sul contrassegno Nascondi/Mostra.
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Riquadro diapositive
Il Riquadro diapositive contiene le immagini in miniatura delle diapositive della vostra 
presentazione, nell'ordine in cui verranno mostrate, a meno che non modifichiate l'ordine della 
presentazione. Facendo clic su una diapositiva in questo pannello la si seleziona e la si colloca 
nell'Area di lavoro. Quando una diapositiva si trova nell'Area di lavoro, potete modificarla a 
piacimento.

Potete eseguire un certo numero di operazioni addizionali su una o più diapositive 
simultaneamente nel Riquadro diapositive:

• Aggiungere nuove diapositive alla presentazione.

• Contrassegnare una diapositiva come nascosta, così che non venga mostrata come 
elemento della presentazione.

• Eliminare dalla presentazione una diapositiva non più necessaria.

• Rinominare una diapositiva.

• Duplicare una diapositiva (copia e incolla) o spostarla in una posizione differente nella 
presentazione (taglia e incolla).

È anche possibile eseguire le seguenti operazioni, sebbene vi siano metodi più efficaci dell'utilizzo 
del Pannello diapositive:

• Modificare la transizione della diapositiva che segue quella selezionata o tutte quelle 
facenti parte di un gruppo di diapositive.

• Modificare la sequenza delle diapositive nella presentazione.

• Cambiare il modello di diapositiva.

• Modificare il layout della diapositiva per un gruppo di diapositive simultaneamente.

Pannello delle attività
Il Pannello delle attività ha cinque sezioni. Per espandere la sezione che desiderate utilizzare, fate 
clic sulla barra del titolo di ciascuna sezione. È possibile espandere una sola sezione alla volta.

Pagine master
Qui si definisce lo Stile pagina (diapositiva) che verrà usato nella presentazione. Impress 
contiene diversi modelli di Pagine Master (diapositive master). Uno dei modelli - quello 
Predefinito - è vuoto, mentre gli altri hanno uno sfondo e del testo con uno stile ad esso 
applicato.

Suggerimento
Premete F11 per aprire la finestra Stili e formattazione , dove potete modificare 
gli stili usati in qualsiasi pagina master per adattarli alle vostre esigenze. Ciò 
può essere fatto in qualsiasi momento.

Layout
I layout inclusi in Impress vengono mostrati qui. È possibile scegliere quello che si desidera e 
usarlo così com'è, oppure modificarlo a seconda delle vostre esigenze. Non è comunque 
possibile salvare layout personalizzati.

Struttura tabella
In questa sezione vengono forniti gli stili di tabella predefiniti. È possibile modificare 
ulteriormente l'aspetto di una tabella con le opzioni per mostrare o nascondere specifiche righe 
e colonne, o per applicare un aspetto di fasce colorate a righe e colonne.
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Animazioni personalizzate
Per rimarcare o migliorare elementi differenti di ciascuna diapositiva sono disponibili diverse 
animazioni. La sezione Animazione personalizzata offre un modo semplice per aggiungere, 
cambiare, o rimuovere animazioni.

Cambio diapositiva
La sezione Cambio diapositiva offre accesso alle opzioni relative alla transizione delle 
diapositive. L'impostazione predefinita è Nessuna transizione, con la quale la diapositiva 
successiva semplicemente rimpiazza quella esistente. Sono comunque disponibili diverse altre 
transizioni. Potete anche specificare la velocità della transizione (lento, medio, veloce), 
scegliere tra una transizione automatica o manuale, e decidere il tempo di esposizione della 
diapositiva selezionata (solo per la transizione automatica).

Area di lavoro
L'Area di lavoro (che normalmente si trova al centro) ha cinque schede: Normale, Struttura, Note, 
Stampati, e Ordine diapositive (Figura 138). Queste cinque schede sono chiamate Pulsanti di 
visualizzazione. L'Area di lavoro sotto i Pulsanti di visualizzazione cambia a seconda della vista 
scelta. Le visualizzazioni dell'Area di lavoro sono descritte in dettaglio a pagina 175.

Figura 138: schede dell'Area di lavoro

Barre degli strumenti
Molte delle barre degli strumenti possono tornare utili durante la creazione delle diapositive; potete 
visualizzarle o nasconderle facendo clic su Visualizza > Barre degli strumenti ed effettuando una 
selezione dal menu che appare.

Potete inoltre selezionare le icone che volete mostrare in ogni barra degli strumenti. Per maggiori 
delucidazioni, fate riferimento al Capitolo 1 (Introduzione a LibreOffice).

Molte delle barre degli strumenti di Impress sono simili a quelle di Draw. Vedete la Guida a Draw 
per dettagli sulle funzioni disponibili e su come usarle.

Barra di stato
La Barra di stato, situata nella parte inferiore della finestra di Impress, contiene informazioni utili 
mentre si lavora ad una presentazione. Per dettagli sul contenuto e utilizzo di questi campi, vedere 
il Capitolo 1, Introduzione a LibreOffice in questa guida e il Capitolo 1 (Introduzione a Impress) 
nella Guida a Impress.

Nota
Le dimensioni sono espresse nell'unità di misura corrente (da non confondere con le 
unità dei righelli). Questa unità è definita in Strumenti > Opzioni > LibreOffice 
Impress > Generale.
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Figura 139: barra di stato

Da sinistra a destra, trovate:

• Area informazioni - cambia in base alla selezione. Ad esempio:

Selezione d'esempio Esempi delle informazioni mostrate

Area di testo Text Edit: Paragrafo x, Riga y, Colonna z

Grafici, fogli elettronici Oggetto incorporato (OLE) “NomeOggetto” 
selezionato

Grafico Bitmap con trasparenza selezionata

• Posizione del cursore - la posizione del cursore o dell'angolo superiore sinistro della 
selezione misurata dall'angolo superiore sinistro della diapositiva, seguita dalla larghezza e 
altezza della selezione o della casella di testo dove il cursore è posizionato.

• Modifiche non salvate - indica la necessità di salvare il file. Facendo doppio clic su questo 
indicatore si apre la finestra di dialogo salva.

• Firma digitale - indica se il documento è firmato digitalmente. Dopo il salvataggio del file, 
facendo doppio clic su questo indicatore si apre la finestra di dialogo firme digitali.

• Numero diapositiva - il numero della diapositiva correntemente visualizzata nell'Area di 
lavoro e il numero totale di diapositive nella presentazione.

• Stile di pagina (diapositiva) - lo stile associato alla diapositiva, stampato, o pagina note 
correntemente nell'Area di lavoro. Facendo doppio clic sul nome dello stile si apre la 
finestra di dialogo modello diapositiva.

• Cursore dello zoom – regola la percentuale dello zoom dell'Area di lavoro visualizzata.

• Percentuale dello zoom - indica la percentuale dello zoom dell'Area di lavoro visualizzata. 
Facendo doppio clic sulla percentuale dello zoom si apre la finestra di dialogo zoom e 
layout visualizzazione.

• Potete nascondere le informazioni nella Barra di stato selezionando Visualizza > Barra di 
stato dal menu principale.

Navigatore
Il Navigatore mostra tutti gli oggetti contenuti in un documento. Permette di spostarsi all'interno di 
un documento e di individuare gli oggetti in esso contenuti. Per visualizzare il Navigatore, fate clic 

sulla sua icona  sulla barra degli strumenti Standard, scegliete Visualizza > Navigatore sulla 
barra dei menu, oppure premete Ctrl+Maiusc+F5.

Il Navigatore è molto utile se date alle diapositive e agli oggetti (fotografie, fogli elettronici, etc) dei 
nomi significativi, al posto di lasciare i nomi predefiniti, come “Diapositiva 1” e “Forma 2”.
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Figura 140: il Navigatore

Vista Area di lavoro

Ciascuna delle viste dell'Area di lavoro è disegnata per facilitare determinati compiti; è quindi utile 
familiarizzare con esse al fine di eseguire tali compiti velocemente.

Nota

Quando selezionata, ciascuna vista dell'Area di lavoro mostra un insieme 
differente di barre degli strumenti. Questi insiemi di barre degli strumenti possono 
essere personalizzati andando su Visualizza > Barre degli strumenti, quindi 
mettendo o togliendo la spunta dalla barra degli strumenti che desiderate 
aggiungere o rimuovere.

Vista normale
La vista Normale è la visualizzazione principale per lavorare con la singola diapositiva. Usate 
questa visualizzazione per formattare e strutturare, aggiungere testo, grafici e effetti di animazione.

Per collocare una diapositiva nell'area di disegno (Vista normale) (Figura 137), fate clic sulla 
miniatura nel riquadro Diapositive oppure fate doppio clic sulla miniatura all'interno del Navigatore 
(pagina 174).

Vista struttura
La visualizzazione Struttura contiene tutte le diapositive della presentazione numerate in 
sequenza. Mostra i titoli e gli elenchi puntati e numerati per ciascuna diapositiva nel formato 
struttura. Viene mostrato solo il testo contenuto nelle caselle di testo predefinite di ogni diapositiva, 
così che se la vostra diapositiva contiene altre caselle di testo o oggetti di disegno , il testo di 
questi oggetti non viene visualizzato. Anche i nomi delle diapositive non sono inclusi.
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Figura 141: vista struttura

Potete utilizzare la Vista struttura per le seguenti operazioni.

1) Effettuare modifiche nel testo di una diapositiva:

• Aggiungere e cancellare il testo in una diapositiva, esattamente come nella vista 
Normale.

• Spostare i paragrafi di testo nella diapositiva selezionata verso l'alto o verso il basso 
usando i pulsanti freccia verso l'alto o verso il basso (Verso l'alto o Verso il basso) 
sulla barra degli strumenti Formattazione del testo (evidenziata in Figura 142).

• Modificare il livello Struttura per ognuno dei paragrafi in una diapositiva usando i 
pulsanti freccia Sinistra e Destra. (Un livello più alto o un livello più basso) sulla barra 
degli strumenti Formattazione del testo.

• Spostare un paragrafo e modificarne il livello struttura usando una combinazione delle 
quattro frecce.

2) Confrontare le diapositive con la vostra struttura (se ne avete preparata una). Se vi rendete 
conto, attraverso la struttura, che vi occorre un'altra diapositiva, potete crearla direttamente 
in Vista struttura oppure crearla ritornando in visualizzazione Normale.

Figura 142: barra degli strumenti Formattazione del testo

Vista Note
Utilizzate la Vista note (Figura 143) per aggiungere note a una diapositiva. Queste note non sono 
visualizzate nel corso della presentazione.
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Figura 143: vista note

1) Fate clic sulla scheda Note nell'Area di lavoro.

2) Selezionate la diapositiva alla quale desiderate aggiungere le note.

• Fate clic sulla diapositiva nel riquadro delle Diapositive, oppure

• fate doppio clic sul nome della diapositiva nel Navigatore.

3) Nella casella di testo sotto la diapositiva, fate clic sulle parole "Fate clic per aggiungere 
note" e iniziate a digitare.

Potete ridimensionare il riquadro di testo delle Note usando le maniglie colorate di 
ridimensionamento che compaiono quando fate clic sul bordo del riquadro. Potete anche spostare 
il riquadro posizionando il puntatore sul bordo, quindi facendo clic e trascinando. Per eseguire 
delle modifiche nello stile del testo, premete il tasto F11 per aprire la finestra Stili e formattazione.

Vista Stampati
La vista Stampati serve a impostare il layout della diapositiva per poterla stampare. Fate clic sulla 
scheda Stampati nell'area di lavoro, quindi scegliete Layout nel pannello Attività. Potete scegliere 
di stampare una, due, tre, quattro, sei o nove diapositive per pagina.
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Figura 144: layout Stampati

Potete usare questa vista anche per personalizzare le informazioni da inserire nello stampato. Fate 
riferimento al Capitolo 10 (Stampa, invia come e-mail, esportazione e salvataggio presentazioni) 
nella Guida a Impress per istruzioni sulla stampa di diapositive, stampati e note.

Selezionate dal menu principale Inserisci > Numero di pagina oppure Inserisci > Data e ora e 
nella finestra di dialogo che si apre fate clic sulla scheda Note e stampati (Figura 145). Potete 
usare questa finestra di dialogo per selezionare gli elementi che desiderate far comparire su 
ciascuna pagina dello stampato e i loro contenuti. Ulteriori dettagli su come utilizzare questa 
finestra di dialogo sono forniti nella Guida a Impress.

Figura 145: finestra di dialogo per impostare le informazioni della pagina per stampati e 
note
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Vista ordine diapositive
La vista Ordine diapositive (Figura 146) riporta tutte le miniature delle diapositive. Usate questa 
visualizzazione per lavorare con un gruppo di diapositive o con una singola diapositiva.

Figura 146: vista Ordine diapositive

Personalizzare la vista Ordine diapositive
Per modificare il numero di diapositive per riga:

1) Spuntate Visualizza > Barre degli strumenti > Ordine diapositive e Vista diapositiva 
per mostrare o nascondere le barre degli strumenti Ordine diapositive e Vista diapositiva 
(Figura 147).

2) Definite il numero di diapositive (fino ad un massimo di 15).

Figura 147: barre degli strumenti Ordine diapositiva 
e Vista diapositiva

Spostare una diapositiva usando Ordine diapositive
Per spostare una diapositiva nella presentazione, in Ordine diapositive:

1) Fate clic sulla diapositiva per evidenziarla (vedere Figura 146).

2) Trascinatela e rilasciatela nella posizione desiderata.
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Selezionare e spostare gruppi di diapositive
Per selezionare un gruppo di diapositive, utilizzate uno di questi metodi:

• Usate il tasto Ctrl: fate clic sulla prima diapositiva e, mentre mantenete premuto il tasto Ctrl, 
selezionate le altre diapositive che desiderate.

• Usate il tasto Maiusc: Fate clic sulla prima diapositiva e, mentre mantenendo premuto il 
tasto Maiusc, selezionate l'ultima diapositiva del gruppo. Questo selezionerà tutte le 
diapositive comprese tra la prima e l'ultima.

• Usate il mouse: fate clic leggermente a lato (sinistro o destro) della prima diapositiva da 
selezionare. Tenete premuto il pulsante sinistro del mouse e trascinate il puntatore del 
mouse fino a evidenziare tutte le diapositive che volete selezionare.

Per spostare un gruppo di diapositive:

1) Selezionate un gruppo di diapositive.

2) Trascinate e rilasciate il gruppo fino alla nuova posizione.

Lavorare in vista Ordine diapositive
Potete lavorare con le diapositive in visualizzazione Ordine diapositive esattamente come nel 
riquadro Diapositive.

Per apportare delle modifiche, fate clic con il pulsante destro del mouse su una diapositiva e 
scegliete una delle seguenti voci dal menu contestuale:

• Aggiungere una nuova diapositiva dopo la diapositiva selezionata.

• Eliminare la diapositiva: elimina la diapositiva selezionata.

• Rinominare la diapositiva: vi permette di rinominare la diapositiva selezionata.

• Layout diapositiva: vi permette di modificare il layout della diapositiva selezionata.

• Transizione diapositiva: vi permette di modificare la transizione della diapositiva 
selezionata.

– Per una diapositiva, fatevi clic sopra per selezionarla e poi aggiungete la transizione 
desiderata.

– Per più di una diapositiva, selezionate il gruppo di diapositive e aggiungete la 
transizione desiderata.

• Nascondere diapositiva: le diapositive nascoste non vengono visualizzate nella 
presentazione.

• Taglia: rimuove la diapositiva selezionata e la salva negli appunti.

• Copia: copia la diapositiva selezionata negli appunti senza rimuoverla.

• Incolla: inserisce una diapositiva dagli appunti. Questa opzione vi permetterà anche di 
specificare se desiderate incollare la diapositiva copiata prima o dopo quella selezionata.

Creazione di una nuova presentazione

Questa sezione descrive come iniziare una nuova presentazione usando la Presentazione guidata.

Suggerimento

Come prima cosa occorre decidere lo scopo della presentazione e pianificarla. 
Sebbene sia possibile modificare la presentazione mentre la preparate, avere 
un'idea del pubblico di riferimento, della struttura, del contenuto, di come verrà 
tenuta la presentazione, vi risparmierà molto tempo fin dall'inizio.
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Quando avviate Impress, vi apparirà la Presentazione guidata (Figura 148).

Figura 148: scegliere il tipo di presentazione

1) Sotto Tipo, scegliete una delle opzioni. Queste opzioni sono trattate nella Guida a Impress.

• Presentazione vuota crea una presentazione vuota.

• Da modello utilizza un modello di pagina già creato come base per una nuova 
presentazione. La procedura guidata si modifica per mostrare un elenco di modelli 
disponibili. Scegliete il modello desiderato.

• Apri una presentazione esistente permette di continuare il lavoro su una 
presentazione creata in precedenza. La procedura guidata si modifica per mostrare 
un elenco di presentazioni esistenti. Scegliete la presentazione desiderata.

2) Fate clic su Avanti. La Figura 149 mostra il secondo passaggio della Presentazione 
guidata, come appare selezionando Presentazione vuota nel primo passaggio. 
Selezionando Da modello, nel riquadro dell'anteprima viene mostrato un esempio di 
diapositiva.
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Figura 149: selezionare un modello diapositiva

3) Scegliete un modello sotto Scegliete un modello di pagina. La sezione dei modelli di 
diapositiva offre due scelte principali: Sfondi di presentazione e Presentazioni. Ciascuno ha 
un elenco di opzioni di modelli di diapositiva. Se invece di <Originale> desiderate usare 
uno di questi modelli, fate clic per selezionarlo.

• I diversi tipi di Sfondi di presentazione sono mostrati in Figura 149. Facendo clic su 
un'opzione, vedrete l'anteprima di quel modello di diapositiva nella finestra 
dell'Anteprima. Impress contiene tre opzioni sotto Presentazioni: <Originale>, 
Presentazione di una novità, e Consiglio di strategia.

• <Originale> è per un modello di diapositiva di presentazione vuoto.

• Entrambe le opzioni Presentazione di una novità e Consiglio di strategia dispongono 
di propri modelli di pagina predefiniti. Quando si fa clic sul nome, ciascun modello 
appare nella finestra dell'Anteprima.

Nota
Presentazione di una novità e Consiglio di strategia sono modelli di presentazione 
predefiniti. Essi possono essere usati per creare una presentazione scegliendo Da 
modello nel primo passaggio (Figura 148).

4) Indicate come verrà usata la presentazione sotto Selezione del mezzo di destinazione. 
Nella maggior parte dei casi, le presentazioni sono create per essere visualizzate sullo 
schermo del computer. Selezionate Schermo. Potete modificare il formato di pagina in 
qualsiasi momento.

Nota

La pagina Schermo è ottimizzata per uno schermo a 4:3 (28cm x 21cm) quindi non è 
adatta per i moderni schermi widescreen. Potete cambiare la dimensione della 
diapositiva in qualsiasi momento passando alla Vista Normale e selezionando 
Formato > Pagina.

5)  Fate clic su Avanti. Apparirà il terzo passaggio della Presentazione guidata (Figura 150).

• Scegliete il tipo di transizione desiderata dal menu a comparsa Effetto.
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• Selezionate la velocità di transizione tra le diverse diapositive della presentazione dal 
menu a comparsa Velocità. Medio è per il momento una buona scelta.

6) Fate clic su Crea. Verrà creata una nuova presentazione.

Figura 150: selezionare un effetto di transizione tra le diapositive

Suggerimento

Potete accettare i valori predefiniti sia per Effetto che per Velocità, a meno che 
non siate esperti nella creazione di presentazioni. Entrambi i valori possono 
essere cambiati in seguito, lavorando con Cambio diapositive e Animazioni. 
Queste due funzionalità sono discusse più dettagliatamente nel Capitolo 9 
(Presentazioni) della Guida a Impress.

Nota
Se avete selezionato Da modello nel passaggio 1 della Procedura guidata, il pulsante 
Avanti sarà attivo nel passaggio 3 e saranno disponibili altre pagine, che non sono 
descritte in questa sede.

Attenzione

Ricordate di salvare frequentemente mentre lavorate con la presentazione, per 
impedire qualsiasi perdita di informazioni che potrebbe accadere per un qualsiasi 
evento inatteso. Eventualmente attivate la funzione Ripristino automatico 
(Strumenti > Opzioni > Carica/Salva . Generale). Assicuratevi che sia 
selezionata la voce Salva informazioni di ripristino automatico ogni e che 
abbiate inserito il numero dei minuti per la frequenza di salvataggio.
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Formattazione di una presentazione

Una presentazione nuova contiene solamente una diapositiva vuota. In questa sezione inizieremo 
ad aggiungere nuove diapositive e a prepararle per i contenuti che desiderate inserire.

Inserimento di diapositive 
È possibile farlo in molti modi; sceglietene uno.

• Inserisci > Diapositiva.

• Tasto destro sulla diapositiva corrente, e selezionate Diapositiva > Nuova diapositiva dal 
menu contestuale.

• Fate clic sull'icona Diapositiva  nella barra degli strumenti Presentazione.

A volte, invece di iniziare da una nuova diapositiva, potreste voler duplicare una diapositiva già 
inserita. Per duplicare una diapositiva, selezionate la diapositiva desiderata dal riquadro 
Diapositive e poi scegliete Inserisci > Duplica diapositiva.

Selezionare un layout
Nel pannello delle Attività, aprite la sezione Layout per mostrare i layout disponibili (Figura 151). I 
Layout differiscono per il numero di elementi contenuti nella diapositiva, da una diapositiva vuota a 
una con sei riquadri per i contenuti e un titolo.

Figura 151: layout diapositiva disponibili

La prima diapositiva in una presentazione è normalmente una diapositiva introduttiva. La 
Diapositiva Titolo (che ha anche una sezione per il sottotitolo) o la diapositiva Solo Titolo sono 
layout adatti per la prima diapositiva, mentre per la maggior parte delle diapositive è più adatto il 
layout Titolo, Contenuto.
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Per creare il titolo, fate clic su Fate clic per aggiungere un titolo (poniamo che non si utilizzi il layout 
Diapositiva vuota) e quindi scrivete il testo del titolo. Per adattare la formattazione del titolo, 
modificate lo stile di presentazione Titolo; vedere il Capitolo 2 (Uso di diapositive master, stili e 
modelli) della Guida a Impress per istruzioni.

Se state usando il layout Diapositiva Titolo, fate clic su Fate clic per aggiungere testo per 
aggiungere un sottotitolo. Se avete necessità di fare correzioni sul formato, procedete come 
spiegato sopra, modificando però lo stile di presentazione Sottotitolo.

Nota

Il testo e gli elementi grafici possono essere riadattati in qualsiasi momento durante la 
preparazione della presentazione, ma la modifica del layout di una diapositiva che ha 
già dei contenuti può avere effetti drammatici. Si consiglia quindi di porre particolare 
attenzione alla selezione del layout. Se avete effettivamente necessità di modificare il 
layout dopo aver inserito dei contenuti, i contenuti non andranno persi, ma potrebbe 
essere necessario riformattarli.

Suggerimento

Per vedere i nomi dei layout inclusi, utilizzate la funzione Suggerimento: 
posizionate il cursore su un'icona nella sezione Layout (o su una icona qualsiasi 
delle barre degli strumenti) e il suo nome verrà visualizzato in un piccolo 
rettangolo.

Se i suggerimenti non sono abilitati, scegliete Strumenti > Opzioni > 
LibreOffice > Generale > Guida e selezionate l'opzione Suggerimenti. Se è 
selezionata anche l'opzione Guida attiva otterrete suggerimenti più dettagliati, 
ma i nomi dei suggerimenti stessi non verranno mostrati.

Per selezionare o cambiare il layout, posizionate la diapositiva nell'area di lavoro e selezionate il 
layout desiderato dalla sezione dei layout nel pannello Attività.

Diversi layout contengono uno o più riquadri per i contenuti. Ciascuno di questi riquadri può essere 
configurato per contenere uno dei seguenti elementi: Testo, Filmati, Immagini, Grafici o Tabelle.

Potete scegliere il tipo di contenuti facendo clic sull'icona corrispondente che è mostrata al centro 
del riquadro, come mostrato in Figura 152. Se invece intendete usare il riquadro per inserire del 
testo, fate clic in qualsiasi punto del riquadro per visualizzare il cursore.
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Figura 152: selezione del tipo di contenuti

Per selezionare o cambiare il layout, posizionate la diapositiva nell'area di lavoro e selezionate il 
layout desiderato dalla sezione dei layout nel pannello Attività.

Se avete selezionato un layout con uno o più riquadri per contenuti, questo è il momento di 
decidere il tipo di contenuti che desiderate inserire.

Modificare gli elementi di una diapositiva
In questa fase, la diapositiva contiene elementi presenti nella diapositiva master, così come 
elementi inclusi nel layout della diapositiva selezionata. È comunque improbabile che i layout 
predefiniti soddisfino tutte le vostre necessità. Potreste voler rimuovere elementi non necessari o 
inserire oggetti come testo e immagini

Sebbene in Impress non sia presente una funzione per creare nuovi layout, è possibile 
ridimensionarne e spostarne gli elementi. È anche possibile aggiungere elementi senza essere 
limitati dalla dimensione e posizione dei riquadri dei layout.

Per ridimensionare un riquadro per i contenuti, fate clic sulla cornice esterna, in modo da 
visualizzare le 8 maniglie di ridimensionamento. Per spostarlo posizionate il cursore del mouse 
sulla cornice, in modo che il cursore cambi forma. Potete ora fare clic con il pulsante sinistro del 
mouse e trascinare il riquadro nella sua nuova posizione all'interno della diapositiva.

Per rimuovere elementi indesiderati fate in questo modo:

1) Fate clic sull'elemento per evidenziarlo. Le maniglie colorate di ridimensionamento indicano 
che è evidenziato.

2) Premente il tasto Canc per eliminarlo.

Attenzione
Le modifiche ai layout inclusi in Impress si possono effettuare solo usando 
Visualizza > Normale, che corrisponde all'impostazione predefinita. Tentare di 
effettuare delle modifiche del master di una diapositiva, sebbene possibile, potrebbe 
avere risultati imprevedibili e richiede particolare attenzione; potrebbe peraltro 
comportare un certo numero di prove ed eventuali errori.
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Aggiungere testo a una diapositiva
Per aggiungere del testo a una diapositiva che contiene una cornice di testo, fate clic su Fate clic 
per aggiungere testo nella cornice di testo e poi digitate il vostro testo. Gli stili di Struttura vengono 
automaticamente applicati al testo mentre lo inserite. Potete modificare il livello di struttura di ogni 
paragrafo così come la sua posizione all'interno del testo usando i pulsanti freccia sulla barra degli 
strumenti Formattazione del testo (vedere Vista struttura a pagina 175). Per maggiori informazioni 
sul testo, vedere “Aggiungere e formattare il testo” a pagina 188.

Aggiungere immagini o oggetti a una diapositiva
Per aggiungere immagini o oggetti a una diapositiva, ad esempio una foto, clip art, un disegno, una 
fotografia, oppure un foglio elettronico, fate clic su Inserisci quindi selezionate dal menu a discesa 
il tipo di inserimento desiderato. Per maggiori informazioni, vedere “Aggiungere immagini, tabelle, 
grafici e contenuti multimediali” a pagina 193.

Modificare l'aspetto di tutte le diapositive
Per modificare lo sfondo ed altre caratteristiche di tutte le diapositive della presentazione, occorre 
modificare la pagina master o scegliere una pagina master differente, come spiegato nella sezione 
“Lavorare con pagine master e stili” a pagina 196.

Un Master di una diapositiva è una diapositiva con uno specifico insieme di caratteristiche che 
funziona come un modello e viene utilizzato come punto d'inizio per creare altre diapositive. 
Queste caratteristiche comprendono lo sfondo, gli oggetti di sfondo, la formattazione del testo che 
sarà utilizzato, ed ogni immagine inclusa nello sfondo.

Nota

LibreOffice usa tre termini intercambiabili per questo concetto. Diapositiva master, 
Master di diapositiva, e pagina master. Tutti questi termini si riferiscono a una 
diapositiva che viene usata come modello per crearne altre. Questo manuale, 
comunque, usa solamente il termine master di diapositiva, tranne quando si 
descrive l'interfaccia utente.

Impress include diversi master di diapositive, che si trovano nella sezione Pagine Master del 
pannello delle Attività. Potete anche creare e salvare nuovi master di diapositive o aggiungerne da 
altre fonti. Vedere il Capitolo 2 (Uso di diapositive master, stili e modelli) nella Guida a Impress per 
informazioni sulla creazione e modifica dei master di diapositiva.

Se tutto ciò che dovete fare è modificare lo sfondo, potete utilizzare questa scorciatoia:

1) Selezionate Formato > Pagina e andate alla scheda Sfondo.

2) Selezionate lo sfondo desiderato tra colore, sfumatura, tratteggio e bitmap.

3) Fate clic su OK per applicarlo.

Apparirà una finestra di dialogo dove indicare se si desidera impostare lo sfondo per tutte le 
diapositive. Se fate clic su sì, Impress modificherà automaticamente la pagina master.

Nota

L'inserimento e la corretta formattazione dello sfondo sono argomenti che vanno 
oltre lo scopo di questo capitolo, ma potete trovare tutte le informazioni di cui avete 
bisogno nel Capitolo 4 (Modificare gli attributi degli oggetti) della Guida a Draw 
oppure nel Capitolo 6 (Formattazione di oggetti grafici) della Guida a Impress.

Capitolo 6  Guida introduttiva a Impress 187



Modificare la presentazione
Per impostazione predefinita la presentazione mostrerà tutte le diapositive nello stesso ordine in 
cui appaiono nella visualizzazione Ordine diapositive, senza alcuna transizione tra le diapositive, e 
dovrete interagire con la tastiera o il mouse per spostarvi da una diapositiva all'altra.

Potete utilizzare il menu della Presentazione per cambiare l'ordine delle diapositive, scegliere quali 
mostrare, automatizzare lo spostamento da una diapositiva all'altra, e altre impostazioni. Per 
modificare la transizione delle diapositive, inserire animazioni, aggiungere una traccia audio alla 
presentazione, ed eseguire altre migliorie, dovrete fare uso delle funzioni nel pannello delle Attività. 
Vedere la Guida a Impress per dettagli sull'utilizzo di queste funzioni.

Aggiungere e formattare il testo

Probabilmente molte delle vostre diapositive contengono del testo. Questa sezione offre alcune 
linee guida su come aggiungere testo e modificarne l'aspetto. Il testo nelle diapositive è contenuto 
in caselle di testo. Per maggiori informazioni sull'aggiunta e la formattazione del testo, vedere il 
Capitolo 3 (Aggiungere e formattare testo), nella Guida a Impress.

Potete aggiungere due tipi di  caselle di testo a una diapositiva:

• Scegliete un layout predefinito dalla sezione Layout del pannello delle Attività, senza 
selezionare uno speciale tipo di contenuti. Queste caselle di testo vengono chiamate 
caselle di testo AutoLayout.

• Create una casella di testo usando lo strumento di testo  nella barra degli strumenti 
Disegno o in quella Testo.

Utilizzare caselle di testo AutoLayout
Assicuratevi che sia selezionata la visualizzazione Normale:

1) Fate clic nella casella di testo che riporta Fate clic per aggiungere testo.

2) Digitate o incollate il vostro testo nella casella di testo.

Usare le caselle di testo create tramite lo strumento testo
Assicuratevi che sia selezionata la visualizzazione Normale:

1) Fate clic sull'icona Testo  sulla barra degli strumenti Disegno oppure premete F2. Se la 
barra degli strumenti Disegno con l'icona testo non è visibile, scegliete Visualizza > Barre 
degli strumenti > Disegno.

2) Fate clic e trascinate per creare un riquadro per il testo sulla diapositiva. Non 
preoccupatevi della dimensione e posizione verticale, in quanto la casella di testo si 
espanderà, se necessario, mentre voi scrivete.

3) Rilasciate il pulsante del mouse quando avete finito. Il cursore apparirà nella casella di 
testo, che si trova ora in modalità modifica (bordo grigio con tratteggio obliquo mostrato in 
Figura 153).

4) Digitate o incollate il vostro testo nella casella di testo.

5) Fate clic al di fuori della casella di testo per deselezionarla.

Potete muovere, ridimensionare e cancellare le caselle di testo. Per maggiori informazioni, vedere 
il Capitolo 3 (Aggiungere e formattare testo) nella Guida a Impress.
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Figura 153: creare e modificare caselle di testo

Usare le caselle di testo create tramite la barra degli strumenti Testo
Assicuratevi che sia selezionata la visualizzazione Normale:

1) Fate clic sull'icona Testo  nella barra degli strumenti Testo (Figura 154). Se la barra 
degli strumenti Testo con l'icona testo non è visibile, scegliete Visualizza > Barre degli 
strumenti > Testo.

2) Fate clic e trascinate per creare un riquadro per il testo sulla diapositiva. In tale modo viene 
impostata la larghezza. Non preoccupatevi dell'altezza, in quanto la casella di testo si 
espanderà mentre digitate.

3) Rilasciate il pulsante del mouse quando avete finito. Il cursore apparirà nella casella di 
testo, che si trova ora in modalità modifica (bordo grigio con tratteggio obliquo; vedere la 
Figura 153).

4) Scrivete o incollate il vostro testo nella casella di testo.

5) Fate clic al di fuori della casella di testo per deselezionarla.

Figura 154: barra degli 
strumenti Testo

Nota Oltre alle normali caselle di testo dove il testo è allineato orizzontalmente, è 
possibile inserire caselle di testo dove il testo viene allineato verticalmente. Questa 
scelta è disponibile solo quando le lingue Asiatiche sono abilitate in Strumenti > 

Opzioni > Impostazioni della lingua > Lingue. Fate clic sul pulsante nella 
barra degli strumenti disegno o in quella testo per creare una casella di testo 
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verticale.

Ridimensionamento veloce dei caratteri

Impress dispone di icone  sulla barra degli strumenti Formattazione del testo per aumentare 
o diminuire la dimensione del carattere del testo selezionato. Il dimensionamento dipende dalle 
dimensioni predefinite disponibili per il carattere in uso.

Incollare testo
Il testo può essere inserito nella casella di testo copiandolo da un altro documento e incollandolo in 
Impress. Tuttavia, il testo incollato probabilmente non avrà la formattazione del testo circostante o 
quella delle altre diapositive della presentazione. Questo potrebbe corrispondere a quanto 
desiderate in alcune occasioni; tuttavia, nella maggior parte dei casi si desidera fare in modo che 
lo stile della presentazione sia coerente e la presentazione non si trasformi in un mosaico di diversi 
stili di paragrafo, tipi di carattere, punti e così via. Ci sono diversi modi per garantire la coerenza; 
questi metodi vengono illustrati di seguito.

incollare testo senza formattazione
Normalmente è una buona pratica incollare il testo senza formattazione e applicare la 
formattazione successivamente. Per incollare del testo privo della sua formattazione, 
premete,Ctrl+Maiusc+V e selezionate quindi Testo non formattato dalla finestra di dialogo che 
appare, oppure fate clic sul piccolo triangolo nero di fianco al simbolo incolla sulla barra degli 

strumenti standard  e selezionate Testo non formattato. Il testo non formattato verrà 
formattato con lo stile di struttura relativo alla posizione del cursore in una casella di testo 
AutoLayout oppure con lo stile grafico predefinito in una normale casella di testo.

Formattare il testo incollato
Se incollate il testo in un spazio AutoLayout, dovete applicare lo stile di struttura appropriato al 
testo per dargli lo stesso aspetto del resto della presentazione.

1) Incollate il testo nella posizione desiderata. Non preoccupatevi se non vi apparirà 
gradevole; occorrerà solo un minuto per sistemarlo.

2) Selezionate il testo appena incollato.

3) Selezionate Formato > Formattazione predefinita dalla barra dei menu.

4) Utilizzate i quattro tasti freccia della barra degli strumenti Formattazione del testo 
(evidenziata in Figura 142) per spostare il testo nella posizione appropriata e dargli 
l'opportuno livello di struttura. Il pulsante con la freccia puntata a sinistra eleva la voce 
dell'elenco di un livello (per esempio da Struttura 3 a Struttura 2), il pulsante con la freccia 
puntata a destra abbassa la voce dell'elenco di un livello, le frecce che puntano verso l'alto 
e verso il basso invece spostano la voce dell'elenco verso l'alto e verso il basso.

5) Applicate la formattazione manuale come desiderato alle sezioni del testo (per modificare 
gli attributi dei caratteri, le tabulazioni e così via).

Se avete incollato del testo in una casella di testo, potete comunque usare gli stili per formattare il 
testo velocemente. Notate che uno ed un solo stile grafico può essere applicato al testo copiato. 
Per fare ciò:

1) Incollate il testo nella posizione desiderata.

2) Selezionate il testo appena incollato.
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3) Selezionate lo stile grafico desiderato.

4) Applicate la formattazione manuale come desiderato alle sezioni del testo.

Creazione di elenchi puntati e numerati
La procedura per creare un elenco puntato o numerato è leggermente differente e dipende dal tipo 
di casella di testo utilizzata, anche se gli strumenti per gestire gli elenchi e personalizzarne 
l'aspetto sono gli stessi.

Nelle caselle di testo create automaticamente da Impress (chiamate AutoLayout), gli stili di 
struttura disponibili sono, per impostazione predefinita, gli elenchi puntati, mentre per le normali 
caselle di testo viene richiesto un ulteriore passo per creare un elenco puntato.

Creazione degli elenchi nelle caselle di testo AutoLayout
Ogni casella di testo inclusa nei layout disponibili è già formattata come un elenco puntato, quindi 
per creare un elenco puntato è solo necessario applicare le seguenti misure:

1) Dal pannello del Layout, scegliete un modello di diapositiva contenente una casella di 
testo. Queste sono facilmente riconoscibili dall'anteprima.

2) Fate clic all'interno della casella di testo dove leggete Fate clic per aggiungere una 
struttura.

3) Digitate il testo, quindi premete Invio per iniziare una nuova linea puntata.

I metodi per modificare l'elenco da puntato a numerato e viceversa sono spiegati in “Modificare 
l'aspetto dell'elenco” a pagina 192.

Suggerimento

Premete Maiusc+Invio per inserire una nuova linea senza creare un nuovo 
punto o numero. La nuova linea avrà lo stesso rientro della linea precedente. 
Per disabilitare l'elenco puntato, fate clic sul pulsante elenco puntato on/off  
sulla barra degli strumenti Formattazione del testo. Se la barra degli strumenti 
Formattazione del testo non è visualizzata, abilitatela selezionando Visualizza 
> Barre degli strumenti > Formattazione del testo (Figura 142) nella barra 
dei menu.

Creare elenchi in altre caselle di testo
Per creare un elenco in una casella di testo, seguite questi passi:

1) Portate il cursore nella casella di testo.

2) Fate clic sul pulsante Elenco puntato on/off  sulla barra degli strumenti Formattazione 
del testo.

3) Digitate il testo e premete Invio per iniziare una nuova linea puntata.

4) Il tipo di elenco predefinito è un elenco puntato. I metodi per modificare l'aspetto dell'elenco 
sono spiegati a pagina 192.

Creare un nuovo livello di struttura
1) Se necessario, premete Invio per cominciare una nuova linea.

2) Premete Tabulazione oppure fate clic sulle frecce di indentazione  nella barra degli 
strumenti Formattazione del testo. Ogni volta che premete il tasto Tabulazione oppure fate 
clic sulla freccia a destra, il rientro della linea passa al livello di struttura successivo. 
Premete Invio per creare una nuova linea allo stesso livello della linea precedente. Per 
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tornare al precedente livello, premete Maiusc+Tabulazione oppure fate clic sulla freccia a 
sinistra.

Nelle caselle di testo AutoLayout, alzare o abbassare un elemento nell'elenco corrisponde 
all'applicazione di un differente stile di struttura, così che il secondo livello di struttura corrisponde 
allo stile Struttura 2, il terzo allo stile Struttura 3, e così via. Di conseguenza, una modifica nel 
livello produce anche altre modifiche (ad esempio le dimensioni del carattere, il tipo di punto, e 
così via).

Nota
Non tentate di modificare il livello di struttura selezionando il testo e quindi facendo 
clic sullo stile di struttura desiderato come fareste in Writer. A causa del modo in cui 
funzionano gli stili di presentazione, non è possibile applicarli in questo modo.

Modificare l'aspetto dell'elenco
Potete completamente personalizzare la rappresentazione di un elenco, modificando il tipo di punti 
o la numerazione per l'intero elenco o per la singola voce. Tutte le modifiche possono essere 
effettuate tramite la finestra di dialogo Elenchi puntati e numerati, a cui potete accedere 
selezionando Formato > Elenchi puntati e numerati o facendo clic sull'icona Elenchi puntati e 
numerati sulla barra degli strumenti Formattazione del testo.

Per l'intero elenco:

1) Selezionate l'intero elenco o fate clic sul bordo grigio della casella di testo, in modo da 
visualizzare le maniglie colorate di ridimensionamento.

2) Selezionate Formato > Elenchi puntati e numerati o fate clic sull'icona Elenchi puntati e 

numerati  sulla barra degli strumenti Formattazione del testo.

3) La finestra di dialogo Elenchi puntati e numerati (Figura 155) contiene cinque schede: 
Punti, Tipo di numerazione, Immagini, Posizione e Opzioni.

• Se si ha necessità di un elenco puntato, selezionate lo stile di punto desiderato dagli 
stili predefiniti disponibili nella pagina Punti.

• Se desiderate uno stile immagine, selezionatene uno da quelli disponibili nella pagina 
Immagini.

• Se desiderate un elenco numerato, selezionate uno degli stili di numerazione 
predefiniti nella pagina Tipo di numerazione.
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Figura 155: la finestra di dialogo Elenchi puntati e numerati

Per una singola linea nell'elenco, fate clic in qualsiasi punto all'interno della linea per posizionarvi il 
cursore e poi seguite i passi 2 e 3 nel precedente gruppo di istruzioni.

Se l'elenco era stato creato in una casella di testo AutoLayout, un modo alternativo per modificare 
l'intero elenco è quello di modificare gli stili di Struttura. Le modifiche apportate allo stile di struttura 
si applicheranno a tutte le diapositive che lo utilizzano. Alcune volte questo è esattamente quello 
che si desidera; altre volte no, perciò occorre prendere qualche precauzione.

Aggiungere immagini, tabelle, grafici e contenuti multimediali
Come detto in precedenza, oltre al testo, nelle caselle per i contenuti è possibile inserire immagini, 
tabelle, grafici o contenuti multimediali. Questa sezione fornisce un veloce sguardo d'insieme su 
come lavorare con questi oggetti; comunque per una descrizione più dettagliata fate riferimento 
alla Guida a Impress.

Aggiungere immagini
Per aggiungere un'immagine ad una casella per contenuti:

• Andate su Inserisci > Immagine sulla barra dei menu principale e poi selezionate Da file 
oppure Scanner.

• In alternativa, o dopo aver inserito una nuova diapositiva, fate clic sull'icona Inserisci 
immagine (Figura 152) e selezionate il file dalla finestra di dialogo Inserisci immagine che 
si apre. Per vedere una anteprima dell'immagine, spuntate Anteprima nella parte bassa 
della finestra di dialogo Inserisci immagine.

• Spostate l'immagine nella posizione voluta.

L'immagine si ridimensionerà fino a riempire l'area del riquadro. Seguite le istruzioni nella nota di 
Avvertenza qui di seguito quando ridimensionate manualmente un oggetto grafico.
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Attenzione

Quando ridimensionate un oggetto grafico, fate clic destro sull'immagine. 
Selezionate Posizione e dimensione dal menu contestuale e assicuratevi che 
Mantieni proporzioni sia selezionato. Quindi adattate l'altezza o la larghezza alle 
dimensioni necessarie. (Adattando una dimensione si modificheranno entrambe). 
Diversamente l'immagine risulterebbe distorta. Tenete anche presente che la 
modifica delle dimensioni di un'immagine bitmap ne riduce la qualità; in questi casi è 
meglio creare direttamente al di fuori di Impress un'immagine delle dimensioni 
desiderate.

Aggiungere tabelle
Per visualizzare una tabella dati, è possibile inserire delle tabelle semplici direttamente nelle 
diapositive, scegliendo come tipo di contenuto Tabella. È anche possibile aggiungere una tabella al 
di fuori di una casella per contenuti in un certo numero di modi:

• Andate su Inserisci > Tabella sulla barra dei menu principale.

• Fate clic sull'icona Tabella  sulla barra degli strumenti standard o sulla barra degli 
strumenti tabella.

• Dopo aver inserito una nuova diapositiva, fate clic sull'icona Inserisci tabella (Figura 152).

• Selezionate un'opzione di stile dalla sezione Struttura tabella nel pannello delle Attività.

• Alternativamente, fate clic sull'icona Struttura tabella  sulla barra degli strumenti tabella 
per aprire la sezione Struttura tabella nel pannello delle Attività e poi selezionate uno stile.

I primi tre metodi sopra indicati aprono la finestra di dialogo Inserisci tabella (Figura 156) dove 
potete selezionare il numero desiderato di colonne e righe. In alternativa, facendo clic sulla piccola 
freccia nera accanto all'icona Tabella viene visualizzata una tabella grafica; questa vi permette, 
trascinando il cursore del mouse sopra la medesima tabella, di selezionare il numero desiderato di 
righe e colonne.

Figura 156: creazione di una tabella tramite la 
finestra di dialogo Inserisci Tabella

Nota

Selezionando uno degli stili presenti nella sezione Struttura tabella del pannello delle 
Attività verrà creata una tabella basata su quello stile. Se create una tabella 
utilizzando un altro metodo, potete comunque applicare uno stile di vostra scelta 
successivamente.

Con la tabella selezionata, apparirà la barra degli strumenti Tabella. Se ciò non accade, potete 
comunque accedere alla barra selezionando Visualizza > Barre degli strumenti > Tabella. 
Diverse icone presenti nella barra degli strumenti Tabella sono le stesse presenti anche nella barra 

194 Guida introduttiva a LibreOffice 3.5



strumenti Tabella di Writer, ad eccezione delle funzioni come Ordina e Somma per eseguire calcoli. 
Per tali funzioni, è necessario usare un foglio elettronico inserito da Calc (discusso sotto).

Dopo aver creato la tabella, potete modificarla allo stesso modo in cui eseguite modifiche alle 
tabelle in Writer: aggiungere e cancellare righe e colonne, regolare larghezza e spaziatura, 
aggiungere bordi, colori di sfondo e così via. Potete trovare informazioni più dettagliate su come 
lavorare con le tabelle e sulla finestra di dialogo Proprietà delle Tabelle nel Capitolo 3 (Aggiungere 
e formattare testo) della Guida a Impress e nel Capitolo 9 (Lavorare con le tabelle) della Guida a 
Writer.

Modificando lo stile della tabella attraverso la sezione Struttura tabella del pannello delle attività, 
potete velocemente cambiare l'aspetto della tabella o crearne di nuove basate sulle opzioni di Stile 
da voi selezionate. Potete scegliere di aggiungere enfasi all'intestazione e alla riga del totale così 
come alla prima e all'ultima colonna della tabella, e applicare un aspetto a bande a righe e 
colonne.

Una volta completata la struttura della tabella, inserire i dati nelle celle è come lavorare con gli 
oggetti caselle di testo. Fate clic sulla cella nella quale desiderate inserire dati, e cominciate a 
scrivere. Per muovervi velocemente fra le celle, utilizzate i seguenti tasti opzione:

• I tasti freccia muovono il cursore alla successiva cella della tabella se la cella è vuota, 
altrimenti muovono il cursore al successivo carattere nella medesima cella.

• Il tasto Tabulazione muove il cursore alla cella successiva, saltando tutti i contenuti della 
cella; Maiusc+Tab sposta all'indietro da cella a cella.

Aggiungere grafici
Per inserire un grafico in una diapositiva potete utilizzare Inserisci > Grafico dalla barra dei menu 

principale, fare clic sull'icona Grafico  nella barra degli strumenti Standard, oppure, dopo aver 
inserito una nuova diapositiva, fare clic sull'icona Inserisci grafico (Figura 152). Impress inserirà un 
grafico predefinito e aprirà la finestra di dialogo Grafico. Per modificare il tipo di grafico, inserire i 
vostri dati e cambiare la formattazione fate riferimento alla Guida a Impress.

Aggiungere file multimediali
Potete inserire vari tipi di file multimediali, come musica e videoclip, nella diapositiva selezionando 
l'icona Inserisci filmato (Figura 152) in una casella per contenuti vuota. Si aprirà un lettore 
multimediale nella parte bassa della schermata e potrete vedere l'anteprima del filmato. Quando 
viene inserito un file audio, nella casella verrà mostrata l'immagine di un altoparlante.

Attenzione In sistemi basati su Linux come Ubuntu, i file multimediali non funzionano; è 
necessario effettuare ulteriori configurazioni. È necessario scaricare il Framework 
per multimedia di Java (Java Media Framework API - JMF) e aggiungere il percorso 
a jmf.jar al Class Path in Strumenti > Opzioni > LibreOffice > Java.

Aggiungere grafici, fogli elettronici e altri oggetti
Gli oggetti grafici, come forme, legende, frecce, e così via, sono spesso utili come complemento 
per il testo delle diapositive. Questi oggetti vengono manipolati nello stesso modo in cui vengono 
manipolati in Draw. Per maggiori informazioni, vedere il Capitolo 1 (Introduzione a Draw) della 
Guida a Draw, oppure i Capitoli 4, 5, e 6 della Guida a Impress.
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I fogli elettronici incorporati in Impress comprendono la maggior parte delle funzionalità dei fogli di 
lavoro in Calc e sono quindi in grado di eseguire calcoli ed analisi dei dati estremamente 
complessi. Se avete bisogno di analizzare i vostri dati o applicare delle formule, queste operazioni 
sono eseguite in modo migliore su un foglio elettronico di Calc ed i risultati visualizzati in un foglio 
elettronico incorporato in Impress o, ancor meglio, in una tabella creata direttamente in Impress.

In alternativa, scegliete Inserisci > Oggetto > Oggetto OLE dalla barra dei menu. In tal modo si 
aprirà un foglio di lavoro elettronico in mezzo alla diapositiva e menu e barre degli strumenti 
diventeranno quelli utilizzati in Calc; così potrete iniziare ad aggiungere dati, ridimensionando 
prima, eventualmente, l'area visibile sulla diapositiva. Potete anche inserire un foglio elettronico 
esistente e utilizzare l'area di visualizzazione per selezionare i dati che volete visualizzare nella 
diapositiva.

Impress offre la possibilità di inserire in una presentazione vari altri tipi di oggetti come documenti 
di Writer, formule di Math, o perfino un'altra presentazione. Per dettagli sull'uso di questi oggetti, 
fate riferimento al Capitolo 7 (Includere fogli elettronici, grafici, e altri oggetti) della Guida a 
Impress.

Lavorare con pagine master e stili

Una diapositiva master è una diapositiva utilizzata all'inizio per la creazione delle successive 
diapositive. È simile a uno stile di pagina in Writer e controlla la formattazione di base di tutte le 
diapositive basate su tale Master. Una presentazione può utilizzare più di una diapositiva master.

Nota

LibreOffice utilizza tre termini per indicare una diapositiva usata per creare altre 
diapositive: diapositiva master, master di diapositiva, e pagina master. Questo 
manuale utilizza il termine master di diapositiva, ad eccezione di quando viene 
descritta l'interfaccia utente.

Una diapositiva master contiene un insieme di caratteristiche definite, come il colore di sfondo, la 
grafica, la sfumatura; oggetti (come i loghi, linee di decorazione e altre parti grafiche) inseriti nello 
sfondo; intestazioni e piè di pagina; posizionamenti e dimensione delle caselle di testo; e 
formattazione di testo.

Stili
Tutte le caratteristiche dei master di diapositiva vengono controllate dagli stili. Gli stili di ogni nuova 
diapositiva che andate a creare dipendono dal master di diapositiva che scegliete per la sua 
creazione. In altre parole, gli stili del master di diapositiva sono disponibili e vengono applicati a 
tutte le diapositive create da quel master. Modificare uno stile in un master di diapositiva ha come 
risultato il cambiamento di tutte le diapositive basate su quello stesso master, ma è comunque 
possibile modificare ogni singola diapositiva senza cambiare il master.

Nota

Sebbene sia altamente raccomandato l'utilizzo dei master di diapositiva ogni volta 
possibile, ci sono occasioni in cui sono necessarie modifiche manuali per una 
particolare diapositiva, ad esempio per allargare l'area di un grafico quando viene 
utilizzato un layout contenente del testo e un grafico. 

I master delle diapositive sono associate a due tipi di stili: gli stili di presentazione e gli stili grafici. 
Gli stili di presentazione preconfigurati possono essere modificati, ma non è possibile creare nuovi 
stili di presentazione. Nel caso di stili grafici, potete modificare quelli preconfigurati e anche 
crearne di nuovi.
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Gli Stili di presentazione incidono su tre elementi dei master di diapositiva: lo sfondo, gli oggetti 
dello sfondo (come icone, linee decorative, e caselle di testo), e il testo posizionato nella 
diapositiva. Gli stili di testo sono ulteriormente suddivisi in Note, Struttura 1 fino a Struttura 9, 
Sottotitolo, e Titolo. Gli stili di struttura sono usati per i differenti livelli della struttura alla quale 
appartengono. Per esempio, la Struttura 2 viene usata per identificare i sotto elenchi di Struttura 1, 
e la Struttura 3 per i sotto elenchi della Struttura 2.

Gli Stili grafici influenzano molti degli elementi di una diapositiva. Notate che gli stili di testo sono 
presenti sia nella selezione di stile presentazione sia in quella grafica.

Master di diapositiva
Impress viene fornito con una collezione di master di diapositiva. Questi master vengono mostrati 
nella sezione Pagine Master del pannello delle Attività (Figura 157). Questa sezione è divisa in tre 
sottosezioni: Usato in questa presentazione, Usato recentemente, e Disponibile per l'uso. Fate clic 
sul segno + vicino al nome della sottosezione per espanderla e vedere le diapositive in anteprima, 
o fate clic sul segno – per chiudere le sottosezioni e nascondere le anteprime.

Ogni master di diapositiva mostrata nella lista Disponibile per l'uso deriva da un modello dallo 
stesso nome. Se avete creato dei modelli personali, o aggiunto modelli da altre sorgenti, i master 
di diapositiva tratti da questi modelli appariranno anch'essi nel medesimo elenco.

Figura 157: disponibilità delle pagine master 
(master di diapositiva)

Creazione di un master di diapositiva
La creazione di un nuovo master di diapositiva avviene in modo simile alla modifica del master di 
diapositiva predefinito.
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Per iniziare, abilitate la modifica dei master di diapositiva selezionando Visualizza > Sfondo > 
Maschera e si aprirà la barra degli strumenti Vista sfondo. Potete anche fare clic con il pulsante 
destro sul master di diapositiva nella sezione Pagine Master del pannello delle Attività e 
selezionare Modifica Master per aprire la barra degli strumenti Vista sfondo. Sulla barra degli 
strumenti Vista sfondo, fate clic sull'icona Nuovo Master (evidenziata in Figura 158).

Figura 158: barra degli strumenti 
Vista sfondo

Un secondo master di diapositiva apparirà nel riquadro Diapositive. Modificate questo master 
secondo le vostre necessità. È anche raccomandato rinominare questo nuovo master di 
diapositiva: fate clic con il pulsante destro sulla diapositiva nel riquadro Diapositive e selezionate 
Rinomina documento master dal menu contestuale. Quando avete fatto, chiudete la barra degli 
strumenti Vista sfondo per tornare al normale metodo di modifica delle diapositive.

Applicare un master di diapositiva
Nel pannello delle Attività, assicuratevi che sia visualizzata la sezione Pagine Master (Figura 157).

Per applicare uno dei master di diapositiva presenti nell'elenco a tutte le diapositive nella vostra 
presentazione, fateci clic sopra.

Per applicare un differente master di diapositiva a una o più diapositive selezionate:

1) Nel riquadro Diapositiva, selezionate le diapositive che desiderate modificare.

2) Nel pannello delle Attività, fate clic con il pulsante destro del mouse sul master di 
diapositiva che desiderate applicare alle diapositive selezionate, quindi fate clic sulla voce 
Applica alle diapositive selezionate dal menu contestuale.

Caricamento di master di diapositiva aggiuntivi
A volte, nella stessa serie di diapositive, potrebbe essere necessario mettere insieme master di 
diapositiva che possono appartenere a modelli differenti. Per esempio, potreste aver bisogno di un 
layout completamente differente per la prima diapositiva della presentazione, o potreste aver 
bisogno di aggiungere alla vostra presentazione una diapositiva proveniente da un'altra 
presentazione (basata su un modello disponibile sul vostro disco fisso).

La finestra di dialogo Struttura diapositiva (Figura 159) rende ciò possibile. Potete accedere a 
questa finestra di dialogo dalla barra dei menu (Formato > Struttura diapositiva) oppure dal 
menu contestuale che appare facendo clic con il pulsante destro su una diapositiva nel riquadro 
delle Diapositive.
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Figura 159: struttura diapositiva

La finestra principale mostra i master di diapositiva già disponibili per l'uso. Per aggiungerne altri:

1) Fate clic sul pulsante Apri.

2) Nella finestra di dialogo Carica modello di diapositiva selezionate (Figura 160) il modello da 
cui caricare il master di diapositiva e fate clic su OK.

3) Di nuovo clic su OK per chiudere la finestra di dialogo Struttura diapositiva.

I master di diapositiva nel modello che avete scelto vengono ora mostrati nella sezione Pagine 
Master del pannello delle Attività, nella sottosezione Disponibile per l'uso.

Nota

I master di diapositiva che avete caricato saranno anche disponibili la volta 
successiva che riaprirete la vostra presentazione. Se volete cancellare i master che 
non utilizzate, fate clic sulla corrispondente casella di controllo nella finestra di 
dialogo Struttura diapositiva. Se il master di diapositiva non è utilizzato nella 
presentazione, viene rimosso dall'elenco dei master disponibili.

Suggerimento
Per limitare le dimensioni del file di presentazione, dovreste limitare il numero 
dei master di diapositiva utilizzati.

Figura 160: la finestra di dialogo Carica modello di diapositiva per la selezione dei modelli
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Modificare un master di diapositiva
In un master di diapositiva potete modificare i seguenti elementi:

• Sfondo (colore, sfumatura, tratteggio, o bitmap)

• Oggetti di sfondo (per es. aggiunta di un logo, o di immagini decorative)

• Dimensione, posizionamento e contenuti degli elementi di intestazione e piè di pagina che 
appaiono in ogni diapositiva.

• Dimensioni e posizionamento delle caselle predefinite per i titoli e il contenuto delle 
diapositive

Prima di lavorare sul master della diapositiva, assicuratevi che la finestra di dialogo Stili e 
Formattazione sia aperta.

Per selezionare il master di diapositiva per le modifiche:

1) Selezionate Visualizza > Sfondo > Maschera dalla barra dei menu. Questa operazione 
sblocca le proprietà del master di diapositiva, che diviene così modificabile.

2) Fate clic su Pagine Master nel pannello delle Attività. Ciò vi consentirà di accedere ai 
master di diapositiva.

3) Fate clic sul master di diapositiva che volete modificare tra quelli disponibili.

4) Effettuate le modifiche desiderate, quindi fate clic sull'icona Chiudi vista sfondo sullo 
strumento Vista sfondo. Per dettagli, vedere il Capitolo 2 (Uso di diapositive master, stili e 
modelli) della Guida a Impress.

5) Salvate il file prima di proseguire.

Attenzione

Qualsiasi modifica fatta ad una diapositiva mentre siete in modalità Vista sfondo 
apparirà in tutte le diapositive della presentazione che usano questo master. Siate 
sempre sicuri di chiudere la Vista sfondo e di essere tornati alla visualizzazione 
Normale prima di lavorare su qualsiasi diapositiva della presentazione. Selezionate 
Visualizza > Normale dalla barra dei menu, o fate clic su Chiudi vista sfondo 
nella barra degli strumenti Vista sfondo per ritornare alla normale visualizzazione 
della diapositiva.

Le modifiche fatte ad una delle diapositive nella visualizzazione Normale (per esempio modifiche 
allo stile dei punti, al colore dell'area titolo, e così via...) non verranno sovrascritte da successive 
modifiche del master di diapositiva. Ci sono casi, tuttavia, in cui risulta opportuno ripristinare una 
modifica manuale di un elemento della diapositiva allo stile definito nel master di diapositiva: per 
fare ciò, selezionate l'elemento e scegliete Formato > Formattazione predefinita dalla barra dei 
menu.

Utilizzare un master di diapositiva per aggiungere testo a tutte le 
diapositive
Alcuni dei master di diapositiva disponibili hanno oggetti di testo nel piè di pagina. È possibile 
aggiungere altri oggetti di testo nella pagina master di modo che si comportino come una 
intestazione o un piè di pagina.

1) Scegliete Visualizza > Sfondo > Maschera dalla barra dei menu.

2) Sulla barra degli strumenti Disegno, selezionate l'icona Testo oppure premete F2.

3) Fate clic una sola volta e trascinate nella pagina master per disegnare un oggetto di testo, 
quindi scrivete o incollate il vostro testo nell'oggetto creato o aggiungete i campi come 
descritto di seguito.
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4) Scegliete Visualizza > Normale quando avete finito.

Per aggiungere numeri di pagina (diapositiva) o data e ora al piè di pagina della diapositiva, 
selezionate Inserisci > Numero di pagina o Inserisci > Data e ora per aprire la finestra di 
dialogo Intestazione e piè di pagina (Figura 161) dove potete selezionare e configurare queste 
aree sulla diapositiva.

Figura 161: configurare l'area del piè di pagina della diapositiva

Per aggiungere un campo, come la data o il numero di pagina (numero di diapositiva), in un 
oggetto o come oggetto separato, selezionate Inserisci > Comando di campo, e selezionate il 
campo desiderato dal sottomenu. Se desiderate modificare questo campo nella vostra diapositiva, 
vedete il Capitolo 3 (Aggiungere e formattare testo) nella Guida a Impress per maggiori 
informazioni.

I campi che potete usare in Impress sono:

• Data (fissa)

• Data (variabile): con aggiornamento automatico quando ricaricate il file

• Orario (fisso)

• Orario (variabile): con aggiornamento automatico quando ricaricate il file

• Autore: nome e cognome inseriti nella finestra dati utente di LibreOffice

• Numero di pagina (numero di diapositiva)

• Nome file

Suggerimento
Per modificare le informazioni sull'autore, andate su Strumenti > Opzioni > 
LibreOffice > Dati utente.
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Suggerimento

Per modificare il formato numero (1,2,3 o a,b,c o i,ii,iii, ecc.) per il campo 
numero pagina, scegliete Formato > Pagina e quindi selezionate un formato 
dall'elenco nell'area Impostazioni layout.

Per cambiare lo stile di paragrafo modificate lo stile di presentazione Oggetti di 
sfondo.

Aggiunta di commenti a una presentazione

In Impress è possibile utilizzare i commenti, in modo simile a quanto avviene in Writer e Calc.

In Visualizzazione Normale, scegliete Inserisci > Commento dalla barra dei menu. Apparirà un 
piccolo riquadro contenente le vostre iniziali nell'angolo superiore sinistro della diapositiva, con una 
casella di testo più grande di fianco. Impress aggiunge automaticamente il vostro nome e la data 
corrente nella parte bassa della casella di testo.

Figura 162: un commento

Scrivete o incollate il vostro commento nella casella di testo. Potete opzionalmente applicare una 
formattazione di base al commento selezionandolo, facendo clic con il pulsante destro, ed 
effettuando una scelta dal menu a comparsa. Da questo menu, potete applicare una formattazione 
al testo selezionato, eliminare il commento corrente, eliminare tutti i commenti dello stesso autore, 
o eliminare tutti i commenti nella presentazione.

Potete spostare i piccoli contrassegni dei commenti in qualsiasi punto della diapositiva. 
Tipicamente potrebbe essere posizionato sopra o vicino ad un oggetto a cui fate riferimento nel 
commento.

Per mostrare o nascondere i contrassegni dei commenti, scegliete Visualizza > Commenti.

Selezionate Strumenti > Opzioni > Dati utente per configurare o modificare il nome che 
desiderate venga mostrato come autore dei commenti.
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Se al documento lavora più di una persona, ad ogni autore viene associato automaticamente un 
diverso colore di sfondo per i commenti.

Impostazione della presentazione

Come detto in “Modificare la presentazione” a pagina 188, Impress assegna delle impostazioni 
predefinite ragionevoli per le presentazioni, permettendo allo stesso tempo di personalizzare vari 
aspetti della presentazione stessa. Questa sezione copre solamente alcuni aspetti; tecniche 
avanzate vengono spiegate nel Capitolo 9 (Presentazioni) della Guida a Impress.

Gran parte delle attività si effettuano più facilmente in visualizzazione Ordine diapositive dove 
potete vedere la maggior parte delle diapositive simultaneamente. Scegliete Visualizza > Ordine 
diapositive dalla barra dei menu oppure fate clic sulla scheda Ordine diapositive nella parte alta 
dello spazio di lavoro.

Presentazioni multiple da un singolo set di diapositive
In molte situazioni, potreste accorgervi di avere più diapositive del tempo necessario a presentarle, 
oppure che desiderate offrire un rapido sguardo d'insieme senza soffermarvi sui dettagli. Piuttosto 
di creare una nuova presentazione, potete fare uso di due strumenti che Impress mette a 
disposizione: nascondere le diapositive e configurare presentazioni personalizzate.

Per nascondere una diapositiva, fate clic con il pulsante destro sulla miniatura della diapositiva, o 
nel riquadro delle diapositive o nell'area di lavoro. Se state usando la visualizzazione Ordine 
diapositive scegliete Nascondi diapositiva dal menu a comparsa. Le diapositive nascoste sono 
contrassegnate da un numero di diapositiva barrato.

Se volete riordinare la presentazione, scegliete Presentazione > Presentazione personalizzata. 
Fate clic sul pulsante Nuovo per creare una nuova sequenza di diapositive e salvarla.

Potete ottenere quante presentazioni desiderate da un singolo insieme di diapositive.

Transizioni delle Diapositive
La transizione della diapositiva è l'animazione che viene riprodotta quando si passa da una 
diapositiva a quella successiva nella presentazione. Potete configurare la transizione della 
diapositiva dalla sezione Cambio diapositiva nel pannello delle Attività. Selezionate la transizione 
desiderata, la velocità dell'animazione, e se la transizione debba avvenire al clic del mouse 
(opzione preferita) oppure automaticamente dopo un certo numero di secondi. Fate clic su Applica 
a tutte le diapositive a meno che preferiate avere differenti transizioni nella presentazione.

Suggerimento

La sezione della transizione delle diapositive ha un'opzione molto utile: 
Anteprima automatica. Spuntandone la casella di controllo, quando si eseguono 
delle modifiche in una transizione, la nuova diapositiva viene mostrata in 
anteprima nell'area di disegno della diapositiva (Vista Normale), compreso 
l'effetto di transizione.

Avanzamento automatico delle diapositive
Potete impostare la presentazione in modo che avanzi automaticamente alla diapositiva 
successiva dopo un certo intervallo di tempo tramite la sezione Cambio diapositiva nel pannello 
delle Attività. Andate su Cambio pagina e selezionate Automaticamente dopo, quindi scegliete 
la durata di tempo desiderata in secondi; ciascuna diapositiva verrà mostrata per la durata scelta. 
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Fate clic sul pulsante Applica a tutte le diapositive per applicare la stessa durata di 
visualizzazione a tutte le diapositive.

Per applicare un intervallo di visualizzazione differente a ciascuna diapositiva nella presentazione, 
scegliete Presentazione > Presentazione cronometrata. In tal modo inizierà la presentazione e 
un piccolo timer verrà visualizzato nell'angolo in basso a sinistra. Quando siete pronti ad avanzare 
alla diapositiva successiva, fate clic con il mouse sullo sfondo visualizzato oppure premete la 
freccia a destra sulla tastiera. Impress memorizzerà i tempi per ciascuna diapositiva e, quando 
eseguirete la presentazione, cambierà  diapositiva automaticamente dopo ciascun intervallo 
impostato.

Per iniziare nuovamente una presentazione in modo automatico, dopo la visualizzazione 
dell'ultima diapositiva, andate su Presentazione > Impostazioni presentazione sulla barra dei 
menu. Selezionate Automatico e la durata della pausa tra le presentazioni. Fate clic su OK 
quando avete finito.

Avviare la presentazione

Per avviare una presentazione, effettuate una delle seguenti scelte:

• Fate clic su Presentazione > Presentazione sulla barra dei menu.

• Fate clic sull'icona Presentazione  sulla barra degli strumenti Presentazione.

• Premete F5 sulla tastiera.

Se il cambio pagina è Automaticamente dopo tot secondi, la presentazione si svolgerà 
autonomamente.

Se il cambio pagina è Al clic del mouse, eseguite un'azione a scelta tra le seguenti, per passare da 
una diapositiva alla successiva:

• Usate i tasti freccia della tastiera per passare alla diapositiva successiva o tornare indietro 
alla precedente.

• Fate clic con il mouse per muovervi alla diapositiva successiva.

• Premete la barra spaziatrice sulla tastiera per avanzare alla diapositiva successiva.

Fate clic con il pulsante destro in qualsiasi punto dello schermo per aprire un menu dal quale 
potete navigare tra le diapositive e configurare altre opzioni.

Per uscire dalla presentazione in qualsiasi momento, incluso alla fine, premete il tasto Esc.

Controllare una presentazione tramite Presenter Console
In LibreOffice Impress è integrata l'estensione Presenter Console.

Presenter Console offre ulteriori controlli sulle presentazioni tramite viste differenti sullo schermo 
del computer del presentatore e sulla proiezione che vede il pubblico. La vista del presentatore 
include la diapositiva corrente, quella successiva, le note delle diapositive, e un timer della 
presentazione.

Per dettagli sull'uso della Presenter Console, vedere il Capitolo 9 (Presentazioni) nella Guida a 
Impress.
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Nota
La Presenter Console funziona esclusivamente su sistemi operativi che supportano 
due schermi, e solo quando due schermi sono collegati (uno potrebbe essere quello 
del portatile).
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Introduzione a Draw

Draw è un programma di disegno basato sulla grafica vettoriale, sebbene possa anche eseguire 
alcune operazioni di grafica raster (pixel). Usando Draw, potete velocemente creare un'ampia 
varietà di immagini grafiche.

La grafica vettoriale memorizza e visualizza le immagini come semplici elementi geometrici come 
linee, cerchi e poligoni, invece di un insieme di pixel (punti sullo schermo). Le immagini generate 
con grafica vettoriale occupano minor spazio su disco e possono essere facilmente scalate.

Draw è pienamente integrato in LibreOffice, e ciò semplifica lo scambio di immagini con tutti gli altri 
componenti della suite. Per esempio, per riutilizzare un'immagine creata in Draw in un documento 
Writer è sufficiente eseguire un copia e incolla. Potete anche disegnare direttamente in Writer o 
Impress, usando alcune delle funzioni e degli strumenti di Draw.

LibreOffice Draw possiede estese funzionalità e, anche se non è stato progettato per rivaleggiare 
con applicazioni grafiche più sofisticate, possiede una quantità di funzioni superiore a molti 
programmi di disegno integrati in altre suite per la produttività d'ufficio.

Alcuni esempi delle funzioni di disegno sono: gestione dei livelli, griglia magnetica, visualizzazione 
di dimensioni e misure, connettori per creare organigrammi, funzioni 3D per creare piccoli disegni 
tridimensionali (con trame ed effetti di luce), integrazione di disegni e stili di pagina, e le curve di 
Bézier.

Questo capitolo ha lo scopo di presentare alcune delle caratteristiche di Draw, ma non le coprirà 
tutte. Per maggiori informazioni potete utilizzare la Guida a Draw e la Guida in linea del 
programma.
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Figura 163: l'area di lavoro di LibreOffice Draw

Lo spazio di lavoro di Draw

I principali componenti dello spazio di lavoro di Draw sono mostrati nella Figura 163.

Nell'ampia area al centro della finestra potete creare i disegni. Quest'area è circondata da barre 
degli strumenti e aree di informazioni. Il numero e la posizione degli strumenti visibili varia in 
relazione al lavoro che si sta eseguendo ed alle preferenze dell'utente. Di conseguenza le vostre 
impostazioni potrebbero apparire diverse. Per esempio, molti utenti posizionano la barra degli 
strumenti Disegno sul lato sinistro dell'area di lavoro e non nella parte inferiore, come mostrato 
nella Figura 163.

In Draw potete suddividere i disegni tra più pagine. I disegni su più pagine sono utilizzati 
principalmente nelle presentazioni. Il riquadro Pagine, sul lato sinistro della finestra di Draw in 
Figura 163 fornisce una panoramica delle pagine che state creando. Se il riquadro Pagine non è 
visibile nelle vostre impostazioni, potete abilitarlo dal menu Visualizza (Visualizza > Riquadro 
Pagina). Per modificare l'ordine delle pagine è sufficiente trascinare e rilasciare una o più pagine.

In LibreOffice Draw la dimensione massima di una pagina di disegno è di 300 cm per 300 cm.

Righelli
Dovreste vedere i righelli (barre con numeri) sui lati superiore e sinistro dello spazio di lavoro. Se 
non sono visibili, potete abilitarli selezionando Visualizza > Righello dalla barra dei menu 
principale. I righelli mostrano la dimensione di un oggetto selezionato nella pagina usando le 
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doppie linee (evidenziate in Figura 164). Quando nessun oggetto risulta selezionato, essi mostrano 
la posizione del puntatore del mouse, cosa che aiuta a posizionare più accuratamente gli oggetti 
disegnati.

Potete anche utilizzare i righelli per gestire le maniglie e le linee guida di un oggetto, facilitandovi il 
posizionamento degli oggetti.

Figura 164: i righelli mostrano la dimensione 
dell'oggetto selezionato

Figura 165: unità di misura dei righelli

Sui righelli sono anche riportati i margini della pagina nell'area di disegno. Potete cambiare i 
margini direttamente dai righelli trascinandoli con il mouse. L'area del margine è indicata dall'area 
in grigio sui righelli, come mostrato in Figura 164.

Per modificare le unità di misura dei righelli, che possono essere definite indipendentemente, fate 
clic con il pulsante destro del mouse sul righello desiderato, come illustrato per il righello 
orizzontale in Figura 165.
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Barra di stato
La Barra di stato è localizzata nella parte inferiore dello schermo in tutti i componenti di LibreOffice; 
include diversi campi specifici di Draw. Per dettagli sui contenuti e l'uso di questi campi, vedere il 
Capitolo 1 (Introduzione a LibreOffice) in questa guida e il Capitolo 1 (Introduzione a Draw) nella 
Guida a Draw.

Figura 166: la barra di stato di Draw

Nota

Le dimensioni sono espresse nell'unità di misura corrente e non vanno confuse con 
le unità di misura dei righelli. L'unità di misura corrente è definita in Strumenti > 
Opzioni > LibreOffice Draw > Generale, dove potete anche cambiare la scala della 
pagina. Un altro modo per cambiare la scala è fare doppio clic sul numero mostrato 
nella barra di stato.

Barre degli strumenti
Per visualizzare o nascondere le varie barre degli strumenti di Draw scegliete Visualizza > Barre 
degli strumenti. Dal menu che appare scegliete la barra degli strumenti che volete visualizzare. 
Per maggiori informazioni sull'utilizzo delle barre degli strumenti, vedere il Capitolo 1 (Introduzione 
a LibreOffice) in questa guida.

Nelle sezioni seguenti sono spiegati gli strumenti disponibili nelle barre degli strumenti di Draw. 
L'aspetto delle icone sulle barre degli strumenti può variare a seconda del sistema operativo e 
della selezione della dimensione delle icone e dello stile in Strumenti > Opzioni > LibreOffice > 
Vista.

Barra degli strumenti Standard
La barra degli strumenti Standard è la stessa per tutti i componenti di LibreOffice e non viene 
descritta in dettaglio in questo capitolo.

Figura 167: barra degli strumenti Standard

La barra degli strumenti Disegno
La barra degli strumenti Disegno è la più importante barra degli strumenti in Draw. Essa contiene 
tutte le funzioni necessarie per disegnare diverse forme geometriche e a mano libera e per poterle 
organizzare nella pagina.

Figura 168: barra degli strumenti Disegno
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La barra degli strumenti Stile e riempimento
La barra degli strumenti Stile e riempimento permette di modificare le principali proprietà 
dell'oggetto che si disegna. Le icone e gli elenchi a discesa variano, a seconda del tipo di oggetto 
selezionato. Ad esempio, per cambiare lo stile di una linea, fate clic sulle frecce verso l'alto e verso 
il basso per lo Stile linea e selezionate lo stile desiderato. Vedere “Modificare gli oggetti” a pagina 
229 per dettagli.

Figura 169: barra degli strumenti Stile e riempimento

Barra degli strumenti Formattazione del testo
Se l'oggetto selezionato è un testo, la barra degli strumenti cambia in quella di Formattazione del 
testo, che assomiglia alla barra degli strumenti di Formattazione presente in Writer. Per maggiori 
informazioni, consultate il Capitolo 4 (Introduzione a Writer) in questa guida.

Figura 170: barra degli strumenti Formattazione del testo

Barra degli strumenti Opzioni
Potete utilizzare la barra degli strumenti Opzioni per attivare o disattivare varie opzioni di aiuto al 
disegno. La barra Opzioni, per impostazione predefinita, non è visualizzata. Per visualizzarla, 
selezionate Visualizza > Barre degli strumenti > Opzioni.

Figura 171: barra degli strumenti Opzioni

Scelta e definizione dei colori

Per visualizzare la Barra dei colori, usate Visualizza > Barre degli strumenti > Barra dei colori. 
La barra degli strumenti appare alla base dello spazio lavoro e mostra la tavola dei colori corrente. 
Questa barra vi permette di scegliere rapidamente il colore dei vari oggetti (linee, aree, ed effetti 
3D). Il primo quadrato nel pannello corrisponde a invisibile (assenza di colore).

Figura 172: la barra dei colori
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Figura 173: cambiare la tavolozza dei colori

In Draw è possibile accedere a diverse apposite tavolozze di colori, così come cambiare i singoli 
colori a piacimento. Ciò si può fare tramite la finestra di dialogo Area, selezionando Formato > 

Area sulla barra dei menu principale oppure l'icona Area  sulla barra degli strumenti Stile e 
riempimento (Figura 169), quindi selezionando la scheda Colori (Figura 173).

Per caricare una diversa tavolozza dei colori, fate clic sull'icona Carica lista colori . La finestra 
di dialogo del selettore dei file permette di scegliere una delle tavolozze colori predefinite di 
LibreOffice (questi file hanno estensione *.soc). Per esempio, web.soc è una tavolozza di colori 
adatta a creare disegni da utilizzare nella realizzazione di pagine web. Questi colori saranno 
correttamente rappresentati su computer con schermi in grado di visualizzare almeno 256 colori.

La scheda di selezione colori vi permette anche di cambiare individualmente qualsiasi colore 
modificando il valore numerico nei campi localizzati alla destra della tavolozza dei colori. Potete 
utilizzare gli schemi di colore conosciuti come CMYK (Cyano, Magenta, Giallo, Nero) oppure RGB 
(Rosso, Verde, Blu).

Fate clic sul pulsante Modifica per aprire la finestra di dialogo Selettore di colore, dove potete 
impostare singoli colori. Vedere “Opzioni colore” nel Capitolo 2 (Configurare LibreOffice) in questa 
guida.

Per una descrizione più dettagliata delle tavolozze dei colori e delle relative opzioni, si veda il 
Capitolo 8 (Trucchi e suggerimenti) nella Guida a Draw.
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Disegnare forme base

Draw mette a disposizioni una larga scelta di forme, posizionate sulle tavolozze accessibili tramite 
la barra degli strumenti Disegno (Figura 168). Questi strumenti sono descritti, da sinistra verso 
destra sulla barra degli strumenti Disegno, nella Tabella 4. Questa sezione descrive solo alcune 
delle forme base, che in Draw sono considerate come oggetti, incluso il testo. Vedere la Guida a 
Draw per una descrizione completa delle forme disponibili.

Notate che alcune delle icone sulla barra degli strumenti Disegno cambiano a seconda della forma 
selezionata. Gli strumenti disponibili sono indicati da un piccolo triangolo o freccia alla destra 
dell'icona.

Tabella 4: strumenti base di disegno

Icon
a

Nome dello 
strumento

Icon
a

Nome dello 
strumento

Icon
a

Nome dello 
strumento

Icon
a

Nome dello 
strumento

Seleziona Linea
Linea con 
freccia 
terminale

Rettangolo

Ellisse Testo
Testo 
verticale

Curva

Connettore
Linee e 
frecce

Forme base
Forme 
simboli

Frecce 
blocchi

Diagrammi 
di flusso

Legende Stelle

Nota
Quando disegnate una forma base o ne selezionate una da modificare, il campo 
Info posto a sinistra nella barra di stato cambia secondo l'azione intrapresa: ad 
esempio Linea creata, Cornice di testo xxyy selezionata, e così via.

Disegnare una linea retta

Fate clic sull'icona Linea  e posizionate il puntatore del mouse nel punto in cui volete iniziare la 
linea (Figura 174). Trascinate il mouse mentre tenete premuto il pulsante. Rilasciate il pulsante del 
mouse nel punto in cui volete terminare la linea. Una maniglia di selezione apparirà a ciascuna 
estremità della linea, ad indicare che questo è l'oggetto correntemente selezionato. La maniglia di 
selezione nel punto iniziale della linea è leggermente più grande dell'altra maniglia di selezione.
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Figura 174: disegnare una linea retta

Tenendo premuto il tasto Maiusc mentre disegnate una linea viene limitato l'angolo di disegno della 
linea ad un multiplo di 45 gradi (0, 45, 90, 135, e così via).

Attenzione
Questo è il comportamento predefinito del tasto Maiusc. Invece, se è selezionata 
l'opzione Nella creazione e nel movimento nella sezione Posizione aggancio in 
Strumenti > Opzioni > LibreOffice Draw > Griglia, l'azione del tasto Maiusc è 
quella opposta. Le linee verranno automaticamente disegnate a multipli di 45 gradi a 
meno che il tasto Maiusc sia premuto.

Tenendo premuto il tasto Ctrl mentre disegnate una linea la fine della linea verrà agganciata al 
punto più vicino della griglia.

Attenzione Questo è il comportamento predefinito del tasto Ctrl. Invece, se è selezionata 
l'opzione Cattura alla griglia nel menu Visualizza > Griglia, il tasto Ctrl disattiva 
l'attività di cattura alla griglia.

Tenendo premuto il tasto Alt mentre disegnate una linea, la stessa si estenderà verso l'esterno, 
simmetricamente e in entrambe le direzioni, dal punto di partenza. In questo modo è possibile 
tracciare delle linee partendo dal punto centrale della linea.

Quando viene tracciata una linea, essa assume attributi predefiniti. Per modificare questi attributi, 
selezionate la linea facendo clic sulla stessa, quindi fate clic con il pulsante destro del mouse e 
selezionate Linea per aprire la finestra di dialogo Linea (Figura 175). Lo stile, la larghezza e il 
colore della linea possono essere modificati anche usando i controlli sulla barra degli strumenti 
Stile e riempimento, nella parte alta dello spazio di lavoro.
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Figura 175: finestra di dialogo Linea

Disegnare una freccia
Le frecce sono disegnate come le linee. Infatti in Draw le frecce sono classificate come un 
sottogruppo di linee: linee con punte a freccia. Esse sono visualizzate solo come linee nel campo 
informazioni della barra di stato. Fate clic sull'icona Linea con freccia terminale  per 
disegnare una freccia. La punta della freccia è disegnata al punto finale della freccia quando 
rilasciate il pulsante del mouse.

Scegliere l'estremità della linea
In Draw sono disponibili diversi tipi di terminazione di linea (frecce, cerchi, quadrati, e altri). Fate 
clic sul piccolo triangolo o freccia alla destra dell'icona Linee e frecce  sulla barra degli 
strumenti Disegno per aprire una barra degli strumenti a comparsa, con dieci strumenti per il 
disegno di linee e frecce. In alternativa, andate su Visualizza > Barre degli strumenti > Frecce 
per aprire la barra degli strumenti Frecce come barra mobile (Figura 176 e Tabella 5). L'icona 
dell'ultimo strumento utilizzato verrà mostrata sulla barra degli strumenti Disegno per rendere più 
facile utilizzare di nuovo lo stesso strumento.

Dopo avere disegnato la linea, potete cambiare lo stile della freccia facendo clic sull'icona Stile 

estremità linea , sulla barra degli strumenti Stile e riempimento , e selezionando poi le opzioni 
per le estremità della freccia.

Figura 176: barra degli strumenti Frecce
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Tabella 5: strumenti sulla barra degli strumenti Frecce

Icon
a

Nome 
dello 
strumento

Icon
a

Nome 
dello 
strumento

Icon
a

Nome 
dello 
strumento

Icon
a

Nome dello 
strumento

Linea
Linea con 
freccia 
terminale

Linea con 
freccia/cerc
hio

Linea con 
freccia/quadr
ato

Linea (45°)
Linea con 
freccia 
iniziale

Linea con 
cerchio/frec
cia

Linea con 
quadrato/frec
cia

Linea di 
quotatura

Linea con 
frecce 
terminali

Disegnare rettangoli o quadrati

Disegnare un rettangolo è simile a disegnare una linea retta. Fate clic sull'icona Rettangolo  
nella barra degli strumenti Disegno. Non appena disegnate il rettangolo con il cursore del mouse, il 
rettangolo appare con l'angolo inferiore destro attaccato al cursore.

I quadrati sono rettangoli con tutti i lati di uguale lunghezza. Per disegnare un quadrato, fate clic 
sull'icona Rettangolo  e tenete premuto il tasto Maiusc finché tracciate il quadrato.

Nota

Se è selezionata l'opzione Nella creazione e nel movimento in Strumenti > Opzioni 
> LibreOffice Draw > Generale, l'azione del tasto Maiusc è invertita. Quando è 
selezionato lo strumento Rettangolo, viene disegnato un quadrato. Per disegnare 
un rettangolo, dovete premere il tasto Maiusc mentre disegnate. L'inversione con il 
tasto Maiusc si applica anche al disegno di ellissi e cerchi.

Per disegnare un rettangolo o un quadrato partendo dal suo centro invece che dall'angolo inferiore 
destro, posizionate il cursore sul disegno, premete il pulsante del mouse e tenete premuto il tasto 
Alt mentre trascinate con il cursore. Il rettangolo o il quadrato utilizza il punto iniziale (dove avete 
fatto clic con il pulsante del mouse) come centro.

Disegnare cerchi o ellissi

Per disegnare un ellisse (anche detta ovale), fate clic sull'icona Ellisse  sulla barra degli 
strumenti Disegno. Un cerchio è un ellisse con entrambi gli assi della stessa lunghezza. Per 
disegnare un cerchio, fate clic sull'icona Ellisse e tenete premuto il tasto Maiusc finché tracciate il 
cerchio.

Per disegnare un ellisse o un cerchio partendo dal suo centro, posizionate il cursore sul disegno, 
premete il pulsante del mouse e tenete premuto il tasto Alt mentre trascinate con il cursore. 
L'ellisse o il cerchio utilizza il punto iniziale (dove avete fatto clic con il pulsante del mouse) come 
centro.
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Nota

Se tenete premuto il tasto Ctrl e poi fate clic su una delle icone Linea, Rettangolo, 
Ellisse, o Testo, nell'area di lavoro verrà disegnato automaticamente un oggetto con 
dimensioni predefinite; dimensione, forma, e colore sono tutti valori predefiniti. 
Questi attributi, in caso di necessità, possono essere cambiati in un secondo tempo. 
Vedere la Guida a Draw per maggiori informazioni.

Disegnare curve o poligoni

Per disegnare una curva o un poligono fate clic sull'icona Curva  sulla barra degli strumenti 
Disegno. Fate clic sul triangolo o freccia alla destra dell'icona per aprire gli strumenti disponibili 
(Figura 177 e Tabella 6).

Nota

Passando il mouse sopra questa icona compare il suggerimento Curva. Se aprite la 
barra degli strumenti rendendola fluttuante, il titolo della barra è Linee, come 
mostrato in Figura 177.

Tenendo premuto il tasto Maiusc quando tracciate linee con gli strumenti Curva o 
Poligono, gli angoli tra le linee verranno limitati a 45 o 90 gradi.

Figura 177: barra degli strumenti Curve 
(Linee)

Tabella 6: strumenti Curva e poligono

Icon
a

Nome 
dello 
strumento

Icon
a

Nome 
dello 
strumento

Icon
a

Nome 
dello 
strumento

Icon
a

Nome dello 
strumento

Curva piena
Poligono 
pieno

Poligono 
45° pieno

Linea a mano 
libera piena

Curva Poligono
Poligono 
45°

Curva a 
mano libera

Se muovete il cursore sopra una delle icone, comparirà un suggerimento ad indicare la funzione 
ad essa associata.

Curve
Fate clic e tenete premuto il pulsante sinistro del mouse per creare il punto iniziale della curva, 
quindi, mentre tenete premuto il pulsante sinistro del mouse, trascinate dal punto iniziale per 
disegnare una linea. Rilasciate il pulsante sinistro del mouse e continuate a trascinare il cursore 
per creare una curva. Fate clic per impostare il punto finale della curva e fissare la linea sulla 
pagina. Per continuare la linea, trascinate il cursore del mouse per disegnare una linea retta. Ogni 
clic del mouse imposta un angolo e permette di continuare a disegnare un'altra linea retta partendo 
dall'angolo. Facendo doppio clic si terminerà il disegno della linea.

In una curva piena, l'ultimo ed il primo punto della curva saranno uniti automaticamente a formare 
la figura, che avrà il colore predefinito di riempimento. Una curva senza riempimento non sarà 
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automaticamente chiusa a tracciamento ultimato.

Poligoni
Fate clic e iniziate a disegnare la prima linea dal punto di partenza tenendo premuto il pulsante 
sinistro del mouse. Come rilascerete il pulsante del mouse, verrà tracciata una linea tra il primo e il 
secondo punto. Muovete il cursore per tracciare la linea successiva. Ogni clic del mouse imposta 
un angolo e permette di continuare a disegnare un'altra linea. Facendo doppio clic si terminerà il 
disegno.

In un poligono pieno l'ultimo ed il primo punto del poligono saranno uniti automaticamente a 
formare la figura, che avrà il colore predefinito di riempimento. Un poligono senza riempimento non 
sarà automaticamente chiuso a tracciamento ultimato.

Poligoni 45°
Come i poligoni normali, questi sono formati da linee, che hanno però angoli di 45 o 90 gradi tra di 
loro.

Curve a mano libera
L'utilizzo dello strumento Curva a mano libera è simile al disegno su carta con una matita. Tenete 
premuto il pulsante sinistro del mouse e trascinate il cursore per dare alla linea la forma 
desiderata. Per terminare di tracciare la linea non è necessario fare doppio clic, è sufficiente  
rilasciare il pulsante del mouse e il disegno è completato.

Se è selezionata Linea a mano libera piena, il primo e l'ultimo punto saranno uniti 
automaticamente e l'oggetto verrà riempito con il colore appropriato.

Aggiungere testo

Per attivare lo strumento Testo, fate clic sull'icona Testo  per il testo orizzontale o sull'icona 

Testo verticale  per la scrittura in verticale. Se l'icona Testo verticale non è visibile, controllate 
che l'opzione Mostra elementi di interfaccia per le scritture asiatiche orientali sia selezionata in 
Strumenti > Opzioni > Impostazioni della lingua > Lingue. Quando l'icona Testo viene 
selezionata appare la barra degli strumenti Formattazione del testo (Figura 170 a pagina 212); da 
questa barra degli strumenti potete selezionare il tipo e la dimensione del carattere, e altre 
proprietà del testo prima di iniziare a digitare.

Dopo aver attivato il comando Testo, fate clic nella posizione dove desiderate inserire il testo. 
Apparirà una piccola cornice di testo, contenente solo il cursore. Questa cornice può essere 
spostata come qualsiasi altro oggetto. Una cornice di testo è dinamica e si allarga man mano che 
inserite il testo.

Osservate il campo informazioni nella barra di stato: esso mostra che state modificando il testo e 
fornisce anche dettagli sulla posizione corrente del cursore, mostrando i numeri di paragrafo, riga, 
e colonna.
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Figura 178: informazioni sul testo nella barra di stato

Potete inserire un'interruzione di riga con la combinazione di tasti Maiusc+Invio o iniziare un nuovo 
paragrafo con il tasto Invio. L'inserimento di interruzioni di riga o nuovi paragrafi non termina 
l'attività di modifica del testo né deseleziona la casella di testo. Una volta che avete terminato di 
inserire il testo, fate clic all'esterno dell'area delimitata per terminare l'attività di inserimento del 
testo.

Se volete modificare il testo, fateci doppio clic sopra per aprire la barra degli strumenti 
Formattazione del testo ed evidenziate il testo per iniziare a modificarlo.

Le proprietà del testo possono essere cambiate nella fase di inserimento; qualsiasi modifica avrà 
effetto dalla posizione del cursore in poi. Per modificare le proprietà per tutto il testo all'interno 
della cornice, dovete evidenziare tutto il testo.

Potete creare Stili immagini da riutilizzare in altre caselle di testo. Selezionate Formato > Stili e 
Formattazione oppure premete F11 per aprire la finestra di dialogo Stili e Formattazione. Gli Stili 
immagini si applicano a tutto il testo all'interno della casella di testo. Per formattare solo una parte 
del testo, usate la formattazione diretta con la barra degli strumenti.

Le cornici di testo possono anche avere colori di riempimento, ombre e altri attributi, proprio come 
ogni altro oggetto di Draw. Potete ruotare il riquadro e scrivere il testo con qualsiasi angolazione. 
Queste opzioni sono disponibili facendo clic con il pulsante destro del mouse sulla casella di testo.

Se fate doppio clic su un oggetto grafico, oppure premete F2 o fate clic sull'icona Testo quando un 
oggetto è selezionato, potete aggiungere testo all'oggetto grafico. Tale testo diviene quindi parte 
dell'oggetto grafico.

Un oggetto grafico non è dinamico e non si comporta come una casella di testo. Per mantenere il 
testo all'interno dei bordi dell'oggetto, dovete usare paragrafi, interruzioni di riga, diminuire le 
dimensioni del testo, aumentare le dimensioni dell'oggetto, oppure combinare i quattro metodi.

Per maggiori informazioni riguardo al testo, vedere il Capitolo 2 (Disegnare forme base) e il 
Capitolo 10 (Draw tecniche avanzate) nella Guida a Draw.

Punti di incollaggio e connettori

Punti di incollaggio
In Draw tutti gli oggetti hanno dei punti di incollaggio, che normalmente non vengono mostrati. I 

punti di incollaggio diventano visibili quando è selezionata l'icona Connettori  sulla barra degli 
strumenti Disegno.
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La maggior parte degli oggetti ha quattro punti di incollaggio (Figura 179). Potete aggiungere più 
punti di incollaggio e personalizzarli, usando la barra degli strumenti Punti di incollaggio(Figura 
180). Andate su Visualizza > Barre degli strumenti > Punti di incollaggio per aprire la barra.

Figura 179: punti di 
incollaggio

Figura 180: barra degli strumenti Punti di incollaggio

I punti di incollaggio sono diversi dalle maniglie di selezione di un oggetto. Le maniglie servono per 
spostare o cambiare la forma di un oggetto. I punti di incollaggio sono usati per fissare o incollare 
un connettore ad un oggetto, in modo tale che, quando l'oggetto si muove, il connettore rimane 
fissato all'oggetto. Per una descrizione più dettagliata sull'utilizzo dei punti di incollaggio, vedere il 
Capitolo 3 Lavorare con gli Oggetti e i Punti degli Oggetti e il Capitolo 9 (Organigrammi, diagrammi  
di flusso e altro) nella Guida a Draw.

Connettori
I connettori sono linee o frecce la cui fine si aggancia automaticamente da un punto di incollaggio 
di un oggetto. I connettori sono particolarmente utili per realizzare organigrammi, diagrammi di 
flusso e mappe mentali. Quando gli oggetti vengono spostati o riordinati, i connettori rimangono 
attaccati al punto di incollaggio. La Figura 181 mostra un esempio di due oggetti ed un connettore.

Draw dispone di un ampio insieme di connettori differenti e funzioni per i connettori. Fate clic sulla 

freccia vicino all'icona Connettore  per aprire la barra degli strumenti Connettori (Figura 
182 e Tabella 7). Per una descrizione più dettagliata sull'utilizzo dei connettori, consultare il 
Capitolo 9 (Organigrammi, diagrammi di flusso e altro) nella Guida a Draw.
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Figura 181: un connettore tra due oggetti

Figura 182: barra degli strumenti Connettori

Tabella 7: strumenti per i connettori

Icon
a

Nome dello 
strumento

Icon
a

Nome dello 
strumento

Icon
a

Nome 
dello 
strumento

Icon
a

Nome dello 
strumento

Connettore
Connettore 
con freccia 
terminale

Connettore 
con frecce

Connettore 
lineare

Connettore 
lineare con 
freccia 
terminale

Connettore 
lineare con 
frecce

Connettore 
diretto

Connettore 
diretto con 
freccia 
terminale

Connettore 
diretto con 
frecce

Connettore 
curvo

Connettore 
curvo con 
freccia 
terminale

Connettore 
curvo con 
frecce

Disegnare forme geometriche

Le icone per il disegno di forme geometriche sono localizzate sulla barra degli strumenti Disegno e 
ogni forma geometrica viene spiegata nelle seguenti sezioni. Facendo clic sul triangolo o freccia 
alla destra dell'icona si apre una barra mobile attraverso la quale si accede agli strumenti per 
quella forma geometrica.

Suggerimento

L'uso di questi strumenti per le forme geometriche è simile a quello usato per 
disegnare rettangoli e quadrati. Per maggiori informazioni, vedere “Disegnare 
rettangoli o quadrati” a pagina 217 e il Capitolo 2 (Disegnare forme base) nella 
Guida a Draw.
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Nota
Le icone per le forme geometriche mostrate sulla barra degli strumenti Disegno 
cambiano forma a seconda dell'ultimo strumento selezionato ed utilizzato per 
disegnare un oggetto.

Forme base

Fate clic sul triangolo o freccia alla destra dell'icona Forme base  per aprire la barra degli 
strumenti Forme base. Questa barra include anche uno strumento rettangolo identico a quello già 
mostrato sulla barra degli strumenti Disegno.

Figura 183: barra degli strumenti Forme base

Forme simboli

Fate clic sul triangolo o freccia alla destra dell'icona Forme simboli  per aprire la barra degli 
strumenti Forme simboli.

Figura 184: barra degli strumenti Forme simboli

Frecce blocchi

Fate clic sul triangolo o freccia alla destra dell'icona Frecce blocchi  per aprire la barra degli 
strumenti Frecce blocchi.

Figura 185: barra degli strumenti Frecce blocchi
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Diagrammi di flusso

Fate clic sul triangolo o freccia alla destra dell'icona Diagrammi di flusso  per aprire la barra 
degli strumenti Diagrammi di flusso, che mostra i simboli usati nei diagrammi di flusso. La 
creazione di diagrammi di flusso, organigrammi e altri strumenti di pianificazione simili è descritta 
ulteriormente nel Capitolo 9 (Organigrammi, diagrammi di flusso e altro) nella Guida a Draw.

Figura 186: barra degli strumenti Diagrammi di flusso

Legende

Fate clic sul triangolo o freccia alla destra dell'icona Legende  per aprire la barra degli strumenti 
Legende.

Figura 187: barra degli strumenti 
Legende

Stelle e banner

Fate clic sul triangolo o freccia alla destra dell'icona Stelle  per aprire la barra degli strumenti 
Stelle e decorazioni.

Figura 188: barra degli strumenti Stelle e decorazioni

Nota
È possibile aggiungere testo a tutte queste forme geometriche. Vedere il Capitolo 2 
(Disegnare forme base) e il Capitolo 10 (Draw tecniche avanzate) nella Guida a 
Draw per dettagli.

Selezionare gli oggetti

Selezione diretta
Il modo più semplice per selezionare un oggetto è di fare clic su di esso direttamente. Per 
selezionare oggetti privi di riempimento, fate clic sul contorno dell'oggetto. Facendo clic una volta 
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sull'oggetto lo si seleziona; facendo un secondo clic lo si deseleziona. Per selezionare o 
deselezionare più di un oggetto, tenete premuto il tasto Maiusc mentre fate clic.

Selezione tramite cornice
Potete anche selezionare diversi oggetti contemporaneamente trascinando il cursore del mouse 
intorno agli oggetti. Il trascinamento del cursore disegna un rettangolo intorno agli oggetti e solo gli 
oggetti che si trovano interamente all'interno del rettangolo saranno selezionati.

Per selezionare più oggetti tramite cornice, l'icona Selezione  sulla barra degli strumenti 
Disegno deve essere attiva.

Nota
Quando trascinate il cursore del mouse per selezionare più oggetti, il rettangolo di 
selezione che viene tracciato è anche detto tenda.

Selezionare oggetti nascosti
Anche gli oggetti posti dietro ad altri oggetti, e quindi non visibili, possono essere selezionati. 
Tenete premuto il tasto Alt e fate clic sull'oggetto davanti a quello nascosto, quindi fate 
nuovamente clic per selezionare l'oggetto nascosto. Se sono presenti diversi oggetti nascosti, 
continuate a tenere premuto il tasto Alt e a fare clic fino a quando non raggiungete l'oggetto 
desiderato. Per spostarvi tra gli oggetti in ordine inverso, premete i tasti Alt+Maiusc e fate clic.

Quando fate clic sull'oggetto selezionato, il suo contorno apparirà brevemente attraverso gli oggetti 
che lo coprono.

Nota
Il metodo che prevede l'utilizzo del tasto Alt funziona su computer con sistemi 
operativi Windows o Mac. Su computer con sistema operativo Linux bisogna usare il 
metodo che prevede l'utilizzo del tasto Tab, descritto di seguito.

Per selezionare un oggetto nascosto da un altro oggetto utilizzando la tastiera, usate il tasto Tab 
per passare da un oggetto all'altro, fermandovi sull'oggetto che desiderate selezionare. Per 
muovervi tra gli oggetti in senso inverso, premete Maiusc+Tab. Questo è un modo molto veloce 
per arrivare ad un oggetto, ma potrebbe non essere pratico se c'è un gran numero di oggetti nel 
disegno.

Disporre gli oggetti 
In un disegno complesso, diversi oggetti potrebbero essere sovrapposti uno sull'altro. Per 
modificare l'ordine con il quale gli oggetti sono sovrapposti gli uni sugli altri, spostandoli avanti o 
indietro, selezionate un oggetto, fate clic su Cambia > Disponi sulla barra dei menu principale e 
selezionate Porta avanti o Porta indietro. In alternativa, fate clic con il pulsante destro del mouse 
sull'oggetto, selezionate Disponi dal menu contestuale, quindi Porta avanti o Porta indietro.

Queste opzioni sono anche disponibili facendo clic sul piccolo triangolo o freccia a destra dell'icona 

Disponi  sulla barra degli strumenti Disegno. In tal modo si apre la barra degli strumenti 
Posizione che dà accesso alle varie opzioni di disposizione.
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Spostare e modificare le dimensioni di un oggetto

Quando spostate un oggetto o ne modificate le dimensioni, controllate l'area sinistra della barra di 
stato, nella parte bassa della finestra di Draw (Figura 189). L'area a sinistra della barra degli 
strumenti Disegno, da sinistra a destra, mostra quale oggetto è selezionato, la sua posizione nel 
disegno in coordinate X/Y e le dimensioni dell'oggetto. Le unità di misura sono quelle selezionate 
in Strumenti > Opzioni > LibreOffice Draw > Generale.

Per maggiori informazioni sullo spostamento e sulla regolazione delle dimensioni di un oggetto, 
vedere il Capitolo 3 (Lavorare con gli oggetti e i punti degli oggetti) nella Guida a Draw.

Figura 189: parte sinistra della barra di stato durante lo spostamento o la 
regolazione di un oggetto

Spostare oggetti
Per spostare un oggetto (o un gruppo di oggetti), selezionatelo e fate clic all'interno dei bordi 
dell'oggetto, quindi tenete premuto il pulsante sinistro del mouse mentre trascinate. Durante lo 
spostamento, la forma dell'oggetto appare come una linea tratteggiata per facilitare il 
riposizionamento (Figura 190). Per localizzare l'oggetto nella sua nuova posizione, rilasciate il 
pulsante del mouse.

Figura 190: spostare un oggetto

Ridimensionare un oggetto
Per cambiare le dimensioni di un oggetto selezionato (o di un gruppo di oggetti selezionati), 
spostate il cursore del mouse su una delle maniglie di selezione. Il cursore del mouse cambierà 
forma ad indicare la direzione di movimento per quella maniglia di selezione. Non appena 
cambiate le dimensioni dell'oggetto, apparirà un contorno ombreggiato dell'oggetto (Figura 191). 
Quando avete raggiunto la dimensione desiderata dell'oggetto, rilasciate il pulsante del mouse.

Il risultato dipende da quale maniglia di selezione usate. Per ridimensionare un oggetto lungo un 
asse, usate una maniglia laterale. Per ridimensionare lungo entrambi gli assi, usate una maniglia 
d'angolo.
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Figura 191: ridimensionare un 
oggetto

Nota

Se premete il tasto Maiusc mentre ridimensionate un oggetto, le dimensioni 
dell'oggetto saranno modificate simmetricamente rispetto ai due assi, in modo tale 
che le proporzioni dell'oggetto rimarranno le stesse. Questo comportamento del 
tasto Maiusc funziona con tutte le maniglie di selezione.

Questo è il comportamento predefinito del tasto Maiusc. Invece, se è selezionata 
l'opzione Nella creazione e nel movimento in Strumenti > Opzioni > LibreOffice 
Draw > Griglia, l'azione del tasto Maiusc è invertita: cioè le proporzioni verranno 
mantenute a meno che il tasto Maiusc sia premuto.

Ruotare e inclinare un oggetto

Per maggiori informazioni sulla rotazione e inclinazione di un oggetto, vedere il Capitolo 3 
(Lavorare con gli oggetti e i punti degli oggetti) nella Guida a Draw.

Ruotare un oggetto
Per ruotare un oggetto (o un gruppo di oggetti), selezionate l'oggetto, quindi andate in modalità 
rotazione, usando uno dei seguenti metodi:

• Fate nuovamente clic sull'oggetto. Non fate doppio clic, perché ciò disattiverebbe la 
selezione dell'oggetto.

• Fate clic sull'icona Ruota  sulla barra degli strumenti Disegno.

• Andate su Visualizza > Barre degli strumenti > Modo e selezionate l'icona Ruota .

Le maniglie di selezione cambieranno forma e colore (Figura 192). Apparirà anche, al centro 
dell'oggetto, un punto che svolge la funzione di centro di rotazione. Quando muovete il cursore del 
mouse sulle maniglie il cursore cambia forma. Le maniglie d'angolo servono per ruotare un 
oggetto; le maniglie in alto, in basso e laterali servono per inclinare un oggetto.
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Figura 192: ruotare un oggetto

Portate il cursore del mouse su una delle maniglie d'angolo ed esso cambierà in un arco con una 
freccia a ciascuna estremità. Fate clic e tenete premuto il pulsante del mouse, quindi iniziate a 
spostare il cursore per ruotare l'oggetto. Il contorno dell'oggetto che viene ruotato è visualizzato 
con una linea a punti, e nella barra di stato è mostrato l'angolo corrente di rotazione.

Nota
La rotazione funziona in maniera diversa per gli oggetti tridimensionali (3D) perché 
avviene rispetto agli assi globali invece che su un singolo asse. Vedere il Capitolo 7 
(Lavorare con oggetti 3D) per maggiori informazioni.

Il punto di rotazione è normalmente situato al centro di un oggetto. Per cambiare la posizione del 
punto di rotazione, fate clic sull'oggetto con il cursore del mouse e trascinate l'oggetto fino a 
quando il punto di rotazione non si trova nella posizione desiderata. Il punto di rotazione può anche 
essere situato al di fuori dell'oggetto.

Nota

Se premete il tasto Maiusc mentre ruotate un oggetto, la rotazione verrà limitata a 
movimenti di 15°.

Questo è il comportamento predefinito del tasto Maiusc. Invece, se è selezionata 
l'opzione Nella creazione e nel movimento in Strumenti > Opzioni > LibreOffice 
Draw > Griglia, l'azione del tasto Maiusc è invertita: cioè la rotazione verrà limitata 
a movimenti di 15° a meno che il tasto Maiusc sia premuto.

Inclinare un oggetto
Per inclinare un oggetto, usate le maniglie situate nei punti medi, in alto, in basso e ai lati 
dell'oggetto selezionato. Il cursore del mouse cambia quando viene portato sopra una delle 
maniglie poste in corrispondenza dei punti medi. L'asse utilizzato per inclinare un oggetto è il 
bordo dell'oggetto direttamente opposto alla maniglia del punto medio utilizzata per inclinare 
l'oggetto. Quando trascinate il cursore del mouse questo asse rimane fisso, mentre gli altri lati 
dell'oggetto si muovono rispetto ad esso.

Fate clic e tenete premuto il pulsante del mouse, quindi iniziate a spostare il cursore per inclinare 
l'oggetto. Il contorno dell'oggetto che viene inclinato è visualizzato con una linea a punti (Figura 
193) e nella barra di stato è mostrato l'angolo corrente di inclinazione.
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Nota

Se premete il tasto Maiusc mentre inclinate un oggetto, l'inclinazione verrà limitata a 
movimenti di 15°.

Questo è il comportamento predefinito del tasto Maiusc. Invece, se è selezionata 
l'opzione Nella creazione e nel movimento in Strumenti > Opzioni > LibreOffice 
Draw > Griglia, l'azione del tasto Maiusc è invertita: cioè l'inclinazione verrà limitata 
a movimenti di 15° a meno che il tasto Maiusc sia premuto.

Figura 193: inclinare un oggetto

Modificare gli oggetti

Per modificare un oggetto o cambiarne gli attributi, come colore, spessore del bordo, e così via, 
potete utilizzare le barre degli strumenti Stile e riempimento, Formattazione del testo, oppure il 
menu contestuale. Potete trovare maggiori informazioni sulla modifica degli oggetti e dei loro 
attributi nel Capitolo 4 (Modificare gli attributi degli oggetti) nella Guida a Draw.

La barra degli strumenti Stile e riempimento
Se non visualizzate la barra degli strumenti Stile e riempimento, andate su Visualizza > Barre 
degli strumenti > Stile e riempimento per aprire la barra (Figura 194). I più comuni attributi di un 
oggetto possono essere modificati tramite questa barra. Potete anche aprire la finestra di dialogo 

Linea facendo clic sull'icona Linea  e la finestra di dialogo Area facendo clic sull'icona Area  
per accedere ad altre opzioni di formattazione. Gli strumenti disponibili sulla barra degli strumenti 
Stile e riempimento sono mostrati da sinistra a destra in Figura 195.

Figura 194: barra degli strumenti Stile e riempimento
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Figura 195: strumenti 
disponibili sulla barra degli 
strumenti Stile e riempimento

Barra degli strumenti Formattazione del testo
Quando selezionate il testo, la barra degli strumenti Stile e riempimento cambia automaticamente 
per mostrare la barra degli strumenti Formattazione del testo (Figura 196). Potete anche aprire la 
barra degli strumenti Formattazione del testo selezionando Visualizza > Barre degli strumenti > 
Formattazione del testo. Gli strumenti su questa barra non diverranno attivi finché non viene 
selezionato il testo. Gli strumenti disponibili sulla barra degli strumenti Formattazione del testo 
sono mostrati da sinistra a destra in Figura 197.

Figura 196: barra degli strumenti Formattazione del testo
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Figura 197: strumenti disponibili sulla barra degli strumenti Formattazione del 
testo

Figura 198: menu contestuale

Menu contestuale
Quando un oggetto è selezionato e fate clic su di esso con il pulsante destro del mouse, si apre un 
menu contestuale (Figura 198) relativo all'oggetto selezionato. Questo menu contestuale fornisce 
l'accesso alle opzioni disponibili e vi permette di modificare gli attributi dell'oggetto senza dover 
aprire una finestra di dialogo. Le voci del menu con una piccola freccia sul lato destro contengono 
un sottomenu.
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Formattare linee e bordi
In LibreOffice il termine linea indica sia un segmento di retta a sé (linea), sia il margine esterno di 
una forma (bordo), sia una freccia. Nella maggior parte dei casi le proprietà della linea che potete 
modificare sono il suo stile (linea continua, tratteggiata, invisibile, e così via), il suo spessore e il 
suo colore.

Selezionate la linea che dovete formattare e poi usate i controlli sulla barra degli strumenti Stile e 
riempimento per cambiare le più comuni opzioni evidenziate in Figura 199.

Figura 199: proprietà comuni alle linee (stile, colore, spessore)

Se avete necessità di rifinire l'aspetto di una linea, scegliete Formato > Linea dalla barra dei 
menu, oppure fate clic con il pulsante destro sulla linea e selezionate Linea dal menu contestuale, 

oppure ancora selezionate l'icona Linea  dalla barra degli strumenti Stile e riempimento. Tutti 
questi metodi aprono la finestra di dialogo Linea (Figura 200), dove potete impostare le proprietà 
della linea. Questa finestra di dialogo è composta da quattro schede: Linea, Ombreggiatura, Stili 
linee, ed Estremità linee.

Figura 200: finestra di dialogo Linea

Frecce, punte delle frecce ed estremità della linea
Le frecce, le punte delle frecce e altre estremità della linea sono normalmente indicate come 
frecce e possono essere trattate come le linee in fase di modifica e di cambiamento degli attributi. 

Selezionate una linea e fate clic sull'icona Stile estremità linea  dalla barra degli strumenti 
Stile e riempimento per aprire il menu Estremità linea (Figura 201).
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Sono disponibili differenti tipi di estremità di linea. Ogni estremità di linea può avere un diverso 
terminale, oppure non averne. I terminali possono essere applicati solo alle linee e non hanno 
effetto sul bordo di un oggetto.

Figura 201: menu Estremità 
linea

Formattazione del riempimento di un'area

Il termine riempimento dell'area si riferisce all'interno di un oggetto, che può essere un colore 
uniforme, una sfumatura, un tratteggio, o bitmap (Figura 202). Il riempimento dell'area può essere 
parzialmente o totalmente trasparente. Nella maggior parte dei casi sceglierete una delle opzioni 
predefinite di riempimento, disponibili sulla barra degli strumenti Stile e riempimento. Potete anche 
definire riempimenti d'area personalizzati. Per maggiori informazioni sulla formattazione del 
riempimento, vedere il Capitolo 4 (Modificare gli attributi degli oggetti) nella Guida a Draw.

Figura 202: differenti tipi di riempimento d'area
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Usare gli stili

Supponete di voler applicare lo stesso riempimento di area, spessore della linea e bordo ad un 
gruppo di oggetti. Questa operazione ripetitiva può essere semplificata con l'utilizzo degli stili. Gli 
stili vi permettono di definire un modello di formattazione (uno stile) e successivamente di applicare 
quello stile a più oggetti. Per maggiori informazioni sugli stili, si consulti il Capitolo 3 (Uso di stili e 
modelli) in questa guida, il Capitolo 6 (Introduzione agli stili) nella Guida a Writer e il Capitolo 4 
(Modificare gli attributi degli oggetti) nella Guida a Draw.

Posizionamento degli oggetti

Funzione di cattura
In Draw gli oggetti possono essere posizionati accuratamente e uniformemente usando la funzione 
di cattura. I punti della Griglia, i punti di cattura e le linee, le cornici oggetto, i singoli punti sugli 
oggetti, o i bordi di pagina possono tutti essere usati con la funzione di cattura.

È più facile utilizzare la funzione di cattura con valori di zoom elevati, che ben si adattino alla 
vostra visualizzazione. È possibile utilizzare due differenti funzioni di cattura allo stesso tempo; ad 
esempio cattura ad una linea guida ed al bordo della pagina. Si consiglia, comunque, di attivare 
solo le funzioni di cui si ha effettivamente bisogno.

Per informazioni più dettagliate sulla funzione di cattura, vedere il Capitolo 8 (Trucchi e 
suggerimenti) e il Capitolo 10 (Draw tecniche avanzate) nella Guida a Draw.

Cattura alla griglia
La cattura alla griglia vi permette di posizionare un oggetto su un punto della griglia (Figura 203). 
Andate su Visualizza > Griglia > Cattura alla griglia o fate clic sull'icona Cattura alla griglia

 sulla barra degli strumenti Opzioni per attivare o disattivare la funzione di cattura alla griglia. 
Se non visualizzate la barra degli strumenti Opzioni, andate su Visualizza > Barre degli 
strumenti > Opzioni.

Figura 203: posizionamento con cattura alla 
griglia
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Mostrare la griglia
Per mostrare o nascondere la griglia in Draw, andate su Visualizza > Griglia > Mostra Griglia 

oppure fate clic sull'icona Mostra griglia  sulla barra degli strumenti Opzioni.

Figura 204: configurare la griglia

Configurare la griglia
È possibile configurare la risoluzione, la cattura e la posizione di cattura dei punti della griglia. 
Andate su Strumenti > Opzioni > LibreOffice Draw > Griglia per aprire la finestra di dialogo 
delle opzioni per la griglia (Figura 204).

• Spaziatura verticale ed orizzontale dei punti della griglia. Potete anche cambiare l'unità di 
misura utilizzata nelle opzioni generali di Draw andando su Strumenti > Opzioni > 
LibreOffice Draw > Generale.

• La risoluzione è la dimensione dei quadrati e dei rettangoli nella griglia. Se la risoluzione 
impostata è di 1 cm in orizzontale e 2 cm in verticale, la griglia consiste di rettangoli alti 2 
cm e larghi 1 cm.

• Le suddivisioni sono ulteriori punti che appaiono lungo i lati di ciascun rettangolo o 
quadrato nella griglia. Gli oggetti si ancorano alle suddivisioni così come agli angoli della 
griglia.

• La dimensione in pixel dell'area di cattura definisce la vicinanza che deve avere un oggetto 
al punto o linea di cattura affinché venga catturato.

• Il colore predefinito della griglia è grigio chiaro. Per cambiare il colore dei punti della griglia, 
andate su Strumenti > Opzioni > LibreOffice > Aspetto.

Linee guida
In Draw è possibile utilizzare linee guida che vi permettono di posizionare più facilmente un 
oggetto usando i righelli sul lato superiore e sinistro dell'area di lavoro. Per attivare o disattivare le 
linee guida, andate su Strumenti > Opzioni > LibreOffice Draw > Vista e selezionate l'opzione 
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Linee di cattura durante lo spostamento oppure andate sulla barra degli strumenti Opzioni e 

fate clic sull'icona Linee guida durante lo spostamento .

Applicare effetti speciali

Con Draw, potete applicare molti effetti speciali a un oggetto o a gruppi di oggetti; questa sezione 
introduce alcuni di questi effetti. Potete trovare maggiori informazioni sugli effetti speciali nel 
Capitolo 4 (Modificare gli attributi degli oggetti) della Guida a Draw.

Per accedere agli strumenti per gli effetti speciali, andate su Visualizza > Barre degli strumenti > 
Modo (Figura 205 e Figura 206). È possibile accedere ai comandi Ruota e Ribalta anche 
andando su Cambia sulla barra dei menu principale o facendo clic con il pulsante destro 
sull'oggetto e usando il menu contestuale.

Figura 205: barra degli strumenti Modo

Figura 206: strumenti disponibili sulla 
barra degli strumenti Modo

Ribaltare oggetti
Il metodo più semplice e veloce per ribaltare un oggetto orizzontalmente o verticalmente è il 
seguente:

1) Fate clic su un oggetto grafico, così da fare comparire le maniglie di selezione.

2) Fate clic con il pulsante destro e selezionate Ribalta > Verticale o Orizzontale, oppure 
andate su Cambia > Rispecchia > Verticale oppure orizzontale sulla barra dei menu 
principale e l'oggetto selezionato verrà ribaltato con la faccia nell'altra direzione.

In ogni caso, per avere maggiore controllo sul processo di ribaltamento, può essere usato lo 
strumento Ribalta sulle barre degli strumenti Modo o Disegno. L'utilizzo di questo strumento vi 
permette di cambiare la posizione e l'angolo rispetto al quale viene ribaltato l'oggetto; questo 
argomento è descritto nel Capitolo 4 (Modificare gli attributi degli oggetti) della Guida a Draw.
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Rispecchiare un oggetto
Al momento non esiste un comando per rispecchiare in Draw. Comunque, il comando può essere 
emulato usando lo strumento Ribalta; ciò è descritto nel Capitolo 4 (Modificare gli attributi degli 
oggetti) della Guida a Draw.

Distorcere un oggetto
Vi sono tre strumenti, sulla barra degli strumenti Modo, che vi permettono di trascinare gli angoli e i 
bordi di un oggetto per distorcere l'immagine.

• Lo strumento Distorci  distorce un oggetto in prospettiva.

• Poni su cerchio (inclina)  crea uno pseudo effetto tridimensionale.

• Poni su cerchio (in prospettiva)  crea uno pseudo effetto tridimensionale.

In tutti e tre i casi viene chiesto inizialmente se si desidera trasformare l'oggetto in una curva. 
Questo primo passaggio è necessario, quindi fate clic su Sì. Potete poi spostare le maniglie 
dell'oggetto per produrre l'effetto desiderato. Vedere il Capitolo 4 (Modificare gli attributi degli 
oggetti) della Guida a Draw per maggiori informazioni su come distorcere gli oggetti.

Gradienti dinamici per la trasparenza
Potete controllare i gradienti di trasparenza con lo stesso metodo utilizzato per i gradienti di colore. 
Entrambi i tipi di gradiente possono essere usati insieme. Con un gradiente di trasparenza, la 
direzione e il grado del colore di riempimento di un oggetto cambia da opaco a trasparente. In un 
gradiente regolare, il riempimento varia da un colore ad un altro, ma il grado di trasparenza rimane 
invariato.

Gli strumenti Trasparenza e Sfumatura sulla barra degli strumenti Modo controllano 
dinamicamente la trasparenza e le sfumature di colore. Vedere il Capitolo 4 (Modificare gli attributi 
degli oggetti) della Guida a Draw per maggiori informazioni su come creare trasparenze e 
sfumature in un oggetto.

Duplicazione
Con la duplicazione potete fare delle copie di un oggetto mentre applicate delle modifiche al colore 
o alla rotazione dei duplicati. Fate clic su di un oggetto o un gruppo di oggetti e scegliete Modifica 
> Duplica sulla barra dei menu principale per aprire la finestra di dialogo Duplica (Figura 207). 
Selezionate le opzioni desiderate tra quelle disponibili. Quando le opzioni nella finestra di dialogo 
vengono applicate a un rettangolo blu, producono il risultato mostrato in Figura 208.
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Figura 207: finestra di dialogo Duplica

Figura 208: risultato di una 
duplicazione

Dissolvenza incrociata
La dissolvenza incrociata permette di trasformare la forma di un oggetto in un'altra forma; funziona 
soltanto quando sono selezionati due oggetti.

1) Selezionate due oggetti con forme diverse.

2) Andate su Modifica > Morphing per aprire la finestra di dialogo Morphing (Figura 209).

3) Selezionate Passaggi per determinare il numero di forme tra i due oggetti.

4) Selezionate Includi gli attributi per applicare una modifica graduale delle proprietà di linea 
e riempimento tra i due oggetti.

5) Selezionate Stesso orientamento per applicare una transizione morbida tra i due oggetti.

6) Fate clic su OK e il risultato sarà un nuovo gruppo di oggetti, con il primo oggetto 
selezionato come oggetto iniziale e il secondo oggetto selezionato come oggetto finale. Gli 
oggetti intermedi mostrano la trasformazione da una forma all'altra (Figura 210).
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Figura 209: finestra di dialogo Morphing

Figura 210: risultato della dissolvenza 
incrociata

Combinare oggetti multipli

Usando Draw, potete raggruppare o combinare gli oggetti insieme, permettendovi di trattare oggetti 
multipli come un'unica unità, o di unire gli oggetti in una nuova forma. Per maggiori informazioni, si 
veda il Capitolo 5 (Combinare oggetti multipli) nella Guida a Draw.

Raggruppare gli oggetti è simile a mettere gli oggetti in un contenitore. Gli oggetti possono essere 
spostati come un gruppo o possono essere applicate ad essi delle modifiche globali. Un gruppo 
può sempre essere sciolto e gli oggetti facenti parte del gruppo possono essere manipolati 
separatamente. Gli oggetti di un gruppo mantengono le loro proprietà individuali.

Con Combina gli oggetti vengono fusi permanentemente per creare un nuovo oggetto. Gli oggetti 
originali non sono più disponibili come entità individuali e non possono essere modificati come 
singoli oggetti. Qualsiasi modifica di un oggetto combinato influisce su tutti gli oggetti usati per 
creare la combinazione.

Raggruppamento

Raggruppamento temporaneo
Un raggruppamento temporaneo si effettua selezionando diversi oggetti tramite l'icona Seleziona

 sulla barra degli strumenti Disegno o usando il mouse per tracciare un rettangolo intorno agli 
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oggetti (anche detto tenda). Qualsiasi modifica effettuata sui parametri degli oggetti viene applicata 
a tutti gli oggetti che fanno parte del gruppo temporaneo. Ad esempio, potete ruotare un gruppo 
temporaneo di oggetti come una unica entità.

Per cancellare un raggruppamento temporaneo di oggetti semplicemente fate clic all'esterno delle 
maniglie di selezione mostrate intorno agli oggetti.

Raggruppamento permanente
Un raggruppamento permanente di oggetti si crea selezionando gli oggetti e andando poi su 
Cambia > Raggruppa sulla barra dei menu principale, oppure facendo clic con il pulsante destro 
sulla selezione e scegliendo poi Raggruppa dal menu contestuale, oppure ancora usando la 
scorciatoia da tastiera Ctrl+Maiusc+G. Quando deselezionate la vostra selezione gli oggetti 
rimangono raggruppati insieme.

Quando degli oggetti sono raggruppati in modo permanente, ogni operazione di modifica applicata 
a quel gruppo sarà applicata anche a tutti gli oggetti del gruppo. Se fate clic su di un oggetto del 
gruppo, l'intero gruppo sarà selezionato.

Potete modificare un singolo oggetto del gruppo senza sciogliere il gruppo. Selezionate il gruppo e 
andate su Cambia > Modifica gruppo, o fate clic con il pulsante destro e selezionate Modifica 
gruppo dal menu contestuale, oppure fate doppio clic sul gruppo.

Quando avete finito le modifiche sul singolo oggetto del gruppo, andate su Cambia > Abbandona, 
oppure fate clic con il pulsante destro e selezionate Esci dal gruppo dal menu contestuale.

Sciogliere gruppi
Per sciogliere un gruppo di oggetti, selezionate il gruppo quindi andate su Cambia > Separa sulla 
barra dei menu principale, o fate clic con il tasto destro e selezionate Separa dal menu contestuale 
oppure usate la scorciatoia da tastiera Ctrl+Alt+Maiusc+G.

Combinare gli oggetti
Con Combina gli oggetti vengono fusi permanentemente per creare un nuovo oggetto. Gli oggetti 
originali non sono più disponibili come entità individuali e non possono essere modificati come 
singoli oggetti. Qualsiasi modifica di un oggetto combinato influisce su tutti gli oggetti usati per 
creare la combinazione.

Selezionate alcuni oggetti, quindi andate su Cambia > Combina sulla barra dei menu principale, o 
fate clic con il pulsante destro del mouse sugli oggetti e selezionate Combina dal menu 
contestuale, oppure usate la scorciatoia da tastiera Ctrl+Maiusc+K.

Dopo che avete selezionato gli oggetti, diventano disponibili anche le funzioni Unisci, Sottrai, e 
Interseca, così da poter creare un nuovo oggetto dagli oggetti selezionati. Vedere il Capitolo 5 
(Combinare oggetti multipli) nella Guida a Draw per maggiori informazioni su queste funzioni.
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Disporre, allineare e distribuire gli oggetti

In Draw potete disporre, allineare e distribuire gli oggetti selezionati, ciascuno rispetto agli altri:

• Potete disporre la posizione di un oggetto spostandolo in avanti o indietro in relazione 
all'ordine degli oggetti.

• Potete allineare gli oggetti l'uno rispetto all'altro usando A sinistra, Centrato, o A destra 
per l'allineamento orizzontale e In alto, Al centro o In basso per l'allineamento verticale.

• Potete distribuire gli oggetti in modo che lo spazio tra ciascuno degli oggetti sia lo stesso.

Consultare il Capitolo 5 (Combinare oggetti multipli) nella Guida a Draw per maggiori informazioni 
riguardo alla disposizione e all'allineamento di oggetti ciascuno rispetto agli altri.

Inserire e modificare le immagini

Draw ha un certo numero di funzioni per modificare immagini o grafica raster (bitmap); ad 
esempio, foto e immagini ottenute da scansione. Ciò include l'importazione e l'esportazione di 
oggetti grafici, e la conversione da un formato grafico ad un altro.

Draw include un ampio numero di filtri grafici che permettono di leggere e visualizzare diversi 
formati di file grafici. Include anche degli strumenti per lavorare con grafica raster, anche se non ha 
le stesse funzionalità di di programmi di grafica come Gimp o Adobe Photoshop. Vedere il Capitolo 
6 (Modificare immagini) nella Guida a Draw per maggiori informazioni.

Potete aggiungere immagini da differenti fonti:

• Direttamente dallo scanner (Inserisci >Immagine > Scanner)

• Immagini create da altri programmi, incluse fotografie prese con macchine fotografiche 
digitali (Inserisci >Immagine > Da File)

• La Galleria di Draw; vedere il Capitolo 11 (Oggetti grafici, Galleria e Fontwork) in questa 
guida per maggiori informazioni.

Lavorare con oggetti tridimensionali (3D)

Nonostante Draw non possieda le funzionalità dei principali programmi di disegno o di ritocco 
fotografico, è però in grado di produrre e modificare con ottimi risultati disegni tridimensionali.

Draw offre due tipi di oggetti tridimensionali: corpi 3D e forme 3D. In base a quale dei due tipi 
scegliete, vi sono metodi differenti per modificare un oggetto 3D (rotazione, illuminazione, 
prospettiva, e così via), essendo poi le forme 3D più semplici da impostare e modificare rispetto ai 
corpi 3D. Di contro, i corpi 3D consentono una maggiore personalizzazione.

Vedere il Capitolo 7 (Lavorare con oggetti tridimensionali) nella Guida a Draw per maggiori 
informazioni.
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Esportare oggetti grafici

Draw salva oggetti grafici e immagini nel formato open source *.odg. Per salvare un oggetto 
grafico o un intero file in un altro formato, usate File > Esporta e selezionate un formato 
dall'elenco mostrato. I formati grafici in cui Draw può esportare e salvare sono elencati 
nell'Appendice B Open Source, Open Standards, OpenDocument in questa guida.

Potete anche esportare file di Draw in formato HTML, XHTML, PDF, o Flash. L'esportazione in 
formato PDF per i moduli di LibreOffice è descritta nel Capitolo 10 (Stampa, esportazione e invio di  
e-mail) in questa guida.

L'esportazione nel formato HTML usa una procedura guidata di conversione che crea tante pagine 
web quante sono le vostre pagine nel documento di Draw. Come opzione potete scegliere di 
visualizzare le pagine in una cornice con un navigatore e impostare un indice. Per maggiori 
informazioni, vedere il Capitolo 12 (Creare pagine web) in questa guida.

Inserire commenti in un disegno

È possibile inserire commenti nei disegni, in modo simile a quanto avviene in Writer e Calc.

1) Andate su Inserisci > Commento sulla barra dei menu. Apparirà un piccolo riquadro 
contenente le vostre iniziali nell'angolo superiore sinistro del disegno, con una casella di 
testo più grande di fianco (Figura 211). Draw aggiunge automaticamente il vostro nome e 
la data nella parte bassa della casella di testo.

Figura 211: inserire commenti

2) Scrivete o incollate il vostro commento nella casella di testo. Potete applicare una 
formattazione di base a parti del testo selezionandolo, facendo clic con il pulsante destro, 
ed effettuando una scelta dal menu contestuale. Da questo menu, potete anche cancellare 
il commento corrente, tutti i commenti dello stesso autore, o tutti i commenti presenti nel 
documento.

3) Potete spostare i piccoli contrassegni dei commenti in qualsiasi punto del disegno. 
Tipicamente potrebbe essere posizionato sopra o vicino ad un oggetto a cui fate riferimento 
nel commento.

4) Per mostrare o nascondere i contrassegni dei commenti, andate su Visualizza > 
Commenti sulla barra dei menu principale.

5) Andate su Strumenti > Opzioni > Dati utente per inserire il nome che desiderate venga 
mostrato come autore dei commenti.
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6) Se al documento lavora più di una persona, ad ogni autore viene associato 
automaticamente un diverso colore di sfondo per i commenti.
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Capitolo 8  
Introduzione a Base
Il Database di LibreOffice 



Introduzione

Una sorgente dati, o database, è un insieme organizzato di informazioni a cui si può accedere con 
LibreOffice. Ad esempio, una lista di nomi e indirizzi è una sorgente dati che può essere impiegata 
per produrre la stampa in serie di una lettera. Anche il catalogo di un negozio potrebbe essere una 
sorgente dati gestibile tramite LibreOffice.

Nota
LibreOffice utilizza i termini “Sorgente dati” e “Database” come sinonimi, per riferirsi di 
volta in volta a database come MySQL o dBase oppure a un foglio elettronico o un 
documento di testo contenente dati.

In questo capitolo verrà spiegato come creare un database, cosa un database contiene, nonché 
come vengono utilizzate le sue componenti da LibreOffice. Inoltre sarà illustrato come registrare 
altre sorgenti dati utilizzando Base. Una sorgente dati può essere un database, un foglio 
elettronico o un documento di testo.

Nota
LibreOffice Base usa HSQL come motore database relazionale. Tutti i file creati da 
questo motore, inclusi i formulari del database,  vengono tenuti in un file .zip 
compresso.

Un database è costituito da un numero di campi i quali contengono ciascuno delle parti di dati. 
Ogni tabella del database è costituita da un gruppo di campi. Quando create una tabella, 
determinate anche le caratteristiche di ogni campo della tabella. I Formulari servono per inserire i 
dati nei campi di una o più tabelle associate al medesimo formulario. Possono essere anche usati 
per visualizzare i campi di una o più tabelle associate al formulario. Una ricerca crea una nuova 
tabella estrapolando i dati che vi interessano da tabelle già esistenti, basandosi sui criteri con i 
quali la ricerca stessa viene impostata. Un rapporto organizza le informazioni contenute nei campi 
di una ricerca in un documento, a seconda delle vostre necessità.

Attenzione

 

Per lavorare con i database in LibreOffice occorre aver installato il Java Runtime 
Environment (JRE). Se non lo avete installato sul vostro computer, potete scaricarlo 
da www.java.com e installarlo seguendo le istruzioni presenti sul sito. Prestate 
attenzione al numero di versione, che dovrebbe essere 6.0 o superiore. Per 
registrare Java in LibreOffice, utilizzate Strumenti > Opzioni > LibreOffice > Java.

La versione di JRE per Windows non può essere usata, mentre possono essere 
usate altre versioni.

Base crea database relazionali. Ciò rende abbastanza semplice la creazione di database dove i 
campi dati si trovano in relazione tra loro.

Per esempio: Considerate il database di una biblioteca. Conterrà un campo per i nomi degli autori 
ed un altro campo per i titoli dei libri. Vi è una chiara relazione tra gli autori ed i libri che ciascuno 
ha scritto. La biblioteca potrà avere più di un libro dello stesso autore. Questo è ciò che viene 
definita relazione uno a molti: un autore e molti libri. La maggior parte, se non tutte, le relazioni in 
un database di questo tipo sono di uno a molti.

Considerate un database degli impiegati per la stessa biblioteca. Uno dei campi riporterà i nomi 
degli impiegati mentre gli altri conterranno il codice fiscale e altri dati personali. La relazione tra il 
nome e il codice fiscale è di tipo uno a uno: un solo codice fiscale corrispondente ad ogni singolo 
nome.
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Se avete dimestichezza con gli insiemi matematici, un database relazionale può facilmente essere 
spiegato in termini di insiemi: elementi, sottoinsiemi, unioni, e intersezioni. I campi di un database 
costituiscono gli elementi. Le tabelle costituiscono i sottoinsiemi. Le relazioni vengono definite in 
termini di unioni ed intersezioni tra i sottoinsiemi (tabelle).

Per spiegare come funziona un database e come utilizzarlo, ne creeremo uno riguardante le spese 
per un'automobile.

Pianificare un database

Il primo passo nella creazione di un database è farsi una serie di domande. Scrivetele e lasciate 
uno spazio libero tra le domande, dove successivamente scriverete le risposte. Alcune delle 
risposte dovrebbero essere abbastanza ovvie prendendosi il giusto tempo per pensarci.

Potrebbe essere necessario passare più volte attraverso questo processo prima che tutto diventi 
chiaro nella vostra mente e sulla carta. Usare un documento di testo per scrivere queste domande 
e risposte rende più semplice spostare le domande, aggiungerne altre e/o cambiare le risposte.

Seguono alcune domande e risposte che sono state sviluppate prima di creare il database sulle 
spese per l'automobile. Avendo un'idea iniziale prima di cominciare, man mano che vengono in 
mente le domande e si elencano le risposte, si può realizzare di avere bisogno di tabelle e campi 
aggiuntivi.

Quali sono i campi necessari? Le spese si dividono in tre principali categorie: acquisto carburante, 
manutenzione e vacanze. Il costo annuale per la tassa di circolazione e il rinnovo della patente 
ogni quattro anni non rientrano in queste categorie. Sarà quindi necessaria una tabella specifica: 
tasse e patente.

Quali campi sono adatti per la categoria acquisti carburante? Data acquisto, lettura chilometrica, 
costo carburante, quantità carburante e metodo di pagamento dovrebbero essere adatti (non è 
necessario includere il consumo di carburante, in quanto può essere calcolato con una ricerca).

Quali campi sono adatti per la categoria manutenzione? Data del servizio, lettura chilometrica, tipo 
di servizio, costo del servizio, e prossima scadenza dello stesso tipo (ad esempio, nel caso di un 
cambio dell'olio, quando sarà necessario sostituirlo la volta successiva). Sarebbe anche utile se ci 
fosse un modo per scrivere delle note. Così alla lista può essere aggiunto un nuovo campo, per 
contenere le note.

Quali campi sono adatti per la categoria vacanze? Data, lettura chilometrica, carburante 
(includendo tutti i campi della tabella carburante), cibo (includendo pasti e spuntini), motel, totale 
pedaggi, altro. Siccome questi acquisti sono pagati con carte di credito o in contanti, è utile un 
campo che indichi il tipo di pagamento usato per ogni articolo.

Quali campi sono adatti per la categoria cibo? Colazione, pranzo, cena e spuntini dovrebbero 
andare bene. È opportuno elencare tutti gli spuntini singolarmente o elencare il costo totale degli 
spuntini della giornata? Si opta per la divisione in due campi degli spuntini: numero di spuntini e 
costo totale degli spuntini. È necessario anche un tipo di pagamento per ciascuna di queste voci: 
colazione, pranzo, cena e costo totale degli spuntini.

Quali sono i campi comuni a più categorie? Il campo Data compare in tutte le categorie, così come 
la lettura chilometrica ed il tipo di pagamento.

Come utilizzare le informazioni su questi tre campi? Mentre si è in vacanza, potrebbe essere 
desiderabile che le spese di ogni giorno vengano elencate insieme. I campi data suggeriscono una 
relazione tra la tabella vacanze e le date presenti nelle tabelle carburante e cibo. Questo significa 
che i campi data di queste tabelle saranno collegati durante la creazione del database.
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Il tipo di pagamento include due carte di credito e il contante. Verrà quindi creata una tabella con 
un campo per il tipo di pagamento, che verrà usata in un elenco a tendina nei formulari.

Suggerimento

Oltre ai campi elencati, che verranno creati nelle tabelle del database, c'è un 
ulteriore campo che potrebbe essere necessario: quello per la chiave primaria. 
In alcune tabelle il campo per la chiave primaria è già stato elencato. In altre 
tabelle, come quella del tipo di pagamento, deve essere creato un campo 
aggiuntivo per la chiave primaria.

Creazione di un nuovo database

Per creare un nuovo database, scegliete File > Nuovo > Database dalla barra dei menu, oppure 
fate clic sulla freccia di fianco all'icona Nuovo sulla barra degli strumenti Standard e selezionate 
Database dal menu a discesa. Entrambi i metodi apriranno la procedura guidata Database.

Nella prima pagina della procedura guidata Database, selezionate Crea un nuovo database e poi 
fate clic su Avanti.

La seconda pagina presenta due domande. Assicuratevi che la scelta per la prima domanda sia Sì, 
registra il database e la scelta per la seconda domanda sia Apri il database per la modifica. 
Fate clic su Fine.

Nota
Se il database non è registrato, non sarà accessibile agli altri componenti di 
LibreOffice, come Writer e Calc. Viceversa se il database è registrato, gli altri 
componenti potranno accedervi.

Salvate il nuovo database con il nome Automobile. Si aprirà la finestra Automobile – LibreOffice 
Base. Figura 212 mostra una parte di questa finestra.

Figura 212: creazione delle tabelle di un database
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Suggerimento

Ogni volta che viene aperto il database Automobile, si apre la finestra 
Automobile – LibreOffice Base. A questo punto potete eseguire modifiche al 
database. Il titolo di questa finestra è sempre <nome del database> – 
LibreOffice Base.

Attenzione

Una volta creato un database, ricordate di salvare il vostro lavoro regolarmente. Ciò 
non significa solo salvare quello che avete appena modificato. Dovete salvare 
l'intero database.

Per esempio, quando create la vostra prima tabella dovrete salvarla prima di poterla 
chiudere. Quando la tabella viene salvata per la prima volta, diviene parte integrante 
del database. In tal modo scrivete la tabella nel file del database.

Creazione delle tabelle di un database

In un database, una tabella immagazzina informazioni relativamente ad un gruppo di elementi detti 
campi. Per esempio, una tabella potrebbe contenere una rubrica di indirizzi, un catalogo, una 
rubrica telefonica o un listino prezzi. Un database deve avere almeno una tabella; e può 
contenerne diverse.

Per lavorare con le tabelle, fate clic sull'icona Tabelle nel riquadro Database, oppure premete 
Alt+a. Le tre attività che potete eseguire su una tabella sono elencate nel riquadro Attività (vedere 
la Figura 212).

Utilizzo della Creazione guidata per creare una tabella
Le procedure guidate sono disegnate per effettuare il lavoro di base. A volte però ciò potrebbe non 
essere sufficiente per le vostre necessità; in questi casi si può usare una procedura guidata come 
punto d'inizio e poi costruire su quanto creato dalla procedura.

La Procedura (o Creazione) guidata Tabella in Base contiene due categorie di tabelle: lavoro e 
personale. Ogni categoria contiene esempi di tabelle fra cui scegliere. Ciascuna tabella presenta 
una lista di campi disponibili. È possibile eliminare alcuni di questi campi e aggiungerne degli altri.

Un campo in una tabella rappresenta un pezzo di informazione. Per esempio, in una tabella per un 
listino prezzi, occorre un campo per il nome articolo, uno per la sua descrizione ed un terzo per il 
prezzo.

Poiché nessuno dei campi che occorrono per il database Automobile è compreso nelle tabelle 
d'esempio della Creazione guidata, usando questa procedura verrà creata una semplice tabella, la 
quale non ha nulla a che vedere con il database Automobile. Questa sezione è solamente un 
esercizio che illustra il funzionamento della Procedura guidata.

La Procedura guidata consente l'inserimento di campi nella tabella prelevandoli da una serie di 
tabelle preimpostate. Verrà creata una tabella con i campi provenienti da tre differenti tabelle 
suggerite nella Creazione guidata.

Attenzione

 

Ogni tabella richiede un campo per la Chiave primaria. Verrà in seguito spiegato a 
cosa serve questo campo, che verrà usato per numerare progressivamente le voci 
inserite e si incrementerà automaticamente ad ogni nuovo inserimento.

Capitolo 8  Introduzione a Base 249



Fate clic su Usa procedura guidata per la creazione di tabelle.... In tal modo si apre la Creazione 
guidata tabella (Figura 213).

Passo 1: Selezione dei campi.

Per selezionare i campi necessari verrà usata la tabella di esempio Collezione_CD, che si trova 
nella categoria Personale.

1) Categoria: Selezionate Personale. L'elenco a discesa Esempi di tabelle viene modificato in 
un elenco di esempi di tabelle appartenenti alla categoria personale.

2) Esempi di tabelle: Selezionare: Collezione_CD. Il riquadro Campi disponibili cambia e 
mostra un elenco di campi disponibili per questa tabella.

3) Campi selezionati: Usando il pulsante >, spostate i seguenti campi dal riquadro Campi 
disponibili al riquadro Campi selezionati, in questo ordine: ID_Collezione, TitoloAlbum, 
Interprete, DataAcquisto, Formato, Note, e NumeroTracce.

4) Campi selezionati da un'altra tabella di esempio. Fate clic sulla Categoria Lavoro. 
Selezionate Dipendenti dall'elenco a discesa Esempi di tabelle. Utilizzate il pulsante > per 
spostare il campo Foto dal riquadro Campi disponibili al riquadro Campi selezionati. Verrà 
inserito al fondo della lista, direttamente sotto il campo NumeroTracce.

5) Se fate un errore selezionando i campi, fate clic sul nome del campo nell'elenco Campi 
selezionati e usate il pulsante < per spostarlo dall'elenco Campi selezionati di nuovo 
all'elenco Campi disponibili.

6) Se fate un errore nell'ordine dei campi selezionati, fate clic sul nome del campo che si trova 
nella posizione errata e usate le frecce Su o Giù, alla destra dell'elenco Campi selezionati, 
per spostare il nome del campo nella posizione corretta.

7) Fate clic su Avanti.

Figura 213: selezione dei campi per la tabella

Passo 2: Impostazione dei tipi e dei formati di campo.

In questo passaggio vengono assegnate le proprietà idonee ai campi. Quando un campo viene 
selezionato, le informazioni sulla destra cambiano. (Vedere la Figura 214.) Diviene quindi possibile 
effettuare tutte le modifiche necessarie. Fate clic su ciascun campo, uno alla volta, ed effettuate le 
modifiche sotto riportate.
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Figura 214: impostazione dei tipi di campo

Nota

Se qualcuno di questi campi richiede obbligatoriamente l'immissione di dati, 
impostate Digitazione necessaria su Sì. Un  campo vuoto non sarà quindi permesso. 
In generale, è consigliabile impostare Digitazione necessaria su Sì solo se il campo 
in questione è determinante e deve sempre contenere un dato. Per impostazione 
predefinita, il campo Digitazione necessaria è impostato su No.

• ID_Collezione: Cambiate Valore Automatico da No a Sì. (esempio di un inserimento 
obbligatorio)

• TitoloAlbum:

– Digitazione necessaria: Lasciate Digitazione necessaria su No, a meno che tutta la 
vostra musica sia su album.

– Lunghezza: A meno che abbiate un titolo di un album che supera i 100 caratteri, 
compresi gli spazi vuoti, non cambiate tale lunghezza.

• Interprete: Usate le impostazioni predefinite. E se le vostre collezioni richiedono sempre un 
Interprete, impostate Digitazione necessaria su Sì.

• DataAcquisto: Tipo campo: impostazione predefinita data. Digitazione necessaria dovrebbe 
essere su No. (Potreste non conoscere la data d'acquisto).

Nota

In Base la lunghezza massima di ciascun campo deve essere specificata al 
momento della creazione. Dato che non è semplice modificare questa impostazione 
in una fase successiva, nel caso di dubbi conviene indicare una lunghezza 
maggiore. Base usa VCHAR come formato per i campi testo. Questo formato usa 
soltanto il numero effettivo dei caratteri digitati nel campo fino al limite massimo 
fissato, quindi  un campo contenente 20 caratteri occuperà solo 20 caratteri, anche 
se il limite è impostato a 100. I titoli di due album contenenti 25 e 32 caratteri 
rispettivamente utilizzeranno quindi spazio per 25 e 32 caratteri, e non per 100 
caratteri.

• Formato: Cambiate solo la Digitazione necessaria, impostandola da No a Sì.

• Note: Non sono necessari cambiamenti.

• Numero Tracce: Cambiate il Tipo di Campo in Intero molto piccolo [TINYINT]. Il numero di 
tracce inseribili sarà fino a 999. Intero piccolo [SMALLINT] ammetterebbe fino a 99999 
tracce, nel caso vi occorresse un numero di tracce superiore a 999.

• Foto: Usate le impostazioni predefinite.

Al termine fate clic su Avanti.
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Nota

Ogni campo ha un'impostazione Tipo di Campo, che deve essere specificata. Questi 
tipi includono testo, numeri interi, date e numeri decimali. Se il campo è destinato a 
contenere informazioni di carattere generale (per esempio un nome o una 
descrizione), allora sarà necessario usare testo. Se il campo conterrà esclusivamente 
numeri (per esempio un prezzo), dovrete scegliere il tipo numero decimale o un altro 
tipo numerico. La procedura guidata sceglie il tipo di campo corretto, così, per avere 
un'idea più precisa, guardate cosa questa propone di volta in volta per i vari campi.

Passo 3: Impostazione di una chiave primaria.

1) Verificate che l'opzione Crea una chiave primaria sia attiva.

2) Selezionate l'opzione Usa un campo esistente come chiave primaria.

3) Nell'elenco a discesa Nome del campo, selezionate ID_Collezione.

4) Spuntate l'opzione Valore Automatico nel caso non sia già selezionata.

5) Fate clic su Avanti.

Nota

Una chiave primaria identifica in modo univoco un elemento (detto più precisamente 
record) nella tabella. Ad esempio, ci potrebbero essere due persone che si 
chiamano “Rossi Mario" o tre persone residenti allo stesso indirizzo e il database 
deve essere in grado di distinguerli.

Il metodo più semplice consiste nell'assegnare un numero diverso a ciascun record: 
assegnare alla prima persona il numero 1, alla seconda il numero 2, e così via. Ogni 
voce ha il proprio numero e tutti i numeri sono differenti fra loro; in questo modo è 
facile fare riferimento ad un record tramite il suo numero identificativo, per esempio 
“record ID 172”. Questo è anche il metodo scelto in questo caso: ID_Collezione è 
solo un numero assegnato automaticamente da Base ad ogni record della tabella.

Passo 4: Creazione della tabella.

1) A questo punto, se lo desiderate, potete rinominare la tabella. In tal caso, si consiglia di 
scegliere un nome significativo. Per questo esempio, non effettuate nessuna modifica.

2) Lasciate selezionata l'opzione Inserisci subito i dati.

3) Fate clic su Fine per completare la Creazione guidata della tabella. Chiudete la finestra 
creata dalla procedura guidata. A questo punto vi trovate nuovamente nella finestra 
principale del database con l'elenco delle tabelle, ricerche, formulari e rapporti. Notate che 
la tabella “Collezione_CD” è ora elencata nel riquadro Tabelle, all'interno della finestra.

Creazione di una tabella tramite copia di una tabella 
esistente
Se disponete di una vasta collezione di musica, potreste voler creare una tabella per ogni tipo di 
musica che avete. Piuttosto che creare ogni tabella con la procedura guidata, potete fare delle 
copie della tabella originale, rinominando ciascuna copia secondo il tipo di musica che dovrà 
contenere.

1) Fate clic sull'icona Tabelle nel riquadro Database per visualizzare le tabelle esistenti.

2) Fate clic con il tasto destro del mouse sulla tabella Collezione_CD. Scegliete Copia dal 
menu contestuale.

3) Spostate il puntatore del mouse sotto la tabella, fate clic con il tasto destro, e selezionate 
Incolla. Si aprirà la finestra di dialogo Copia tabella.
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4) Modificate il nome della tabella in Pop e fate clic su Avanti.

5) Fate clic sul pulsante >> per spostare tutti i campi dal riquadro di sinistra a quello di destra, 
quindi fate clic su Avanti.

6) Poiché tutti i campi hanno già un Tipo di campo appropriato, non dovrebbe essere 
necessaria alcuna modifica. In ogni caso, eventuali modifiche devono essere apportate in 
questa fase della procedura. (Vedere l'Avvertenza più avanti nel testo per maggiori 
dettagli). Fate clic su Crea. La nuova tabella viene creata.

Attenzione

 

Dopo che una tabella è stata creata e vi sono stati immessi dei dati, eventuali 
modifiche dovrebbero essere molto limitate. È possibile aggiungere o rimuovere 
campi, ma l'aggiunta di un campo vi richiederà di inserire i dati richiesti da quel 
campo per ogni record che abbia dati da inserirvi.

L'eliminazione di un campo provoca la cancellazione di tutti i dati in esso 
contenuti. La modifica del tipo di campo può portare alla perdita parziale o completa 
dei dati. Quando si crea una nuova tabella, è quindi importante crearne i campi 
impostando oculatamente nomi, lunghezza e formati prima che i dati vengano 
inseriti.

La cancellazione di una tabella rimuove tutti i dati contenuti in ciascun campo della 
tabella. A meno che non ne siate certi, non cancellate mai una tabella.

Creazione di tabelle in Vista struttura
La Vista struttura è un metodo più avanzato per creare una nuova tabella, con il quale le 
informazioni relative ad ogni campo della tabella vengono inserite direttamente. Si utilizzerà questo 
metodo per le tabelle del database.

Nota
Anche se in Vista struttura il Tipo di campo e la formattazione sono differenti rispetto 
alla Procedura guidata, i concetti sono identici.

La prima tabella che verrà creata è quella del Carburante. I suoi campi sono IDCarburante, Data, 
CostoCarburante, QuantitàCarburante, Chilometraggio, e TipoDiPagamento.

1) Fate clic su Crea tabella in Vista struttura.

2) Campo IDCarburante: Digitate IDCarburante come primo Nome campo. Premete il tasto 
Tab per spostarvi alla colonna Tipo campo. Selezionate Intero [INTEGER] come Tipo 
campo dall'elenco a tendina. (L'impostazione predefinita è Testo [VARCHAR]).

Suggerimento

È possibile utilizzare una scorciatoia per selezionare il Tipo di campo dal menu 
a discesa digitando la prima lettera dell'opzione che si vuole scegliere. Potete 
scorrere le scelte per una determinata lettera premendo ripetutamente tale 
lettera.

a) Modificate le Proprietà di campo nella sezione in basso.

Modificate Valore automatico da No a Sì.
b) Impostate IDCarburante come Chiave Primaria.

Fate clic con il pulsante destro sul triangolo verde alla sinistra di IDCarburante (Figura
215) e scegliete Chiave primaria dal menu. In tal modo verrà inserita l'icona di una 
chiave a sinistra di IDCarburante.
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Figura 215: definizione del campo chiave primaria

Nota
La chiave primaria ha un unico scopo: individuare un record in modo univoco. Per il 
relativo campo può essere usato un qualsiasi nome. È stato usato IDCarburante per 
comodità, così da sapere a quale tabella appartiene.

3) Tutti gli altri campi (Data, CostoCarburante, QuantitàCarburante, Chilometraggio, e 
TipoDiPagamento):

a) Digitate il nome di campo successivo nella colonna Nome campo.

b) Selezionate Tipo campo per ogni campo.

• Per la Data usate Data[DATE]. (Premete il tasto D per selezionarla.)

• Per TipoDiPagamento usate Testo [VARCHAR], l'impostazione predefinita.

• Per tutti gli altri campi usate Numero [NUMERIC]. (Premete il tasto N per 
selezionarla.)

c) CostoCarburante, QuantitàCarburante, e Chilometraggio necessitano di modifiche 
nella sezione Proprietà del campo (Figura 216).

• QuantitàCarburante: Impostate la Lunghezza a 5 e le Posizioni decimali a 2 (La 
maggior parte delle pompe di carburante può misurare fino a 999,99 litri).

• Chilometraggio: Impostate la Lunghezza su 10 e le Posizioni decimali a 1.

• CostoCarburante: Impostate la Lunghezza a 5 e le Posizioni decimali a 2. Fate 
clic sul pulsante Esempio di formato (Figura 216). In tal modo si apre la finestra 
Formattazione di campo (Figura 217). Scegliete Valuta come Categoria e la 
vostra valuta come Formato. Per l'Euro scegliere 2 posizioni decimali. Usate 
comunque il valore che vi sembra più appropriato.
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Figura 216: impostazione delle proprietà di campo

Figura 217: opzioni Formattazione di campo

4) Per accedere ad ulteriori opzioni di formattazione, fate clic sul pulsante a destra del campo 
Esempio di formato.

5) Descrizione può contenere un commento qualsiasi, oppure può essere lasciato in bianco.

6) Per salvare e chiudere la tabella, selezionate File > Chiudi. Assegnate alla tabella il nome 
Carburante. Chiudete la tabella Carburante.

Seguite gli stessi passaggi per creare la tabella Vacanze. I campi ed i loro tipi di campo sono 
elencati nella Figura 218. Assicuratevi di aver definito il campo Data come chiave primaria prima di 
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chiudere. (Fate clic con il pulsante destro sul riquadro grigio alla sinistra di Data e selezionate 
Chiave primaria dal menu.) Salvate la tabella chiamandola Vacanze. Chiudete la tabella Vacanze.

Figura 218: campi nella tabella Vacanze

Definizione delle relazioni
Ora che le tabelle sono state create, quali sono le relazioni tra di esse? È giunto il momento di 
definirle basandosi sulla serie di domande e di risposte che ci si era posti all'inizio.

Quando si è in vacanza, può essere desiderabile inserire ogni giorno tutte le spese in una volta 
sola. La maggior parte di queste spese quindi rientrerà nella tabella Vacanze, tranne il carburante 
acquistato. Quindi queste due tabelle verranno collegate usando i campi Data. Siccome la tabella 
Carburante potrebbe avere più di un record nella medesima data, la relazione tra le tabelle 
Vacanze e Carburante è di uno a molti (indicata come 1:n).

Le tabelle Carburante e Manutenzione non hanno realmente una relazione anche se utilizzano 
campi simili, come Data e Chilometraggio.

Suggerimento
Nella creazione di un database, è importante determinare quali tabelle sono in 
relazione tra loro e come.

1) Per definire le relazioni, scegliete Strumenti > Relazioni. Si aprirà la finestra Automobile – 
LibreOffice Base: Struttura relazione e verrà mostrata la finestra di dialogo Aggiungi tabelle. 
(È anche possibile aprirla facendo clic sull'icona Aggiungi tabelle sulla finestra Struttura 
relazione).
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2) Nella finestra di dialogo Aggiungi tabelle, usate uno di questi metodi per aggiungere una 
tabella alla finestra Struttura relazione:

• Fate doppio clic sul nome della tabella che volete aggiungere. In questo caso, fatelo 
sulle tabelle Vacanze e Carburante.

• Oppure, fate clic sul nome della tabella e poi fate clic su Aggiungi per ogni tabella.

3) Fate Clic su Chiudi per chiudere la finestra di dialogo Aggiungi tabelle, quando avete 
aggiunto le tabelle che desiderate.

4) Potete definire la relazione tra le tabelle Vacanze e Carburante in due modi:

• Fate clic sul campo Data nella tabella Carburante e trascinatelo sul campo Data nella 
tabella Vacanze. Quando rilascerete il pulsante del mouse, apparirà una linea di 
collegamento tra i due campi data (Figura 219).

• Oppure fate clic sull'icona Nuova relazione. Si aprirà così la finestra Relazioni 
(Figura 220). Le due tabelle sono elencate nella sezione Tabelle considerate.

a) Nella sezione Campi considerati fate clic sull'elenco a tendina sotto l'etichetta 
Carburante.

b) Selezionate Data dall'elenco della tabella Carburante.

c) Fate clic nella cella a destra di questo elenco a discesa. Si aprirà un elenco a 
discesa per la tabella Vacanze.

d) Selezionate Data dall'elenco della tabella Vacanze. Ora la finestra dovrebbe 
assomigliare alla Figura 220.

e) Fate clic su OK.

Figura 219: attribuzione di una relazione di tipo 
1:n

Figura 220: campi selezionati in una relazione

5) Modifica delle sezioni Opzioni di aggiornamento e Opzioni di eliminazione della finestra 
Relazioni.
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a) Fate clic con il pulsante destro sulla linea che collega i campi Data nei due elenchi 
delle tabelle per aprire un menu.

b) Selezionate Modifica per aprire la finestra di dialogo Relazioni (Figura 221).

Figura 221: sezione Opzioni di aggiornamento e Opzioni di 
eliminazione

c) Selezionate Aggiorna cascata.

d) Selezionate Elimina cascata.

e) Fate clic su OK per chiudere la finestra di dialogo Relazioni e scegliete File > Salva 
per salvare la finestra Struttura relazione.

Sebbene queste opzioni non siano strettamente necessarie, costituiscono un aiuto. La loro 
attivazione vi permette di aggiornare una tabella che ha una relazione con un'altra tabella 
che è stata modificata. Ciò vi permette inoltre di cancellare un campo dalla tabella senza 
causare incongruenze.

Creazione di un formulario

I Database vengono usati per archiviare dati. Ma come si inseriscono i dati nel database? I 
Formulari vengono usati per questo. Nel linguaggio dei database, un formulario è l'interfaccia 
tramite la quale si inseriscono o si modificano i dati.

Figura 222: campi di un semplice formulario Figura 223: semplice formulario con aggiunte

Un semplice formulario è composto dai campi di una tabella (Figura 222). Formulari più complessi 
possono contenere molto altro, come testi aggiuntivi, grafica, caselle di scelta e altri elementi 
ancora. La figura 223 mostra la stessa tabella con una etichetta di testo (Acquisti di carburante), 
una casella di riepilogo (elenco a tendina) in TipodiPagamento e uno sfondo grafico.

Una casella di riepilogo è utile quando un campo contiene una scelta di opzioni fissa. Vi evita di 
dover inserire i dati a mano, e impedisce l'inserimento di opzioni non valide.
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Nel database d'esempio, i pagamenti per cibo o carburante potrebbero essere effettuati con una 
delle due carte di credito oppure in contanti, quindi queste sarebbero le opzioni disponibili per tutte 
le caselle che contengono pagamenti.

Per creare una casella di riepilogo (o menu a tendina), è prima necessario creare una piccola 
tabella separata, contenente le opzioni. Questa verrà poi collegata al campo corrispondente nel 
formulario. L'argomento è trattato in dettaglio nella Guida Utente di Base e non viene discussa in 
questa guida.

Utilizzo della Procedura guidata per creare un formulario
Verrà utilizzata la Procedura guidata Formulario per creare il formulario Vacanze, che conterrà un 
formulario e un formulario secondario.

Nella finestra principale del database (Figura 212), fate clic sull'icona Formulario nella colonna di 
sinistra. Nel riquadro delle Attività, fate doppio clic su Usa procedura guidata per la creazione 
dei formulari... per aprire la Creazione guidata formulario (Figura 224). Un formulario semplice 
richiede solo alcuni di questi passi, mentre per formulari più complessi potrebbero essere 
necessari tutti.

Passo 1: Selezione dei campi.

1) In Tabelle o query, selezionate Tabella: Vacanze. Campi disponibili elenca i campi della 
tabella Vacanze.

2) Fate clic sulla doppia freccia verso destra per spostare tutti i campi nell'elenco Campi nel 
formulario. Fate clic su Avanti.

Figura 224: fasi della Creazione guidata formulario

Passo 2: Impostazione di un formulario secondario

Dal momento che è già stata creata una relazione tra le tabelle Carburante e Vacanze, verrà usata 
tale relazione. Se non ci fosse nessuna relazione già definita, questo dovrebbe essere fatto al 
passo 4.

1) Fate clic sulla casella con l'etichetta Aggiungi formulario secondario.

2) Fate clic su Formulario secondario basato su una relazione esistente.

3) Carburante viene elencato come relazione che vogliamo aggiungere. Quindi fate clic su 
Carburante per evidenziarlo, come in Figura 225. Fate clic su Avanti.
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Figura 225: aggiungere un formulario secondario

Passo 3: Aggiungere campi nel formulario secondario.

Questo passo è esattamente uguale al passo 1. La sola differenza è che non tutti i campi verranno 
usati per il formulario secondario.

1) Carburante è la voce preselezionata sotto Tabelle o query.

2) Usate il pulsante >> per spostare tutti i campi a destra.

3) Fate clic su IDCarburante per evidenziarlo.

4) Usate il pulsante < per spostare il campo IDCarburante a sinistra (Figura 226). 

5) Fate clic su Avanti.

Figura 226: selezione dei campi di un formulario secondario

Passo 4: Caricamento dei campi uniti.

Questo passaggio è per quelle tabelle o ricerche per le quali non sono state ancora definite delle 
relazioni. Siccome è già stata definita una relazione, la procedura guidata salta questo passaggio.
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Nota
È possibile creare tra due tabelle una relazione basata su più di una coppia di 
campi. Le modalità e il motivo di ciò sono discussi nella Guida a Base.

Attenzione

Quando selezionate una coppia di campi da due tabelle per utilizzarli come 
relazione, essi devono avere lo stesso tipo di campo. Questo è il motivo per il quale 
è stato usato il campo Data in entrambe le tabelle: entrambi i campi sono del tipo 
Data[DATE].

In base al numero di coppie di campi scelte come relazione, occorre che certi 
requisiti siano soddisfatti perché il formulario possa funzionare.

• Nessun campo dal formulario secondario può essere la Chiave primaria della sua 
tabella. (IDCarburante non può essere usato).

• Ogni coppia di campi collegati deve avere lo stesso tipo di campo.

• Uno dei campi del formulario principale deve essere la Chiave primaria della sua 
tabella. (Data deve essere usata).

Passo 5: Disporre i controlli.

Un controllo in un formulario è costituito da due parti: l'etichetta ed il campo. Questo passo nella 
creazione del formulario determina come l'etichetta ed il campo sono posizionati l'uno rispetto 
all'altro. Le quattro scelte da sinistra a destra sono In colonna - testo fisso a sinistra, In colonna - 
testo fisso in alto, Tabellare, e In riga - testo fisso in alto.

1) Disposizione del formulario principale: fate clic sulla seconda icona (In colonna - testo fisso 
in alto). Le etichette verranno messe sopra al loro campo relativo.

2) Disposizione del formulario secondario: Fate clic sulla terza icona (Tabellare). (Le etichette 
sono i titoli delle colonne ed i campi sono le voci al loro interno, disposti come in un foglio 
elettronico). Fate clic su Avanti.
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Passo 6: Impostazione immissione dati.

A meno che abbiate uno specifico bisogno di spuntare una di queste voci, scegliete le impostazioni 
predefinite. Fate clic su Avanti.

Passo 7: Applicare stili di formato.

1) Selezionate il colore che desiderate nell'elenco Applica stili di formato. (Nell'esempio si è 
scelto il beige che corrisponde a Arancione 4 nella tabella Colore.)

2) Selezionate il Bordo campo che desiderate. (Nell'esempio si è scelto il 3D. Potete 
sperimentare le differenti configurazioni possibili).

3) Fate clic su Avanti.

Passo 8: Impostare il nome.

1) Inserite il nome del formulario. In questo caso, è Carburante.

2) Fate clic su Modifica il formulario.

3) Fate clic su Fine. Il formulario si apre in Modalità struttura.

Modifica di un formulario
I controlli verranno spostati in parti diverse del formulario e lo sfondo verrà cambiato con 
un'immagine. Inoltre l'etichetta del campo TipoDiPagamento verrà modificata e il campo verrà 
trasformato in un elenco a tendina.

Per prima cosa, bisogna decidere cosa si desidera cambiare. La discussione verrà articolata in 
dieci passi relativi alle modifiche pianificate.

• Creare un menu a discesa per il campo Data nel formulario principale e allungare il campo 
per mostrare il giorno della settimana, il giorno in numero, il mese e l'anno.

• Accorciare la lunghezza dei campi pagamento (tutti i campi che contengono la parola 
Pagamento).

• Disporre i controlli in gruppi: cibo, formulario secondario carburante e varie.

• Cambiare la formulazione di alcune delle etichette. Alcune parole singole dovrebbero 
diventare due. Dove possibile bisognerebbe usare abbreviazioni (Km. per chilometraggio).

• Modificare la lunghezza di diversi campi ed etichette. Solo Pranzo, Cena, Motel e Pedaggi 
hanno una lunghezza accettabile. Tuttavia, per ottenere un aspetto più gradevole, verranno 
apportate modifiche anche ad essi.

• Allungare il campo Note verticalmente, aggiungere una barra di scorrimento e spostarlo.

• Effettuare modifiche nelle colonne Data e TipoDiPagamento nel Formulario secondario, di 
modo che siano simili a quelle del formulario principale.

• Aggiungere delle intestazioni per ogni gruppo nel formulario principale.

• Cambiare lo sfondo con un'immagine, quindi modificare alcune delle etichette in modo che 
siano chiaramente leggibili sullo sfondo scelto. Cambiare il colore del carattere delle 
intestazioni.

Di seguito alcuni metodi che verranno usati in questi passaggi. I controlli nel formulario principale 
sono costituiti dalle etichette e dai loro campi. Alcune volte si agirà sull'intero controllo,  altre volte 
solo sull'etichetta o sul campo, altre ancora su un gruppo di controlli.
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• Facendo clic sull'etichetta o sul campo viene selezionato l'intero controllo. Intorno al 
controllo apparirà un bordo con otto maniglie verdi. Potete quindi trascinarlo dove 
desiderate.

Figura 227: un controllo selezionato

• Con Ctrl+clic sull'etichetta o sul campo si seleziona solo l'etichetta o il campo. Premendo il 
tasto Tab potete spostare la selezione dal campo all'etichetta e viceversa.

Figura 228: selezione del campo di un 
controllo

• Spostare un gruppo di controlli è quasi semplice quanto muoverne uno solo.

1) Fate clic sul campo di controllo più in alto e a sinistra tra quelli che desiderate 
spostare, per selezionarlo.

2) Spostate il cursore appena sopra e a sinistra del campo di controllo selezionato.

3) Tenendo premuto il pulsante del mouse trascinate il cursore verso il basso a destra 
del gruppo dei controlli, poi rilasciate il pulsante.

Mentre trascinate il cursore, appare una casella tratteggiata che indica cosa è contenuto nella 
selezione. Assicuratevi che questa sia sufficientemente ampia da poter contenere tutti i controlli.

Quando rilasciate il pulsante del mouse, intorno ai campi di controllo selezionati appare un bordo 
con delle maniglie verdi.

Figura 229: selezione di controlli 
multipli

Spostate il cursore su uno dei campi. Esso si modifica nell'icona di trascinamento. Trascinate il 
gruppo di controlli dove li volete posizionare.

• Fate clic sul controllo Pedaggi per selezionarlo. Quindi trascinatelo sulla destra, vicino al 
controllo Pranzo.

Suggerimento

Quando si vuole ridimensionare o spostare un controllo, è opportuno selezionare 
due proprietà della barra degli strumenti Struttura del formulario: Cattura alla 
griglia e Linee guida durante lo spostamento. Sarà più facile allineare i controlli, 
ed uno schema di ciò che state muovendo si sposterà insieme al cursore.

Sarebbe anche opportuno avere entrambi i righelli attivi (Visualizza > 
Righello).
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Passo 1: Modifica del campo Data.

1) Fate Ctrl+clic sul campo Data per selezionarlo.

2) Spostate il cursore sulla maniglia verde centrale del lato destro. Dovrebbe modificarsi in 
una freccia a doppia punta.

3) Tenendo premuto il pulsante sinistro del mouse, trascinate il cursore verso destra fino a 
raggiungere la lunghezza di 6 cm. La linea tratteggiata verticale è allineata con il numero 6. 
Rilasciate il pulsante del mouse.

4) Fate clic sull'icona Controllo sulla barra degli strumenti Controlli per formulario. Se non è 
visibile, scegliete Visualizza > Barre degli strumenti > Controlli per formulario. Si aprirà 
la finestra Proprietà: Campo data. Ogni riga contiene una proprietà del campo.

Figura 230: barra degli strumenti Controlli per formulario

• Scorrete verso il basso fino alla proprietà Formato data. Si tratta di un elenco a 
tendina la cui impostazione predefinita è Standard (breve). Fate clic per aprire 
l'elenco. Selezionate la voce Standard (esteso).

• Scorrete verso il basso fino alla proprietà Apribile. L'impostazione predefinita è No. Si 
tratta anche in questo caso di un elenco apribile. Fate clic per aprire l'elenco. 
Selezionate Sì.

Suggerimento

Per vedere come apparirà il campo Data, fate clic sull'icona Modo bozza 
On/Off (la seconda icona da sinistra nella Figura 230). Potete fare ciò ogni 
volta che volete vedere come appare il formulario con i cambiamenti che avete 
apportato.

Passo 2: Ridurre la larghezza di un campo.

Tutti i campi con un'etichetta contenente la parola pagamento sono troppo lunghi. Prima di 
spostare i controlli occorre accorciarli.

Figura 231: selezione di un campo

1) Fate Ctrl+clic sul campo PagamentoCo.

2) Spostate il cursore sulla maniglia verde centrale del lato destro. Il cursore cambia forma e 
diventa una freccia a doppia punta.

3) Trascinatelo verso sinistra finché il campo raggiunge una larghezza di 2,5 cm (1 pollice).

4) Ripetete questi passaggi per accorciare i seguenti campi: PagamentoPr, PagamentoCe, 
PagamentoSn, PagamentoMo e PagamentoVa.

Suggerimento
Se avete attivato le icone Cattura alla griglia e Linee guida durante lo 
spostamento nella barra degli strumenti Struttura del formulario, potrete vedere 
la lunghezza del campo mentre lo accorciate.
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Passo 3: Spostare i controlli per raggrupparli in categorie.

Ora verranno spostati i controlli in modo che l'insieme assomigli alla Figura 232.

1) Fate clic sul primo controllo che volete spostare. Intorno al controllo apparirà un bordo con 
otto maniglie verdi.

2) Portate il cursore sopra l'etichetta o il campo del controllo. Esso si modifica nell'icona di 
trascinamento.

3) Trascinate e rilasciate il controllo nella posizione che desiderate.

4) Usate lo stesso metodo per posizionare nel modo opportuno gli altri controlli.

Figura 232: posizionamento dei controlli

Attenzione

  

Non utilizzate il comando Ctrl+clic quando spostate un campo. Questo comando 
sposta il campo oppure l'etichetta ma non entrambi. Per spostarli entrambi, 
trascinateli, tenendo premuto il pulsante del mouse, nella posizione desiderata.

Passo 4: Modifica delle etichette.

I nomi dei campi, fino a poco tempo fa, dovevano essere costituiti da una sola parola. Tuttavia, le 
etichette dei campi in un formulario possono essere costituite da più parole. Ne verrà quindi 
modificato il testo nelle etichette.

1) Fate Ctrl+clic sull'etichetta NumSnack. Utilizzate uno dei seguenti modi:

• Fate clic con il pulsante destro sull'etichetta NumSnack e selezionate Campo di 
controllo dal menu contestuale.

• In alternativa, fate clic sull'icona Controllo nella barra degli strumenti Struttura del 
formulario (Figura 230).

2) Si apre una finestra di dialogo chiamata Proprietà: Testo fisso. Essa contiene tutte le 
proprietà dell'etichetta selezionata.

• Nella casella Didascalia, modificate l'etichetta in Num Snack.

• Chiudete la finestra di dialogo Proprietà.

3) Utilizzate la stessa procedura per modificare anche queste etichette: PagamentoCo in 
Pagamento, PagamentoPr in Pagamento, PagamentoCe in Pagamento, SpeseSnack in 
Spese Snack, PagamentoMo in Pagamento, PagamentiVa in Pagamenti Vari, e NoteVarie 
in Note.
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Suggerimento

Potete modificare tutte le specifiche dell'elenco nella finestra Proprietà. Ad 
esempio, modificando l'Allineamento da Sinistra a Centro, il testo verrà centrato 
all'interno dell'etichetta. Avendo un poco di tempo a disposizione, potete 
sperimentare le differenti impostazioni giusto per per farvi un'idea di quello che 
potete ottenere.

Passo 5: Modificare la larghezza delle etichette e dei campi.

La larghezza dei seguenti controlli verrà impostata a 2 cm (0.8 pollici): Colazione, Pranzo, Cena, 
Chilometraggio, Num Snack, Pedaggi, Spese Snack, Motel, e Varie. Tutti i campi dei pagamenti 
sono stati modificati nel passo 2, tranne PagamentiVa, che deve essere portato a 3 cm (1.2 pollici).

1) Fate clic con il pulsante destro su Colazione e scegliete Posizione e dimensione. Nella 
finestra di dialogo Posizione e dimensione, modificate la Larghezza a 2 cm.

2) Ripetete l'operazione per l'intero elenco dei controlli, usando 3 cm per PagamentiVa.

Attenzione

  

Quando modificate la posizione o la dimensione di un intero controllo, utilizzate la 
finestra di dialogo Posizione e dimensione oppure il metodo del trascinamento.

Quando lavorate su un'etichetta oppure su un campo (ma non entrambi 
contemporaneamente), potete utilizzare la finestra di dialogo Proprietà, che 
permette una maggiore precisione. In ogni caso, fate attenzione a non selezionare 
accidentalmente l'intero controllo quando utilizzate la finestra di dialogo Proprietà, 
altrimenti applicherete gli stessi identici valori sia all'etichetta che al campo. Ad 
esempio, se inserite i valori per una nuova posizione, sia il campo che l'etichetta si 
sposteranno nella stessa posizione e il campo verrà posizionato sopra l'etichetta. 
Dovrete quindi spostarli entrambi nella posizione desiderata.

Nota

Per aprire la finestra Proprietà, fate clic con il pulsante destro su un controllo e 
selezionate Campo di controllo dal menu contestuale. Oppure, fate clic sull'icona 
Controllo sulla barra degli strumenti Controlli per formulario. Prestate la dovuta 
attenzione, e utilizzate Ctrl+Z per annullare eventuali errori. Istruzioni dettagliate su 
come usare la finestra Proprietà sono reperibili nella Guida a Base.

Passo 6: Modificare il campo NoteVarie.

La modifica prevede l'inserimento, nel controllo NoteVarie, che ha un campo di tipo memo, di una 
barra di scorrimento verticale per dello spazio aggiuntivo, in caso si desiderasse aggiungere altro 
testo.
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Figura 233: selezione delle Barre di scorrimento nella 
finestra Proprietà

1) Fate Ctrl+clic sul campo Note Varie. Le maniglie verdi appariranno intorno al campo, ma 
non intorno alla sua etichetta.

2) Fate clic sull'icona Controllo per aprire la finestra Proprietà (Figura 233).

3) Scorrete verso il basso alla proprietà Tipo di testo, dove vedrete impostato il valore 
predefinito Riga singola.

• Cambiatelo in Più righe.

4) Scorrete verso il basso fino alla voce Barre di scorrimento. In questo elenco modificate la 
selezione da Nessuno a Verticale.

5) Chiudete la finestra Proprietà. (Tasto Esc)

6) Allungate il campo Note Varie spostando il cursore sulla maniglia verde centrale nella parte 
bassa del campo e trascinando verso il basso fino alla lunghezza di 6 cm (2.4 pollici).

Passo 7: Modifica delle etichette e dei campi nel formulario secondario

Il formulario secondario è posizionato nella parte bassa del formulario. Qui è opportuno ampliare la 
colonna Data,  e cambiare l'etichetta della colonna TipoDiPagamento in due parole.

• Per allargare la colonna Data, portate il puntatore del mouse sulla linea di divisione tra le 
colonne Data e CostoCarburante. Quando il puntatore cambia forma, fate clic e trascinate, 
spostando il divisore verso destra.

• Per modificare la colonna TipoDiPagamento:

– Fate clic con il pulsante destro sull'etichetta TipoDiPagamento per aprire il menu.

– Selezionate Colonna per aprire la finestra di dialogo Proprietà. Nella casella 
Didascalia, modificate TipoDiPagamento in Tipo di pagamento.

– Chiudete la finestra di dialogo Proprietà.
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Passo 8: Assegnare delle intestazioni ai gruppi.

Questo passaggio risulta più semplice da eseguire se i segni di fine paragrafo sono visibili. 
Scegliete Visualizza > Caratteri non stampabili per attivarli.

Figura 234: elenco Applica stile

1) Assicuratevi di aver posizionato il cursore nella parte alta sull'angolo sinistro del formulario. 
in caso contrario, fate clic sull'angolo per spostarvi in tale posizione.

2) Premete il tasto Invio per spostare il cursore in basso, nello spazio tra il campo Data e il 
campo Colazione.

3) Nell'elenco a discesa Applica Stile cambiate da Stile predefinito a Intestazione 2.

4) Utilizzate la barra spaziatrice per spostare il cursore dove volete che inizi l'intestazione.

5) Digitate l'intestazione Pasti.

6) Usate la barra spaziatrice per muovere il cursore al centro dell'area snack.

7) Digitate l'intestazione Snack.

8) Usate il tasto Invio per spostare il cursore tra il controllo Cena e il formulario secondario.

9) Usate la barra spaziatrice per portare il cursore al centro del formulario secondario.

10)  Digitate l'intestazione Dati Carburante.

Nota

Se sapete usare gli stili, potete aprire la finestra Stili e formattazione con il tasto F11. 
Selezionando con il pulsante destro del mouse lo stile di paragrafo Intestazione 2 
potete modificare l'aspetto di tutte e tre le intestazioni. Vedere il Capitolo 6 della 
Guida a Writer per dettagli.

Passo 9: Modifica dello sfondo del formulario.

Lo sfondo del formulario può essere costituito da un colore o da un oggetto grafico (un'immagine). 
Potete utilizzare qualsiasi colore presente nella Tabella Colori in Strumenti > Opzioni > 
LibreOffice > Colori; Se sapete come crearli, potete anche usare dei colori personalizzati. È 
anche possibile utilizzare un'immagine (un file grafico) come sfondo.

1) Fate clic destro sul formulario per aprire il menu contestuale.

2) Selezionate Pagina.

3) Assicuratevi che sia selezionata la scheda Sfondo. (Sarà in grassetto, mentre le altre 
schede saranno in carattere predefinito).
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Figura 235: finestra di dialogo Stile di pagina

4) Fate clic su Ciano chiaro. (Seconda riga, quarta colonna da sinistra).

5) Fate clic su Applica per vedere gli effetti della modifica del colore. Oppure, fate clic su OK 
per chiudere la finestra di dialogo.

Suggerimento

Imparare ad utilizzare gli stili può essere molto utile. Utilizzando gli stili, si può 
cambiare il colore del carattere di tutte e tre le intestazioni 
contemporaneamente. Ci sono altri metodi per cambiare il colore del carattere, 
ma richiedono la ripetizione degli stessi passaggi per ogni intestazione che si 
vuole modificare.

6) Per aggiungere un'immagine allo sfondo:

a) Fate clic sullo strumento Galleria (cerchiato in rosso). Si aprirà la finestra Galleria.

b) Selezionate l'immagine che volete usare. (nell'esempio si è utilizzato pebble-light).

i) Sfogliate le varie scelte possibili.

ii) Fate clic con il pulsante destro sulla vostra scelta.

iii) Inserisci > Sfondo > Pagina

c) Fate clic sullo strumento Galleria per chiudere la finestra della galleria.

d) Il formulario dovrebbe assomigliare a quello in Figura 236.
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Figura 236: il formulario ultimato

Passo 10: Modificare l'ordine delle schede.

Il tasto Tab sposta il cursore da un campo all'altro. È molto più semplice utilizzare questo sistema 
piuttosto che fare clic su ogni campo per inserirvi i dati. Questo permette inoltre di raggruppare le 
spese in aree prima di iniziare l'inserimento dei dati. Ad esempio, tutte le spese pasto possono 
essere raggruppate insieme, così come le spese snack e gli acquisti carburante.

Figura 237: barra degli strumenti Struttura del formulario con l'icona Sequenza di 
attivazione cerchiata

1) Fate Ctrl+clic sul campo Data.

2) Fate clic sull'icona Struttura del formulario nella barra degli strumenti Controlli per 
formulario per aprire la barra degli strumenti Struttura del formulario (Figura 237), oppure 
scegliete Visualizza > Barre degli strumenti > Struttura del formulario per aprire questa 
barra.

3) Fate clic sull'icona Sequenza di attivazione (cerchiata).

4) Ora riorganizzate l'ordine dei campi nella finestra Ordine schede.

a) Cercate txtPagamentoMo in basso nella lista e fateci clic sopra.

b) Fate clic sul pulsante Sposta in alto fino a quando txtPagamentoMo non si trova 
sotto fmtMotel.

c) Ripetete questa procedura per mettere i campi nell'ordine mostrato in Figura 238. 
Fate clic su OK.

5) Salvate e chiudete il formulario.

6) Salvate il database.
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Figura 238: sequenza di ordinamento per il formulario 
principale

Creazione di formulari e formulari secondari in Vista struttura
Questo metodo richiede l'uso delle barre degli strumenti Controlli per formulario e Struttura del 
formulario. Queste tecniche esulano dallo scopo di questo documento. Le istruzioni per creare 
formulari utilizzando la Vista struttura sono descritte nella Guida a Base.

Accesso ad altre sorgenti dati

LibreOffice consente l'accesso a sorgenti dati e quindi il loro collegamento con documenti di 
LibreOffice. Per esempio, una stampa in serie collega un documento esterno contenente un elenco 
di nomi e di indirizzi ad una lettera, stampando una copia della lettera per ogni voce della lista.

Per accedere a una sorgente dati diversa da un file *.odb:

1) Selezionate File > Nuovo > Database per visualizzare la finestra Creazione guidata 
Database.

2) Selezionate l'opzione Collega a un database esistente. Fate clic sulla freccia di fianco al 
campo Tipo di Database e selezionate il tipo di database dall'elenco a tendina. Fate clic su 
Avanti.

3) Fate clic su Sfoglia e selezionate il database. Fate clic su Avanti.

4) Accettate le impostazioni predefinite: Sì, registra il database e Apri il database per la 
modifica. Fate clic su Fine. Assegnate un nome al database e salvatelo nella cartella 
desiderata.

Accedere a un foglio elettronico come sorgente dati
Anche in questo caso la procedura è molto simile a quella vista per accedere ai database di altro 
tipo:

1) Scegliete File > Nuovo > Database.
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2) Selezionate l'opzione Collega a un database esistente. Selezionate Foglio elettronico come 
Tipo di database.

3) Fate clic su Sfoglia per cercare il foglio elettronico a cui volete collegarvi. Se il foglio 
elettronico è protetto da password, spuntate l'opzione Password necessaria. Fate clic su 
Avanti.

4) Se è necessario specificare un nome utente, indicatelo. Se è necessaria anche una 
password, attivate la corrispondente opzione. Fate clic su Avanti.

Nota

Utilizzando questo metodo di accesso al foglio elettronico non è possibile fare 
alcuna modifica nel foglio stesso. Potete solo visualizzare il contenuto del foglio 
elettronico, eseguire ricerche e creare rapporti basati sui dati che sono già stati 
inseriti nel foglio elettronico.

Tutte le modifiche in un foglio elettronico devono essere fatte nel foglio stesso, 
tramite Calc. Dopo aver modificato e salvato il foglio elettronico, vedrete le 
modifiche nel database. Se create e salvate una tabella aggiuntiva nel vostro foglio 
elettronico, troverete una nuova tabella nel database, alla sua successiva apertura.

Registrare database *.odb
Database creati con LibreOffice 3.x o successivi sono salvati nel formato *.odb (OpenDocument 
Base). È possibile utilizzare anche altri programmi per creare database in questo formato. 
Registrare un database *.odb è semplice:

1) Scegliete Strumenti > Opzioni > LibreOffice Base > Database.

2) Sotto Database registrati, fate clic su Nuovo.

3) Navigate fino alla cartella in cui si trova il database.

4) Assicuratevi di aver scritto correttamente il nome registrato.

5) Fate clic su OK.

Nota
A volte, aggiornando LibreOffice a una nuova versione, l'elenco di file database 
registrati scompare. Quando capita, dovete seguire questi passaggi per registrare i 
file database con l'ultima versione di LibreOffice.

Utilizzo delle sorgenti dati in LibreOffice

Le sorgenti dati registrate, siano esse fogli elettronici, documenti di testo, database esterni o altre 
sorgenti compatibili, possono essere utilizzate con gli atri componenti di LibreOffice, inclusi Writer 
e Calc.

Visualizzazione delle sorgenti dati
Aprite un documento con Writer oppure Calc. Per visualizzare le sorgenti dati a disposizione 
premete F4 oppure selezionate Visualizza > Sorgenti dati dal menu. In questo modo viene 
mostrato un elenco dei database registrati, incluso Bibliography e qualsiasi altro database 
registrato, come il database Automobile creato precedentemente in questo capitolo.

Per visualizzare ciascun database, fate clic sul segno  alla sinistra del nome del database 
(vedere Figura 239). In questo modo si visualizzano le Tabelle e le Ricerche. Fate clic sul segno 
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 accanto a Tabelle per visualizzare le singole tabelle create. Ora fate clic su una tabella per 
visualizzare tutti i record in essa contenuti.

Figura 239: database

Modifica delle sorgenti dati
Alcune sorgenti dati (tranne i fogli elettronici) possono essere modificate all'interno della finestra 
Visualizza Sorgenti dati. È possibile modificare, aggiungere o eliminare record di dati.

Visualizzare i dati di una tabella

Facendo clic su una tabella le righe e le colonne di dati appariranno sul lato destro della finestra 
Sorgente dati. Per modificare questi dati è sufficiente fare clic nella cella in cui si desidera 
effettuare le modifiche, cambiare quanto necessario, e poi fare clic nella riga al di sopra o al di 
sotto per salvare i nuovi dati.

Al di sotto dei record di dati sono presenti cinque piccoli pulsanti. I primi quattro permettono di 
spostarsi indietro o avanti attraverso i record, oppure direttamente all'inizio o alla fine. Il quinto 
pulsante, sul quale è raffigurata una piccola stella, permette di inserire un nuovo record.

Figura 240: pulsanti di navigazione all'interno della Visualizzazione sorgenti dati

Per eliminare un record, fate clic con il pulsante destro sul riquadro grigio a sinistra di una riga per 
evidenziare l'intera riga, quindi selezionate Elimina righe per eliminare la riga selezionata.

Figura 241: eliminazione di una riga nella finestra di Visualizzazione dati

Avvio di Base per lavorare con sorgenti dati
In qualsiasi momento è possibile avviare LibreOffice Base dal riquadro di Visualizzazione delle 
sorgenti dati. Fate semplicemente clic con il pulsante destro del mouse su un database o sulle 
icone Tabelle o Ricerche e selezionate Modifica file del database. Una volta avviato Base, è 
possibile modificare, aggiungere ed eliminare tabelle, ricerche, formulari e rapporti.
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Utilizzo di sorgenti dati in Writer e Calc
I dati possono essere inseriti in documenti di Writer e Calc attraverso le tabelle della finestra 
sorgente dati. In Writer, è possibile inserire valori di singoli campi. È anche possibile creare una 
tabella completa nel documento di Writer. Un tipico modo di utilizzare una sorgente dati è quello 
della stampa in serie.

Suggerimento

Scegliete Strumenti > Stampa guidata in serie oppure fate clic sull'icona 
Stampa in serie sul pannello della Visualizzazione sorgenti dati per avviare la 
procedura Stampa guidata in serie, che vi guida nella creazione di un 
documento per la stampa in serie. Vedere il Capitolo 11 nella Guida a Writer.

documenti Writer
Per inserire un campo di una tabella dalla finestra Sorgenti dati all'interno di un documento Writer, 
fate clic sul nome del campo (il rettangolo grigio sovrastante l'elenco del campo) e, tenendo 
premuto il pulsante sinistro del mouse, trascinate il campo nel documento. Nel documento Writer, 
esso apparirà come <CAMPO> (dove CAMPO rappresenta il nome del campo trascinato).

Ad esempio, per inserire le spese per i pasti e chi le ha pagate, in una determinata data della 
vacanza:

1) Aprite l'elenco delle sorgenti dati (F4) e selezionate la tabella Vacanze nel database 
Automobile.

2) Create una frase di questo tipo: “Il giorno (data), la colazione del costo di (costo) è stata 
pagata da (nome), il pranzo del costo di (costo) è stato pagato da (nome), e la cena del 
costo di (costo) è stata pagata da (nome)." Però digitate solamente 
“Il giorno , la colazione del costo di è stata pagata da , il pranzo del costo di è stato pagato 
da , e la cena del costo di è stata pagata da .”

3) Per sostituire (data), fate clic sul campo Data nella finestra sorgente dati e trascinatelo alla 
destra della parola giorno. Il risultato sarà: Il giorno <Data>. Se avete attivato 
l'ombreggiatura dei nomi di campo (Visualizza > Contrassegni), il campo <Data> sarà 
contrassegnato da uno sfondo grigio. In caso contrario, no.

4) Per sostituire il primo (costo), fate clic sul campo Colazione e trascinatelo a destra di la 
colazione del costo di. Assicuratevi di avere il giusto spazio tra il nome del campo e le 
parole inserite prima e dopo il campo. Risultato: la colazione del costo di <Colazione>.

5) Per sostituire il primo (nome), fate clic sul campo PagamentoCo e trascinatelo a destra di 
pagato da. Risultato: pagato da <PagamentoCo>.

6) Allo stesso modo riempite il resto dei campi della frase.

• Usate <Pranzo> e <PagamentoPr> per la seconda coppia di (costo) e (nome) della 
frase.

• Usate <Cena> e <PagamentoCe> per la terza coppia di (costo) e (nome) della frase.

7) Risultato finale: Il giorno <Data>, la colazione del costo di <Colazione> pagato da 
<PagamentoCo>, il pranzo del costo di <Pranzo> pagato da <PagamentoPr>, e la cena del 
costo di <Cena> pagato da <PagamentoCe>.

8) Aggiungete ora i dati ai campi della frase:

• Fate clic nel riquadro grigio a sinistra della riga di cui volete aggiungere i dati. Questa 
riga dovrebbe essere evidenziata come la seconda riga della Figura 242.

• Fate clic sull'icona (cerchiata) Dati in campi. Questa operazione dovrebbe mostrarvi i 
campi compilati con i dati della riga che avete scelto.
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• Selezionate un'altra riga e fate ancora clic su questa icona. I dati nella frase cambiano 
con quelli della riga scelta ora.

• Salvate il documento se volete utilizzarlo come esempio in seguito.

Figura 242: riga selezionata nel riquadro sorgenti dati

Aggiungere dati in una tabella è più semplice e richiede forse meno passaggi. Alcuni dei passaggi 
sono molto simili.

1) Spostatevi nella posizione in cui volete inserire la tabella e fate clic.

2) Fate Ctrl+clic sul riquadro grigio a sinistra di ogni riga della sorgente dati che volete 
importare come riga nella vostra tabella, se le righe non sono consecutive. Per selezionare 
righe consecutive, fate clic sul riquadro grigio a sinistra della riga più in alto e poi 
Maiusc+clic sulla riga più in basso tra quelle che volete selezionare.

3) Fate clic sull'icona Dati in testo per aprire la finestra di dialogo Inserisci colonne di 
database (Figura 243). (L'icona Dati in testo si trova a sinistra dell'icona Dati in campi in 
Figura 242.)

4) Spostate i campi che desiderate nella tabella dall'elenco Colonne database all'elenco 
Colonne tabella.

• Per posizionare i campi nell'ordine che desiderate, fateci clic sopra ed usate la freccia 
singola per spostarli nell'ordine preferito. Potete anche usare solo i campi che vi 
occorrono e non necessariamente tutti quelli disponibili.

• Se desiderate invece selezionare tutti i campi, usate la doppia freccia che punta verso 
destra per spostarli tutti insieme. L'ordine dei campi nella tabella creata sarà lo stesso 
della tabella sorgente dati.

• Per rimuovere un campo dall'elenco Colonne tabella, fateci clic sopra ed utilizzate la 
freccia singola che punta a sinistra.

5) Per ricominciare la procedura, spostando tutti i campi indietro nell'elenco, fate clic sulla 
doppia freccia che punta verso sinistra.

6) Scegliete la configurazione della vostra tabella. Utilizzate la configurazione standard 
mostrata nella Figura 243.

7) Fate clic su OK. Salvate il documento.
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Figura 243: finestra di dialogo Inserisci colonne di database

Fogli elettronici di Calc
Vi sono due modi per trasferire dati in un foglio elettronico di Calc. In un caso i dati vengono inseriti 
nelle celle del foglio elettronico. Nell'altro caso vengono creati dei record completamente nuovi nel 
foglio elettronico . Mentre è possibile accedere direttamente ai dati inseriti nelle celle del foglio 
elettronico, i dati contenuti nei  nuovi record creati nel foglio elettronico possono essere solo 
visualizzati.

Per inserire i dati direttamente nelle celle del foglio elettronico si utilizza l'icona Dati in testo, come 
per inserire una tabella in un documento Writer. Vi sono comunque alcune differenze.

La procedura è molto semplice.

1) Fate clic nella cella del foglio elettronico che volete sia l'angolo superiore sinistro 
dell'insieme di dati, includendo anche il nome della colonna. 

2) Usate F4 per aprire la finestra sorgente dati e selezionate la tabella di cui volete utilizzare i 
dati.

3) Selezionate le righe dei dati che volete inserire nel foglio elettronico:

• Fate clic nel riquadro grigio a sinistra della riga che volete selezionare, se avete 
bisogno di una sola riga. Questa riga risulterà evidenziata.

• Per selezionare più righe, tenete premuto il tasto Ctrl mentre fate clic sul riquadro 
grigio delle righe di cui avete bisogno. Queste righe verranno evidenziate.

• Per selezionare tutte le righe presenti, fate clic sul riquadro grigio nell'angolo 
superiore sinistro. Tutte le righe verranno evidenziate.

4) Fate clic sull'icona Dati in testo per inserire i dati nelle celle del foglio elettronico.

5) Salvate il foglio elettronico.

Aggiungere record a un foglio elettronico è abbastanza facile. Dovete aver aperto la finestra 
Sorgente dati e il vostro foglio elettronico, e selezionato la tabella dalla quale desiderate prelevare i 
dati.

1) Fate clic sul riquadro grigio contenente il nome del campo per il campo ID della tabella.
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2) Trascinate il riquadro grigio dove volete che il record venga inserito nel foglio elettronico.

3) Ripetete questo passaggio fino a che avete posizionato tutti i campi che vi occorrono nella 
giusta posizione.

4) Salvate il foglio elettronico.

5) Fate clic su una riga della tabella nella finestra Sorgenti dati.

6) Trascinate i dati dal campo ID della riga selezionata al campo ID all'interno del foglio 
elettronico. L'icona Salva dovrebbe attivarsi.

7)  Fate clic sul pulsante Modifica file sulla barra degli strumenti standard, per impostare il 
foglio in sola lettura. Fate clic su Salva quando viene richiesto se volete salvare il file.

La finestra Sorgenti dati scompare, i campi nel foglio elettronico vengono popolati con i dati della 
riga precedentemente selezionata, e la barra degli strumenti Navigazione formulario appare nella 
parte bassa del foglio elettronico.

8) Fate clic sulle frecce della barra Navigazione formulario per vedere i diversi record della 
tabella. (Le frecce sono cerchiate in rosso). Il numero nella casella cambia in base al 
numero del record selezionato facendo clic sulle frecce. I dati nei campi variano in base al 
contenuto del record selezionato.

Figura 244: frecce di navigazione del formulario

Inserimento dei dati tramite formulario

I record servono ad organizzare i dati che vengono inseriti in un formulario. Organizzano anche i 
dati inseriti nei formulari secondari.

Differenti tipi di campi consentono metodi differenti di inserimento dei dati. In molti   casi, è 
possibile utilizzare più metodi.

Il primo passo per inserire dati in un formulario consiste nell'aprire il formulario dalla finestra 
principale del database (Figura 212).

1) Fate clic sull'icona Formulari nell'elenco Database.

2) Trovate nell'elenco Formulari il nome del formulario (Vacanze).

3) Fate doppio clic sul nome del formulario.

Il modo più veloce per inserire la data nel campo Data è di fare clic sulla freccia a destra del 
campo che apre il calendario a comparsa (Figura 245). Quindi fate clic sul giorno che desiderate. 
Premete quindi il tasto Tab per spostarvi nel campo Chilometraggio.

Figura 245: calendario apribile
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I campi Chilometraggio, Pedaggi e Motel sono campi numerici. Inserite i valori direttamente al loro 
interno, oppure utilizzate le frecce su e giù. Dopo avere inserito il valore, usate il tasto Tab per 
spostarvi nel campo successivo.

• Facendo clic sulla freccia verso l'alto incrementate il valore, e sulla freccia verso il basso 
diminuite il valore di una unità.

• Queste due frecce modificano solo i numeri a sinistra della virgola.

• I numeri alla sua destra devono essere modificati cancellandoli e reinserendo il valore 
desiderato.

Il campo Pagamento del Motel è un elenco a tendina. Se, come in questo caso, tutti gli elementi 
dell'elenco iniziano con lettere differenti, è sufficiente digitare la lettera iniziale per selezionare la 
voce desiderata.

• Se due o più elementi dell'elenco hanno la stessa lettera iniziale, ripetendo la digitazione di 
tale lettera vedrete comparire ciclicamente questi elementi.

• Quando la selezione è corretta, mediante il tasto Tab spostatevi nel campo Varie. 

Il resto dei campi del formulario principale sono campi numerici o elenchi apribili fino al campo 
NoteVarie. Si tratta di un campo testo. Digitate quello che volete in questo campo come fareste in 
un normale editor di testo.

Nota

Dato che il tasto Tab viene usato per spostarsi tra i campi, non può essere usato 
all'interno di un campo di testo. Tutti gli spazi devono essere inseriti mediante la 
barra spaziatrice. Inoltre, nei campi di testo il tasto Invio agisce come un'interruzione 
di riga, spostando il cursore nella riga successiva. Mentre Invio vi permette di 
spostarvi tra campi non testuali, non si comporta allo stesso modo in un campo di 
testo. Usate quindi il tasto Tab per uscire da un campo di testo.

Se non vi fosse un formulario secondario per i dati relativi al carburante, premendo il 
tasto Tab nell'ultimo campo si salverebbe il contenuto di tutti i campi, che verrebbero 
anche puliti, e il formulario diverrebbe pronto per l'inserimento dei dati relativi al 
secondo record.

Siccome è presente un formulario secondario, usando il tasto Tab si posiziona il cursore nel primo 
campo Data del formulario secondario, con la data inserita automaticamente uguale a quella del 
campo Data del formulario principale.

I campi CostoCarburante, QuantitàCarburante e Chilometraggio sono campi numerici. Il campo 
Pagamento è un elenco a tendina. Inserite i dati come già avete fatto nel formulario principale, e 
usate il tasto Tab per spostarvi al campo successivo.

Usando il tasto Tab per lasciare il campo Pagamento vi sposterete nel campo Data della riga 
successiva, con la data inserita automaticamente. Ora potete inserire un secondo record di dati 
carburante per il medesimo giorno.

Per muovervi su un altro record quando il formulario ha anche un formulario secondario, fate clic 
su uno qualsiasi dei campi del formulario principale. In questo caso, fate clic sul campo Data del 
formulario principale, quindi utilizzate le frecce direzionali in basso. Ve ne sono quattro, da sinistra 
a destra: Primo record di dati, Record di dati precedente, Record dati successivo, e Ultimo Record 
(Figura 244). A destra di queste frecce vi è l'icona Nuovo record di dati.

Per creare un nuovo record mentre vi trovate in un altro record sul formulario principale, fate clic 
sull'icona Record dati successivo oppure sull'icona Nuovo Record.
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Suggerimento

Il numero che compare nella casella Numero record dati corrisponde al record i 
cui dati sono visualizzati nel formulario.

Se conoscete il numero del record che volete, potete inserirlo nel riquadro 
Record di dati e poi premere il tasto Invio per visualizzarne il contenuto.

La Figura 246 riporta un record con i dati inseriti nei rispettivi campi.

Figura 246: esempio di record del formulario principale e secondario Vacanze

Creazione di ricerche

Le ricerche servono ad ottenere specifiche informazioni da un database. I risultati di una ricerca 
sono tabelle particolari all'interno del database.

Per mostrare l'utilizzo delle ricerche, verranno usati due diversi metodi:

• Usando la tabella Collezione CD, verrà creato un elenco di album di un particolare artista, 
tramite la Creazione guidata.

• Tra le informazioni che si possono ricavare dai dati della tabella Carburante c'è il consumo 
medio. Ciò verrà fatto utilizzando la Vista struttura. (È preferibile creare in Vista struttura le 
ricerche che richiedono dei calcoli).

Utilizzo della Creazione guidata per creare una ricerca
Le ricerche prodotte dalla Creazione guidata forniscono uno o più elenchi di informazioni, in base a 
ciò che si vuole conoscere. È possibile ottenere una o più risposte, a seconda delle circostanze.

Nella finestra principale del database (Figura 212), fate clic sull'icona Ricerche nella sezione 
Database, poi, nella sezione Attività, fate clic su Usa procedura guidata per la creazione di 
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ricerche. Si aprirà la finestra Creazione guidata ricerca (Figura 247). Si vuole sapere quali album 
sono di un certo gruppo o musicista (l'autore dell'album). È anche possibile includere la data di 
acquisto di ogni album.

Nota

Quando lavorate con una ricerca, potete usare più di una tabella. Dal momento che 
tabelle differenti possono contenere campi con lo stesso nome, il formato usato per 
identificare i campi della ricerca è Nome tabella.nome campo, con un punto (.) tra il 
nome della tabella e il nome del campo. Per esempio, il campo Pranzo della tabella 
Vacanze sarebbe identificato in una ricerca come Vacanze.Pranzo.

Passo 1: Selezione dei campi.

1) Selezionate la tabella Collezione_CD dall'elenco a tendina Tabelle.

2) Selezionate i campi dalla tabella Collezione_CD nell'elenco Campi disponibili.

a) Fate clic su Interprete, e usate il pulsante > per spostarlo nell'elenco Comandi di 
campo nella ricerca.

b) Allo stesso modo spostate i campi TitoloAlbum e DataAcquisto.

c) Fate clic su Avanti.

Suggerimento
Per cambiare l'ordine dei campi, selezionate il campo che volete spostare e fate 
clic sulla freccia verso l'alto o la freccia verso il basso.

Figura 247: prima pagina della Creazione guidata ricerca

Passo 2: Selezione del tipo di ordinamento.

Per ordinare le informazioni della ricerca è possibile indicare fino a quattro campi. La scelta implica 
una piccola riflessione volta ad individuare quale sia il campo più importante.

Nella ricerca, il campo Interprete è il più importante. Ad esso segue il titolo dell'album, e la data di 
acquisto è il meno importante di tutti. Naturalmente, se si fosse interessati a conoscere il tipo di 
musica comprato in un certo giorno, la data di acquisto sarebbe il dato più importante.
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Figura 248: pagina di impostazione dell'ordinamento

1) Fate clic sul primo elenco a discesa Ordina per.

a) Fate clic su Collezione_CD.Interprete 2> per selezionarlo.

b) Per elencare gli Interpreti in ordine alfabetico (a-z), selezionate Crescente sulla 
destra.

2) Fate clic sul secondo elenco a discesa Ordina per.

• Fate clic su Collezione_CD.TitoloAlbum e selezionate Crescente.

3) Ripetete questa procedura per Collezione_CD.DataAcquisto.

4) Fate clic su Avanti.

Passo 3: Selezione delle condizioni di ricerca.

Le condizioni di ricerca permettono di confrontare il nome inserito con il nome dell'artista nel 
database e di decidere se includere o meno quel particolare artista nella ricerca.

• è uguale a: lo stesso

• non è uguale a: diverso

• è minore di: viene prima di

• è maggiore di: viene dopo di 

• è uguale o minore di: è lo stesso o viene prima di

• è uguale o maggiore di: è lo stesso o viene dopo di

• come: simile in qualche modo

Nota
Queste condizioni si applicano a numeri, lettere (seguendo l'ordine alfabetico) e 
date.

1) Dal momento che si sta cercando una sola cosa, verrà usata l'impostazione standard Trova 
tutti i seguenti.

2) Si sta cercando un particolare interprete, quindi selezionate Collezione_CD. Interprete 
nell'elenco Comandi di campo e è uguale a come Condizione.

3) Digitate il nome dell'interprete nel riquadro Valore. Fate clic su Avanti.

Passo 4: Selezione del tipo di ricerca.

Desiderando semplici informazioni, l'impostazione standard: Ricerca dettagliata dovrebbe 
rispondere alle vostre esigenze. Fate clic sul pulsante Avanti nella parte inferiore della finestra.

Nota
Dal momento che si sta preparando una ricerca semplice, il Raggruppamento e le 
Condizioni di raggruppamento non ci servono. Quindi i passi 5 e 6 vengono saltati in 
questo caso.
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Passo 7: Assegnazione degli Alias desiderati.

Vengono qui usate le impostazioni predefinite. Fate clic su Avanti.

Passo 8: Panoramica.

Assegnate un nome alla ricerca (ad esempio: Ricerca_Interprete). Alla destra del nome vi sono 
due possibili scelte; selezionate Mostra ricerca. Fate clic su Fine.

Utilizzo della Vista struttura per creare una ricerca
Creare ricerche usando la Vista struttura non è difficile come potrebbe sembrare a prima vista. Può 
richiedere diversi passaggi, ma ognuno di essi è abbastanza semplice.

Si supponga di voler sapere quanto consuma il nostro veicolo (in Italia, chilometri per litro). Per 
ottenere tale dato è necessario creare due ricerche, di cui la prima è usata come parte della 
seconda.

Passo 1: Aprire la prima ricerca in Vista struttura.

• Fate clic su Crea ricerca in vista struttura.

Passo 2: Aggiungere le tabelle.

Figura 249: finestra di dialogo Aggiungi tabella o ricerca

1) Fate clic su Carburante per evidenziarlo.

2) Fate clic su Aggiungi, quindi su Chiudi.

Suggerimento
Portate il cursore sul bordo inferiore della tabella carburante (Figura 249) e 
trascinatelo per allungare la tabella e visualizzare così tutti i campi presenti.
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Figura 250: tabella Carburante 
nella ricerca

Passo 3: Aggiungere i campi nella tabella in basso.

1) Nella tabella Carburante fate doppio clic sul campo IDCarburante, 

2) sul campo Chilometraggio e 

3) sul campo QuantitàCarburante.

La tabella in basso nella finestra della ricerca è costituita adesso da tre colonne.

Figura 251: tabella ricerca

Passo 4: Impostare i criteri per la ricerca.

Si desidera che il campo IDCarburante della ricerca inizi con il numero 1.

1) Nella tabella Ricerca, digitate >0 nella cella Criteri sotto IDCarburante.

2) Fate clic sull'icona Esegui ricerca nella barra degli strumenti Struttura ricerca.

Figura 252: barra degli strumenti Struttura ricerca

La Figura 253 contiene la tabella Carburante con le voci inserite e il risultato della ricerca basata 
sulla tabella Carburante: i risultati della ricerca sono in Figura 254.
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Figura 253: tabella Carburante

Figura 254: ricerca della tabella Carburante

Passo 5: Salvare e chiudere la ricerca.

Visto che questa ricerca contiene l'ultima lettura del contachilometri, chiamatela Ultima_lettura al 
momento del salvataggio. Quindi chiudete la ricerca.

Passo 6: Creare la ricerca per calcolare il consumo di carburante.

1) Fate clic su Crea ricerca in vista struttura per aprire una nuova ricerca.

2) Aggiungete nella ricerca la tabella Carburante, come già fatto al passo 2: Aggiungere le 
tabelle, senza però chiudere la finestra Aggiungi tabella o ricerca.

3)  Aggiungete la ricerca Ultima_lettura a questa ricerca appena creata.

a) Fate clic su Ricerche per ottenere la lista delle ricerche presenti nel database (Figura 
255).

b) Fate clic su Ultima_lettura.

c) Fate clic su Aggiungi, e quindi su Chiudi.

Figura 255: selezione delle ricerche da aggiungere a un'altra 
ricerca

Passo 7: Aggiungere i campi alla tabella nella parte inferiore della ricerca.

Si desidera ora calcolare il consumo di carburante; per fare ciò c'è bisogno della quantità di 
carburante e della distanza percorsa. Poiché la quantità di carburante da considerare è relativa 
all'ultima lettura del contachilometri, verrà usata la ricerca Ultima_lettura per ottenerla. Verrà usato 
anche il campo Chilometraggio dalla tabella Carburante e dalla ricerca Ultima_Lettura.
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Figura 256: tabelle in questa ricerca

1) Nella ricerca Ultima_lettura fate doppio clic sul campo QuantitàCarburante 

2) e poi su Chilometraggio.

3) Nella tabella Carburante fate doppio clic su Chilometraggio.

Figura 257: campi aggiunti alla ricerca

Passo 8: Inserire il campo differenza IDCarburante.

Si vuole ora impostare ad uno (1) la differenza tra il valore del campo IDCarburante della tabella 
Carburante ed il valore del campo IDCarburante della ricerca Ultima_Lettura.

1) Digitate "Ultima_lettura"."IDCarburante" - "Carburante"."IDCarburante" 
nel campo a destra del campo Chilometraggio della tabella Carburante.

2) Digitate il numero 1 (uno) nella cella Criteri di questa colonna.

3) Calcolo della distanza percorsa:

• Digitate "Ultima_lettura"."Chilometraggio" - 
"Carburante"."Chilometraggio" nella cella Campo.

• Digitate >0 nella cella Criteri.

4) Calcolo del consumo: digitate ("Ultima_lettura"."Chilometraggio" - 
"Carburante"."Chilometraggio")/"Ultima_lettura"."QuantitàCarburante
" nella colonna successiva, alla destra della parola Campo.

Figura 258: inserimento dei calcoli dei campi
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Figura 259: campo per il calcolo della distanza percorsa

Figura 260: campo per il calcolo del consumo di carburante

Nota

Quando inserite campi per questi calcoli, dovete utilizzare il seguente formato: 
nome della tabella o della ricerca seguito da un punto (.) e quindi dal nome del 
campo. Per le tabelle o ricerche aventi nomi composti separati da trattini, 
racchiudete il nome tra virgolette doppie. La ricerca aggiungerà automaticamente le 
virgolette rimanenti, come si può notare in Figura 260.

Usate il simbolo aritmetico tra i due elementi. È possibile eseguire più operazioni 
utilizzando le parentesi per raggruppare le operazioni aritmetiche.

Passo 9: Avviare la ricerca e fare alcune modifiche.

Dopo avere avviato la ricerca per essere sicuri che tutto funzioni correttamente, si possono 
nascondere tutti i campi non necessari.

Figura 261: risultato della ricerca consumo di carburante

1) Fate clic sull'icona Esegui ricerca nella barra degli strumenti Struttura ricerca (Figura 252). 
Il risultato sarà simile a quello mostrato nella Figura 261.

Notate che alcune etichette di colonna non sono visibili in quanto sono molto lunghe; si può 
risolvere questo problema usando un alias (soprannome) per molti di questi campi. Le 
etichette vengono sostituite dai loro alias.

2) Aggiungere Alias:

Digitate gli alias come mostrato nella Figura 262.
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Figura 262: tabella ricerca con gli alias inseriti

3) Eseguite di nuovo la ricerca. Il risultato è raffigurato in Figura 263.

Figura 263: esecuzione ricerca con alias

Non essendovi bisogno della colonna che mostra la differenza tra i campi IDCarburante della 
tabella e della ricerca, la medesima verrà nascosta; anche se non visibile, verrà comunque usata 
per i calcoli.

4) Nascondere una colonna che non è necessario vedere.

Rimuovete la spunta dalla casella di controllo della cella Visibile, come in Figura 264.

Figura 264: rendere un campo invisibile nell'esecuzione di una ricerca

5) Eseguite nuovamente la ricerca (Figura 265).

Figura 265: esecuzione della ricerca con una colonna nascosta

Passo 10: Chiudere, salvare e assegnare un nome alla ricerca.

Il nome di questa ricerca potrebbe essere Consumo carburante.

È ovviamente possibile eseguire molti altri calcoli in questa ricerca, come per esempio il costo per 
distanza percorsa o quanto si è pagato complessivamente con ogni tipo di pagamento utilizzato.

Nota

Per utilizzare appieno le ricerche sono necessarie competenze matematiche, in 
particolare sulle operazioni insiemistiche (unioni, intersezioni, AND, OR, 
complementi, e ogni loro combinazione). È inoltre opportuno avere una copia della 
Guida all'uso di HSQLDB, disponibile sul sito http://hsqldb.org/.

Creazione dei rapporti

I rapporti forniscono informazioni reperite nel database, disponendole in modo utile. Da questo 
punto di vista sono simili alle ricerche. I rapporti sono generati da una tabella, da una vista o da 
una ricerca del database.
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Essendo basati su una singola tabella, vista o ricerca, dovete prima decidere quali campi volete 
usare nel rapporto. Se volete usare campi provenienti da tabelle diverse, dovete prima combinarli 
in una singola ricerca o vista, utilizzando poi una di queste per creare un rapporto.

Ad esempio, un rapporto sulle spese delle vacanze include sia i costi per il carburante che i costi 
per i pasti. Questi valori sono contenuti nei campi di due differenti tabelle: Vacanze e Carburante, 
perciò questo rapporto richiede la creazione di una ricerca o di una vista.

Attenzione

I rapporti dinamici aggiornano solo i dati che sono stati modificati o aggiunti in una 
tabella o in una ricerca. Non mostrano invece alcuna modifica effettuata a una 
tabella o a una ricerca. Ad esempio, dopo aver creato il rapporto sottostante, aprite 
la ricerca Consumo carburante creata nella sezione precedente. Per la colonna 
"Ultima_lettura".”Chilometraggio” – “Carburante".”Chilometraggio”, sostituite il 
numero 1 con 3. Il rapporto resterà identico a come era prima della modifica. Ma se 
aggiungete altri dati alla ricerca ed eseguite nuovamente il rapporto, esso conterrà i 
nuovi dati.

Creazione di un rapporto
Si procederà ora a creare un rapporto sulle spese delle vacanze. È opportuno porsi alcune 
domande prima di creare un rapporto.

• Quali informazioni si vogliono inserire nel rapporto?

• Come si vogliono presentare le informazioni?

• Quali campi sono necessari per fornire queste informazioni?

• Sarà necessario creare una ricerca o una vista, nel caso i campi necessari appartengano a 
tabelle diverse?

• I dati devono essere elaborati prima di essere inseriti nel rapporto?

Le categorie di spesa per la vacanza sono: motel, pedaggi, varie, colazione, pranzo, cena, snack e 
carburante. Un possibile rapporto potrebbe corrispondere ad un elenco dei totali per ognuna delle 
categorie di spesa. Un altro potrebbe produrre l'elenco dei totali di spesa per ogni giorno di 
vacanza. Una terza possibilità potrebbe essere un elenco del totale di ogni categoria di spesa 
suddiviso per ogni tipo di pagamento. (questo permetterebbe di sapere da dove si preleva il 
denaro necessario per pagare tali spese). Una volta creata una ricerca per ottenere uno qualsiasi 
di questi elenchi, è possibile creare un rapporto basato sulla ricerca.

Verranno ora creati due rapporti: il primo elencherà le spese di ogni giorno (escluse quelle per il 
carburante) e il secondo elencherà delle statistiche sul carburante. I campi della tabella Vacanze 
necessari per il primo rapporto sono: Data, Motel, Pedaggi, Colazione, Pranzo, Cena, SpeseSnack 
e Varie. Questo rapporto richiede soltanto la tabella Vacanze. Se il rapporto elencasse le spese 
totali per ciascuno di questi campi, si dovrebbe anche creare una ricerca per avere questi totali.

Il secondo rapporto riguarda la tabella Carburante. Dal momento che questa tabella include 
acquisti di carburante effettuati anche al di fuori del periodo di vacanze, occorre creare una ricerca 
che contenga solo gli acquisti di carburante fatti durante la vacanza.

Rapporti statici e dinamici
Creando un rapporto tramite la Procedura guidata, si possono scegliere due tipi di rapporti, 
nell'ultima pagina della procedura: statici o dinamici. La scelta dipende anche dalla presenza o 
meno, nella vostra installazione di LibreOffice, dell'estensione Report Builder. Se questa 
estensione funziona con la vostra versione di LibreOffice, dovreste sempre selezionare dinamico. 
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Diversamente, se desiderate aggiornare il rapporto successivamente, dovreste selezionare 
dinamico. Se scegliete statico, il rapporto conterrà sempre i dati relativi alla data originale del 
rapporto.

LibreOffice include l'estensione Report Builder; tuttavia, in alcune versioni sono stati riscontrati dei 
problemi di funzionamento. Quindi, in tali casi, la creazione di un rapporto viene fatta allo stesso 
modo in cui viene fatta in OpenOffice.org 3.3; il capitolo Introduzione a Base per OpenOffice.org 
3.3 spiega i concetti base per creare tale tipo di rapporto.

Se l'estensione Report Builder è funzionante, selezionando un rapporto di tipo statico si otterrà 
solo un layout tabellare dei dati nel rapporto, simile alla Figura 270292. L'area al di sopra dei dati 
può contenere cose come l'autore del rapporto, la sua data e il suo nome. È anche possibile 
inserire in tale posizione un logo aziendale. L'area al di sotto dei dati può contenere testo e campi 
come il numero di pagina e il numero di pagine (totali).

Nota
La modifica di un rapporto statico verrà discussa nel Capitolo 4 della Guida a Base, 
Output dei dati.

Quando viene selezionato un rapporto di tipo dinamico e l'estensione Report Builder è funzionante, 
il rapporto può essere modificato. Il layout del rapporto può essere in due formati: documento di 
testo o foglio elettronico. Inoltre, può essere salvato in diversi formati disponibili per i documenti di 
Writer e Calc.

È comunque opportuno, se l'estensione Report Builder funziona con la vostra versione di 
LibreOffice, selezionare sempre un rapporto di tipo dinamico; ciò consente un maggiore controllo 
sul layout del rapporto, rispetto ad un rapporto di tipo statico.

Rapporto tabella Vacanze
Per creare un nuovo rapporto.

1) Fate clic sull'icona Rapporti nell'elenco Database della finestra Automobile – LibreOffice 
Base (Figura 212).

2) Nell'elenco Attività, fate clic su Usa procedura guidata per la creazione dei rapporti.... Si 
aprirà la finestra Creazione guidata rapporto.

Suggerimento

Quando si apre la Creazione guidata rapporto, si apre anche, sullo sfondo, 
l'Oracle Report Builder. Mentre eseguite i vari passaggi della procedura, essi 
vengono applicati al Report Builder. Quindi, in questi passaggi non verrà usato 
direttamente il Report Builder.

Passo 1: Selezione dei campi

1) Selezionate Tabella: Vacanze nell'elenco a tendina Tabelle o query.

2) Usate il pulsante > per spostare i seguenti campi dall'elenco Campi disponibili all'elenco 
Campi del rapporto: Data, Motel, Pedaggi, Varie, Colazione, Pranzo, Cena e SpeseSnack. 
Fate clic su Avanti.
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Figura 266: aggiungere campi in un rapporto

Passo 2: Indicare una didascalia per i campi

Potete modificare le didascalie dei campi a piacimento. Il campo Varie non necessita di modifiche, 
a differenza del campo SpeseSnack.

1) Lasciate quindi il primo campo com'è;

2) usando la barra spaziatrice dividete SpeseSnack in due parole.

3) Fate clic su Avanti.

Figura 267: indicare una didascalia per i campi

Passo 3: Raggruppamento

Dato che dovete raggruppare i dati in base alla data, usate il pulsante > per spostare il campo 
Data nell'elenco Raggruppamenti. Fate clic su Avanti.
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Figura 268: selezionare i campi per il raggruppamento dei dati

Passo 4: Opzioni di ordinamento

In questo caso non si indica alcun tipo di ordinamento.

• Fate clic su Avanti.

Passo 5: Scelta del layout

Usate l'opzione Standard per il layout. 

1) Selezionate  Standard per il Layout dei dati.

2) Per il Layout di intestazione e piè di pagina non sono possibili selezioni.

3) Selezionate l'orientamento Orizzontale per il layout della pagina.

4) Fate clic su Avanti.

Figura 269: il modello del Report Builder determinato dalla Creazione guidata rapporto

Passo 6: Creazione del rapporto

1) Rinominate il rapporto: Spese Vacanze.

2) Selezionate Rapporto dinamico.

3) Fate clic su Fine.

Il rapporto è stato creato, ma necessita di alcune modifiche. La data potrebbe essere formattata 
meglio, e tutti i numeri devono essere formattati come valuta. Si potrebbe usare una intestazione 
che includa il suo nome, il suo autore e la data in cui è stato preparato. In caso di rapporti più 
lunghi di una pagina, si potrebbe inserire il numero di pagina nel piè di pagina, magari includendo 
anche il numero totale di pagine.
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Figura 270: il rapporto senza modifiche

Report Builder: un altro modo per creare rapporti

Utilizzando la Creazione guidata rapporto, è stato creato un modello in Report Builder per il 
rapporto. Modificando il rapporto, si apre il Report Builder con tale modello. Modificando il modello, 
viene modificato anche il rapporto. Ad esempio, è possibile cambiare il formato del campo Data, 
cambiando in tal modo anche  il formato di tutte le date contenute in tale campo nel rapporto. Allo 
stesso modo, si può cambiare la formattazione di qualsiasi altro campo, cambiando così il formato 
ovunque tale campo appaia nel rapporto.

Il Report Builder può anche creare rapporti autonomamente. Per fare ciò fate clic su Crea 
rapporto in vista struttura. Potete trovare istruzioni su come utilizzare il Report Builder nel 
Capitolo 4 della Guida a Base, Output dei dati, dove l'argomento è discusso in dettaglio.

Per ulteriori informazioni sull'uso del Report Builder, vedere la guida di Dmitri Popov Sun Report 
Builder Guidebook, disponibile in versione PDF (cercare “Sun Report Builder Guidebook”) e in 
versione stampata su Lulu.com: http://www.lulu.com/spotlight/writertools

Nota

Il Report Builder è un'estensione di LibreOffice per facilitare l'utente nella creazione 
dei rapporti. Con il Report Builder potete creare rapporti di database raffinati e 
complessi. È possibile definire intestazioni e piè di pagina per pagine e gruppi, e 
campi di calcolo. Viene installato con LibreOffice per impostazione predefinita.
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Capitolo 9  
Guida introduttiva a Math
L'Editor di Equazioni di LibreOffice



Introduzione a Math

Math è il modulo di LibreOffice per la scrittura di equazioni matematiche e chimiche. È impiegato 
soprattutto come editor di equazioni nei documenti di testo, ma può essere usato anche in altri tipi 
di documenti o autonomamente. Quando è usato in combinazione con Writer, l'equazione è trattata 
come un oggetto all'interno del documento di testo.

Nota
L'editor di equazioni si utilizza per scrivere equazioni in forma simbolica, come 
nell'equazione 1. Per il calcolo di valori numerici, consultate la Guida a Calc.

df (x )
dx

=ln(x )+ tan−1(x2) (1)

oppure

  NH3+H2 O⇌NH4
++OH−

Introduzione

Potete creare un'equazione (una formula) come documento separato o inserirla in un documento 
di Writer o di un altro modulo di LibreOffice.

Creare un'equazione come documento separato
Per creare un'equazione come documento separato aprite il modulo Math di LibreOffice in uno di 
questi modi:

• Sulla barra dei menu, scegliete File > Nuovo > Formula.

• Sulla barra degli strumenti standard, fate clic sul triangolo a destra dell'icona Nuovo e 
scegliete Formula.

• Dal Centro di Avvio, fate clic su Formula.

Si aprirà un documento per le formule vuoto (vedere la Figura 271).
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Figura 271: un documento per formule vuoto

Nell'area superiore è presente la finestra di anteprima, dove compare l'equazione durante e dopo 
l'inserimento. Nell'area inferiore vi è invece l'editor di equazioni, dove viene inserito il codice con 
l'istruzione testuale per l'equazione. Appare anche la finestra mobile Elementi.

Inserire una formula in un documento di Writer
Per inserire una formula in un documento di Writer aprite il documento e poi scegliete Inserisci > 
Oggetto > Formula dalla barra dei menu.

Si aprirà l'editor delle formule nella parte bassa della finestra di Writer, e apparirà la finestra mobile 
Elementi. Nel documento vedrete anche un piccolo riquadro con bordo grigio, dove verrà 
visualizzata la formula, come mostrato in Figura 272.
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Figura 272: l'Editor di Equazioni, la finestra Elementi e la posizione dell'equazione risultante in 
Writer

Suggerimento
Se la finestra Elementi non è presente, potete visualizzarla tramite Visualizza > 
Elementi.

Dopo aver inserito la formula, potete chiudere l'editor premendo il tasto Esc o facendo clic in 
un'area all'esterno della formula nel documento principale. Con un doppio clic potete nuovamente 
aprire l'editor, e modificare ulteriormente la formula.

Le formule vengono inserite come oggetti OLE. In un documento di Writer, la formula è ancorata 
come carattere, quindi è integrata nel testo. Potete, come con qualsiasi altro oggetto OLE, 
modificare l'ancoraggio e rendere la formula mobile. Nei documenti di Calc, Impress e Draw le 
formule sono inserite come oggetti OLE mobili.

Se avete necessità di inserire formule frequentemente, è consigliabile aggiungere il pulsante 
Formula alla barra degli strumenti Standard, oppure creare una scorciatoia da tastiera. Vedere il 
Capitolo 14 (Personalizzazione di LibreOffice), per maggiori informazioni.

Inserimento di una formula

Nell'editor di equazioni vengono usate istruzioni testuali (markup) per rappresentare le formule. 
Per esempio, %beta crea il carattere greco beta ( β ). Le istruzioni testuali corrispondono alle 
rispettive espressioni in lingua inglese quando possibile. Per esempio, a over b crea una frazione: 
a
b

.

Potete inserire una formula in tre modi:

• Selezionate un simbolo dalla finestra Elementi.

296 Guida introduttiva a LibreOffice 3.5



• Fate clic con il pulsante destro sull'editor di equazioni e selezionate il simbolo dal menu 
contestuale.

• Digitate l'istruzione testuale nell'editor di equazioni.

Il menu contestuale e la finestra Elementi inseriscono l'istruzione corrispondente al simbolo. 
Questo è anche un metodo semplice per imparare le istruzioni testuali di LibreOffice Math.

Nota
Fate clic sul corpo del documento per uscire dall'editor di equazioni.

Fate doppio clic su una formula per entrare nuovamente nell'editor di equazioni.

La finestra Elementi
Il metodo più semplice per inserire una formula è quello di utilizzare la finestra Elementi.

Figura 273: i simboli sono raggruppati in 
categorie

La finestra Elementi è divisa in due parti.

• La parte superiore mostra le categorie di simboli. Fate clic su queste categorie per 
modificare la lista dei simboli.

• La parte inferiore mostra i simboli disponibili per la categoria corrente.

Suggerimento
Potete nascondere o visualizzare la finestra Elementi tramite Visualizza > 
Elementi.

Esempio 1: 5×4

In questo esempio verrà inserita una semplice formula: 5×4 . Nella finestra Elementi:

7) Selezionate il pulsante in alto a sinistra della sezione categorie.

8) Fate clic sul simbolo di moltiplicazione.
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Figura 274: selezione del simbolo di 
moltiplicazione

Quando selezionate il simbolo di moltiplicazione nella finestra Elementi, accadono due cose:

• L'editor di equazioni mostra l'istruzione testuale: <?> times <?>

• Il corpo del documento mostra un riquadro grigio come questo: ❑×❑

Figura 275: risultato della selezione del simbolo di moltiplicazione

I simboli <?> mostrati in Figura 275 sono dei segnaposto che possono essere sostituiti con altro 
testo, ad esempio 5 e 4. L'equazione verrà aggiornata automaticamente, e il risultato dovrebbe 
essere simile a quello mostrato in Figura 276.

Suggerimento
Quando aggiungete una formula, i segnaposto riservati sono indicati dai quadrati 
nella formula e dai <?> nella finestra dei comandi. Potete spostarvi tra questi 
segnaposto usando F4 e Maiusc+F4.
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Figura 276: risultato dell'inserimento di 5 e 4 come operandi dell'istruzione times 
(moltiplicazione)

Suggerimento
Per evitare che l'equazione venga aggiornata automaticamente, deselezionate 
Visualizza > Aggiorna automaticamente la vista. Per aggiornare una formula 
manualmente, premete F9 oppure selezionate Visualizza > Aggiorna.

Menu contestuali (clic destro)
Alternativamente, è possibile accedere ai simboli matematici facendo clic con il pulsante destro 
sull'editor di equazioni. In tal modo comparirà il menu mostrato in Figura 277. Le voci in questo 
menu corrispondono a quelle della finestra Elementi, con alcune voci aggiuntive.
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Figura 277: menu contestuale (clic destro)

Nota

Né la finestra Elementi, né il menu contestuale contengono un elenco completo dei 
comandi. Per alcuni comandi usati più raramente, dovete sempre inserire l'istruzione 
testuale. Un elenco completo dei comandi si trova nell'Appendice della Guida a 
Math.

Istruzioni testuali
Potete digitare le istruzioni testuali direttamente all'interno dell'editor di equazioni. Per esempio, 
potete digitare 5 times 4 per ottenere 5×4 . Se conoscete le istruzioni testuali, potrete 
comporre le formule in maniera rapida.

Suggerimento Le istruzioni testuali sono simili alla corrispondente formulazione in inglese.

La tabella che segue riporta alcuni esempi di formule con le rispettive istruzioni testuali.

Risultato 
visivo

Istruzione Risultato visivo Istruzione

a=b a = b √ a sqrt {a}

a2 a^2 an a_n

∫ f (x )dx int f(x) dx ∑ an
sum a_n

a≤b a <= b ∞ infinity
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Risultato 
visivo

Istruzione Risultato visivo Istruzione

a×b a times b x⋅y x cdot y

Caratteri greci
I caratteri greci ( α ,β ,γ ,θ , etc) sono di uso comune nelle formule matematiche. Questi caratteri 
non sono disponibili nella finestra Elementi o nel menu contestuale. Tuttavia, i comandi testuali per 
le lettere greche sono semplici: è sufficiente digitare il simbolo % seguito dal nome del carattere in 
inglese.

• Per scrivere un carattere minuscolo, digitate il nome della lettera in minuscolo.

• Per scrivere un carattere maiuscolo, digitate il nome della lettera in maiuscolo.

•  Per scrivere in corsivo, è sufficiente aggiungere una i tra il simbolo % e il nome del 
carattere.

La tabella completa dei caratteri greci è disponibile nell'appendice della Guida a Math. Alcuni 
esempi sono riportati nella tabella che segue.

Minuscolo Maiuscolo Corsivo minuscolo Corsivo maiuscolo

%alpha → α %ALPHA → Α %ialpha → α %iALPHA → Α

%beta → β %BETA → Β %ibeta → β %iBETA → Β

%gamma → γ %GAMMA → Γ %igamma → γ %iGAMMA → Γ

%psi  → ψ %PSI  → Ψ %ipsi  → ψ %iPSI  → Ψ

%phi  → ϕ %PHI  → Φ %iphi  → ϕ %iPHI  → Φ

%theta → θ %THETA → Θ %itheta → θ %iTHETA → Θ

In alternativa, i caratteri greci possono essere inseriti tramite la finestra catalogo dei Simboli. 
Scegliete Strumenti > Catalogo. Questa finestra è mostrata in Figura 278. Sotto la voce Simboli, 
selezionate Greco e fate doppio clic sul carattere desiderato. Il nome dell'istruzione testuale 
relativa al carattere è mostrato sotto la finestra dell'elenco.

Capitolo 9  Guida introduttiva a Math 301



Figura 278: il catalogo dei simboli, usato per inserire caratteri greci e alcuni simboli speciali

Esempio 2: π ≃ 3.14159

Si consideri il seguente esempio:

• Si desidera inserire la formula qui sopra (pi greco arrotondato alla quinta cifra decimale).

• Si conosce il nome del carattere greco (pi).

• Non si conosce però l'istruzione testuale del simbolo ≃ .

Passo 1: Digitate % seguito dal testo pi. In questo modo viene visualizzato il carattere π .

Passo 2: Aprite la finestra Elementi (Visualizza > Elementi).

Passo 3: Il simbolo ≃  è una relazione, fate quindi clic sul pulsante Relazioni. Al passaggio del 
cursore sopra il pulsante comparirà l'indicazione Relazioni (Figura 279).

La Figura 280 mostra la finestra Elementi dopo aver fatto clic sul pulsante Relazioni. Il simbolo 
desiderato è cerchiato.
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Figura 279: indicazione relativa al 
pulsante Relazioni

Figura 280: dopo la selezione del 
pulsante Relazioni

Passo 4: Fate clic sul simbolo a ≃ b. L'editor di equazioni mostra ora l'istruzione testuale  %pi<?> 
simeq <?>.

Passo 5: Eliminate il testo <?>, premete il tasto F4 e digitate 3.14159 alla fine dell'equazione. 
Otterrete l'istruzione testuale  %pi simeq 3.14159. Il risultato è mostrato in Figura 281.

Figura 281: risultato finale

Modificare una formula
È possibile modificare una formula in qualsiasi momento. Per passare alla modalità di modifica, 
fate doppio clic sulla formula.
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Per andare alla sezione appropriata nel codice di istruzione testuale, eseguite una delle seguenti 
operazioni:

• Nell'editor di equazioni, fate clic sulla posizione.

• Selezionate un'area del codice di istruzione testuale che volete modificare.

• Fate clic su un elemento nell'area di anteprima; il cursore si sposterà automaticamente nel 
punto corrispondente nell'editor di equazioni.

• Fate doppio clic su un elemento nell'area di anteprima; la sezione corrispondente nell'editor 
di equazioni verrà selezionata.

Per potere lavorare nell'area superiore (di anteprima) nella finestra autonoma di Math (Figura 271), 
il cursore di formula deve essere attivo. Usate il pulsante Cursore di formula sulla barra degli 
strumenti Strumenti.

Potete cambiare un'equazione sovrascrivendo il testo selezionato o inserendo nuovo codice di 
istruzione testuale nella posizione del cursore.

Layout delle formule

La scrittura di formule complesse presenta maggiori difficoltà. Questa sezione fornisce alcuni 
consigli.

Importanza delle parentesi
Le precedenze degli operatori non sono implementate in Math. Dovete utilizzare le parentesi per 
specificare in maniera esplicita la precedenza degli operatori. Considerate i seguenti esempi:

Istruzioni testuali Risultato Istruzioni testuali Risultato

2 over  x + 1
2
x
+1 2 over {x + 1}

2
x+1

– 1 over 2   
−1
2

– {1 over 2}   −
1
2

Nel primo esempio, Math ha riconosciuto che il 2 e la x, rispettivamente prima e dopo di over 
appartengono alla frazione, e li ha rappresentati di conseguenza. Se desiderate che x+1 invece di 
x sia il denominatore, dovete inserirli tra parentesi insieme.

Nel secondo esempio, Math ha riconosciuto il segno meno come prefisso per l'1 e lo ha quindi 
messo al numeratore della frazione. Se desiderate indicare che l'intero insieme è negativo, con il 
segno meno davanti alla frazione, dovete mettere la frazione tra parentesi per fare capire a Math 
che i caratteri devono stare insieme.

Le parentesi fanno parte del layout del codice di istruzione testuale e non vengono stampate. Se 
desiderate utilizzare le parentesi in una formula, usate i comandi lbrace e rbrace.
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Confrontate i seguenti esempi:

Istruzioni testuali Risultato Istruzioni testuali Risultato

x over {–x + 1}  
x

−x+1
x over lbrace –x + 1 
rbrace  

x
{−x +1}

Uso delle parentesi con le matrici
La seguente tabella ricapitola l'uso del comando matrix.

Istruzioni testuali Risultato

matrix { a # b ## c # d } a b
c d

Nota
Le righe vanno separate digitando due volte il carattere #, mentre i valori di ciascuna 
riga sono separati tra loro da un singolo #.

Il problema principale che si ha con le matrici consiste nel fatto che le parentesi non scalano 
correttamente assieme alle dimensioni della matrice stessa:

Istruzioni testuali Risultato

(  matrix { a # b ## c # d }  ) (a b
c d

)

In Math sono disponibili parentesi scalabili. Questo tipo di parentesi aumentano di dimensioni in 
maniera consistente al loro contenuto. Utilizzate i comandi left( e right) per creare delle parentesi 
scalabili.

Istruzioni testuali Risultato

left(  matrix { a # b ## c # d }  right) (a b
c d )

Suggerimento
Utilizzate i comandi left[ e right] per ottenere delle parentesi quadre scalabili. 
L'elenco di tutte le parentesi disponibili si trova nell'appendice della Guida a 
Math.

Le parentesi scalabili possono essere utilizzate anche con qualsiasi altro elemento, come frazioni, 
radici quadrate, ecc.

Parentesi isolate e spaiate
Math si aspetta che per ogni parentesi aperta ve ne sia una chiusa. Se vi dimenticate una 
parentesi, Math inserirà un punto interrogativo invertito vicino alla parentesi corrispondente; esso 
scompare quando tutte le parentesi sono abbinate correttamente. A volte dimenticare una 
parentesi fa cadere tutta la struttura della formula.
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Comunque, in certi casi, una parentesi spaiata può essere necessaria. In tali casi, avete due 
possibilità:

• Con le parentesi non scalabili, usate una barra retroversa \ per indicare che il carattere 
seguente non deve essere inteso come una parentesi, ma come un carattere letterale. 
Quindi l'intervallo semiaperto [a;b[ è rappresentato con \[a;b\[ — provate a 
confrontare questo esempio con [a;b[ 

• Le parentesi scalabili possono anche essere spaiate. Lo stesso intervallo semiaperto può 
essere rappresentato con

    left [ a; b right [ 

Per le parentesi scalabili, potete anche usare il comando none per sostituire una parentesi 
abbinata non esistente.

∣x∣={ x for x≥0
−x for x<0

può essere rappresentata con

abs x = left lbrace stack {x "for" x >= 0 # -x "for" x < 0} right none

Riconoscimento delle funzioni in Math
Con l'installazione predefinita, Math rende in corsivo l'output delle variabili. Se inserite una 
funzione, Math di solito la riconosce e ne rende l'output normalmente (nella Guida a Math è 
presente un elenco delle funzioni riconosciute). Se invece Math non riesce a riconoscere una 
funzione, potete indicarla esplicitamente. Inserite il codice di istruzione testuale func prima della 
funzione, e il testo seguente verrà riconosciuto come una funzione.

Alcune funzioni riconosciute da Math devono essere seguite da numeri o variabili. Se questi non 
sono presenti, Math inserisce al loro posto un punto interrogativo invertito di colore rosso ¿ , che 
potete rimuovere solo correggendo la formula: inserite una variabile o un numero, o un paio di 
parentesi graffe vuote { } come segnaposto.

Suggerimento Potete spostarvi tra gli errori usando F3 e Maiusc+F3.

Equazioni su più righe

Supponete di voler creare un'equazione che richieda più di una riga, ad esempio:
x=3
y=1

Forse la prima cosa che fareste potrebbe essere di premere semplicemente il tasto Invio. In questo 
modo, se premete il tasto Invio, l'istruzione testuale va a capo, ma non l'equazione risultante. 
Dovete invece digitare esplicitamente il comando newline. La tabella seguente mostra un esempio.

Istruzioni testuali Risultato

x = 3

y = 1
x=3 y=1

x = 3 newline

y = 1

x=3
y=1
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Non è direttamente possibile continuare il calcolo su una nuova riga senza scrivere una nuova 
equazione, perché Math si aspetta un termine alla sinistra di un segno di uguale. Potete sostituire:

• Virgolette vuote "". Ciò farà in modo che la riga sia allineata a sinistra automaticamente.

• Parentesi graffe vuote { }. La riga seguente verrà centrata.

• Caratteri di spazio ` o ~. La riga verrà centrata con gli spazi.

L'allineamento dei segni di uguale l'uno sotto l'altro è descritta a pagina 309.

Anche la spaziatura tra gli elementi delle formule non vengono impostati dai caratteri di spazio nel 
codice. Dovete utilizzare speciali istruzioni testuali per aggiungere spazi: ` (grave) per uno spazio 
piccolo, ~ per uno spazio grande. Un'altra soluzione potrebbe essere quella di aggiungere i 
caratteri di spazio tra virgolette, in modo che vengano considerati come testo. Istruzioni testuali di 
spazio alla fine di una formula sono ignorate per impostazione predefinita.

Aggiungere limiti alle sommatorie e agli integrali
I comandi sum (sommatoria) e int (integrale) (vedere l'elenco completo nell'appendice della Guida 
a Math) supportano i parametri opzionali from e to. Questi definiscono rispettivamente i limiti 
inferiore e superiore. Questi parametri possono essere usati singolarmente o insieme.

Istruzioni testuali Risultato

sum from k = 1 to n a_k ∑
k=1

n

ak

int from 0 to x f(t) dt

oppure

int_0^x f(t) dt

∫
0

x

f (t )dt  or ∫0

x
f (t )dt

int from Re f ∫
ℜ

f

sum to infinity 2^{-n} ∑
∞

2−n

Creazione di una derivata
Per le derivate è necessario ricorrere a una piccola astuzia: impostarle come frazioni.

In altre parole, dovete utilizzare il comando over. La combinazione della frazione e della lettera d 
(per una derivata totale) oppure del comando partial (per una derivata parziale) permette di 
ottenere il risultato di una derivata.

Nota Notate l'uso delle parentesi graffe per la scrittura delle derivate.
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Istruzioni testuali Risultato

{df} over {dx}
df
dx

{partial f} over {partial y}
∂ f
∂ y

{partial^2 f} over {partial t^2}
∂2 f

∂ t 2

Per scrivere i nomi delle funzioni con numeri primi, come è usuale nella notazione scolastica, 
dovete prima aggiungere i simboli al catalogo. L'utilizzo delle virgolette, singole e doppie, è 
tipograficamente sgradevole. Vedere “Personalizzazione del catalogo” a pagina 316.

Caratteri di istruzione testuale come caratteri standard
I caratteri che vengono usati per controllare le istruzioni testuali non possono essere inseriti 
direttamente come caratteri normali. I caratteri in questione sono:  %, {, }, &, |, _, ^ e ". Quindi, ad 
esempio, non potete scrivere 2% = 0.02 oppure 1" = 2.56cm. Per superare questa limitazione vi 
sono due metodi:

• Usare le doppie virgolette per contrassegnare il carattere come testo, ad esempio 2"%"= 
0.02. Ovviamente ciò non è possibile per il carattere doppie virgolette stesso.

• Aggiungere il carattere al catalogo. Consultate la sezione  “Personalizzazione del catalogo” 
a pagina 316.

In alcuni casi è possibile usare dei comandi:

• lbrace e rbrace permettono di inserire i caratteri delle parentesi graffe {}.

• mline permette di inserire la linea verticale, ad esempio 2 mline 3 vi darà (2∣3)  

La conversione in una entità carattere, come in HTML, o l'utilizzo di un carattere escape non è 
possibile in Math.

Testo in una formula
Per includere del testo in una formula, racchiudetelo tra doppie virgolette indifferenziate ("):

abs x = left lbrace matrix {x # "for " x >= 0 ## -x # "for " x < 0} right none

∣x∣={ x for x≥0
−x for x<0

Tutti i caratteri, tranne le doppie virgolette, sono ammissibili nel testo. Purtroppo la finestra di 
dialogo Caratteri speciali non è disponibile. Se necessario, potete scrivere il testo in un documento 
di testo e copiarlo nell'editor di equazioni tramite gli appunti. Si possono così inserire le virgolette 
(doppi apici), come mostrato sotto.
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Figura 282: doppi apici inseriti tramite copia e incolla da Writer

Il testo viene mostrato nel carattere selezionato dall'elenco Caratteri formule , nella finestra di 
dialogo Tipi di carattere (potete confrontare con la sezione “Modifica del tipo di carattere” a 
pagina 311). Per utilizzare un carattere dalla finestra inferiore dell'editor di equazioni, impostate 
l'attributo Serif, Sans oppure Fixed prima del testo.

Per impostazione predefinita, il testo è allineato a sinistra. Potete modificare l'allineamento con 
alignc o alignr.

I comandi all'interno del testo non vengono interpretati. Usate le virgolette per interrompere il testo 
se desiderate utilizzare comandi speciali di formattazione.

"Nei triangoli " color blue bold "isosceli" " gli angoli alla base sono 
uguali" 

Nei triangoli isosceli  gli angoli alla base sono uguali

Allineare le equazioni al segno di uguale
Math non possiede un comando per allineare le equazioni a un particolare carattere, ma, a tal fine, 
potete utilizzare una matrice, come mostrato sotto.

Istruzioni testuali Risultato

matrix{

   alignr x+y # {}={} # alignl 2 ##

   alignr x   # {}={} # alignl 2-y

}

x+ y = 2
x = 2− y

Le parentesi graffe intorno al segno = sono necessarie perché = è un operatore binario e necessita 
di un'espressione su ogni lato.

Potete ridurre la spaziatura intorno al segno = modificando la spaziatura tra le colonne della 
matrice:

1) Con l'editor di equazioni aperto, scegliete Formato > Spaziatura dalla barra dei menu.
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2) Nella finestra di dialogo Spaziatura (Figura 283), fate clic sul pulsante Categoria e 
selezionate Matrici nel menu a discesa.

3) Inserite 0% per la Distanza colonne e fate clic su OK.

Figura 283: modifica della spaziatura in una formula di matrice

Modificare l'aspetto delle formule

Modifica delle dimensioni dei caratteri
Una delle domande più frequenti su LibreOffice Math riguarda l'ingrandimento di formule. La 
risposta è semplice, sebbene non intuitiva:

1) Avviate l'editor di equazioni e scegliete Formato > Dimensione carattere.

2) Selezionate una dimensione del carattere maggiore alla voce Dim. di base (voce più in 
alto).

Figura 284: modifica delle Dimensioni di base per ingrandire la 
formula

Il risultato di tale modifica è mostrato in Figura 285.
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Figura 285: risultato della modifica delle 
dimensioni di base del carattere

Nota

La modifica delle dimensioni del carattere viene applicata solo alla formula corrente. 
Per cambiare le dimensioni in modo generalizzato, fate clic sul pulsante Predefinita 
e poi su OK. Una modifica generalizzata delle dimensioni del carattere potrebbe, ad 
esempio, rendere il lavoro più semplice se state preparando una presentazione e 
desiderate che tutte le formule abbiano una dimensione base di 28pt—non 
dimenticate però di reimpostare le dimensioni del carattere al suo valore originale 
quando il lavoro è finito.

Attenzione: in tal modo si modificano solo la formula corrente e le formule scritte 
dopo aver applicato la modifica. Per modificare tutte le formule già esistenti nel 
documento, è necessario usare una macro (consultare la sezione sulle macro nella 
Guida a Math).

Le dimensioni di un gruppo di caratteri in una formula possono essere modificate usando il 

comando size. Ad esempio: b size 5{a} : b a . Nella finestra Elementi, l'icona  sulla 
scheda Attributi vi permette di utilizzare il comando size. Il valore inserito subito dopo size può 
essere assoluto (valore numerico) o relativo al contesto (dimensioni di base per impostazione 
predefinita): ad esempio, +6, -3, /2, o *2/

Modifica del tipo di carattere
I caratteri utilizzati nelle formule possono essere cambiati usando Formato > Tipi di carattere. 

La sezione Caratteri formule della finestra di dialogo Tipi di carattere (Figura 286) si riferisce ai 
quattro elementi della formula specificati. I caratteri per gli operatori, le relazioni e le parentesi, resi 
normalmente con il tipo di carattere OpenSymbol, non sono influenzati da eventuali modifiche. Allo 
stesso modo gli elementi facenti parte del catalogo (vedere “Personalizzazione del catalogo” a 
pagina 316) vengono mostrati nel tipo di carattere lì specificato.

Figura 286: finestra di dialogo Tipi di carattere
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La sezione Caratteri dell'utente permette di scegliere quali tipi di carattere verranno utilizzati 
quando vengono specificati gli attributi Serif, Sans o Fisso.

Per modificare un tipo di carattere, fate prima clic su Cambia e scegliete il tipo di voce che volete 
modificare. Si aprirà una ulteriore finestra di dialogo Tipi di carattere, che mostra tutti i tipi di 
carattere disponibili sul vostro sistema.

Figura 287: finestra di dialogo Tipi di carattere

Se inserite un carattere iniziale nel riquadro di testo in alto, l'elenco scorrerà ai tipi di carattere i cui 
nomi iniziano con tale lettera. Inserendo altri caratteri, potete specificare il nome esatto del tipo di 
carattere desiderato. Se non ne conoscete il nome, usate la barra laterale per scorrere l'elenco. 
Facendo clic sul nome nel riquadro in basso verrà mostrata un'anteprima del tipo di carattere.

Le variabili dovrebbero essere scritte in corsivo, quindi assicuratevi che la casella Corsivo sia 
spuntata. Per tutti gli altri elementi, usate la forma base (Roman). Lo stile può essere facilmente 
cambiato nella formula stessa usando i comandi italic o bold per impostare queste caratteristiche 
e nitalic o nbold per disattivarle.

Una volta che avete scelto un nuovo carattere per una formula, il precedente carattere rimane 
nell'elenco insieme a quello nuovo, in modo da poter essere nuovamente selezionato. Ciò vale 
solo per la sessione corrente; il vecchio carattere non è memorizzato in modo permanente.

Potete scegliere qualsiasi carattere desiderate, ma se dovete scambiare documenti con altre 
persone, sarebbe meglio scegliere caratteri presenti anche sul pc della persona che riceve i vostri 
documenti.

Modifica del colore
Potete usare il comando color per cambiare il colore di parte di una formula: con color red 
ABC otterrete ABC . Sono disponibili 8 colori: white, black, cyan, magenta, red, blue, 
green, yellow.

È possibile dare un colore a parte di una formula se è inserita tra { } o altre parentesi. Ad 
esempio: con A B color green {C D} E otterrete A BC D E .

Se vengono utilizzati più colori, quello più interno alla formula viene applicato come in questo 
esempio: color blue {A B color yellow C D} vi darà A BC D .
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In Math non è possibile selezionare un colore di sfondo; lo sfondo rimane sempre trasparente. Il 
colore di sfondo dell'intera formula coincide quindi con lo sfondo del documento o della cornice (ad 
esempio in un documento di testo). In Writer, potete sfruttare le proprietà dell'oggetto (clic con il 
pulsante destro > Oggetto) per scegliere un colore di sfondo per l'intera formula (vedere “Sfondo, 
bordi e dimensioni” a pagina 315).

Formule nei documenti di Writer

Numerazione delle equazioni
La numerazione delle equazioni è una delle funzioni più utili in Writer, sebbene sia una funzione 
abbastanza nascosta. I passi da seguire sono semplici, ma non molto intuitivi:

1) Iniziate una nuova linea.

2) Digitate fn e poi premete F3.

fn verrà sostituito da una formula numerata:

E=mc 2 (2)

Adesso potete modificare la formula facendo doppio clic su di essa.

Potete fare riferimento a una equazione (“come mostrato nell'Equazione (2)”) seguendo questi 
passaggi:

1) Scegliete Inserisci > Riferimento incrociato dalla barra dei menu.

2) Nella scheda Riferimenti incrociati (Figura 288), sotto la voce Tipo di campo, selezionate 
Testo.

3) Sotto la voce Selezione, scegliete il numero dell'equazione.

4) Sotto la voce Inserisci riferimento a, selezionate Testo di riferimento.

5) Fate clic su Inserisci.

Se successivamente vengono inserite nel documento nuove equazioni prima di quelle presenti già 
numerate, tutta la numerazione viene modificata automaticamente e i riferimenti contenuti nel testo 
vengono aggiornati.

Suggerimento
Se desiderate che il numero dell'equazione non sia racchiuso tra parentesi, 
scegliete Numero invece di Riferimento sotto Inserisci riferimento a.
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Figura 288: inserimento di un riferimento incrociato a un numero di equazione

Il Testo automatico inserito come risultato della procedura sopra descritta consiste di una tabella 
1x2. La cella di sinistra contiene la formula, mentre quella di destra contiene il numero. Il numero è 
un  contatore automatico chiamato Testo. Potete modificare il Testo automatico se, ad esempio, 
preferite parentesi quadre invece che rotonde, oppure se desiderate che la formula e il numero 
siano separati da tabulazione invece che formattati come tabella. Al riguardo leggete la sezione 
relativa all'“Uso del Testo automatico” nel Capitolo 3 (Lavorare con il testo) nella Guida a Writer.

Posizione
Normalmente una formula è ancorata Come carattere in un documento di Writer. È possibile 
comunque, come con qualsiasi altro oggetto OLE, modificare il metodo di ancoraggio, così da 
posizionare la formula dove desiderate. Per ulteriori informazioni, vedere il Capitolo 11 (Immagini, 
Galleria e Fontwork) della Guida introduttiva.

Per impostazione predefinita, gli oggetti formula ancorati Come carattere sono automaticamente 
allineati verticalmente alla linea di base del testo circostante. Per allineare la formula 
manualmente, andate su Strumenti > Opzioni > LibreOffice Writer > Formattazione e togliete la 
spunta dall'opzione Allineamento linea di base Math. Questa impostazione è memorizzata nel 
documento e viene applicata a tutte le formule al suo interno. I nuovi documenti utilizzano 
l'impostazione configurata in questa finestra di dialogo.
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Margini
Un oggetto di Math, inserito in un documento, ha dei margini alla sua sinistra e alla sua destra, che 
lo separano dal testo circostante. Se non desiderate questo comportamento, è meglio modificare 
lo stile di cornice per le formule, siccome tale modifica verrà applicata simultaneamente a tutte le 
formule esistenti e a quelle che verranno inserite in futuro nel documento. Procedete come segue:

1) Premete F11. Si apre la finestra di dialogo Stili e formattazione.

2) Fate clic sulla scheda Stili di cornice.

3) Trovate lo stile di cornice Formula e fateci clic sopra con il pulsante destro.

4) Scegliete Modifica dal menu contestuale. Si apre la finestra di dialogo Stile di cornice.

5) Passate alla scheda Scorrimento. Nella sezione Distanza cambiate i valori per Sinistra e 
Destra a 0.00.

6) Fate clic su OK per chiudere la finestra di dialogo.

Ciò modificherà la distanza per tutte le formule la cui distanza non è stata regolata manualmente. 
Potete trovare maggiori informazioni sull'uso degli stili in “Layout predefinito tramite lo stile” a 
pagina 318 e nel Capitolo 3 (Uso di Stili e Modelli) della Guida introduttiva.

Modalità testo
Le formule più ampie dovrebbero essere inserite in un paragrafo a sè, separato dal testo. Quando 
usate elementi delle formule in un testo scorrevole, tali elementi possono essere più alti 
dell'altezza delle lettere.

In ogni caso, se è necessario posizionare una formula in un testo scorrevole, attivate l'editor di 
equazioni e andate su Formato > Modo testo. Math cercherà di restringere la formula per 
adattarla all'altezza delle lettere. Il numeratore e il denominatore delle frazioni vengono ristretti, e i 
limiti di integrali e somme vengono posizionati di fianco al segno dell'integrale/somma.

Esempio:
Formula in un paragrafo separato:

∑
i=2

5

i2

e la stessa formula inserita in modo testo: ∑i=2
5 i2

Sfondo, bordi e dimensioni
Per quanto concerne la formattazione, le formule sono trattate come oggetti del tipo Stile di 
cornice, con lo Stile di cornice Formula. Il colore di sfondo e i bordi possono essere impostati 
usando questo stile o direttamente con Formato > Cornice/Oggetto, o facendo clic con il pulsante 
destro sulla formula e scegliendo Oggetto dal menu contestuale. Nell'installazione di base le 
formule hanno uno sfondo trasparente senza bordi. Le dimensioni della formula non possono 
essere modificate; in un documento di Writer dipendono direttamente dal modo in cui la formula è 
costruita (vedere “Modifica delle dimensioni dei caratteri” a pagina 310).

Creazione di una libreria di formule
Quando utilizzate il componente di Math direttamente tramite File > Nuovo > Formula, vengono 
creati dei documenti con estensione file .odf, ciascuno contenente una singola formula. Potete fare 
uso di questi file per costruirvi una libreria delle formule utilizzate più frequentemente. Le formule 
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incorporate possono anche essere memorizzate come documenti di Math separati facendo clic con 
il pulsante destro sulla formula e scegliendo Salva copia con nome dal menu contestuale. Per 
inserire un documento di Math in un documento di Writer, scegliete Inserisci > Oggetto > 
Oggetto OLE. Selezionate l'opzione Crea da file e inserite il percorso del file oppure cercatelo con 
il file manager del vostro sistema, premendo il pulsante Cerca.

Nota
Non è possibile inserire il documento trascinando e rilasciando con il mouse, né 
usando Inserisci > File.

Le formule non possono essere salvate nella galleria in quanto non sono in un formato grafico. 
Potete comunque salvarle come Testo Automatico. Scrivete la formula in un paragrafo separato, 
selezionatelo e scegliete Modifica > Testo automatico. Per ulteriori informazioni vedere “Uso del 
Testo automatico” nel Capitolo 3 (Lavorare con il testo) nella Guida a Writer.

Inserimento veloce delle formule
Se conoscete già le istruzioni testuali della vostra formula, seguite questo metodo per comporla 
velocemente:

• Scrivete le istruzioni testuali della formula in Writer.

• Selezionate le istruzioni testuali.

• Inserite la formula usando un pulsante sulla barra degli strumenti, una voce di menu, o una 
scorciatoia da tastiera.

In questo modo eviterete di aprire e chiudere la finestra di Math, risparmiando così del tempo.

Personalizzazione

Personalizzazione del catalogo
Se avete necessità di usare un simbolo non disponibile in Math, potete aggiungerlo al catalogo. Il 
seguente esempio mostra la procedura per i simboli utilizzati per valutare il lavoro scolastico.

1) Andate su Strumenti > Catalogo oppure fate clic sul pulsante Catalogo  per aprire il 
catalogo dei Simboli (Figura 278).

2) Fate clic sul pulsante Modifica. Si aprirà la finestra Modifica simboli (Figura 289).

3) I simboli sono disposti in gruppi. Nella parte più bassa della finestra, scegliete un insieme 
disponibile per il vostro nuovo simbolo dall'elenco dei gruppi di Simboli, ad esempio il 
gruppo Speciale. Oppure potete digitare il nome di un nuovo gruppo di simboli direttamente 
nel riquadro.

4) Dall'elenco Tipo di carattere, scegliete un tipo di carattere che contenga il simbolo 
desiderato.

Una volta selezionato il tipo di carattere, i relativi caratteri appaiono nella finestra di 
riepilogo dei tipi di carattere. Per effettuare la vostra scelta potete anche utilizzare la barra 
di scorrimento laterale all'interno di questa finestra, o usare l'elenco Area per andare 
direttamente alla posizione desiderata.

Per seguire l'esempio, scegliete il tipo di carattere DejaVu Sans e l'area Punteggiatura 
generale.

316 Guida introduttiva a LibreOffice 3.5



5) Fate clic sul simbolo desiderato (Ux2032 nell'esempio). Esso apparirà allargato nel 
riquadro di anteprima in basso a destra (vedere Figura 290). Assicuratevi che il gruppo di 
simboli sia impostato su Speciale.

6) Nel campo Simbolo, inserite un nome per il simbolo, ad esempio apice.

7) Se il nome non è già utilizzato, il pulsante Aggiungi diviene attivo. Fateci clic sopra.

8) Mentre avete la finestra aperta potete aggiungere altri simboli. Nell'esempio, vengono 
aggiunti il simbolo “U+2033”, chiamato doppioapice, e il simbolo “U+2034”, chiamato 
triploapice (vedere Figura 291).

9) Fate clic su OK per chiudere la finestra di dialogo.

Figura 289: finestra di dialogo Modifica simboli

Figura 290: finestra di dialogo Modifica simboli: caratteri selezionati

Ora l'area di visualizzazione dei gruppi di Simboli mostra il nuovo simbolo. Potete selezionarlo, 
esattamente come gli altri simboli, o da questa finestra, o scrivendolo direttamente nell'editor di 
equazioni, nella forma %apice.

Attenzione
I simboli, (Greco o Speciale), diversamente dai comandi, sono sensibili al 
maiuscolo/minuscolo.
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Esistono inoltre numerosi tipi di carattere gratuiti che contengono molti simboli matematici. Per il 
tipo di carattere “STIX1” è opportuno un cenno speciale. È stato sviluppato in modo particolare per 
la scrittura di testi matematici e tecnici. Anche i tipi di carattere DejaVu2 e Lucida3 hanno un buon 
numero di simboli.

Figura 291: il catalogo con il nuovo simbolo

Nota
Diversi simboli sono presenti in più tipi di carattere. Se desiderate scambiare 
documenti con altre persone, fate attenzione a utilizzare un tipo di carattere che sia 
installato anche sui loro computer.

Nell'installazione di base di LibreOffice, solo i simboli personalizzati, effettivamente presenti nel 
documento, vengono memorizzati al suo interno. A volte può tornare utile incorporare tutti i simboli 
personalizzati, ad esempio quando il documento deve essere ulteriormente modificato da un'altra 
persona. Andate su Strumenti > Opzioni > LibreOffice Math e nella pagina Impostazioni, 
deselezionate l'opzione Incorpora solo simboli utilizzati (dimensioni inferiori). Questa 
impostazione è disponibile solo quando si lavora su documenti di Math.

Layout predefinito tramite lo stile
In Writer, le formule sono formattate secondo lo Stile di 
cornice Formula. Nella finestra Stili e formattazione 
(visualizzabile con F11), fate clic sulla terza icona in alto: Stili  
di cornice. Fate clic con il pulsante destro su Formula e 
selezionate Modifica. In tal modo, potete direttamente 
modificare tutte le formule di un documento, riguardo a 
spaziatura (pagina 315) o sfondo (pagina 315), a meno che 
non modifichiate manualmente la formattazione della formula.

Per applicare questo stile in tutti i nuovi documenti di Writer, dovete includere lo stile Formula nel 
vostro modello predefinito. Per fare ciò, create un nuovo documento di Writer e modificate lo stile 
di cornice Formula come preferite. Salvate il documento usando File > Modelli > Salva. Per 
impostare questo modello come predefinito, selezionate File > Modelli > Organizza e fate doppio 
clic su Personalizzati. Fate clic con il pulsante destro sul modello appena creato e scegliete 

1 I file del tipo di carattere STIX (Scientific and Technical Information Exchange) sono disponibili sul sito 
http://www.stixfonts.org 

2 I file per il DejaVu Sans sono disponibili sul sito http://www.dejavu-fonts.org 
3 Il tipo di carattere Lucida Sans fa parte del pacchetto JRE, che è probabilmente già installato sul vostro 

computer.
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Imposta come predefinito. Se desiderate ritornare al modello impostato come predefinito con 
l'installazione, usate il comando Ripristina il modello predefinito.

I nuovi documenti di testo saranno basati su questo modello.

Applicazione alle formule chimiche
Math è stato disegnato per creare formule matematiche, ma può anche essere usato per scrivere 
formule chimiche. In chimica, le formule vengono rappresentate ad esempio come H2O: i nomi di 
solito sono in maiuscolo non corsivo. Per scrivere formule chimiche con Math, potreste impostare 
non-corsivo per le variabili (vedere “Modifica del tipo di carattere” a pagina 311).

Di seguito alcuni esempi di formule chimiche:

Costruzione Esempio Inserimento

Molecole H2 SO4 H_2 SO_4 (fate attenzione allo spazio!)

Isotopi U92
238 U lsub 92 lsup 238

Ioni SO4
2− SO_4^{2-{}} oppure SO_4^{2"-"}

Nota: lsub oppure lsup sono abbreviazioni per left subscript e left superscript (rispettivamente 
pedice sinistro e apice sinistro). Le parentesi graffe vuote dopo 2- sono necessarie per evitare 
errori, siccome non è presente un membro a destra, dopo il segno meno.

Per le reazioni reversibili, non è presente in Math una doppia freccia soddisfacente. Se avete un 
tipo di carattere con un simbolo corretto, potete usare il metodo descritto in “Personalizzazione del 
catalogo” a pagina 316. Ad esempio, nei tipi di carattere DejaVu sono presenti queste doppie 
frecce ⇄ ⇆ ⇋ ⇌.

Diversamente, potete copiare un carattere speciale da un altro documento e incollarlo in una 
formula, come in questo esempio: C+O⇌CO  "⇌". Potete inoltre trovare altre doppie frecce a 
questo indirizzo:
http://dev.w3.org/html5/html-author/charref (carattere x021C4 e seguenti).

Comandi di Math – Riferimenti

L'elenco completo dei comandi e delle parole riservate utilizzate in Math è disponibile nella Guida 
a Math:

• Operatori unari/binari

• Relazioni

• Operazioni sugli insiemi

• Funzioni

• Operatori

• Attributi

• Parentesi

• Formati

• Altri

• Caratteri greci
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• Caratteri speciali

• Parole riservate in ordine alfabetico
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Capitolo 10  
Stampa, esportazione e invio 
di e-mail



Introduzione

Questo capitolo fornisce informazioni generali sulla stampa, l'esportazione e l'invio tramite e-mail 
dei documenti in LibreOffice.

Stampa rapida

Fate clic sull'icona Stampa file direttamente  per inviare l'intero documento alla stampante 
predefinita del computer.

Nota

È possibile modificare l'azione associata all'icona Stampa file direttamente per 
stampare sulla stampante predefinita del documento invece che sulla stampante 
predefinita del computer. Andate su Strumenti > Opzioni > Carica/Salva > 
Generale e selezionate l'opzione Carica le impostazioni della stampante 
assieme al documento.

Controllo della stampa

Nota per 
gli utenti 

Mac

Se preferite utilizzare le finestre di dialogo predefinite per la stampa del Mac, 
deselezionate l'opzione Finestre di dialogo di stampa – Utilizza finestre di 
dialogo LibreOffice in LibreOffice > Preferenze > Generale.

Questo testo utilizza le finestre di dialogo per la Stampa di LibreOffice nelle 
illustrazioni.

Per maggiori controlli sulle funzionalità di stampa, usate la finestra di dialogo Stampa (File > 
Stampa oppure Ctrl+P).
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Figura 293: la finestra di dialogo Stampa

La finestra di dialogo Stampa ha quattro schede, tramite le quali potete scegliere diverse opzioni, 
come descritto nelle seguenti sezioni.

Nota

Le opzioni selezionate nella finestra di dialogo Stampa vengono applicate solo alla 
stampa del documento corrente.

Per specificare impostazioni di stampa predefinite per LibreOffice, andate su 
Strumenti > Opzioni > LibreOffice – Stampa e Strumenti > Opzioni > 
LibreOffice Writer – Stampa. Vedere il Capitolo 2 (Configurare LibreOffice) per 
maggiori dettagli.

Per i vari componenti di LibreOffice sono disponibili differenti impostazioni di stampa, riassunte 
nella Tabella 8.
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Tabella 8: opzioni di stampa nei componenti di LibreOffice

Caratteristica Writer Calc Impress Draw

Selezione pagine/fogli/diapositive da 
stampare

Sì Sì Sì Sì

Stampa di pagine/fogli/diapositive multiple 
su un'unica pagina

Sì Sì Sì Sì

Stampa di un depliant Sì No Sì Sì

Stampa di buste Sì No No No

Stampa di etichette o biglietti da visita Sì No No No

Anteprima di pagine/fogli prima della stampa Sì Sì No No

Selezione delle opzioni generali di stampa
Nella scheda Generale della finestra di dialogo Stampa potete scegliere:

• La stampante (tra quelle disponibili)

• Quali pagine stampare, il numero di copie, e se fascicolare copie multiple (sezione 
Intervallo e copie)

• Se e dove stampare i commenti presenti nel documento.

Alcune selezioni potrebbero non essere sempre presenti. Ad esempio, se il documento non 
contiene commenti, l'elenco a discesa Stampa – Commenti non sarà attivo.

Figura 294: opzioni di stampa dei commenti

Selezionate il pulsante Proprietà per visualizzare una finestra di dialogo dove è possibile scegliere 
l'orientamento verticale oppure orizzontale , quale cassetto della carta utilizzare, e le dimensioni 
della carta su cui stampare.

Nella scheda Opzioni della finestra di dialogo Stampa (Figura 295), l'ultima voce, Usa cassetto 
solo da impostazione stampante, non è disponibile in Calc.

Figura 295: scheda Opzioni della finestra di dialogo Stampa
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Stampa di pagine multiple su foglio singolo
Potete stampare più pagine di un documento su un unico foglio di carta. Per eseguire questa 
operazione:

1) Nella finestra di dialogo Stampa, selezionate la scheda Layout di pagina (Figura 296).

Figura 296: stampa di pagine multiple per foglio

2) Nella sezione Layout, selezionate dall'elenco a discesa il numero di pagine da stampare 
per foglio. Il pannello di anteprima sulla sinistra della finestra di dialogo Stampa mostra 
come verrà stampato il documento.

Quando si stampano più di 2 pagine per foglio, è possibile scegliere l'ordine verticale e 
orizzontale in cui le pagine verranno stampate nel foglio.

3) Nella sezione Lati della pagina, selezionate se stampare tutte le pagine o solamente 
alcune pagine. Fate clic sul pulsante Stampa.

Suggerimento
In Writer, per stampare due pagine per foglio in stile “pagine affiancate” (layout 
libro), stampate invece da Anteprima di stampa. Vedere pagina 332.

Capitolo 10  Stampa, esportazione e invio di e-mail 325



Selezione di pagine/fogli/diapositive da stampare
Oltre a stampare un intero documento, potete scegliere di stampare singole 
pagine/fogli/diapositive, intervalli di pagine/fogli/diapositive, o una selezione di un documento. I 
dettagli variano leggermente in Writer, Calc, Draw e Impress, come descritto in questa sezione.

Writer
Stampa di una singola pagina:

1) Scegliete File > Stampa dalla barra dei menu.

2) Nella finestra di dialogo Stampa, selezionate la pagina da stampare.

a) Nella sezione Intervallo e copie della scheda Generale, selezionate l'opzione Pagine.

b) Inserite il numero sequenziale della pagina che desiderate stampare. Questo potrebbe 
essere diverso dal numero di pagina se avete ricominciato la numerazione di pagina nel 
documento. Il riquadro di anteprima cambia per mostrare la pagina selezionata.

3) Fate clic sul pulsante Stampa.

Stampa di un intervallo di pagine:

1) Scegliete File > Stampa dalla barra dei menu.

2) Nella finestra di dialogo Stampa, selezionate l'intervallo di pagine da stampare.

a) Nella sezione Intervallo e copie della scheda Generale, selezionate l'opzione Pagine.

b) Inserite i numeri sequenziali delle pagine da stampare (ad esempio 1–4 oppure 
1,3,7,11).

3) Fate clic sul pulsante Stampa.

Stampa di una selezione di testo:

1) Nel documento, selezionate il materiale (testo e immagini) da stampare.

2) Scegliete File > Stampa dalla barra dei menu.

3) La sezione Intervallo e copie della finestra di dialogo Stampa ora include un'opzione 
Selezione e il riquadro di anteprima mostra il materiale selezionato. Vedere la Figura 297.

4) Fate clic sul pulsante Stampa.
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Figura 297: stampa di una selezione di testo

Calc
Potete scegliere di stampare fogli singoli, multipli, e selezioni di celle.

Figura 298: scegliere cosa stampare in Calc

Stampa di un singolo foglio:

1) Nel foglio elettronico, fate clic sulla scheda del foglio che volete stampare.

2) Scegliete File > Stampa dalla barra dei menu.

3) Nella sezione Intervallo e copie della finestra di dialogo Stampa, scegliete l'opzione Fogli 
selezionati.

4) Fate clic sul pulsante Stampa.
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Stampa di un gruppo di fogli:

1) Nel foglio elettronico, selezionate i fogli da stampare.

a) Selezionate il primo foglio.

b) Tenete premuto il tasto Ctrl.

c) Fate clic sulle schede degli altri fogli.

d) Rilasciate il tasto Ctrl quando avete selezionato tutti i fogli.

2) Scegliete File > Stampa dalla barra dei menu.

3) Nella sezione Intervallo e copie della finestra di dialogo Stampa, scegliete l'opzione Fogli 
selezionati.

4) Fate clic sul pulsante Stampa.

Stampa di una selezione di celle:

1) Nel documento, selezionate la sezione di celle da stampare.

2) Scegliete File > Stampa dal menu.

3) Nella sezione Intervallo e copie della finestra di dialogo Stampa, selezionate l'opzione Celle 
selezionate.

4) Fate clic sul pulsante Stampa.

Attenzione Dopo la stampa, assicuratevi di deselezionare i fogli sui quali non dovete lavorare. 
Mantenendoli selezionati, invece di inserire i dati su un unico foglio li inserirete su 
tutti i fogli selezionati. Questo potrebbe non essere ciò che volete fare.

Impress e Draw
Potete scegliere di stampare singole diapositive, gruppi di diapositive, o selezioni di diapositive.

Stampa di una singola diapositiva:

1) Scegliete File > Stampa dalla barra dei menu.

2) Selezionate la diapositiva da stampare.

a) Nella sezione Intervallo e copie della finestra di dialogo Stampa, selezionate l'opzione 
Diapositive.

b) Inserite il numero della diapositiva da stampare.

3) Fate clic sul pulsante Stampa.
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Stampa di un intervallo di pagine:

1) Scegliete File > Stampa dalla barra dei menu.

2) Selezionate le diapositive da stampare.

a) Nella sezione Intervallo e copie della finestra di dialogo Stampa, selezionate l'opzione 
Diapositive.

b) Inserite il numero delle diapositive da stampare (ad esempio 1-4 o 1,3,7,11).

3) Fate clic sul pulsante Stampa.

Stampa di una selezione di una diapositiva, o una selezione da più diapositive:

1) Nel documento, selezionate la sezione della diapositiva da stampare.

2) Scegliete File > Stampa dalla barra dei menu.

3) Selezionate l'opzione Selezione nella sezione Intervallo e copie della finestra di dialogo 
Stampa.

4) Fate clic sul pulsante Stampa.

Stampa di stampati, note, o strutture in Impress
Con Stampati le diapositive vengono stampate in dimensioni ridotte sulla pagina, da una a nove 
diapositive per pagina. Le diapositive possono essere stampate sulla pagina con orientamento 
orizzontale o verticale.

Con Note su ciascuna pagina viene stampata una singola diapositiva, con le note inserite in 
Visualizzazione Note per quella diapositiva.

Con Struttura ciascuna diapositiva viene stampata in formato struttura, con il titolo e le intestazioni.

Per stampare stampati, note o strutture:

1) Scegliete File > Stampa dalla barra dei menu.

2) Nella sezione Stampa della finestra di dialogo Stampa, selezionate l'opzione desiderata.

3) Per gli Stampati, potete quindi scegliere quante diapositive stampare per pagina, e l'ordine 
di stampa.

4) Fate clic sul pulsante Stampa.

Stampa di un depliant
In Writer, Impress e Draw, potete stampare un documento con due pagine su ciascun lato del 
foglio, disposte in modo tale che, quando le pagine stampate vengono ripiegate a metà, le pagine 
sono nell'ordine corretto per formare un libretto o un depliant.
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Suggerimento
Organizzate il documento in modo che risulti adeguato a una stampa a 
dimensione dimezzata; scegliete opportunamente i margini, la dimensione dei 
caratteri, etc). Potreste comunque aver bisogno di fare più prove.

Per stampare un depliant su una stampante priva della funzione fronte-retro:

1.  Scegliete File > Stampa.

2. Nella finestra di dialogo Stampa, fate clic su Proprietà.

3. Controllate che l'impostazione dell'orientamento (verticale o orizzontale) della stampante 
sia la stessa specificata nelle impostazioni della pagina del documento. In generale 
l'orientamento non è rilevante, ma lo è per i depliant. Fate clic su OK per ritornare alla 
finestra di dialogo Stampa.

4. Selezionate la scheda Layout di pagina nella finestra di dialogo Stampa.

5. Selezionate l'opzione Depliant.

6. Nella sezione Lati della pagina, selezionate l'opzione Retro / pagine sinistre dall'elenco a 
discesa Includi.

7. Fate clic sul pulsante Stampa.

8. Estraete le pagine stampate dalla stampante, capovolgetele, e inseritele nuovamente nella 
stampante con l'orientamento corretto per stampare sul lato vuoto. Potreste aver bisogno di 
eseguire più prove per trovare la disposizione corretta per la vostra stampante.

9. Nella finestra di dialogo Stampa, nella sezione Lati della pagina, selezionate l'opzione 
Fronte / pagine destre dall'elenco a discesa Includi.

10. Fate clic sul pulsante Stampa.
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Suggerimento
Se la vostra stampante può stampare fronte-retro automaticamente, scegliete 
Tutte le pagine.

Stampa di buste, etichette, biglietti da visita
La stampa di buste, etichette o biglietti da visita con Writer comporta due passaggi: l'impostazione 
e la stampa.

Per dettagli relativi alle impostazioni, vedere il Capitolo 11 (Uso della stampa in serie) nella Guida 
a Writer. Per la stampa:

1) Scegliete File > Stampa dalla barra dei menu.

2) Nella finestra di dialogo Stampa, sotto Intervallo e copie, scegliete Pagine e digitate 1 nel 
riquadro. Fate clic sul pulsante Stampa.

Stampa in bianco e nero con una stampante a colori
A volte potreste desiderare di stampare documenti in bianco e nero con una stampante a colori. 
Sono disponibili diverse opzioni. Alcune stampanti potrebbero comunque stampare a colori, 
indipendentemente dalle opzioni scelte.

Cambiate le impostazioni della stampante per stampare  in bianco e nero o in toni di grigio:

1) Scegliete File > Stampa per aprire la finestra di dialogo Stampa.

2) Fate clic su Proprietà per aprire la finestra di dialogo Proprietà della stampante. Le scelte 
disponibili dipendono dal modello di stampante, ma dovrebbe essere disponibili le opzioni 
per le impostazioni del colore. Consultate l'aiuto o il manuale utente della vostra stampante 
per maggiori informazioni.

3) Le scelte per il colore potrebbero includere bianco e nero o toni di grigio: Scegliete le 
impostazioni desiderate.

4) Fate clic su OK per confermare le vostre scelte e ritornare alla finestra di dialogo Stampa.

5) Fate clic sul pulsante Stampa per stampare il documento.

Suggerimento Se ci sono oggetti grafici nel documento è preferibile la sfumatura di grigio.

Cambiate le impostazioni di LibreOffice per stampare tutti i testi e gli oggetti grafici in toni di grigio:

1) Scegliete Strumenti > Opzioni > LibreOffice > Stampa.

2) Selezionate l'opzione Converti i colori in sfumature di grigio. Fate clic su OK per salvare 
la modifica.

3) Aprite la finestra di dialogo Stampa (File > Stampa).

4) Fate clic sul pulsante Stampa per stampare il documento.

Cambiate le impostazioni di LibreOffice Writer (o Calc, Impress, Draw) per stampare tutti i testi 
colorati in nero, e tutti gli oggetti grafici in toni di grigio:

1) Scegliete Strumenti > Opzioni > LibreOffice Writer > Stampa.

2) Sotto Contenuto, selezionate l'opzione Stampa testo in nero. Fate clic su OK per salvare 
la modifica.

3) Aprite la finestra di dialogo Stampa (File > Stampa).

4) Fate clic sul pulsante Stampa per stampare il documento.

Capitolo 10  Stampa, esportazione e invio di e-mail 331



Anteprima di pagine/fogli prima della stampa
In Writer e Calc potete usare le opzioni di anteprima per vedere come verrà stampato un 
documento. Sono disponibili diverse opzioni di visualizzazione.

Writer
La visualizzazione di pagina normale in Writer vi mostra come risulterà la pagina una volta 
stampata, e potete modificare le pagine in tale visualizzazione. Se state producendo un 
documento per la stampa fronte-retro può essere utile vedere come risulteranno le pagine 
affiancate. Ci sono due modalità per fare questo in Writer:

• Vista Layout (vista che consente la modifica): usate il pulsante Fianco a fianco (Anteprima 
libro) sulla barra di stato.

• Anteprima di stampa (vista di sola lettura).

Per utilizzare Anteprima di stampa:

1) Scegliete File > Anteprima di stampa (o fate clic sul pulsante Anteprima di stampa  
sulla barra degli strumenti Standard).

Writer ora mostra la barra degli strumenti Anteprima di stampa invece della barra degli 
strumenti Formattazione.

Figura 299: barra degli strumenti Anteprima di stampa (Writer)

2) Selezionate l'icona di anteprima desiderata: Due pagine ( ), Più pagine ( ) o 

Anteprima del libro ( ).

3) Per stampare il documento da questa vista, fate clic sull'icona Stampa documento ( )  

per aprire la finestra di dialogo Stampa. Scegliete le opzioni di stampa e fate clic sul 
pulsante Stampa.

Calc
Per vedere l'anteprima dei fogli in Calc prima della stampa:

1) Scegliete File > Anteprima di stampa.

La finestra di Calc ora mostra la barra degli strumenti  Anteprima di stampa invece della 
barra degli strumenti Formattazione.

Figura 300: barra degli strumenti Anteprima di stampa (Calc)

2) Per stampare il documento da questa vista, fate clic sull'icona Stampa documento  per 

aprire la finestra di dialogo Stampa.

3) Scegliete le opzioni di stampa e fate clic sul pulsante Stampa.
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Esportazione in PDF

Con LibreOffice è possibile esportare file in PDF (Portable Document Format). Questo formato 
standard è ideale per l'invio di file che potranno essere aperti usando Adobe Acrobat Reader o altri 
visualizzatori PDF.

I processi e le finestre di dialogo sono gli stessi per Writer, Calc, Impress e Draw, con alcune 
differenze menzionate in questa sezione.

Esportazione veloce in PDF

Fate clic sull'icona Esporta direttamente come file PDF  per esportare l'intero documento 
utilizzando le impostazioni PDF selezionate nella finestra di dialogo Opzioni PDF. Vi verrà chiesto 
di inserire il nome del file e il percorso per il file PDF, ma non avrete la possibilità di scegliere un 
intervallo di pagine, la compressione dell'immagine, o altre opzioni.

Controllo del contenuto e della qualità del PDF
Per un maggior controllo sul contenuto e sulla qualità del PDF risultante, utilizzate File > Esporta 
nel formato PDF. Si aprirà la finestra di dialogo Opzioni PDF. Questa finestra è composta da 
cinque pagine (Generale, Visualizzazione iniziale, Interfaccia utente, Collegamenti e Sicurezza). 
Selezionate le impostazioni appropriate e poi fate clic su Esporta. Vi verrà chiesto di immettere il 
percorso e il nome del file PDF che state creando, e di fare clic su Salva per esportare il file.

Finestra di dialogo Opzioni PDF - scheda Generale
Nella scheda Generale, potete scegliere quali pagine includere nel PDF, il tipo di compressione per 
le immagini (che riguarda la qualità delle immagini nel PDF), e altre opzioni.

Sezione Intervallo
• Tutto: esporta tutto il documento in PDF.

• Pagine: per esportare un intervallo di pagine usate il formato 3-6 (pagine da 3 a 6). Per 
esportare pagine singole, usate il formato 7;9;11 (pagine 7, 9 e 11). Potete anche 
esportare una combinazione di un intervallo di pagine e pagine singole, utilizzando un 
formato come 3-6;8;10;12.

• Selezione: esporta il contenuto selezionato.
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Figura 301: finestra di dialogo Opzioni PDF, scheda Generale

Sezione Immagini
• Compressione senza perdite:  il salvataggio avviene senza perdita di qualità nelle 

immagini. Crea file di grandi dimensioni quando il documento contiene fotografie. 
Consigliato per altri tipi di immagini od oggetti grafici.

• Compressione JPEG: consente di variare la gradazione della qualità. L'impostazione 90% 
è adatta alle fotografie (file di piccole dimensioni, perdita di qualità appena percettibile).

• Riduci risoluzione immagine: le immagini con un numero inferiore di DPI (dots per inch - 
punti per pollice) sono di qualità più scarsa. Per la visualizzazione a schermo generalmente 
una risoluzione di 72dpi (per Windows) o 96dpi (per GNU/Linux) è sufficiente, mentre per la 
stampa è normalmente preferibile usare almeno 300 o 600 dpi, a seconda delle 
caratteristiche della stampante. Con valori di dpi più elevati le dimensioni del file esportato 
aumentano.

Nota
Le immagini EPS (Encapsulated PostScript) con anteprime incorporate sono 
esportate solo come anteprime. Immagini EPS senza anteprima vengono esportate 
come segnaposti vuoti.

Sezione Generale
• Incorpora file OpenDocument: rende il PDF facilmente modificabile in LibreOffice o 

programmi simili.

• PDF/A-1a: il PDF/A è uno standard ISO per la conservazione dei documenti per lunghi 
periodi, mediante l'incorporamento di tutte le informazioni necessarie per una riproduzione 
fedele (come i tipi di carattere) mentre altri elementi vengono tralasciati (inclusi formulari, la 
sicurezza e la crittografia). I tag PDF vengono scritti. Se selezionate PDF/A-1a, gli elementi 
tralasciati saranno in grigio (non disponibili).

• PDF con tag: un PDF con tag contiene informazioni relative alla struttura dei contenuti del 
documento. Ciò può essere utile per la visualizzazione del documento su dispositivi con 
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schermi differenti, e se vengono usati software appositi per la lettura su schermo. Alcuni dei 
tag esportati sono indici, collegamenti e controlli. Questa opzione può far incrementare in 
modo significativo le dimensioni del file.

• Crea formulario PDF - Formato di invio dati: Scegliete il formato per l'invio dei formulari 
dal file PDF. Questa impostazione consente di ignorare le proprietà URL del controllo che 
avete inserito nel documento. Esiste solo una impostazione comune valida per l'intero 
documento PDF: PDF (invia l'intero documento), FDF (invia i contenuti del controllo), HTML 
e XML. Il formato PDF è la scelta più comune.

• Esporta segnalibri: Esporta le intestazioni dei documenti di Writer, i nomi di pagine e 
diapositive dei documenti di Impress e Draw, come “segnalibri” (un elenco indice mostrato 
dalla maggior parte dei lettori PDF, incluso Adobe Reader).

• Esporta i commenti: Esporta i commenti come note PDF. Forse non desiderate questo!

• Esporta pagine vuote inserite automaticamente: se l'opzione è selezionata, le pagine 
vuote inserite automaticamente vengono esportate in PDF. Questa opzione torna utile se si 
stampa il PDF fronte-retro. Per esempio, i capitoli dei libri di solito iniziano sempre su una 
pagina dispari (a destra). Quando il precedente capitolo si conclude su una pagina dispari, 
LibreOffice inserisce una pagina vuota tra le due pagine dispari. Questa opzione controlla 
se esportare o no la pagina vuota.

• Incorpora caratteri standard: Normalmente i tipi di carattere PostScript standard 14 non 
vengono incorporati in un file PDF, in quanto i software per la lettura dei PDF li contengono 
già. Potete comunque scegliere di incorporare questi tipi di carattere in tutti i documenti 
PDF creati con LibreOffice per migliorare la visualizzazione con i lettori di file PDF. 
L'incorporamento dei caratteri potrebbe anche essere necessario per poter stampare su 
alcune stampanti.

Finestra di dialogo Opzioni PDF - scheda Visualizzazione iniziale
Nella scheda Visualizzazione iniziale (Figura 302), potete scegliere la modalità predefinita di 
apertura del file PDF in un visualizzatore PDF. Le selezioni dovrebbero essere autoesplicative.

Se avete abilitato la Disposizione di testo complesso (Complex Text Layout) (in Strumenti > 
Opzioni > Impostazioni della lingua > Lingue), sarà disponibile un'ulteriore opzione sotto 
Continuo - pagine affiancate: Prima pagina a sinistra (normalmente, la prima pagina è sulla 
destra utilizzando l'opzione Continuo - pagine affiancate).

Figura 302: scheda Visualizzazione iniziale della finestra di dialogo Opzioni PDF
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Finestra di dialogo Opzioni PDF - scheda Interfaccia utente
Nella scheda Interfaccia utente (Figura 303), potete scegliere diverse impostazioni e determinare 
come verrà visualizzato il vostro file sul visualizzatore PDF. Alcune di queste scelte sono 
particolarmente utili se state creando un PDF da usare come presentazione o come 
visualizzazione da chiosco.

Sezione Opzioni finestra
• Ridimensiona finestra a pagina iniziale. Fa sì che il visualizzatore di PDF ridimensioni la 

finestra adattandola alla prima pagina del file PDF.

Figura 303: scheda Interfaccia utente della finestra di dialogo Opzioni PDF

• Centra finestra sullo schermo. Fa sì che il visualizzatore di PDF centri la finestra sullo 
schermo.

• Apri in modalità schermo intero. Fa sì che il visualizzatore di PDF apra a pieno schermo 
invece che in una finestra più piccola.

• Visualizza titolo documento. Fa sì che il visualizzatore di PDF mostri il titolo del 
documento nella barra del titolo.

Sezione Opzioni interfaccia utente
• Nascondi barra dei menu. Fa sì che il visualizzatore di PDF nasconda la barra dei menu.

• Nascondi barra degli strumenti. Fa sì che il visualizzatore di PDF nasconda la barra 
degli strumenti.

• Nascondi controlli finestra. Fa sì che il visualizzatore di PDF nasconda altri controlli 
finestra.

Transizioni
In Impress, gli effetti di transizione delle diapositive vengono visualizzati come i rispettivi effetti 
PDF.

Segnalibri
Selezionate quanti livelli di intestazione devono essere visualizzati come segnalibri, se Esporta 
segnalibri è selezionato sulla scheda Generale.

Finestra di dialogo Opzioni PDF - scheda Collegamenti
Nella scheda Collegamenti, potete scegliere come esportare i collegamenti in PDF.
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Figura 304: scheda Collegamenti della finestra di dialogo Opzioni PDF

Esporta segnalibri come segnaposto PDF
Se avete definito dei segnalibri in Writer, nomi di diapositive in Impress o in Draw, o nomi di 
fogli in Calc, questa opzione vi permette di esportarli come "nomi di destinazione", a cui 
possono essere collegati pagine Web e documenti PDF.

Converti i segnalibri secondo il formato PDF
Se avete definito dei collegamenti ad altri documenti con estensione OpenDocument (come 
.ODT, .ODS, e .ODP), questa opzione converte i nomi dei file in .PDF nel documento PDF 
esportato.

Esporta URL relativamente al file system
Se avete definito dei collegamenti relativi in un documento, questa opzione esporta questi 
collegamenti nel PDF.

Collegamenti incrociati a un documento
Definisce il comportamento dei collegamenti su cui si fa clic nei file PDF.

Finestra di dialogo Opzioni PDF - scheda Sicurezza
L'esportazione dei file in PDF include le opzioni per la cifratura del PDF (così che essi non 
possano essere aperti senza una password) e per l'applicazione di alcune funzionalità relative alla 
gestione dei diritti digitali (DRM).

• Impostando una password di apertura, il documento può essere aperto solamente con la 
password. Una volta aperto il file, non esistono restrizioni su cosa può fare l'utente sul 
documento (per esempio stamparlo, copiarlo o cambiarlo).

• Con una password di autorizzazione impostata, il PDF può essere aperto, ma i permessi a 
operare su esso possono essere limitati. Vedere Figura 305. Dopo aver inserito una 
password dei permessi, le altre opzioni della scheda Sicurezza diventano accessibili.

• Con entrambe le password di apertura e password di autorizzazione impostate, il file PDF 
può essere aperto solo con la password corretta e le operazioni su esso possono essere 
limitate.

Nota
Le impostazioni di autorizzazione funzionano solo se il visualizzatore di file PDF 
dell'utente rispetta tali impostazioni.
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Figura 305: scheda sicurezza della finestra di dialogo Opzioni PDF

La Figura 306 mostra la finestra di dialogo che viene visualizzata facendo clic sul pulsante 
Imposta password di apertura contenuta nella scheda Sicurezza della finestra di dialogo Opzioni 
PDF.

Figura 306: impostare una password per codificare un PDF

Esportazione in altri formati

LibreOffice usa il termine “esporta” per alcune operazioni sui file che comportano una modifica del 
tipo di file. Se non riuscite a trovare quello che desiderate sotto File > Salva con nome, cercate 
anche sotto File > Esporta.

LibreOffice può esportare file in XHTML, se è installato il filtro appropriato (predefinito su Mac e 
Linux; opzionale su Windows). Inoltre, Draw e Impress possono esportare in Adobe Flash (.swf) e 
in diversi altri formati immagine.
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Per eseguire l'esportazione in uno di questi formati, scegliete File > Esporta. Nella finestra di 
dialogo Esporta, specificate un nome file per il documento che state esportando, poi selezionate il 
formato desiderato nell'elenco Formato file e fate clic sul pulsante Esporta.

Inviare documenti come e-mail

LibreOffice offre svariati metodi per inviare documenti facilmente e velocemente come allegati di 
posta elettronica in uno dei tre seguenti formati: OpenDocument (formato predefinito di 
LibreOffice), Microsoft Office o PDF.

Nota
I documenti possono essere inviati utilizzando il menu di LibreOffice soltanto se è 
stato impostato un profilo di posta elettronica in Strumenti > Opzioni > LibreOffice 
Writer > Stampa in serie e-mail.

Per inviare il documento corrente nel formato OpenDocument:

1) Scegliete File > Invia > Documento come e-mail. LibreOffice aprirà il programma di posta 
predefinito. Il documento viene allegato.

2) Nel vostro programma di posta, inserite il destinatario, il soggetto e ogni parte di testo che 
volete aggiungere, quindi inviate il messaggio.

Tramite File > Invia > Documento allegato nel formato OpenDocument Text (o Foglio 
elettronico o Presentazione) si ottiene lo stesso risultato.

Se scegliete Documento allegato nel formato Microsoft [Word, Excel, o Powerpoint], 
LibreOffice creerà prima un file in uno di questi formati e poi aprirà il vostro programma di posta 
allegando il file creato.

Allo stesso modo, se scegliete E-mail come PDF, LibreOffice creerà prima un PDF usando le 
vostre impostazioni PDF predefinite (le stesse che vengono usate con il pulsante Esporta 
direttamente come file PDF) e poi aprirà il vostro programma di posta, allegando il file PDF.

Inviare per e-mail un documento a diversi destinatari
Per inviare un documento tramite posta elettronica a più destinatari, potete utilizzare le funzionalità 
del vostro programma di posta oppure la stampa in serie di LibreOffice per estrarre gli indirizzi di 
posta elettronica da una rubrica.

Potete usare la stampa in serie di LibreOffice per inviare i messaggi in due modi:

• Usate la procedura della Stampa guidata in serie per creare il documento e quindi inviarlo. 
Vedere il Capitolo 11 (Uso della stampa in serie) nella Guida a Writer per maggiori dettagli.

• Create il documento in Writer senza usare la procedura guidata, quindi usate la Stampa 
guidata per inviarlo. Questo metodo è qui descritto.

Per usare la Stampa guidata in serie per inviare un documento precedentemente creato con 
Writer:

1) Fate clic su Strumenti > Stampa guidata in serie. Sulla prima pagina della procedura 
guidata, selezionate Usa il documento attivo e fate clic su Avanti.
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Figura 307:  selezione del documento iniziale

2) Sulla seconda pagina, selezionate Messaggio e-mail e fate clic su Avanti.

Figura 308:  selezione del tipo di documento

3) Sulla terza pagina, fate clic sul pulsante Seleziona elenco di indirizzi. Scegliete l'elenco di 
indirizzi desiderato (anche se ne viene visualizzato soltanto uno) e fate clic su OK. (se 
l'elenco di cui avete bisogno non viene mostrato, potete fare clic su Aggiungi per trovarlo e 
aggiungerlo all'elenco).
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Figura 309: selezione dell'elenco di indirizzi

4) Una volta tornati alla pagina di selezione dell'elenco indirizzi, fate clic su Avanti. Sulla 
pagina Crea una formula di saluto, deselezionate Questo documento dovrebbe 
contenere una formula di saluto.

Figura 310: deselezione della formula di saluto

5) Nell'elenco di sinistra selezionate 8. Salvate, stampate o inviate il documento. 
LibreOffice visualizza un messaggio di “Creazione documenti” e successivamente la 
pagina della creazione guidata Salvate, stampate o inviate il documento.

6) Selezionate Invia il documento composto come e-mail. La parte inferiore della pagina si 
modificherà mostrando le scelte di configurazione per il messaggio di posta.
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Figura 311: invio di un documento come messaggio e-mail

7) Scrivete un oggetto per il vostro messaggio di posta e fate clic su Invia documenti. 
LibreOffice invia i messaggi.

Firma digitale dei documenti

Per apporre una firma digitale a un documento, avete la necessità di possedere una chiave 
personale, anche conosciuta come certificato. Una chiave personale è immagazzinata sul vostro 
computer come combinazione tra una chiave privata, che deve essere mantenuta segreta, e una 
chiave pubblica, che viene aggiunta ai vostri documenti quando li firmate. Potete ottenere un 
certificato da una autorità di certificazione, che potrebbe essere un'azienda privata o un'istituzione 
governativa.

Quando applicate una firma digitale a un documento, viene calcolata una specie di somma di 
controllo dal contenuto del documento e dalla vostra chiave personale. La somma di controllo e la 
vostra chiave pubblica vengono salvate insieme nel documento.

Quando qualcuno, successivamente, aprirà il documento su qualsiasi computer che possiede una 
versione recente di LibreOffice, il programma ricalcolerà di nuovo la somma di controllo, 
comparandola poi con quella salvata in precedenza. Se risultano uguali, il programma vi segnalerà 
che state visualizzando il documento originale, non modificato. Inoltre, il programma può mostrarvi 
informazioni sulla chiave pubblica del certificato. Potete fare una comparazione tra la chiave 
pubblica ricevuta e la chiave pubblica presente sul sito web dell'autorità di certificazione. Nel caso 
qualcuno cambi qualcosa nel documento, queste variazioni modificano la firma digitale.

Sui sistemi operativi Windows vengono utilizzate le funzionalità di convalida della firma digitale 
fornite da Windows. Su sistemi Solaris e Linux, vengono utilizzati i file forniti da Thunderbird, 
Mozilla o Firefox. Per una descrizione più dettagliata di come ottenere e operare con un certificato, 
e per la convalida della firma, vedere "Applicare le firme digitali" nella Guida di LibreOffice.
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Per firmare un documento:

1) Scegliete File > Firme digitali.

2) Se non avete salvato il documento dall'ultima modifica, vi apparirà un messaggio. Fate clic 
su Sì per salvare il file.

3) Dopo il salvataggio, vedrete la finestra di dialogo Firme digitali. Fate clic su Aggiungi per 
aggiungere una chiave pubblica al documento.

4) Nella finestra di dialogo Seleziona certificato, selezionate il vostro certificato e fate clic su 
OK.

5) Ricomparirà la finestra di dialogo Firme digitali, dove, se volete, potete aggiungere altri 
certificati. Fate clic su OK per aggiungere la chiave pubblica nel file salvato.

Un documento firmato viene contrassegnato da un'icona nella barra di stato. È possibile fare 
doppio clic sull'icona per visualizzare il certificato.

Eliminare i dati personali

Potreste volervi assicurare che i dati personali, le versioni, le note, le informazioni nascoste, o le 
modifiche registrate siano eliminati dai file prima di inviarli ad altre persone o di esportarli in PDF.

In Strumenti > Opzioni > LibreOffice > Sicurezza > Opzioni, potete impostare LibreOffice in 
modo da essere avvisati quando i file contengono determinate informazioni ed eliminare le 
informazioni personali automaticamente durante il salvataggio.

Per eliminare dati personali e di altro tipo da un file, andate su File > Proprietà. Sulla scheda 
Generale, deselezionate Usa i dati utente e poi fate clic sul pulsante Ripristina. In tal modo verrà 
rimosso qualsiasi nome presente in comandi di campo creati o modificati, verranno eliminate le 
date di modifica e stampa, il tempo di modifica verrà azzerato, la data di creazione verrà impostata 
alla data e ora corrente, e il numero di versione verrà riportato a 1.

Per eliminare le informazioni di versione, potete (a) andare su File > Versioni, selezionare le 
versioni dall'elenco e fare clic su Elimina; oppure (b) usare File > Salva con nome e salvare il file 
con un nome differente.
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Introduzione

Nei documenti di LibreOffice si possono aggiungere elementi grafici e immagini, compresi foto, 
disegni, immagini acquisite da scanner, ecc. LibreOffice può importare vari formati di file grafici di 
tipo vettoriale (disegno di linee) e raster (bitmap). I formati di immagini più usati sono GIF, JPG, 
PNG e BMP. Vedere l'Appendice B per un elenco completo dei formati grafici che LibreOffice può 
importare.

In LibreOffice ci sono tre tipologie principali di oggetti grafici:

• File immagine, come foto, disegni e immagini acquisite da scanner.

• Diagrammi creati con gli strumenti di disegno di LibreOffice

• Grafici creati utilizzando l'apposito componente Chart di LibreOffice.

Questo capitolo tratta di immagini e diagrammi.

Potete trovare descrizioni più dettagliate su come lavorare con gli strumenti di disegno nella Guida 
a Draw e nella Guida a Impress. Istruzioni su come creare grafici sono fornite nella Guida a Calc.

Aggiunta di immagini a un documento

Potete aggiungere delle immagini a un documento in diversi modi: inserendo un file immagine, 
direttamente da un programma di grafica o da uno scanner, o dalla Galleria di LibreOffice.

Inserimento di un file immagine
Quando l'immagine si trova in un file salvato sul computer, potete inserirla in un documento di 
LibreOffice usando uno dei seguenti metodi.

Trascinamento
1) Aprite una finestra di esplorazione file e trovate l'immagine che volete inserire.

2) Trascinate l'immagine nel documento di LibreOffice e rilasciatela dove desiderate che 
compaia. Una tenue linea verticale segna la posizione in cui l'immagine verrà rilasciata.

Questo metodo incorpora il file immagine (ne salva una copia) nel documento. Per collegare il file, 
anziché incorporarlo, tenete premuti i tasti Ctrl+Maiusc mentre trascinate l'immagine.

Finestra di dialogo Inserisci immagine.
1) Fate clic nel documento di LibreOffice dove desiderate che compaia l'immagine.

2) Scegliete Inserisci > Immagine > Da file dalla barra dei menu.

3) Nella finestra di dialogo Inserisci immagine (Figura 312), notate le due opzioni in basso a 
sinistra: Anteprima e Collegamento. Scegliete Anteprima per vedere una miniatura 
dell'immagine selezionata sulla destra, in modo da poter verificare di avere selezionato il 
file corretto. Vedere pagina 347 per l'utilizzo del comando Collegamento.

4) Rintracciate il file da inserire, selezionatelo e fate clic su Apri.
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Nota

Se scegliete l'opzione Collegamento, apparirà un messaggio quando fate clic su 
Apri. Il messaggio specifica che l'immagine non verrà salvata con il documento, ma 
sarà solamente collegata, e chiede se desiderate invece incorporare l'immagine. 
Scegliete Mantieni collegamento se volete collegare l'immagine, o Incorpora 
immagine se volete incorporarla. Per evitare che il messaggio compaia 
nuovamente, deselezionate la casella Chiedi quando colleghi un'immagine nella 
parte bassa del riquadro del messaggio.

Figura 312: finestra di dialogo Inserisci immagine

Collegare un file immagine
Se l'opzione Collegamento è selezionata nella finestra di dialogo Inserisci immagine, LibreOffice 
crea un collegamento al file che contiene l'immagine, anziché includere una copia dell'immagine 
nel documento. In questo modo l'immagine viene mostrata nel documento, ma il documento 
salvato contiene solo un riferimento al file dell'immagine, non l'immagine stessa. Il documento e 
l'immagine rimangono due file separati, che vengono riuniti solo quando si riapre il documento.

Collegare un'immagine presenta due vantaggi e uno svantaggio:

• Vantaggio – Con il collegamento si possono ridurre le dimensioni del documento quando 
viene salvato, poiché non si include il file dell'immagine. Le dimensioni di un file in genere 
non sono un problema su computer moderni con una memoria ampia, a meno che il 
documento non includa molte immagini di grosse dimensioni; LibreOffice è in grado di 
gestire anche file di grandi dimensioni.
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• Vantaggio – Potete modificare il file dell'immagine separatamente senza dover modificare il 
documento perché il collegamento al file rimane attivo; quando poi riaprirete il documento 
vedrete l'immagine modificata. Questo può essere un grande vantaggio se l'autore del 
documento (o qualcun altro, per esempio un grafico) aggiorna le immagini.

• Svantaggio – Se inviate il documento a qualcun altro, o lo trasferite su un altro computer, 
dovete inviare anche i file delle immagini, altrimenti il destinatario non potrà vedere le 
immagini collegate. È necessario prendere nota della posizione delle immagini e 
assicurarsi che il destinatario sappia dove metterle in un altro computer, in modo che il 
documento, quando viene aperto, le possa ritrovare. Per esempio, potreste tenere le 
immagini in una sottocartella chiamata Immagini (all'interno della cartella che contiene il 
documento); chi riceve il file dovrà mettere le immagini in una sottocartella con lo stesso 
nome e nella stessa posizione relativamente al documento.

Nota

Quando dovete inserire la stessa immagine più volte nel documento, potrebbe 
essere utile creare dei collegamenti anziché incorporare; ciò non è comunque 
necessario, in quanto LibreOffice include nel documento una sola copia del file 
dell'immagine.

Inserimento di immagini collegate
Se in un primo momento avete collegato le immagini, potete facilmente incorporarne una o più in 
seguito. Per eseguire questa operazione:

1) Aprite il documento in LibreOffice e scegliete Modifica > Collegamenti.

2) La finestra di dialogo Modifica collegamenti (Figura 313) mostra tutti i file collegati. 
Nell'elenco File sorgente selezionate i file che volete modificare da collegati a incorporati.

3) Fate clic sul pulsante Interruzione.

4) Salvate il documento.

Nota
Il procedimento inverso, da incorporato a collegato, non è altrettanto semplice: 
bisogna cancellare e reinserire ogni immagine, una per volta, selezionando l'opzione 
Collegamento.

Figura 313: la finestra di dialogo Modifica collegamenti
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Inserimento di un'immagine dagli appunti
Utilizzando gli appunti, potete copiare immagini in un documento di LibreOffice da un altro 
documento di LibreOffice o da altri programmi. Per eseguire questa operazione:

1) Aprite sia il documento sorgente, sia quello di destinazione.

2) Nel documento sorgente, selezionate l'immagine da copiare.

3) Portate il puntatore del mouse sull'immagine selezionata e premete Ctrl+C per copiarla 
negli appunti.

4) Passate al documento di destinazione.

5) Fate clic per posizionare il cursore nel punto in cui volete inserire l'immagine.

6) Premete Ctrl+V per inserirla.

Attenzione Se chiudete l'applicazione dalla quale avete copiato l'immagine prima di incollarla 
nel documento di destinazione, l'immagine memorizzata negli appunti potrebbe 
andare persa.

Inserimento di un'immagine da scanner
Se avete uno scanner collegato al computer, LibreOffice può attivare l'applicazione utilizzata per la 
scansione e inserire il risultato della scansione come immagine nel documento di LibreOffice. Per 
iniziare questa procedura, portate il cursore nel punto in cui volete inserire l'immagine e scegliete 
Inserisci > Immagine > Scanner > Scegli sorgente.

Anche se questo procedimento è facile e veloce, si potrebbero non ottenere immagini di alta 
qualità e delle dimensioni giuste. Potete ottenere risultati migliori elaborando il materiale acquisito 
con un programma di grafica prima di inserire le immagini così prodotte in LibreOffice.

Inserimento di un'immagine dalla Galleria
La Galleria offre un modo pratico per raggruppare oggetti come immagini e suoni che potreste aver 
necessità d'inserire nei documenti più volte. La Galleria è presente in tutti i componenti di 
LibreOffice. Vedere “Gestione della Galleria di LibreOffice“ a pagina 351. È possibile copiare 
oppure collegare all'interno di un documento gli oggetti della Galleria.

Per inserire un oggetto:

1) Scegliete Strumenti > Galleria oppure fate clic sull'icona Galleria  sulla barra degli 
strumenti Standard (in Writer e Calc) o sulla barra degli strumenti Disegno (in Impress e 
Draw).

2) Selezionate una categoria.

3) Selezionate un oggetto con un singolo clic.

4) Trascinate l'immagine e rilasciatela nel documento. (Vedere la Figura 314)

Potete anche fare clic con il pulsante destro sull'oggetto e scegliere Inserisci > Copia.
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Figura 314: copia di un oggetto grafico dalla Galleria in un documento (l'ovale indica il pulsante 
per nascondere/mostrare la Galleria)

Per inserire un oggetto come collegamento:

1) Scegliete Strumenti > Galleria e selezionate una categoria.

2) Selezionate un oggetto con un clic, quindi, tenendo premuti i tasti Maiusc e Ctrl sulla 
tastiera, trascinatelo e rilasciatelo all'interno del documento.

Inserire un'immagine come sfondo
Per inserire un'immagine come sfondo di una pagina o di un paragrafo:

1) Scegliete Strumenti > Galleria e selezionate una categoria.

2) Selezionate un oggetto con un clic, fate clic con il pulsante destro sull'oggetto e scegliete 
Inserisci > Sfondo > Pagina oppure > Paragrafo.

Modificare e posizionare le immagini

LibreOffice offre molti strumenti per ridimensionare, modificare, filtrare e disporre le immagini; 
gestire il testo intorno alle immagini; usare le immagini come sfondi e filigrana (watermark). Questi 
strumenti sono descritti nei relativi capitoli delle altre guide. È comunque preferibile eseguire le 
modifiche più complesse con un programma di elaborazione di immagini per poi portare il risultato 
in LibreOffice, anziché usare gli strumenti di LibreOffice.
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Gestione della Galleria di LibreOffice

Nella Galleria le immagini sono raggruppate per categorie, come Punti, Limiti e Sfondi. Potete 
creare altri gruppi o categorie e aggiungere le vostre immagini o trovare estensioni contenenti altre 
immagini.

Il riquadro a sinistra della finestra della Galleria elenca le categorie disponibili. Fate clic su una 
categoria per vedere il suo contenuto nella finestra della Galleria.

Potete visualizzare la Galleria in Vista icone (Figura 315) o in Vista dettagli, e potete nasconderla o 
mostrarla facendo clic sul pulsante Nascondi (simile al pulsante Nascondi per le finestre 
Navigatore e Stili e formattazione quando sono ancorate).

Figura 315: Vista icone di una categoria della Galleria

Per impostazione predefinita, la Galleria è ancorata al di sopra dello spazio di lavoro. Per 
espandere la Galleria, posizionate il puntatore sulla linea che la divide dalla parte superiore dello 
spazio di lavoro. Quando il puntatore prende la forma di linee parallele con delle frecce, fate clic e 
trascinate verso il basso. Lo spazio di lavoro si ridimensiona di conseguenza.

Come con altre finestre ancorate, potete rendere “mobile” la Galleria portando il puntatore del 
mouse su un bordo della finestra della Galleria, e fare doppio clic mentre tenete premuto il tasto 
Ctrl. Ripetete la stessa procedura per ancorare di nuovo la Galleria.

Le categorie predefinite sono bloccate; non è possibile aggiungere né cancellare elementi da 
queste categorie. Le categorie bloccate si riconoscono facilmente: facendo clic con il pulsante 
destro su di essi, l'unica opzione disponibile nel menu a comparsa è Proprietà.

In un'installazione predefinita, è possibile modificare soltanto la Categoria personale. Potete 
comunque aggiungere nuove categorie, come spiegato in “Aggiungere una nuova categoria alla 
Galleria” a pagina 353.

Aggiungere oggetti alla Galleria
Può capitare di voler aggiungere alla Galleria immagini di uso frequente, per esempio un logo 
aziendale. Tali immagini possono poi essere inserite nei documenti in modo molto semplice.
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Potete aggiungere immagini solo alla “Categoria personale” o a qualsiasi altra categoria da voi 
creata. Le vostre categorie sono contrassegnate da un'icona verde nell'elenco delle categorie. Non 
potete invece aggiungere immagini alle categorie predefinite, che sono contraddistinte da un'icona 
di un altro colore.

Metodo 1 (selezione di un file):

1) Fate clic con il pulsante destro sulla categoria desiderata e selezionate Proprietà dal menu 
contestuale.

2) Nella finestra di dialogo delle Proprietà della categoria, andate alla scheda File e fate clic 
sul pulsante Cerca file.

Figura 316: finestra di dialogo Proprietà della Galleria

3) Si aprirà la finestra di dialogo Seleziona percorso (non mostrata). Per trovare il file, potete 
inserire l'indirizzo della cartella dove si trova il file nella casella di testo Percorso, oppure 
sfogliare le cartelle presenti sul vostro computer per localizzare quella che contiene il file.

4) Fate clic sul pulsante Seleziona per iniziare la ricerca. Nella finestra di dialogo Proprietà 
apparirà un elenco di file di immagini. Potete usare l'elenco a discesa Tipo file per 
restringere il numero di file visualizzati.

5) Per aggiungere tutti i file mostrati in elenco, fate clic su Aggiungi tutti. Altrimenti, 
selezionate i file da aggiungere e poi fate clic su Aggiungi (tenete premuto il tasto Maiusc 
o il tasto Ctrl mentre fate clic sui file).

352 Guida introduttiva a LibreOffice 3.5



Metodo 2 (Trascinamento):

Potete trascinare e rilasciare un'immagine nella Galleria da un documento.

1) Aprite il documento contenente l'immagine che volete aggiungere alla Galleria e 
visualizzate la categoria della Galleria in cui volete aggiungerla.

2) Posizionate il puntatore del mouse sull'immagine, senza fare clic.

3) Se il puntatore del mouse assume l'aspetto di una mano, l'immagine si riferisce a un 
collegamento ipertestuale. In questo caso, premete il tasto Alt mentre fate clic 
sull'immagine per selezionarla senza attivare il collegamento. Se il puntatore del mouse 
non assume l'aspetto di una mano, basta fare clic sull'immagine per selezionarla.

4) Quando avete selezionato l'immagine (appariranno le maniglie colorate di selezione attorno 
a essa), rilasciate il pulsante del mouse. Fate di nuovo clic sull'immagine, tenendo il 
pulsante del mouse premuto per più di due secondi. Senza rilasciare il pulsante del mouse, 
trascinate l'immagine nella Galleria.

5) Rilasciate il pulsante del mouse.

Eliminare immagini dalla Galleria
Per eliminare un'immagine da una categoria da voi creata:

1) Fate clic con il pulsante destro sul nome del file dell'immagine o sulla sua miniatura nella 
Galleria.

2) Fate clic su Elimina nel menu a comparsa. Apparirà un messaggio con la richiesta di 
conferma dell'eliminazione dell'oggetto. Fate clic su Sì.

Nota
Quando si elimina il nome di un file dall'elenco nella Galleria, il file corrispondente 
non viene invece eliminato dal disco rigido o da altra posizione.

Aggiungere una nuova categoria alla Galleria
Per aggiungere una nuova categoria alla Galleria:

1) Fate clic sul pulsante Nuova categoria al di sopra dell'elenco delle categorie (Figura 315).

2) Nella finestra di dialogo Proprietà della nuova categoria, fate clic sulla scheda Generale e 
digitate il nome della nuova categoria.

3) Fate clic sulla scheda File e aggiungete immagini alla categoria, come descritto 
precedentemente.

Eliminare una categoria dalla Galleria
Potete eliminare solo le categorie da voi aggiunte alla Galleria; non è possibile eliminare quelle 
predefinite. Per eliminare una categoria dalla Galleria:

1) Selezionate Strumenti > Galleria.

2) Selezionate la categoria che volete eliminare dall'elenco nella parte sinistra della Galleria.

3) Fate clic col pulsante destro sulla categoria, poi clic su Elimina nel menu a comparsa.

Ubicazione della Galleria e degli oggetti in essa contenuti
Le immagini e gli altri oggetti mostrati nella Galleria possono risiedere ovunque, nel disco rigido del 
computer, su un drive di rete o su un CD-ROM. Gli elenchi nella Galleria si riferiscono alla 
posizione di ciascun oggetto. Quando aggiungete un'immagine alla Galleria i file non vengono 

Capitolo 11  Immagini, Galleria e Fontwork 353



spostati o copiati, ma viene solamente aggiunta la posizione di ciascun nuovo oggetto come 
riferimento.

Nel caso di un gruppo di lavoro, potreste avere accesso a una Galleria condivisa (il cui contenuto 
non può essere modificato, a meno che non disponiate della necessaria autorizzazione) e a una 
Galleria utente, in cui potete aggiungere, modificare o eliminare oggetti.

La posizione della Galleria utente è specificata in Strumenti > Opzioni > LibreOffice > Percorsi. 
Potete modificare questa posizione e potete anche copiare i file della vostra Galleria (*.sdv) in 
altri computer.

I contenuti della Galleria forniti con LibreOffice sono memorizzati in una posizione diversa. Non è 
possibile modificare questa posizione.

Creare una mappa immagine

Una mappa immagine definisce aree di un'immagine (dette hotspots - zone attive) con 
collegamenti ipertestuali a indirizzi web, altri file sul computer o parti dello stesso documento. Gli 
hotspot sono l'equivalente grafico dei collegamenti ipertestuali in testo (descritti nel capitolo 12). 
Facendo clic su un hotspot LibreOffice aprirà la pagina collegata nel programma appropriato (ad 
esempio, il browser predefinito per una pagina HTML; LibreOffice Calc per un file .ODS; un 
visualizzatore PDF per un file PDF). Potete creare hotspot di varie forme e includere diversi 
hotspot nella stessa immagine.

Per usare l'editor mappa immagine:

1) Nel vostro documento di LibreOffice, selezionate l'immagine dove desiderate definire gli 
hotspot.

2) Scegliete Modifica > ImageMap dalla barra dei menu. Si aprirà l'Editor mappa immagine 
(Figura 317).

3) Usate gli strumenti e i comandi di campo presenti nella finestra di dialogo (descritti di 
seguito) per definire gli hotspot e i collegamenti necessari.

4) Fate clic sull'icona Applica  per applicare le impostazioni.

5) Quando avete finito, fate clic sull'icona Salva  per salvare la mappa immagine in un file, 
quindi fate clic sulla X nell'angolo in alto a destra per chiudere la finestra di dialogo.
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Figura 317: la finestra di dialogo per creare o modificare una mappa immagine

L'area principale della finestra di dialogo mostra l'immagine sulla quale vengono definiti gli hotspot. 
Un hotspot è identificato da una linea indicante la sua forma.

La barra degli strumenti nella parte superiore della finestra di dialogo contiene i seguenti strumenti:

• Pulsante Applica: fateci clic sopra per applicare le modifiche.

• Icone Apri, Salva, e Seleziona.

• Strumenti per disegnare la forma di un hotspot: questi strumenti funzionano nello stesso 
identico modo in cui funzionano i corrispondenti strumenti nella barra degli strumenti 
Disegno.

• Modifica, Sposta, Inserisci, Elimina Punti: strumenti avanzati di editing per manipolare 
un hotspot con forma poligonale. Scegliete lo strumento Modifica punti per attivare gli altri 
strumenti.

• Icona Attivo: cambia lo stato dell'hotspot selezionato tra attivo e inattivo.

• Macro: associa una macro con l'hotspot, invece di un collegamento ipertestuale.

• Proprietà: permette di impostare le proprietà del collegamento ipertestuale e aggiungere 
l'attributo Nome al collegamento.

Sotto la barra degli strumenti, potete specificare per l'hotspot selezionato:

• Indirizzo: l'indirizzo a cui punta il collegamento ipertestuale. Potete anche puntare a un 
ancoraggio in un documento; per fare questo, scrivete l'indirizzo in questo formato: 
file:///<percorso>/nome_documento#nome_ancora

• Testo: digitate il testo da mostrare quando il puntatore del mouse passa sopra l'hotspot.

• Frame: dove desiderate si apra la destinazione del collegamento ipertestuale: scegliete tra 
_blank (apertura in una nuova finestra del browser), _self (apertura nella finestra attiva del 
browser), _top or _parent.
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Suggerimento
Il valore _self per il frame di destinazione è normalmente la scelta migliore. Le 
altre opzioni sono sconsigliate, a meno che il loro utilizzo non sia strettamente 
necessario.

Uso degli strumenti di disegno di LibreOffice

È possibile utilizzare gli strumenti di disegno di LibreOffice per creare oggetti grafici come semplici 
diagrammi, usando rettangoli, cerchi, linee, testo e altre forme predefinite. È anche possibile 
raggruppare più oggetti di disegno per essere sicuri che mantengano la loro posizione e 
proporzioni relative.

Potete posizionare gli oggetti direttamente su una pagina nel vostro documento, oppure inserirli in 
una cornice.

Potete anche usare gli strumenti di disegno per commentare fotografie, immagini catturate da 
schermo o prodotte con altri programmi, anche se ciò non è raccomandato, in quanto:

• Non potendo includere immagini in un gruppo con oggetti di disegno, esse potrebbero 
perdere l'allineamento nel documento.

• Se convertite un documento in un altro formato, come HTML, gli oggetti di disegno e gli 
oggetti grafici non rimarranno associati; essi vengono salvati separatamente.

In generale, se avete necessità di creare disegni complessi, è meglio utilizzare LibreOffice Draw, 
che include molte più funzionalità, come livelli, stili, e così via.

Creare oggetti di disegno
Per iniziare a utilizzare gli strumenti di disegno, visualizzate la barra degli strumenti Disegno 
(Figura 318) facendo clic su Visualizza > Barre degli strumenti > Disegno.

Se utilizzate spesso gli strumenti di disegno, potete staccare la barra e spostarla in una posizione 
più pratica nella finestra.

1 Seleziona 5 Linea a mano libera 9 Forme simboli 13 Stelle

2 Linea 6 Testo 10 Frecce blocchi 14 Punti

3 Rettangolo 7 Legende 11 Diagrammi di flusso 15 Galleria Fontwork

4 Ellisse 8 Forme base 12 Legende (grafiche) 16 Da file

17 Estrusione sì/no
Figura 318: la barra degli strumenti Disegno
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Per utilizzare uno strumento di disegno:

1) Fate clic nel documento dove volete che il disegno rimanga ancorato. Potete modificare 
l'ancoraggio in seguito, se necessario.

2) Scegliete lo strumento dalla barra degli strumenti Disegno (Figura 318). Il puntatore del 

mouse cambia forma, divenendo un puntatore con funzioni di disegno .

3) Portate il puntatore a croce nel punto del documento in cui desiderate che compaia 
l'immagine e poi fate clic e trascinate per creare l'oggetto di disegno. Rilasciate il pulsante 
del mouse. La funzione di disegno selezionata rimane attiva, in modo da poter disegnare 
un altro oggetto dello stesso tipo.

4) Per disattivare la funzione selezionata premete il tasto Esc oppure fate clic sull'icona 
Seleziona (la freccia) sulla barra degli strumenti Disegno.

5) Potete ora modificare le proprietà (colore di riempimento, tipo e spessore della linea, 
ancoraggio e altro) dell'oggetto di disegno usando la barra degli strumenti Proprietà 
oggetto di disegno (Figura 319) oppure le opzioni e le finestre di dialogo raggiungibili 
facendo clic col pulsante destro del mouse sull'oggetto di disegno.

Impostare o modificare le proprietà degli oggetti di disegno
Per impostare le proprietà di un oggetto di disegno prima di crearlo:

1) Sulla barra degli strumenti Disegno (Figura 318), fate clic sullo strumento Seleziona.

2) Sulla barra degli strumenti Proprietà oggetto di disegno (Figura 319), fate clic sull'icona per 
ciascuna proprietà e selezionate il valore desiderato per quella proprietà.

3) Per avere un maggiore controllo, o per definire nuovi attributi, potete fare clic sulle icone 
Area o Linea sulla barra degli strumenti per visualizzare finestre di dialogo dettagliate.

1 Linea 5 Colore della linea 9 In primo piano 13 Allineamento

2 Stile estremità 
linea

6 Area 10 Sullo sfondo 14 Cambia 
l'ancoraggio

3 Stile linea 7 Stile di riempimento 11 Porta in primo piano 15 Separa

4 Spessore linea 8 Ruota 12 Porta in fondo 16 Raggruppa

Figura 319: barra degli strumenti Proprietà oggetto di disegno

I valori predefiniti da voi impostati (prima di creare un oggetto di disegno) si applicano al 
documento e alla sessione corrente. Non vengono mantenuti quando chiudete il documento o 
chiudete Writer, e non si applicano agli altri documenti che aprite. Essi si applicano a tutti gli 
oggetti di disegno, tranne gli oggetti di testo.

Per modificare le proprietà di un oggetto di disegno esistente:

1) Selezionate l'oggetto.

2) Continuate come sopra descritto.
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Potete anche specificare le proprietà dell'oggetto di disegno per posizione e dimensioni, rotazione, 
raggio d'inclinazione e d'angolo:

1) Fate clic col pulsante destro del mouse sull'oggetto di disegno e scegliete Posizione e 
dimensione dal menu a comparsa. Viene quindi mostrata la finestra di dialogo Posizione e 
dimensione.

2) Scegliete le proprietà da modificare, secondo le vostre necessità.

Ridimensionare un oggetto di disegno
Il ridimensionamento di un oggetto è simile a quello di un'immagine. Selezionate l'oggetto, fate clic 
su una delle otto maniglie attorno all'oggetto e trascinatela nella sua nuova posizione. Per 
ridimensionare in scala, selezionate una delle maniglie d'angolo e tenete premuto il tasto Maiusc 
mentre trascinate la maniglia nella sua nuova posizione.

Per un controllo più sofisticato delle dimensioni dell'oggetto, scegliete Formato > Oggetto > 
Posizione e dimensione dalla barra dei menu. Usate la finestra di dialogo Posizione e 
dimensione per impostare indipendentemente larghezza e altezza. Se l'opzione Mantieni 
rapporto è selezionata, le due dimensioni cambiano in modo proporzionale, permettendo un 
ridimensionamento in scala.

Raggruppare oggetti di disegno
Per raggruppare oggetti di disegno:

1) Selezionate un oggetto, quindi tenete premuto il tasto Maiusc e selezionate gli altri oggetti 
che desiderate includere nel gruppo. Il riquadro di selezione si allarga per includere tutti gli 
oggetti selezionati.

2) Mentre gli oggetti sono selezionati, scegliete Formato > Raggruppa > Raggruppa dalla 
barra dei menu, oppure, portando il puntatore del mouse su uno degli oggetti, fate clic con 
il pulsante destro del mouse e scegliete Raggruppa > Raggruppa dal menu a comparsa.

Nota
In un gruppo di oggetti di disegno non è possibile includere un'immagine incorporata 
o collegata.

Uso di Fontwork

Con Fontwork potete creare elementi di testo elaborati graficamente con cui rendere più originale il 
vostro lavoro. Avete a disposizione una vasta scelta di impostazioni per gli oggetti di testo grafici 
(linea, area, posizione, dimensioni, ecc.). Troverete sicuramente qualcosa di adeguato per il vostro 
documento.

Fontwork può essere utilizzato in ogni componente di LibreOffice, ma potrete notare delle piccole 
differenze nel modo in cui viene visualizzato nei vari componenti.

Le barre degli strumenti di Fontwork
Potete utilizzare due barre degli strumenti diverse per creare e modificare un oggetto Fontwork.

• Selezionate Visualizza > Barre degli strumenti > Fontwork.
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Figura 320: la barra degli strumenti 
mobile di Fontwork

• Se fate clic su un oggetto Fontwork esistente, la barra degli strumenti di Formattazione 
cambia per mostrare le opzioni Fontwork, come si nota nella Figura 325. I contenuti di 
questa barra variano a seconda del componente LibreOffice con cui viene utilizzata.

Creazione di un oggetto Fontwork

1) Fate clic sull'icona Galleria fontwork sulla barra degli strumenti Disegno o Fontwork . Se 
non visualizzate la barra degli strumenti Disegno, selezionatela da Visualizza > Barre 
degli strumenti > Disegno.

Figura 321: la Galleria fontwork

2) Nella Galleria fontwork, selezionate uno stile fontwork, quindi fate clic su OK. L'oggetto 
fontwork apparirà nel documento. Fate attenzione ai quadratini colorati attorno al bordo 
(che indicano che l'oggetto è selezionato) e il punto giallo; questi elementi saranno discussi 
in modo più dettagliato nel paragrafo “Spostare e ridimensionare gli oggetti fontwork” a 
pagina 364.

3) Fate doppio clic sull'oggetto per modificare il testo fontwork (vedere Figura 322). Digitate il 
testo desiderato sostituendo la scritta nera fontwork che appare sull'oggetto.

4) Fate clic in un'area vuota qualsiasi oppure premete il tasto Esc per applicare le modifiche.
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Figura 322: modifica del testo 
Fontwork

Modifica di un oggetto Fontwork
Una volta creato l'oggetto fontwork, è possibile modificare alcuni dei suoi attributi. Per farlo, potete 
usare la barra degli strumenti fontwork, la barra degli strumenti Formattazione, o le opzioni di 
menu descritte in questa sezione. Se l'oggetto fontwork selezionato è un oggetto 3-D, potete 
anche usare la barra degli strumenti Impostazioni 3D.

Uso della barra degli strumenti fontwork
Assicuratevi che la barra degli strumenti fontwork, mostrata nella Figura 320, sia visibile. Se non 
riuscite a visualizzare la barra, selezionatela da Visualizza > Barre degli strumenti > fontwork. 
Fate clic sulle diverse icone per modificare gli oggetti fontwork.

Forma fontwork: consente di modificare la forma 
dell'oggetto selezionato. Potete sceglierla tramite una 
tavolozza delle forme.

Figura 323: la tavolozza 
delle forme della barra degli 
strumenti fontwork

Lettere di uguale altezza fontwork: consente di modificare l'altezza dei caratteri 
nell'oggetto. Permette di passare dall'altezza normale (alcuni caratteri sono più alti degli 
altri, per esempio le lettere maiuscole, d, h, l e altre) a lettere della stessa altezza.
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Figura 324: a sinistra: lettere normali; a destra: lettere 
della stessa altezza

Allineamento fontwork: permette di modificare 
l'allineamento dei caratteri. Potete scegliere fra: allinea a 
sinistra, centrale, allinea a destra, giustifica parole e 
giustifica caratteri. L'effetto dell'allineamento del testo si può 
vedere solo se il testo si estende su due o più linee. Nel 
modo "giustifica caratteri" tutte le linee vengono occupate 
completamente.

Spaziatura caratteri fontwork: consente di modificare la 
spaziatura e la crenatura fra i caratteri dell'oggetto. Per 
scegliere la spaziatura, inserite un valore percentuale: 
100% corrisponde alla spaziatura normale; meno di 100% è 
una spaziatura stretta; più di 100% è una spaziatura larga.

Uso della barra degli strumenti Formattazione
A questo punto potete personalizzare l'oggetto fontwork con numerose altre caratteristiche.

Fate clic sull'oggetto fontwork. La barra degli strumenti Formattazione cambia per mostrare le 
opzioni disponibili per modificare l'oggetto (la barra degli strumenti mostrata nella Figura 325 
apparirà quando utilizzate Fontwork in Writer).
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Figura 325: la barra degli strumenti Formattazione in Writer, selezionando un oggetto fontwork

La figura mostra la barra degli strumenti mobile. Per impostazione predefinita, quando è ancorata 
si trova posizionata sotto la barra dei menu, con altre barre. La barra degli strumenti nell'esempio è 
stata personalizzata per mostrare tutte le opzioni disponibili; per impostazione predefinita sono 
visibili solo alcune delle opzioni.

Sulla barra degli strumenti Formattazione avete a disposizione numerose opzioni per 
personalizzare l'oggetto. Queste opzioni sono le stesse utilizzabili per altri oggetti di disegno. Per 
maggiori informazioni consultate la Guida a Draw.

Opzioni Linea
Icona Linea: apre una finestra di dialogo con tre schede: Linea, Stili linee, Estremità linee. Usate 
la scheda Linea per modificare le proprietà più comuni della linea intorno all'oggetto Fontwork 
selezionato, scegliendo fra gli attributi definiti precedentemente, compresi lo stile linea, il colore 
linea e gli stili delle estremità. Usate le schede Stili linee e Estremità linee per modificare le 
proprietà degli stili di linea e delle estremità linee, e per definire nuovi stili.

Icona Stile estremità linea: consente di scegliere tra i diversi stili di estremità linea.

Riquadro Stile linea: permette di scegliere fra i diversi stili di linea disponibili.

Riquadro Spessore linea: consente di impostare lo spessore della linea.

Riquadro Colore della linea: permette di selezionare il colore della linea.
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Opzioni Area
Icona Area: consente di aprire una finestra di dialogo con sette schede: Area, Ombre, 
Trasparenza, Colori, Sfumature, Tratteggio, Bitmap.

• Scheda Area: consente di scegliere dall'elenco predefinito un colore, un tipo di bitmap, una 
sfumatura o un tratteggio per riempire l'oggetto selezionato.

• Scheda Ombre: consente d'impostare le proprietà dell'ombreggiatura dell'oggetto 
selezionato.

• Scheda Trasparenza: consente d'impostare le proprietà della trasparenza dell'oggetto 
selezionato.

• Scheda Colori: permette di modificare i colori disponibili o di aggiungerne di nuovi a quelli 
che appaiono nella scheda Area.

• Scheda Sfumature: consente di modificare le sfumature disponibili o di aggiungerne di 
nuove a quelle che appaiono nella scheda Area.

• Scheda Tratteggio: consente di modificare i modelli di tratteggio disponibili o di 
aggiungerne di nuovi a quelli che appaiono nella scheda Area.

• Scheda Bitmap: consente di creare dei semplici modelli bitmap e di importarne altri per 
renderli disponibili nella scheda Area.

Riquadri Stile area/Riempimento: consentono di scegliere il tipo di riempimento dell'oggetto 
selezionato. Usate l'icona Area per impostazioni più dettagliate.

Opzioni di posizionamento
Icona Ruota: consente di ruotare manualmente l'oggetto selezionato utilizzando il mouse per 
trascinarlo.

Icona In primo piano: permette di spostare l'oggetto selezionato davanti al testo.

Icona Sullo sfondo: permette di spostare l'oggetto selezionato dietro al testo.

Icona Allineamento: consente di modificare l'allineamento degli oggetti selezionati.

Icona Porta in primo piano: consente di spostare l'oggetto selezionato davanti agli altri.

Icona Porta in fondo: consente di spostare l'oggetto selezionato dietro agli altri.

Icona Cambia l'ancoraggio: consente di scegliere tra le diverse opzioni di ancoraggio:

• Alla pagina - L'oggetto mantiene la stessa posizione rispetto ai margini della pagina. 
L'oggetto non si sposterà se aggiungete o cancellate del testo.

• Al paragrafo - L'oggetto è associato al paragrafo e si sposta con esso. Può essere 
posizionato sul margine o altrove.

• Al carattere - L'oggetto è associato al carattere ma non si trova nella sequenza del testo. Si 
sposta assieme al paragrafo ma può essere posizionato sul margine o altrove. Questo 
metodo è simile all'ancoraggio al paragrafo.

• Come carattere - L'oggetto è posizionato nel documento come qualsiasi carattere e si 
sposta col paragrafo ogni volta che viene aggiunto o cancellato del testo prima dell'oggetto.

Icona Separa: consente di separare gli oggetti selezionati, così da poterli gestire singolarmente.

Icona Raggruppa: consente di raggruppare gli oggetti selezionati, per poterli gestire come un 
oggetto singolo.
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Uso delle opzioni del menu
Potete utilizzare alcune opzioni del menu Formato per ancorare, allineare, disporre e raggruppare 
gli oggetti fontwork selezionati, disporre il testo attorno ad essi, e rispecchiarli in orizzontale e in 
verticale.

Facendo clic col pulsante destro del mouse su un oggetto fontwork potete scegliere molte delle 
stesse opzioni dal menu a comparsa. Inoltre, il menu a comparsa offre un accesso rapido alle 
finestre di dialogo Linea, Area, Testo e Posizione e dimensione. La finestra di dialogo Testo offre 
solo poche opzioni per gli oggetti fontwork e non viene descritta in questa guida. Nella finestra di 
dialogo Posizione e dimensione potete inserire dei valori precisi relativi alle dimensioni e alla 
posizione. Per maggiori informazioni su tutte queste opzioni dei menu consultate la Guida a Draw.

Utilizzo della barra degli strumenti Impostazioni 3D
Se l'oggetto fontwork selezionato è un oggetto 3-D, potete anche usare le opzioni sulla barra degli 
strumenti Impostazioni 3D. Potete anche modificare un oggetto fontwork 2-D in un oggetto 3-D (o 
modificare un oggetto 3-D in un oggetto 2-D) facendo clic sull'icona Estrusione sì/no sulla barra 
degli strumenti Impostazioni 3D. Per maggiori informazioni consultate la Guida a Draw.

Figura 326: barra degli strumenti Impostazioni 3D

Spostare e ridimensionare gli oggetti fontwork
Quando selezionate un oggetto fontwork, otto quadratini colorati (detti maniglie) appaiono attorno 
ai bordi dell'oggetto, come si nota sotto. Potete ridimensionare l'oggetto trascinando queste 
maniglie.

Sull'oggetto appare anche un punto giallo. Questo punto 
può trovarsi sul bordo dell'oggetto o altrove; vedere la figura 
a destra per un esempio. Se portate il cursore del mouse sul 
punto giallo, esso si trasformerà in una mano. Potete 
trascinare il punto in diverse direzioni per modificare la 
forma dell'oggetto.

Posizionando il cursore su altre parti dell'oggetto, esso 
riprende la forma abituale. In questo caso è possibile 
trascinare l'oggetto in un'altra posizione nella pagina.

Usate la finestra di dialogo Posizione e dimensione per definire in modo preciso la posizione e le 
dimensioni dell'oggetto.
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Capitolo 12  
Creare pagine web
Salvare documenti come file HTML



Introduzione

Questo capitolo descrive come effettuare le seguenti operazioni in Writer, Calc, Draw e Impress:

• Creare collegamenti ipertestuali all'interno di un documento e verso altri documenti come 
pagine web, file PDF e altri file.

• Salvare documenti come pagine web (documenti HTML).

Quando create un documento che volete salvare come una pagina web, dovete considerare che:

• In un documento HTML, i collegamenti ipertestuali sono attivi (potete farci clic sopra), a 
differenza di altri riferimenti incrociati inseriti da LibreOffice.

• Un oggetto come un'immagine viene salvato come un file separato. Tuttavia, se l'oggetto è 
posizionato in una cornice (ad esempio, con una didascalia associata), esso non viene 
salvato e non compare nel documento HTML; comparirà invece il nome della cornice.

Collegamenti ipertestuali relativi e assoluti

I collegamenti ipertestuali memorizzati in un file possono essere relativi o assoluti.

Un collegamento ipertestuale relativo indica la posizione di un file a partire dalla posizione corrente 
nell'albero del file system (cioè dalla cartella in cui è salvato il documento corrente), mentre un 
collegamento ipertestuale assoluto indica la posizione di un file a partire dalla radice del file 
system.

Un collegamento assoluto non funzionerà più se la destinazione viene spostata. Un collegamento 
relativo non funzionerà più se le posizioni di partenza e di destinazione cambiano l'una rispetto 
all'altra. Ad esempio, se avete due fogli elettronici nella stessa cartella, collegati l'uno con l'altro, e 
spostate la cartella in una nuova posizione, un collegamento assoluto non funzionerà più, mentre 
un collegamento relativo continuerà a funzionare.

Per cambiare il modo in cui LibreOffice memorizza i collegamenti ipertestuali nei file, selezionate 
Strumenti > Opzioni > Carica/Salva > Generale e scegliete se salvare gli URL in modo relativo, 
quando sono riferiti al File System o a Internet o a entrambi.

Calc mostra sempre collegamenti ipertestuali assoluti. Non preoccupatevi se, pur avendo salvato 
un collegamento relativo, vedete un collegamento assoluto: l'indirizzo 'assoluto' della destinazione 
verrà aggiornato se spostate il file.

Nota
Se salvate i collegamenti come relativi al file system e avete intenzione di eseguire il 
caricamento delle pagine su Internet, assicuratevi che la struttura delle cartelle sul 
vostro computer sia la stessa presente sul vostro server web.

Suggerimento

Quando lasciate il puntatore del mouse su un collegamento ipertestuale, un 
suggerimento mostra il riferimento assoluto, siccome LibreOffice internamente 
utilizza nomi di percorso assoluti. Il percorso completo e l'indirizzo sono visibili 
solo quando si osserva il risultato dell'esportazione in HTML (salvando il foglio 
elettronico come file HTML), caricando il file HTML come testo, oppure 
aprendolo con un editor di testo.
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Creazione di collegamenti ipertestuali

Quando inserite del testo (come un indirizzo di un sito web o URL) che può essere usato come 
collegamento ipertestuale, e poi premete la barra spaziatrice oppure il tasto Invio, LibreOffice crea 
automaticamente il collegamento ipertestuale e applica la formattazione al testo (normalmente 
colorazione e sottolineatura). Se ciò non accade, potete abilitare tale funzionalità dal menu 
Strumenti > Opzioni di correzione automatica > Opzioni, selezionando l'opzione Riconosci 
URL.

Se non desiderate che LibreOffice converta uno specifico URL in un collegamento ipertestuale, 
dopo la pressione della barra spaziatrice scegliete Modifica > Annulla inserimento dalla barra 
dei menu oppure premete Ctrl+Z, non appena la formattazione è stata applicata. Potete anche 
posizionare il cursore su una qualsiasi parte del collegamento ipertestuale, fare clic con il pulsante 
destro del mouse e scegliere Elimina collegamento.

Suggerimento

Per modificare il colore dei collegamenti ipertestuali, andate su Strumenti > 
Opzioni > LibreOffice > Aspetto, scorrete sino a Collegamenti non visitati e/o 
Collegamenti visitati, scegliete il nuovo colore e fate clic su OK. Attenzione: 
l'operazione indicata modificherà il colore di tutti i collegamenti ipertestuali in tutti 
i componenti di LibreOffice; questo potrebbe non essere ciò che volete.

In Writer e Calc (ma non in Draw o Impress), potete anche cambiare lo stile del 
carattere del Collegamento Internet o definire e applicare nuovi stili ai 
collegamenti selezionati.

Potete anche inserire collegamenti ipertestuali usando il Navigatore e la finestra di dialogo 
Collegamento ipertestuale, e modificare tutti i collegamenti ipertestuali usando la medesima 
finestra di dialogo, come descritto in questa sezione.

Usare il Navigatore
Il metodo più facile per inserire un collegamento ipertestuale a un'altra parte dello stesso 
documento è quello di utilizzare il Navigatore:

1) Aprite i documenti contenenti gli elementi per i quali desiderate creare un riferimento 
incrociato.

2) Aprite il Navigatore facendo clic sulla sua icona , scegliendo Visualizza > Navigatore, 
o premendo F5.

3) Fate clic sulla freccia vicino all'icona Modo trascinamento, e scegliete Inserisci come 
collegamento ipertestuale. (Vedere figura 327.)

4) Nell'elenco nella parte bassa del Navigatore, selezionate il documento contenente 
l'elemento per il quale desiderate creare un riferimento incrociato.

5) Nell'elenco del Navigatore, selezionate l'elemento che volete inserire come collegamento 
ipertestuale.

6) Trascinate l'elemento nel punto in cui desiderate inserire il collegamento ipertestuale nel 
documento. Il nome dell'elemento viene inserito nel documento come un collegamento 
ipertestuale attivo.

Capitolo 12  Creare pagine web 367



Figura 327: inserimento di un collegamento ipertestuale 
usando il Navigatore

Quando si utilizza il Navigatore per collegare un oggetto come un'immagine, per fare in modo che 
il collegamento mostri un testo significativo, come Grafico vendite 2009, dovrete dare a tale 
oggetto un nome significativo, invece di un nome standard (“Grafico6”), oppure dovrete modificare 
il risultante testo del collegamento tramite la finestra di dialogo Collegamento ipertestuale, come 
descritto di seguito.

Potete anche usare il Navigatore per inserire un collegamento ipertestuale da un documento 
(sorgente) a una specifica posizione in un altro documento (destinazione). Aprite il Navigatore nel 
documento di destinazione e trascinate l'elemento nel punto all'interno del documento sorgente in 
cui desiderate che compaia il collegamento ipertestuale.

Uso della finestra di dialogo Collegamento ipertestuale

Per visualizzare la finestra di dialogo, fate clic sull'icona Collegamento ipertestuale  sulla barra 
degli strumenti Standard o scegliete Inserisci > Collegamento ipertestuale dalla barra dei menu. 
Per convertire del testo esistente in un collegamento, selezionatelo prima di aprire la finestra di 
dialogo.
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Figura 328: la finestra di dialogo Collegamento ipertestuale con i dettagli per i collegamenti di 
tipo Internet

Sul lato sinistro potete selezionare una delle quattro categorie di collegamento ipertestuale:

• Internet: il collegamento ipertestuale rimanda a un indirizzo web, che inizia normalmente 
con http://

• Mail e News: il collegamento ipertestuale apre un messaggio di posta elettronica già 
indirizzato a uno specifico destinatario

• Documento: il collegamento ipertestuale rimanda a un altro documento o a un altro punto 
nel documento corrente

• Nuovo documento: il collegamento ipertestuale crea un nuovo documento

La parte superiore destra della finestra di dialogo varia in relazione al tipo di collegamento 
ipertestuale selezionato nel pannello di sinistra. Una descrizione completa di tutte le scelte possibili 
e delle loro interazioni esula dallo scopo di questo capitolo. Di seguito un riepilogo delle scelte più 
comuni.

Per un collegamento ipertestuale della categoria Internet, scegliete il tipo di collegamento (Web, 
FTP o Telnet), e poi inserite l'indirizzo web richiesto (URL).

Per un collegamento ipertestuale della categoria Mail e News, specificate se si tratta di un 
collegamento di tipo e-mail oppure news, l'indirizzo del destinatario e, nel primo caso, anche 
l'oggetto.

Per un collegamento ipertestuale della categoria Documento, specificate il percorso del 
documento, (il pulsante Apri file apre una finestra di esplorazione file); non inserite nulla se 
desiderate un collegamento a una destinazione nello stesso documento. Come opzione è possibile 
specificare la destinazione nel documento (ad esempio, una particolare diapositiva). Fate clic 
sull'icona Destinazione nel documento per aprire il Navigatore che consente di selezionare la 
destinazione; oppure, se ne conoscete il nome, potete digitarlo direttamente nel riquadro.

Per un collegamento ipertestuale della categoria Nuovo documento, specificate se volete 
modificare immediatamente il documento appena creato (Modifica subito) o solo crearlo 
(Modifica dopo), inserite il nome del file, e selezionate il tipo di documento da creare (documento 
di testo, foglio elettronico, e così via). Fate clic sul pulsante Seleziona percorso per aprire una 
finestra di esplorazione file e scegliere dove salvare il file.
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La sezione Ulteriori impostazioni nella parte destra in basso della finestra di dialogo è comune per 
tutte le categorie di collegamento ipertestuale, nonostante alcune scelte siano più adatte per alcuni 
tipi di collegamenti.

• Potete impostare il valore di Frame per definire come si aprirà il collegamento ipertestuale. 
Queste impostazioni si applicano a documenti che saranno aperti con un browser web.

• Formulario permette di definire se il collegamento deve essere visualizzato come testo o 
come un pulsante. La Figura 329 mostra un collegamento formattato come pulsante. Un 
pulsante collegamento ipertestuale è un tipo di controllo formulario. Vedere il Capitolo 15 
della Guida a Writer per ulteriori informazioni.

Figura 329: collegamento ipertestuale Autori come 
pulsante (in Calc)

• Testo permette di definire il testo che sarà visibile all'utente. Se non inserite nulla in questo 
campo, LibreOffice utilizzerà l'URL o il percorso completo come testo del collegamento. Da 
notare che se il collegamento è relativo e voi spostate il file, questo testo non cambierà, 
sebbene cambi la destinazione.

• Nome è utilizzabile per i documenti HTML. Definisce il testo che sarà aggiunto come 
attributo Name nel codice HTML del collegamento ipertestuale.

• Pulsante Eventi : fate clic su questo pulsante per aprire la finestra di dialogo Assegna 
Macro e scegliere una macro da eseguire quando si fa clic sul collegamento. Si veda il 
Capitolo 13 (Introduzione alle Macro) per ulteriori informazioni.

Modificare collegamenti ipertestuali
Per modificare un collegamento esistente, fate clic in un qualsiasi punto del testo del collegamento 

e poi fate clic sull'icona Collegamento ipertestuale  sulla barra degli strumenti Standard 
oppure scegliete Modifica > Collegamento dalla barra dei menu oppure fate clic con il pulsante 
destro del mouse e scegliete Modifica Collegamento dal menu contestuale. Si aprirà la finestra di 
dialogo Collegamento ipertestuale. Fate le vostre modifiche, quindi fate clic su Applica. Per 
modificare diversi collegamenti ipertestuali, potete lasciare aperta la finestra di dialogo 
Collegamento ipertestuale sino a che non li avete modificati tutti. Accertatevi di fare clic su Applica 
dopo ciascuna modifica. Una volta che avete terminato, fate clic su Chiudi.

Il metodo standard (predefinito) per attivare collegamenti ipertestuali in LibreOffice è di utilizzare 
Ctrl+clic. Per modificare questo comportamento andate in Strumenti > Opzioni> LibreOffice > 
Sicurezza> Opzioni, e deselezionate l'opzione È necessario Ctrl+clic per l'apertura dei 
collegamenti. Se facendo clic su un collegamento esso si attiva, controllate quella pagina per 
verificare se l'opzione è stata deselezionata.
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Eliminare collegamenti ipertestuali
Potete rimuovere un collegamento dal testo dello stesso collegamento - lasciando quindi 
solamente il testo - facendo clic col pulsante destro del mouse sul collegamento e selezionando 
Elimina collegamento. Potrebbe poi essere necessario riapplicare la formattazione per rendere 
omogeneo il testo con il resto del documento.

Per eliminare completamente il testo o il pulsante del collegamento dal documento, selezionatelo e 
premete il tasto Backspace o il tasto Canc.

Salvare documenti di Writer come pagine web

Le funzionalità HTML di Writer includono il salvataggio di documenti esistenti nel formato HTML, la 
creazione di nuovi documenti HTML (qua non descritta), e la creazione di diversi tipi di pagine web 
mediante l'utilizzo di una procedura guidata.

Il metodo più semplice per creare documenti in formato HTML è utilizzare un documento di Writer 
esistente. Potete farvi un'idea di come apparirà come pagina web usando Visualizza > Layout 
Web. Tuttavia, la vista layout web non vi mostrerà quali caratteristiche verranno correttamente 
salvate in HTML. Alcune considerazioni al riguardo sono descritte nell'introduzione a questo 
capitolo.

Salvare un documento come una singola pagina web
Per salvare un documento come una singola pagina web (in formato HTML), scegliete File > 
Salva con nome e specificate come tipo di file Documento HTML.

Nota

Writer non sostituisce gli spazi multipli nel documento originale con il codice HTML 
per lo spazio non divisibile. Se volete avere degli spazi extra nel file HTML o nella 
pagina Web, è necessario inserire dello spazio non divisibile in LibreOffice. Per farlo, 
premete Ctrl+barra spaziatrice invece della sola barra spaziatrice.

Salvare un documento come una serie di pagine web.
Writer può salvare un documento di grandi dimensioni come una serie di pagine web (differenti file 
HTML), collegate da una pagina indice. Per eseguire questa operazione:

1) Decidete quali intestazioni nel documento debbano iniziare su una nuova pagina e 
assicuratevi che tutte le intestazioni abbiano lo stesso stile (per esempio, Intestazione 1).

2) Scegliete File > Invia > Crea documento HTML.

3) Nella finestra di dialogo Nome e percorso del documento HTML, digitate il nome del file 
sotto cui salvare le pagine. Indicate anche quale stile indica una nuova pagina (come 
deciso al punto 1).
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Figura 330: creare una serie di pagine web da un unico documento

4) Fate clic su Salva per creare un documento HTML a più pagine. I file HTML ottenuti sono 
conformi alle specifiche HTML 4 Transitional.

Creare pagine web utilizzando una procedura guidata.

La procedura guidata per la creazione di pagine web di LibreOffice permette di creare diversi tipi di 
pagine web standard. Per utilizzarla:

1) Scegliete File > Procedure guidate > Pagina Web. Nella prima pagina della procedura 
guidata, selezionate le impostazioni desiderate e fate clic su Avanti >. Se questa è la 
vostra prima pagina web, l'unica opzione disponibile è <predefinito>.
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2) Scegliete o scorrete sino al documento a cui volete applicare la formattazione. Le 
informazioni relative al Titolo, al Sommario e all'Autore sono ricavate dalle proprietà del 
documento; se necessario potete modificarle. Fate clic su Avanti >.

Capitolo 12  Creare pagine web 373



3) Scegliete un layout per il sito web facendo clic sui riquadri di layout. Fate clic su Avanti >.

4) Scegliete le informazioni da elencare e la risoluzione dello schermo. Fate clic su Avanti >.
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5) Selezionate uno stile per la pagina. Utilizzate l'elenco a discesa per scegliere tra i differenti 
stili e le combinazioni di colori. È possibile selezionare un'immagine di sfondo e un insieme 
di icone dalla Galleria. Fate clic su Avanti >.

6) Inserite le informazioni generali, come il Titolo e i metadati HTML. Fate clic su Avanti >.

7) Scegliete dove salvare il file; se volete, potete visualizzare l'anteprima della pagina. Fate 
clic su Fine.
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Per modificare o visualizzare il codice HTML del documento, apritelo e scegliete poi Visualizza > 

Testo sorgente HTML oppure fate clic sull'icona Testo sorgente HTML  sulla barra degli 

strumenti principale.

Salvare Fogli elettronici di Calc come pagine web.

Calc può salvare file come documenti HTML. Come per Writer, scegliete File > Salva con nome e 
selezionate Documento HTML, oppure scegliete File > Procedure guidate > Pagina Web.

Se il file contiene più di un foglio, i fogli aggiuntivi saranno disposti uno dopo l'altro nel file HTML. I 
collegamenti a ciascun foglio saranno posti all'inizio del documento. Calc permette inoltre 
l'inserimento di collegamenti direttamente nel foglio elettronico usando la finestra di dialogo 
Collegamento ipertestuale.

Salvare presentazioni di Impress come pagine web

Potete esportare le presentazioni come file di tipo Macromedia Flash: scegliete File > Esporta e 
selezionate Macromedia Flash come tipo di file.

È inoltre possibile convertire le presentazioni in una serie di pagine web, come descritto di seguito.

Nota
Salvando come pagine web (formato HTML) non vengono mantenute le animazioni e 
gli effetti di transizione delle diapositive.

1) Per iniziare, scegliete File > Esporta e selezionate Documento HTML come tipo di file.

2) Create una cartella per i file, assegnate un nome al risultante file HTML, e fate clic su 
Salva. Si aprirà la procedura guidata di esportazione HTML.
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Nota

In base alle dimensioni della vostra presentazione e del numero di immagini che 
contiene, la funzione di esportazione in formato HTML potrebbe creare diversi file in 
formato HTML, JPG e GIF. Se salvate direttamente sul vostro desktop anziché in 
una cartella specifica, tutti i file HTML e quelli in formato grafico saranno posizionati 
sul vostro desktop. È opportuno quindi creare una cartella all'interno della quale 
salvare tutti i file.

3) Scegliete il design per tutte le pagine, uno esistente oppure uno nuovo. L'opzione Design 
esistente non è disponibile se non è stato salvato un design in precedenza.

4) Fate clic su Avanti per selezionare il tipo di pagine web da creare.

• Formato Standard HTML: una pagina per ogni diapositiva, con collegamenti ipertestuali 
per la navigazione da una diapositiva all'altra.

• HTML standard con frame: una pagina con una barra per la navigazione sul lato 
sinistro; utilizza il titolo della diapositiva come collegamento ipertestuale per la 
navigazione. Fate clic sui collegamenti ipertestuali per visualizzare le pagine sul lato 
destro.

• Automatico: ciascuna pagina contiene una diapositiva, ed è impostata con il meta tag 
Refresh, che fa sì che il browser faccia scorrere automaticamente una pagina dopo 
l'altra.

• WebCast: genera un'applicazione ASP o Perl per visualizzare le diapositive. 
Sfortunatamente LibreOffice non dispone ancora del supporto diretto per PHP.
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5) Decidete come salvare le immagini (in formato PNG, GIF o JPG) e quale risoluzione usare.

Quando scegliete una risoluzione, tenete conto della risoluzione maggiormente utilizzata da 
coloro che vedranno le diapositive. Se specificate una risoluzione alta, chi utilizzerà un 
monitor con una risoluzione media dovrà far scorrere la diapositiva lateralmente per poterla 
visualizzare completamente; probabilmente questa non è la scelta migliore.

6) Se avete scelto Crea pagina sommario al punto 4, dovrete fornire le informazioni 
necessarie nella pagina seguente. Il sommario contiene il nome dell'autore, l'indirizzo e-
mail e la home page, con l'aggiunta di tutte le informazioni che vorrete includere.
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Questa pagina della procedura guidata non viene visualizzata se non è stato scelto Crea 
pagina sommario.

7) Scegliete lo stile dei pulsanti di navigazione, da usare per spostarvi da una pagina all'altra. 
Se non ne scegliete nessuno, LibreOffice creerà un navigatore di testo.

8) Selezionate lo schema dei colori per le pagine web. Gli schemi disponibili includono lo 
schema del documento, quello basato sui colori del browser e uno interamente definito 
dall'utente. È possibile salvare un nuovo schema in modo da farlo apparire nella prima 
pagina della procedura guidata di esportazione HTML.
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9) Fate clic su Crea per generare i file HTML. Se si tratta di un nuovo design, si aprirà una 
piccola finestra di dialogo. Nel caso vogliate riutilizzare questo design, potete assegnargli 
un nome e salvarlo. In caso contrario fate clic su Non salvare.

Salvare documenti di Draw come pagine web

La procedura per esportare disegni dall'applicazione Draw di LibreOffice è simile a quella per 
l'esportazione di una presentazione da Impress. Scegliete File > Esporta e selezionate 
Documento HTML come tipo di file.

Quando si usa la procedura guidata, è possibile scegliere di creare la pagina web in ogni momento 
facendo clic sul pulsante Crea.
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Capitolo 13  
Primi passi con le macro
Utilizzo del Registratore di Macro … e oltre



Le prime macro

Una macro è una sequenza di comandi o tasti memorizzata per un utilizzo successivo. Ad 
esempio, una semplice macro è quella che “digita” il vostro indirizzo. Il linguaggio macro di 
LibreOffice è molto flessibile, permettendo l'automazione di attività sia semplici, sia complesse. Le 
macro sono particolarmente utili per eseguire un'azione sempre nello stesso modo.

Le macro di LibreOffice sono scritte solitamente in un linguaggio chiamato LibreOffice Basic, o più 
brevemente Basic. Sebbene si possa imparare direttamente il Basic per scrivere delle macro, la 
curva di apprendimento per crearle da zero è abbastanza ripida. I metodi più semplici per un 
principiante sono quelli di aggiungere macro scritte da altri e di utilizzare il registratore di macro, 
che registra i tasti premuti e li memorizza per poterli utilizzare in seguito.

In LibreOffice la registrazione di macro è una funzionalità al momento valutata come “sperimentale 
(instabile)”. Per abilitare la registrazione di macro, usate Strumenti > Opzioni > LibreOffice > 
Generale e selezionate l'opzione Abilita le funzionalità sperimentali.

Figura 331: abilitazione delle macro nella finestra di dialogo Opzioni

La maggior parte dei compiti in LibreOffice è portata a termine tramite la "invocazione di un 
comando" (invio di un comando), che viene intercettato e utilizzato. Il registratore di macro 
funziona registrando i comandi che vengono invocati; fate riferimento a “Il framework dei comandi” 
a pagina 392).

Aggiungere una macro esistente
Il primo passo nell'apprendimento della programmazione di macro è quello di trovare e usare delle 
macro già esistenti. In questa sezione si presume che siate in possesso di una macro da utilizzare; 
la macro potrebbe trovarsi in un messaggio di posta, in una pagina web, o perfino in un libro. Per 
questo esempio, usate la macro presente nel Listato 1.

Listato 1: semplice macro che stampa a video la parola Ciao.

Sub MacroCiao
  Print "Ciao"
End Sub
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È necessario creare una libreria e un modulo che conterranno la vostra macro; al riguardo vedere 
“Organizzazione delle macro” a pagina 393. Usate questi passaggi per creare una libreria che 
contenga le vostre macro:

1) Andate su Strumenti > Macro > Organizza Macro > LibreOffice Basic per aprire la 
finestra di dialogo Macro (vedere Figura 332 e Figura 337).

2) Fate clic su Gestisci... per aprire la finestra di dialogo Gestione macro Basic (vedere Figura
338).

3) Selezionate la scheda Librerie.

4) Impostate la Posizione a Macro e finestre di dialogo personali, che è l'opzione predefinita.

5) Fate clic su Nuovo per aprire la finestra di dialogo Nuova libreria. Inserite un nome per la 
libreria, ad esempio “LibreriaTest” e fate clic su OK.

6) Selezionate la scheda Moduli.

7) Nell'elenco Modulo, espandete Macro personali e selezionate LibreriaTest. Esiste già un 
modulo con nome Module1, che può contenere la vostra macro. Potete eventualmente fare 
clic su Nuovo per creare un altro modulo nella  LibreriaTest.

8) Selezionate Module1, o il nuovo modulo da voi creato, e fate clic su Modifica per aprire l' 
Ambiente di sviluppo integrato (IDE, Integrated Development Environment).

9) L'IDE è un editor di testo per macro che permette di creare e modificare le macro. Copiate 
la macro nell'IDE.

Quando viene creato un nuovo modulo, esso contiene un commento e una macro vuota chiamata 
Main, che non fa nulla.

Listato 2: contenuto del Module1 dopo la sua creazione.

REM  *****  BASIC  *****

Sub Main

End Sub

Aggiungete la nuova macro o prima di Sub Main o dopo End Sub. Nel Listato 3, la nuova macro è 
stata aggiunta prima di Sub Main.

Listato 3: il Module1 dopo l'aggiunta della nuova macro.

REM  *****  BASIC  *****

Sub MacroCiao
  Print "Ciao"
End Sub

Sub Main

End Sub

Fate clic sul pulsante Esegui programma Basic  sulla barra degli strumenti, oppure premete F5, 
per eseguire la prima macro nel modulo. Usate la finestra di dialogo Macro, aperta usando il 

pulsante Scegli macro  oppure Strumenti > Macro > Organizza Macro > LibreOffice Basic, 
per selezionare ed eseguire qualsiasi macro nel modulo.
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Creazione di una semplice macro
Supponete di dover inserire ripetutamente sempre le stesse informazioni. Sebbene sia possibile 
memorizzare le informazioni negli appunti, se questi nel frattempo vengono utilizzati per 
qualcos'altro, il loro contenuto cambia. Una semplice soluzione consiste nel memorizzare le 
informazioni in una macro (in alcuni semplici casi, come l'esempio utilizzato in questa sede, una 
soluzione migliore consiste nell'utilizzo del Testo automatico).

1) Fate clic su Strumenti > Macro > Registra Macro per cominciare la 
registrazione di una macro.

Comparirà una piccola finestra, per far sapere che LibreOffice sta 
registrando.

2) Digitate le informazioni desiderate o eseguite la serie di operazioni appropriate. In questo 
caso, è stato digitato il nome Andrew Pitonyak.

3) Fate clic sul pulsante Termina registrazione per interrompere la registrazione, salvare la 
macro, e visualizzare la finestra di dialogo Macro LibreOffice Basic.

Figura 332: finestra di dialogo Macro LibreOffice Basic, con il modulo Writer 
selezionato

Suggerimento
I pulsanti nella finestra di dialogo Macro LibreOffice Basic cambiano a seconda 
di cosa è selezionato e dell'operazione che si sta effettuando (vedere Figura 
332 e Figura 337).

4) Assicuratevi di selezionare la cartella di libreria denominata Macro personali. Cercate la 
libreria denominata Standard all'interno di Macro personali. Notate che tutte le cartelle di 
libreria hanno una libreria denominata Standard. Selezionate la libreria Standard e fate clic 
su Nuovo modulo per creare un nuovo modulo che conterrà la macro.

5) Il nome predefinito del modulo è Module1. Digitate un nome descrittivo (ad esempio 
Registrato), e fate clic su OK per creare il modulo. Verrà visualizzata nuovamente la 
finestra di dialogo Macro LibreOffice Basic, mostrando il nuovo modulo.
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Figura 333: assegnazione di un nome descrittivo al modulo

6) Selezionate il modulo appena creato. Nella casella di testo in alto a sinistra, digitate il nome 
della macro, come "InserisciMioNome", poi fate clic su Registra per salvare la macro.

Se avete seguito tutti i passaggi correttamente, la libreria Standard adesso conterrà un modulo 
chiamato Registrato (o altro nome, se ne avete digitato un altro), che contiene la macro 
InserisciMioNome, come mostrato in Figura 334.

Nota
Quando LibreOffice crea un nuovo modulo, aggiunge automaticamente la macro 
chiamata Main.

Esecuzione di una macro
Usate Strumenti > Macro > Esegui Macro per aprire la finestra di dialogo Selettore Macro. 
Selezionate la macro appena creata e fate clic su Esegui.

Figura 334: selezione ed esecuzione di una macro

Ci sono altri metodi per eseguire una macro. Per esempio, potete usare Strumenti > Macro > 
Organizza Macro > LibreOffice Basic per aprire la finestra di dialogo Macro LibreOffice Basic, 
che contiene il pulsante Esegui, come nel caso precedente.

Visualizzazione e modifica delle macro
Potete visualizzare e modificare la macro appena creata. Usate Strumenti > Macro > Organizza 
Macro > LibreOffice Basic per aprire la finestra di dialogo Macro LibreOffice Basic (vedere Figura
332). Selezionate la nuova macro e fate clic su Modifica per aprire la macro nel Basic IDE 
(Integrated Development Environment).
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Listato 4: la macro “InserisciMioNome” generata.

REM  *****  BASIC  *****
Sub Main

End Sub

sub InserisciMioNome
rem -------------------------------------------------------------
rem definizione variabili
dim document   as object
dim dispatcher as object
rem -------------------------------------------------------------
rem accesso al documento
document   = ThisComponent.CurrentController.Frame
dispatcher = createUnoService("com.sun.star.frame.DispatchHelper")

rem -------------------------------------------------------------
dim args1(0) as new com.sun.star.beans.PropertyValue
args1(0).Name = "Text"
args1(0).Value = "Andrew Pitonyak"

dispatcher.executeDispatch(document, ".uno:InsertText", "", 0, args1())
end sub

La macro del Listato 4 è più semplice di come appare a prima vista. Per capire meglio la macro 
generata sono necessarie solo alcune nozioni. La spiegazione comincia con la descrizione degli 
elementi della macro che sono presenti all'inizio del listato. Se preferite saltare questi dettagli, 
allora basta cambiare il testo “Andrew Pitonyak” nella macro con quello che volete inserire nella 
posizione corrente del cursore all'interno del documento.

I commenti cominciano con REM
La parola chiave REM, abbreviazione di remark, si trova all'inizio di una riga di commento. Tutto il 
testo che segue REM (nella stessa riga) viene ignorato. Si può utilizzare, come scorciatoia, anche 
il carattere di apice singolo ' per scrivere un commento.

Suggerimento

LibreOffice Basic non è sensibile alle maiuscole per le parole chiave, quindi 
REM, Rem e rem danno tutte inizio a un commento. Se utilizzate le costanti 
simboliche definite dalle API, è buona norma supporre che i nomi siano sensibili 
alle maiuscole - le costanti simboliche sono un argomento avanzato che di 
solito può essere ignorato dagli utenti che utilizzano il registratore di macro.

Definizione delle subroutine con SUB
Le singole macro sono memorizzate in subroutine tramite la parola chiave SUB. La fine di una 
subroutine è indicata dalle parole chiave END SUB. Il codice comincia dalla definizione di una 
subroutine denominata Main, che è vuota e non fa niente. La subroutine seguente, 
InserisciMioNome, contiene il codice generato.

Suggerimento
LibreOffice crea sempre una subroutine vuota, denominata Main, quando si 
crea un modulo.
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Questi sono argomenti avanzati che vanno al di là degli scopi di questo documento, ma la loro 
conoscenza potrebbe essere utile:

• Potete scrivere una macro in maniera tale da poter passare dei valori alla subroutine. 
Questi valori sono chiamati argomenti. Le macro registrate non accettano argomenti.

• Un altro tipo di subroutine è la funzione. Una funzione è una subroutine che restituisce un 
valore. Per definire una funzione si utilizza la parola chiave FUNCTION al posto di SUB. Le 
macro generate cominciano sempre con la parola chiave SUB.

Definizione delle variabili mediante l'utilizzo di DIM
Potete scrivere delle informazioni su un foglio, per poterle riutilizzare in seguito. Una variabile, 
come un foglio, contiene informazioni che possono essere lette e modificate. Utilizzare il costrutto 
DIM è come preparare un foglio che verrà utilizzato per memorizzare dei messaggi o degli appunti.

La macro InserisciMioNome definisce le variabili document e dispatcher di tipo object. Altri tipi di 
variabili comunemente utilizzati sono string, integer, e date. Una terza variabile, denominata args1, 
è un vettore di valori. Una variabile di tipo array permette a una singola variabile di contenere più 
valori, in maniera simile ad avere molte pagine per un solo libro. I valori in un vettore (array) sono 
solitamente numerati a partire da zero. Il numero racchiuso dalle parentesi indica il numero più 
elevato utilizzabile per accedere a una locazione di memoria. In questo esempio, c'è solo un 
valore, e il suo indice è zero.

Assemblare la macro
L'argomento seguente è molto dettagliato; non è necessario comprenderlo a fondo. La prima riga 
definisce l'inizio della macro.

sub InserisciMioNome

Qui vengono dichiarate due variabili:

dim document   as object

dim dispatcher as object

ThisComponent fa riferimento al documento corrente.

La proprietà CurrentController di un documento si riferisce al servizio che “controlla” il documento 
stesso. Per esempio, quando scrivete qualcosa, è questo il controller che viene attivato. Il 
controller corrente poi invia i cambiamenti alla finestra del documento.

La proprietà Frame di un controller restituisce il contenitore principale del documento. Pertanto, la 
variabile denominata document fa riferimento al contenitore del documento stesso, che riceve i 
comandi da eseguire.

document = ThisComponent.CurrentController.Frame

La maggior parte dei compiti in LibreOffice è eseguita tramite l'invocazione di un comando. 
LibreOffice include il servizio dispatch helper, il quale esegue la maggior parte del lavoro 
necessario per utilizzare gli invii nelle macro. Il metodo CreateUnoService accetta come 
argomento il nome di un servizio, e cerca di creare un'istanza di tale servizio. Per finire, la variabile 
dispatcher contiene un riferimento a DispatchHelper.

dispatcher = createUnoService("com.sun.star.frame.DispatchHelper")

Viene dichiarato un vettore di proprietà. Ogni proprietà ha un nome e un valore. In altre parole, è 
una coppia nome/valore. Il vettore creato ha una proprietà nella posizione zero.

dim args1(0) as new com.sun.star.beans.PropertyValue
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Dà alla proprietà il nome “Text” e il valore “Andrew Pitonyak”, che è il testo che viene inserito 
quando verrà eseguita la macro.

args1(0).Name = "Text"

args1(0).Value = "Andrew Pitonyak"

Qui è dove avviene la magia. Il dispatch helper invia una richiesta al contenitore del documento 
(memorizzato nella variabile denominata document) mediante il comando .uno:InsertText. I 
due argomenti successivi, frame name e search flags, vanno al di là dello scopo di questo 
documento. L'ultimo argomento è il vettore dei valori della proprietà che verrà utilizzato durante 
l'esecuzione del comando InsertText.

dispatcher.executeDispatch(document, ".uno:InsertText", "", 0, args1())

Si arriva, poi, alla fine della subroutine.

end sub

Creazione di una macro

Quando si crea una macro, prima di registrare è opportuno porsi due domande:

1) Il compito può essere eseguito come un semplice insieme di comandi?

2) È possibile disporre i vari passaggi in maniera tale che l'ultimo comando lasci il cursore 
pronto per il comando successivo?

Un esempio complesso
Può capitare di dover copiare righe e colonne di dati da un sito web, e formattarli in una tabella, 
all'interno di un documento di testo. Prima di tutto, si copia la tabella dal sito web negli appunti. Per 
evitare di copiare anche la formattazione e i tipi di carattere, si incolla il testo in un documento 
Writer come testo non formattato. Si riformatta il testo con l'utilizzo delle tabulazioni tra le colonne, 
in maniera tale da poter utilizzare il comando Tabella > Converti > Testo in tabella per convertirlo 
in una tabella.

Si analizza poi il testo, per vedere se è possibile registrare una macro che formatti il testo 
(ricordando le due domande precedenti). Come esempio, si è copiato il gruppo di costanti 
FontWeight dal sito web API. La prima colonna indica il nome delle costanti. (NdT: la seconda 
colonna non è stata tradotta al fine di mantenere la macro uguale al testo originale). Ogni nome è 
seguito da uno spazio e una tabulazione.
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DONTKNOW The font weight is not specified/known.

THIN specifies a 50% font weight.

ULTRALIGHT specifies a 60% font weight.

LIGHT specifies a 75% font weight.

SEMILIGHT specifies a 90% font weight.

NORMAL specifies a normal font weight.

SEMIBOLD specifies a 110% font weight.

BOLD specifies a 150% font weight.

ULTRABOLD specifies a 175% font weight.

BLACK specifies a 200% font weight.

Si desidera che la prima colonna contenga il valore numerico, la seconda colonna il nome, e la 
terza colonna la descrizione. Il lavoro è facilmente eseguibile per ogni riga, eccetto per 
DONTKNOW e NORMAL, che non contengono un valore numerico - ma si sa che i valori sono 
rispettivamente 0 e 100, quindi è possibile inserirli manualmente.

I dati possono essere ripuliti in molti modi - tutti semplici. Il primo esempio utilizza la pressione di 
opportuni tasti, presumendo che il cursore si trovi all'inizio della riga con il testo THIN.

1) Fate clic su Strumenti > Macro > Registra Macro per cominciare la registrazione.

2) Premete Ctrl+Freccia destra per muovere il cursore all'inizio di “specifies”.

3) Premete Backspace due volte per rimuovere lo spazio e la tabulazione.

4) Premete Tab per aggiungere una tabulazione senza lo spazio dopo il nome della costante.

5) Premete Canc per cancellare la s minuscola, poi premete S per aggiungere una S 
maiuscola.

6) Premete Ctrl+Freccia destra due volte per muovere il cursore all'inizio del numero.

7) Premete Ctrl+Shift+Freccia destra per selezionare e muovere il cursore prima del simbolo 
%.

8) Premete Ctrl+C per copiare il testo selezionato negli appunti.

9) Premete Fine per muovere il cursore alla fine della riga.

10) Premete Backspace due volte per rimuovere gli spazi rimanenti.

11) Premete Home Per muovere il cursore all'inizio della riga.

12) Premete Ctrl+V per incollare il numero selezionato all'inizio della riga.

13) Quando incollate il valore, viene incollato anche uno spazio extra, quindi premete 
Backspace per rimuovere lo spazio in più.

14) Premete Tab per inserire una tabulazione fra il numero e il nome.

15) Premete Home per muovervi all'inizio della riga.

16) Premete Freccia giù per muovere il cursore alla riga successiva.

17) Fermate la registrazione e salvate la macro.

Ci vuole molto più tempo per leggere i passi da eseguire che per registrare la macro. Lavorate con 
calma e pensate ai vari passaggi mentre li eseguite. Con la pratica verrà tutto più naturale.

La macro generata è stata modificata per contenere il numero del passaggio nei commenti, per 
vedere la corrispondenza tra il codice e le azioni descritte sopra.
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Listato 5: copia del valore numerico all'inizio della colonna.

sub CopyNumToCol1
rem -------------------------------------------------------------
rem definizione variabili
dim document   as object
dim dispatcher as object
rem -------------------------------------------------------------
rem accesso al documento
document   = ThisComponent.CurrentController.Frame
dispatcher = createUnoService("com.sun.star.frame.DispatchHelper")

rem (2) Premete Ctrl+Freccia destra per spostare il cursore all'inizio di “specifies”.
dispatcher.executeDispatch(document, ".uno:GoToNextWord", "", 0, Array())

rem (3) Premete Backspace due volte per rimuovere lo spazio e la tabulazione.
dispatcher.executeDispatch(document, ".uno:SwBackspace", "", 0, Array())

rem -------------------------------------------------------------
dispatcher.executeDispatch(document, ".uno:SwBackspace", "", 0, Array())

rem (4) Premete Tab per aggiungere una tabulazione senza lo spazio dopo il nome della 
costante.
dim args4(0) as new com.sun.star.beans.PropertyValue
args4(0).Name = "Text"
args4(0).Value = CHR$(9)

dispatcher.executeDispatch(document, ".uno:InsertText", "", 0, args4())

rem (5) Premete Canc per cancellare la s minuscola....
dispatcher.executeDispatch(document, ".uno:Delete", "", 0, Array())

rem (5) ... e dopo premete S per aggiungere una S maiuscola.
dim args6(0) as new com.sun.star.beans.PropertyValue
args6(0).Name = "Text"
args6(0).Value = "S"

dispatcher.executeDispatch(document, ".uno:InsertText", "", 0, args6())

rem (6) Premete Ctrl+Freccia destra due volte per spostare il cursore all'inizio del 
numero.
dispatcher.executeDispatch(document, ".uno:GoToNextWord", "", 0, Array())

rem -------------------------------------------------------------
dispatcher.executeDispatch(document, ".uno:GoToNextWord", "", 0, Array())

rem (7) Premete Ctrl+Maiusc+Freccia destra per selezionare il numero.
dispatcher.executeDispatch(document, ".uno:WordRightSel", "", 0, Array())

rem (8) Premete Ctrl+C per copiare il testo selezionato negli appunti.
dispatcher.executeDispatch(document, ".uno:Copy", "", 0, Array())

rem (9) Premete Fine per spostare il cursore alla fine della riga.
dispatcher.executeDispatch(document, ".uno:GoToEndOfLine", "", 0, Array())

rem (10) Premete Backspace due volte per rimuovere gli spazi rimanenti.
dispatcher.executeDispatch(document, ".uno:SwBackspace", "", 0, Array())

rem -------------------------------------------------------------
dispatcher.executeDispatch(document, ".uno:SwBackspace", "", 0, Array())

rem (11) Premete Home per spostare il cursore all'inizio della riga.
dispatcher.executeDispatch(document, ".uno:GoToStartOfLine", "", 0, Array())
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rem (12) Premete Ctrl+V per incollare il numero selezionato all'inizio della riga.
dispatcher.executeDispatch(document, ".uno:Paste", "", 0, Array())

rem (13) Premete Backspace per rimuovere lo spazio in più.
dispatcher.executeDispatch(document, ".uno:SwBackspace", "", 0, Array())

rem (14) Premete Tab per inserire una tabulazione fra il numero e il nome.
dim args17(0) as new com.sun.star.beans.PropertyValue
args17(0).Name = "Text"
args17(0).Value = CHR$(9)

dispatcher.executeDispatch(document, ".uno:InsertText", "", 0, args17())

rem (15) Premete Home per andare all'inizio della riga.
dispatcher.executeDispatch(document, ".uno:GoToStartOfLine", "", 0, Array())

rem (16) Premete Freccia giù per spostare il cursore alla riga successiva.
dim args19(1) as new com.sun.star.beans.PropertyValue
args19(0).Name = "Count"
args19(0).Value = 1
args19(1).Name = "Select"
args19(1).Value = false

dispatcher.executeDispatch(document, ".uno:GoDown", "", 0, args19())
end sub

I movimenti del cursore vengono utilizzati per tutte le operazioni (al contrario di quanto accade 
nella ricerca). Se eseguite la macro nella riga contenente DONTKNOW, la parola weight viene 
spostata all'inizio della riga, e il primo “The” viene cambiato in “She”. In questo caso la macro non 
funziona bene, ma non dovrebbe essere eseguita nelle righe che non hanno il formato appropriato; 
queste vanno elaborate manualmente.

Esecuzione rapida di una macro
È tedioso eseguire ripetutamente una macro facendo clic su Strumenti > Macro > Esegui Macro 
(vedere Figura 334). Potete eseguire la macro dall'interno dell'IDE. Usate Strumenti > Macro > 
Organizza Macro > LibreOffice Basic per aprire la finestra di dialogo Macro LibreOffice Basic. 
Selezionate la vostra macro e fate clic su Modifica per aprire la macro nell'IDE.

L'IDE contiene l'icona Esegui Programma Basic nella barra degli strumenti, che esegue la prima 
macro presente nell'IDE. Fino a quando non la cambiate, la prima macro è quella vuota 
denominata Main. Modificate Main in maniera tale che appaia come mostrato nel Listato 6.

Listato 6: modifica di Main per invocare CopyNumToCol1 (Copia del valore numerico all'inizio della  
colonna).

Sub Main
  CopyNumToCol1
End Sub

Adesso, potete eseguire CopyNumToCol1 facendo clic ripetutamente sull'iconaEsegui 
Programma Basic nella barra degli strumenti dell'IDE. Questo metodo è semplice e rapido, 
specialmente per macro temporanee che vengono utilizzate solo poche volte, per poi essere 
cancellate.
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Qualche volta la registrazione di una macro fallisce

Comprendere il funzionamento di LibreOffice è importante per capire come e perché il registratore 
di macro a volte non funziona. La causa primaria è in relazione con il framework dei comandi e con 
il suo collegamento al registratore di macro.

Il framework dei comandi
Lo scopo del framework dei comandi è quello di fornire un accesso uniforme ai componenti 
(documenti) per i comandi che corrispondono di solito alle voci di menu. Si può fare clic su File > 
Salva direttamente dal menu, si può usare la scorciatoia da tastiera Ctrl+S, oppure fare clic 
sull'icona Salva sulla barra degli strumenti. Tutti questi comandi sono tradotti nella stessa 
“richiesta di comando”.

Il framework dei comandi può anche essere utilizzato per inviare “comandi” direttamente 
all'interfaccia utente (UI - User Interface). Per esempio, dopo che si salva il documento, il comando 
Salva è disabilitato. Non appena si esegue una modifica al documento, il comando viene 
nuovamente abilitato.

Se vedete una richiesta di comando, si tratta di una stringa di testo come .uno:InsertObject 
oppure .uno:GoToStartOfLine. Il comando viene inviato al contenitore del documento, e il 
contenitore tralascia il comando fino a quando non viene trovato un oggetto che si possa occupare 
del comando.

Come il registratore di macro utilizza il framework dei comandi
Il registratore di macro registra le richieste generate. Il registratore è relativamente semplice da 
implementare e i medesimi comandi che vengono eseguiti sono salvati per un utilizzo successivo. 
Il problema consiste nel fatto che non tutti i comandi inviati sono completi. Per esempio, 
l'inserimento di un oggetto genera il seguente codice:

dispatcher.executeDispatch(document, ".uno:InsertObject", "", 0, Array())

Non è possibile specificare il tipo di oggetto da creare o inserire. Se un oggetto viene inserito a 
partire da un file, non potete specificare quale file inserire.

Si può provare a registrare una macro, e fare clic su Strumenti > Opzioni per aprire e modificare 
le impostazioni di configurazione. Il registratore di macro non registra alcun cambiamento di 
configurazione; infatti, il codice generato è commentato in maniera tale da non poter essere 
eseguito.

rem dispatcher.executeDispatch(document,

    ".uno:OptionsTreeDialog", "", 0, Array())

Se viene aperta una finestra di dialogo, è probabile che venga generato il comando per aprirla. 
Ogni azione che eseguite all'interno della finestra di dialogo non verrà registrata. Alcuni esempi 
includono la finestra di dialogo dell'organizzatore di macro, l'inserimento di caratteri speciali e altri 
tipi simili di finestre di dialogo. Altri possibili problemi nell'utilizzo del registratore di macro sono 
relativi all'inserimento di formule, all'impostazione dei dati utente, all'impostazione dei filtri in Calc, 
ad azioni eseguite nei formulari dei database e all'esportazione di un documento in formato PDF 
criptato. Non sarete comunque mai certi di quello che funziona e quello che non funziona, fino a 
quando non lo provate. Le azioni eseguite nella finestra di dialogo di ricerca sono registrate 
correttamente, per esempio.
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Altre opzioni
Quando il registratore di macro non è in grado di risolvere uno specifico problema, la soluzione di 
solito consiste nello scrivere direttamente il codice utilizzando gli oggetti di LibreOffice. 
Sfortunatamente, la curva di apprendimento per gli oggetti è abbastanza ripida. Di solito la cosa 
migliore da fare è cominciare con dei semplici esempi, per poi eseguire pian piano compiti più 
complessi. Un buon punto di partenza consiste nell'imparare a comprendere il codice delle macro 
generate.

Se registrate delle macro in Calc, e il registratore può generare correttamente la macro, c'è 
un'estensione creata da Paolo Mantovani, che converte le macro di Calc quando vengono 
registrate. Il codice finale manipola gli oggetti di LibreOffice invece di generare richieste. Ciò può 
essere molto utile per imparare il modello a oggetti.

Potete scaricare il registratore di macro direttamente dal sito web di Paolo:

http://www.paolo-mantovani.org/downloads/DispatchToApiRecorder/ 

Organizzazione delle macro

In LibreOffice, le macro sono raggruppate in moduli, i moduli in librerie, e le librerie in contenitori di 
libreria. Una libreria viene utilizzata di solito sia per raggruppare un'intera categoria di macro, sia 
per un'intera applicazione. I moduli sono di solito suddivisi per funzionalità, come quelli per 
l'iterazione con l'utente o quelli per eseguire particolari calcoli. Le singole macro sono subroutine e 
funzioni.

Figura 335: gerarchia delle librerie delle macro

Un esperto informatico userebbe la Figura 336 per descrivere accuratamente la situazione. La 
scritta “1..*” significa uno o più di uno, mentre “0..*” significa zero o più di zero. Il triangolo nero 
rappresenta un insieme di contenitori.

• Un contenitore di libreria contiene una o più librerie, e ogni libreria è contenuta in un 
contenitore di libreria.

• Una libreria contiene zero o più moduli, e ogni modulo è contenuto in un'unica libreria.
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• Ogni modulo può contenere zero o più macro, e ogni macro è contenuta in un solo modulo.

Figura 336: gerarchia delle librerie delle macro

Usate Strumenti > Macro > Organizza Macro > LibreOffice Basic per aprire la finestra di 
dialogo Macro LibreOffice Basic (vedere Figura 337). Tutti i contenitori di libreria disponibili sono 
visualizzati nella lista Macro da. Ogni documento è un contenitore di libreria, capace di contenere 
più librerie. La stessa applicazione si comporta come due contenitori di libreria: un contenitore per 
le macro distribuite con LibreOffice, chiamato Macro di LibreOffice, e un altro per le macro 
personali chiamato Macro personali. Vedere ad esempio la Figura 337, dove sono aperti due 
documenti.

Figura 337: i contenitori di libreria sono mostrati sulla sinistra

Le macro di LibreOffice sono memorizzate assieme al codice runtime dell'applicazione, che 
potrebbe non essere modificabile, a meno che non siate un utente amministratore. Ciò è dovuto al 
fatto che queste macro non devono essere modificate e voi non dovete memorizzare le vostre 
macro nel contenitore LibreOffice.

A meno che le vostre macro siano applicabili a un singolo documento, e solo a un quel documento, 
esse saranno memorizzate probabilmente all'interno del contenitore Macro personali. Il contenitore 
Macro personali è memorizzato nel vostro spazio utente, o nella cartella utente.

Se una macro viene inclusa all'interno di un documento, allora verrà eseguita all'interno dello 
stesso, principalmente perché utilizza "ThisComponent" per le sue azioni.
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Ogni contenitore di libreria contiene una libreria denominata Standard. È più pratico creare le 
proprie librerie con dei nomi descrittivi, invece di utilizzare la libreria Standard. Le librerie con nomi 
descrittivi, oltre a essere più semplici da organizzare, possono anche essere importate in altri 
contenitori di librerie, al contrario della libreria Standard.

Attenzione LibreOffice vi permette d'importare le librerie all'interno di un contenitore di librerie, 
ma non vi permette di sovrascrivere la libreria Standard. Inoltre, se memorizzate le 
vostre macro nella libreria Standard, non potrete importarle in altri contenitori di 
libreria.

Per lo stesso motivo per cui date dei nomi significativi alle vostre librerie, è consigliato utilizzare 
nomi significativi anche per i vostri moduli. LibreOffice utilizza, per impostazione predefinita, nomi 
come Module1. Rinominate pure i vostri moduli con il nome che riterrete più opportuno.

Non appena create le vostre macro, dovete decidere dove memorizzarle. Memorizzare una macro 
all'interno di un documento è utile quando il documento deve essere condiviso e volete distribuire 
la macro assieme al documento. Le macro memorizzate nel contenitore di libreria dell'applicazione 
chiamato Macro personali, comunque, sono disponibili per tutti i documenti.

Le macro non sono disponibili fino a quando non viene caricata la rispettiva libreria. Comunque la 
libreria Standard e la libreria Template vengono caricate automaticamente. Una libreria caricata 
viene visualizzata in maniera differente rispetto a una non caricata. Per caricare una libreria con i 
rispettivi moduli, basta effettuare un doppio clic sulla libreria.

Dove vengono memorizzate le macro?
LibreOffice memorizza i dati utente in un'apposita cartella all'interno della cartella utente. La 
posizione dipende dal sistema operativo in uso. Usate Strumenti > Opzioni > LibreOffice > 
Percorsi per vedere dove sono memorizzati altri dati di configurazione. Su Windows XP, la cartella 
è C:\Documents and Settings\<nome>\ Application Data. Le macro dell'utente 
vengono memorizzate in LibreOffice\3\user\basic. Ogni libreria viene memorizzata in una 
cartella apposita all'interno della cartella basic.

Non è importante sapere dove vengono memorizzate le macro, se vengono utilizzate 
saltuariamente. Comunque, se sapete dove sono memorizzate, potete effettuare delle copie di 
sicurezza, condividere le vostre macro o verificare se sono presenti errori.

Fate clic su Strumenti > Macro > Organizza finestre di dialogo per aprire la finestra di dialogo 
LibreOffice: Gestione macro Basic. Un metodo alternativo, comunemente utilizzato, per aprire 
questa finestra di dialogo consiste nel fare clic su Strumenti > Macro > Organizza macro > 
LibreOffice Basic per aprire la finestra di dialogo Macro LibreOffice Basic, per poi fare clic sul 
pulsante Gestisci.
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Figura 338: la finestra di dialogo Gestione macro Basic

Importazione delle macro
La finestra di dialogo LibreOffice Gestione macro Basic contiene delle funzionalità per creare, 
eliminare e rinominare le librerie, i moduli e le finestre di dialogo. Selezionate il contenitore di 
libreria da utilizzare e dopo fate clic sul pulsante Importa per importare le librerie delle macro 
(vedere Figura 339).

Nota Non è possibile importare la libreria Standard.

Suggerimento

Su Linux, i file di LibreOffice vengono memorizzati sotto la cartella home 
dell'utente, in una cartella il cui nome comincia con un punto. Le cartelle e i file i 
cui nomi cominciano con un punto non sono visualizzati nelle normali finestre di 
selezione. Per aprire la cartella andate nella vostra cartella home, inserite il 
nome .libreoffice\3, e poi fate clic su Apri, oppure premete Ctrl-H per mostrare 
le cartelle e i file nascosti e spostatevi poi come di solito. In tal modo si aprirà la 
cartella, che inizialmente non viene mostrata.
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Figura 339: selezione di una libreria di macro da importare

Spostatevi nella cartella che contiene la libreria che volete importare. Vi sono normalmente due file 
da scegliere, dialog.xlb e script.xlb. Non importa quale dei due selezionate; verranno comunque 
importati entrambi. Selezionate un file e fate clic su Apri per continuare.

Figura 340: scelta delle opzioni per l'importazione della 
libreria

Se la libreria è già presente, essa non verrà sostituita, a meno che non venga selezionata 
l'opzione Sostituisci librerie esistenti. Se Inserite come referenza è selezionato, la libreria verrà 
referenziata nella posizione attuale, ma non potrà essere modificata. Se Inserisci come referenza 
non viene selezionato, la libreria verrà comunque copiata nella cartella delle macro dell'utente.

Le macro possono essere memorizzate nelle librerie, all'interno dei documenti di LibreOffice. 
Selezionate un documento invece di una directory su disco (come mostrato in Figura 339) per 
importare le librerie contenute in un documento.
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Scaricamento delle macro da importare
Le macro sono disponibili per lo scaricamento. Alcune macro sono contenute nei documenti, altre 
in normali file che dovete selezionare e importare, altre ancora sono disponibili come codice macro 
che dovete copiare e incollare nell'IDE Basic; fate clic su Strumenti > Macro > Organizza macro 
> LibreOffice Basic per aprire la finestra di dialogo Macro LibreOffice Basic, scegliete la macro da 
modificare, poi fate clic su Modifica per aprire la macro nell'IDE Basic.

Alcune macro sono disponibili gratuitamente su Internet (vedere Tabella 9). “Aggiungere una 
macro esistente“ a pagina 382 spiega come aggiungere queste macro alla vostra libreria delle 
macro.

Tabella 9: siti di riferimento per trovare esempi di macro

Pagina Descrizione

http://www.ooomacros.org/ Collezione di macro in pacchetti - alcune sono 
datate.

http://www.pitonyak.org/oo.php Materiale di riferimento riguardo alle macro.

http://www.pitonyak.org/database/ Materiale di riferimento riguardo le macro dei 
database.

http://development.openoffice.org/ Un insieme di collegamenti a vari argomenti.

http://www.oooforum.org/ Un forum, con molti esempi e aiuto.

http://user.services.openoffice.org/ Un altro forum, con molti esempi e aiuto.

Come eseguire una macro

Un modo tipico per eseguire una macro è il seguente:

1) Fate clic su Strumenti > Macro > Esegui Macro per aprire la finestra di dialogo Selettore 
macro (vedere Figura 341).

2) Selezionate la libreria e il modulo nella lista delle librerie sulla sinistra.

3) Selezionate la macro in Nome macro, sulla destra.

4) Fate clic su Esegui per eseguire la macro.

Figura 341: utilizzo della finestra di dialogo Selettore macro per eseguire le macro
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Sebbene sia possibile utilizzare la strada Strumenti > Macro > Esegui macro per eseguire le 
macro, essa non è il modo più efficiente nel caso di utilizzo frequente delle macro. Una tecnica 
comunemente utilizzata consiste nell'assegnare una macro a un pulsante su una barra strumenti, 
a una voce di menu, a una scorciatoia da tastiera, oppure a un pulsante incluso all'interno del 
documento. Quando si sceglie un metodo è utile porsi le seguenti domande:

• La macro deve essere disponibile solo per un documento o per tutti i documenti?

• La macro è pertinente solo a un determinato tipo di documento, come i documenti di Calc?

• Con quale frequenza verrà utilizzata la macro?

Le risposte a queste domande indicheranno dove memorizzare la macro e come renderla 
disponibile. Per esempio, probabilmente non inserirete una macro utilizzata raramente in una barra 
degli strumenti. Come ausilio alla scelta, analizzate la Tabella 10.

Tabella 10: metodi per eseguire una macro

Tipo LibreOffice Tipo documento Documento

Barra degli 
strumenti

No Sì Sì

Menu No Sì Sì

Scorciatoia Sì Sì No

Eventi Sì No Sì

Per aggiungere una voce di menu, una scorciatoia da tastiera, oppure un pulsante, che richiamino 
una macro, alla barra degli strumenti, utilizzate la finestra di dialogo Personalizza (vedere Figura 
342). Potete aprire questa finestra di dialogo in ciascuno di questi modi:

• Scegliete Strumenti > Personalizza dalla barra dei menu principale.

• Ogni barra degli strumenti ha un'icona  che apre un menu; scegliete l'opzione 
Personalizza barra degli strumenti.

Suggerimento
Una completa descrizione della finestra di dialogo Personalizza va al di là degli 
scopi di questo documento. Fate clic sul pulsante Aiuto per accedere alle 
pagine di aiuto incluse in LibreOffice.

La finestra di dialogo Personalizza contiene schede per configurare i menu, le scorciatoie da 
tastiera, le barre degli strumenti e gli eventi.

Barra degli strumenti
Le macro possono essere aggiunte alle barre degli strumenti. Per saperne di più sulla modifica 
delle barre degli strumenti, fate riferimento al Capitolo 14 (Personalizzazione di LibreOffice).

Voci di menu
Fate clic su Strumenti > Personalizza per aprire la finestra di dialogo Personalizza, e selezionate 
la scheda Menu. Potete modificare i menu esistenti, oppure creare nuovi menu che richiamino 
delle macro. Per ulteriori informazioni sulla modifica dei menu, fate riferimento al Capitolo 14.
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Scorciatoie da tastiera
Andate su Strumenti > Personalizza per aprire la finestra di dialogo Personalizza, e selezionate la 
scheda Tastiera. L'assegnazione delle scorciatoie da tastiera viene trattata nel Capitolo 14.

Figura 342: finestra di dialogo Personalizza di LibreOffice

Eventi
In LibreOffice, quando accade qualcosa, si dice che si è verificato un evento. Ad esempio, 
l'apertura di un documento, la pressione di un tasto, o il movimento del puntatore del mouse. 
LibreOffice permette agli eventi di invocare delle macro; la macro viene in questo caso chiamata 
gestore dell'evento. La trattazione completa della gestione degli eventi va molto al di là degli scopi 
di questo documento, ma l'argomento può essere introdotto.
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Attenzione

Fate attenzione quando configurate un gestore di eventi. Per esempio, ipotizzate di 
voler scrivere un gestore di eventi che viene richiamato ogni volta che un tasto 
viene premuto, ma effettuate un errore in maniera tale che l'evento non sia 
correttamente gestito. Una possibile conseguenza può essere che il gestore di 
eventi impedisca la gestione della pressione degli altri tasti, costringendovi a 
chiudere in maniera forzata LibreOffice.

Fate clic su Strumenti > Personalizza per aprire la finestra di dialogo Personalizza, e dopo fate 
clic sulla scheda Eventi (vedere Figura 343). Gli eventi elencati nella finestra di dialogo 
Personalizza fanno riferimento sia all'intera applicazione, sia al documento specifico. Utilizzate 
l'elenco a discesa Salva in per scegliere LibreOffice, oppure un documento specifico.

Figura 343: assegnazione di una macro a un evento a livello di applicazione

Un metodo comunemente utilizzato consiste nell'assegnare all'evento di Apri documento 
l'esecuzione di una specifica macro. La macro può quindi eseguire certe azioni di configurazione 
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specifiche per il documento. Selezionate l'evento desiderato e fate clic sul pulsante Macro per 
aprire la finestra di dialogo Selettore Macro (vedere Figura 344).

Figura 344: assegnazione di una macro all'evento di apertura di un documento

Selezionate la macro desiderata e fate clic su OK per assegnare la macro all'evento. La scheda 
Eventi mostra che l'evento è stato assegnato a una macro (vedere Figura 345). Quando verrà 
aperto il documento, si avvierà la macro selezionata.

Si possono impostare molti oggetti di un documento per richiamare delle macro quando 
avvengono degli eventi. L'utilizzo più comune consiste nell'aggiungere un controllo, come un 
pulsante, all'interno di un documento. Persino effettuare un doppio clic su un'immagine permette di 
aprire una finestra di dialogo con la scheda Macro che vi permette di assegnare una macro a un 
evento.

Figura 345: la macro selezionata viene assegnata all'evento Apri documento

Estensioni

Un'estensione è un pacchetto che può essere installato all'interno di LibreOffice per aggiungere 
nuove funzionalità. Le estensioni possono essere scritte in quasi tutti i linguaggi di 
programmazione e possono essere sia semplici, sia complesse. Le estensioni possono essere 
raggruppate in vari tipi:

• Add-in per Calc, che forniscono nuove funzionalità in Calc, incluse nuove funzioni che 
possono essere utilizzate come funzioni integrate

• Nuovi componenti e funzionalità, che includono normalmente un qualche livello di 
integrazione con l'interfaccia utente, come nuovi menu o nuove barre degli strumenti

• Tabelle Pivot che vengono utilizzate direttamente in Calc

• Add-in per i grafici con nuovi tipi di grafico

• Componenti linguistiche come i correttori ortografici

• Modelli di documenti e immagini
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Sebbene sia possibile trovare le singole estensioni in posti differenti, esiste attualmente un 
deposito delle estensioni all'indirizzo: http://extensions.libreoffice.org/ e della documentazione 
all'indirizzo: http://libreplanet.org/wiki/Group:OpenOfficeExtensions/List 

Per ulteriori informazioni su come ottenere e installare le estensioni, fate riferimento al Capitolo 14 
(Personalizzare LibreOffice).

Scrittura delle macro senza l'utilizzo del registratore

Gli esempi raccolti in questo capitolo sono stati creati utilizzando il registratore di macro e il 
dispatcher. Potete anche scrivere macro che accedono direttamente agli oggetti che sono inclusi in 
LibreOffice. In altre parole, potete manipolare direttamente un documento.

Manipolare direttamente gli oggetti interni di LibreOffice è un argomento avanzato che va oltre gli 
scopi di questo capitolo. Tuttavia, potete vederne il funzionamento tramite un piccolo esempio.

Listato 7: aggiungere il testo "Ciao" alla fine del documento corrente.

Sub AppendHello
  Dim oDoc
  Dim sTextService$
  Dim oCurs
  
  REM ThisComponent fa riferimento al documento attualmente attivo.
  oDoc = ThisComponent

  REM Verifica che si tratti di un documento di testo
  sTextService = "com.sun.star.text.TextDocument"
  If NOT oDoc.supportsService(sTextService) Then
    MsgBox "Questa macro funziona solamente con documenti di testo"
    Exit Sub
  End If
  
  REM Prende il controllo del cursore dal controller corrente.
  oCurs = oDoc.currentController.getViewCursor()
  
  REM Sposta il cursore alla fine del documento
  oCurs.gotoEnd(False)
  
  REM Inserisce il testo "Ciao" alla fine del documento
  oCurs.Text.insertString(oCurs, "Ciao", False)  
End Sub

Ulteriori informazioni

Sono disponibili molte risorse che forniscono informazioni utili per la scrittura delle macro. Fate clic 
su ? > Guida di LibreOffice per aprire le pagine di aiuto di LibreOffice. L'angolo superiore sinistro 
della finestra di aiuto in linea di LibreOffice contiene un menu a discesa che determina quale 
insieme di documenti di aiuto viene visualizzato. Per visualizzare l'aiuto per Basic, scegliete 
LibreOffice Basic dal menu a discesa.
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Materiale incluso
In LibreOffice sono incluse molte macro eccellenti. Usate Strumenti > Macro > Organizza Macro 
> LibreOffice Basic per aprire la finestra di dialogo Macro LibreOffice Basic. Espandete la libreria 
Tools nel contenitore di libreria LibreOffice. Ispezionate il modulo Debug - alcuni esempi 
interessanti includono WritedbgInfo(document) e printdbgInfo(sheet).

Risorse online
I collegamenti seguenti contengono informazioni sulla programmazione delle macro:

http://user.services.openoffice.org/ (forum OOo, ben supportato; i volontari rispondono anche alle 
domande relative a LibreOffice)

http://api.openoffice.org/docs/common/ref/com/sun/star/module-ix.html (riferimento ufficiale a IDL: 
qui troverete quasi ogni comando con la relativa descrizione)

http://wiki.documentfoundation.org/Documentation/Publications#Other_Documentation_and_Reso
urces  (BASIC Programming Guide (Guida alla programmazione in BASIC) e Developers Guide 
(Guida per sviluppatori); la seconda contiene spiegazioni dettagliate)

http://www.pitonyak.org/oo.php (pagina delle macro di Andrew Pitonyak)

http://www.pitonyak.org/AndrewMacro.odt (numerosi esempi di macro)

http://www.pitonyak.org/OOME_3_0.odt (il libro di Andrew Pitonyak sulle macro)

http://www.pitonyak.org/database/ (numerosi esempi di macro per Base)

Materiale stampato e in formato elettronico
Al momento non sono disponibili per il download libri specifici sulle macro di LibreOffice.

Per OpenOffice.org sono disponibili per l'acquisto, sia in formato cartaceo, sia in formato e-book, i 
seguenti libri:

Learn OpenOffice.org Spreadsheet Macro Programming del Dr. Mark Alexander Bain.
Vedere http://www.packtpub.com/openoffice-ooobasic-calc-automation/book.

Database Programming with OpenOffice.org Base & Basic di Roberto Benitez. 
Vedere http://www.lulu.com/product/paperback/database-programming-with-openofficeorg-base-
basic/3568728
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Introduzione

Questo capitolo contiene le istruzioni per effettuare alcune delle personalizzazioni più comuni.

In LibreOffice è possibile personalizzare il contenuto dei menu, le barre degli strumenti e i tasti di 
scelta rapida, aggiungere nuovi menu e barre degli strumenti, e assegnare macro agli eventi. Non 
è tuttavia possibile personalizzare i menu contestuali (pulsante destro del mouse).

Altre personalizzazioni sono possibili grazie alle estensioni installabili dal sito di LibreOffice o da 
altri siti.

Nota
Le personalizzazioni dei menu e delle barre degli strumenti si possono salvare in un 
modello. Per farlo, salvatele prima in un documento e poi salvate il documento come 
modello, così come descritto nel Capitolo 3 (Uso di stili e modelli).

Personalizzare il contenuto dei menu

Oltre a poter cambiare il tipo di carattere del menu [come descritto nel Capitolo 2 (Configurare 
LibreOffice)], è possibile aggiungere e riorganizzare categorie sulla barra dei menu, aggiungere 
comandi ai menu, e apportare altre modifiche.

Per personalizzare i menu:

1) Scegliete Strumenti > Personalizza.

2) Nella finestra di dialogo Personalizza, scegliete la pagina Menu.

Figura 346: la scheda Menu della finestra di dialogo Personalizza

3) Nell'elenco a tendina Salva In, scegliete se salvare il menu modificato per l'applicazione 
(ad esempio LibreOffice Writer) o per un documento selezionato (ad esempio, 
Documento.odt).
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4) Nella sezione Menu di LibreOffice [nome del programma (esempio: Writer)], 
selezionate dall'elenco a tendina Menu il menu che volete personalizzare. L'elenco include 
tutti i menu principali e i sottomenu (ossia menu contenuti in altri menu). Ad esempio, oltre 
ai menu File, Modifica, Visualizza, e così via, ci sono i menu File | Invia e File |Modelli. I 
comandi disponibili per il menu selezionato sono mostrati nella parte centrale della finestra 
di dialogo.

5) Per personalizzare il menu selezionato, fate clic sui pulsanti Menu o Modifica. È possibile 
aggiungere comandi a un menu facendo clic sul pulsante Importa. Queste azioni sono 
illustrate in dettaglio nelle sezioni seguenti. Usate le frecce su e giù poste accanto 
all'elenco delle Voci per spostare l'elemento del menu selezionato in una posizione diversa.

6) Una volte terminate tutte le modifiche, fate clic su OK (non mostrato nell'illustrazione) per 
salvarle.

Creare un nuovo menu
Nella pagina Menu della finestra di dialogo Personalizza, fate clic su Nuovo per visualizzare la 
finestra di dialogo Nuovo menu, mostrata in Figura 347.

1) Digitate un nome per il nuovo menu nel campo Nome del menu.

2) Usate i pulsanti freccia su e giù per spostare il nuovo menu nella posizione desiderata sulla 
barra dei menu.

3) Fate clic su OK per salvare.

Il nuovo menu appare ora nella lista dei menu nella finestra di dialogo Personalizza (apparirà sulla 
barra dei menu dopo aver salvato la personalizzazione).

Dopo aver creato un nuovo menu, è necessario aggiungervi dei comandi, come descritto in 
“Aggiungere un comando a un menu” a pagina 408.

Figura 347: aggiungere un nuovo menu

Modificare menu esistenti
Per modificare un menu esistente, da voi creato o incorporato, selezionatelo nell'elenco Menu e 
fate clic sul pulsante Menu per visualizzare un elenco di modifiche: Sposta, Rinomina, Elimina. 
Non tutte le modifiche possono essere applicate a tutte le voci nell'elenco dei Menu. Ad esempio, 
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Rinomina ed Elimina non sono disponibili per i menu forniti, e Sposta non è disponibile per i 
sottomenu.

Per spostare un menu (come File), scegliete Menu > Sposta. Si aprirà una finestra di dialogo 
simile a quella mostrata nella Figura 347 (ma senza il campo Nome del menu). Usate i pulsanti 
freccia su e giù per spostare il menu nella posizione desiderata.

Per spostare i sottomenu (come File | Invia), selezionate il menu principale (File) nell'elenco del 
Menu, quindi, nella sezione Contenuto del menu della finestra di dialogo, selezionate il sottomenu 
(Invia) nell'elenco delle Voci e utilizzate i tasti freccia per spostarlo verso l'alto o verso il basso 
nella sequenza. Un piccolo triangolo nero a destra del nome permette di riconoscere facilmente i 
sottomenu nella lista delle Voci.

Oltre a rinominare, potete specificare una lettera nel nome di un menu personalizzato, che diverrà 
sottolineata; in tal modo la lettera verrà utilizzata come scorciatoia da tastiera, permettendovi di 
selezionare il menu quando premete Alt+ la lettera scelta. I sottomenu esistenti possono essere 
modificati per cambiare la lettera utilizzata per selezionarli dalla tastiera, quando il menu è aperto.

1) Selezionate un menu personalizzato o un sottomenu nell'elenco a discesa Menu.

2) Fate clic sul pulsante Menu e selezionate Rinomina.

3) Aggiungete una tilde (~) davanti alla lettera che volete usare come acceleratore. Ad 
esempio, per selezionare il comando del sottomenu Invia premendo I (dopo avere aperto il 
menu File usando Alt+F), inserite ~Invia. In tal modo si modifica l'impostazione 
predefinita, che non prevede scorciatoie per la selezione del comando (per le versioni di 
LibreOffice meno recenti).

Attenzione
Quando assegnate una scorciatoia ai menu personalizzati, assicuratevi di non 
utilizzare una lettera già utilizzata per un'altra scorciatoia.

Aggiungere un comando a un menu
Potete aggiungere comandi ai menu forniti e ai menu da voi creati. Nella finestra di dialogo 
Personalizza, selezionate il menu nell'elenco dei Menu e fate clic sul pulsante Importa nella 
sezione Contenuto del menu della finestra di dialogo.

Nella finestra di dialogo Aggiungi comandi (Figura 348), selezionate una categoria, quindi il 
comando, e poi fate clic su Aggiungi. La finestra di dialogo resta aperta, affinché possiate 
selezionare più comandi. Quando avete terminato di aggiungere comandi, fate clic su Chiudi. 
Ritornati alla finestra di dialogo Personalizza, potete organizzare i comandi nella sequenza 
desiderata utilizzando i pulsanti freccia su e giù.
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Figura 348: aggiungere comandi a un menu

Modifica delle voci del menu
Oltre a poter cambiare la sequenza delle voci di un menu o sottomenu, si possono aggiungere 
sottomenu, rinominare o eliminare le voci e aggiungere separatori di gruppo.

Per iniziare, selezionate il menu o sottomenu da modificare, dall'elenco Menu nella parte alta della 
pagina Personalizza, quindi selezionate la voce nell'elenco delle Voci nell'area Contenuto menu. 
Fate clic sul pulsante Modifica e scegliete l'azione richiesta dall'elenco a comparsa delle azioni.

La maggior parte delle azioni dovrebbe risultare autoesplicativa. Scegliendo Inizia un gruppo 
viene aggiunta una linea di separazione dopo la voce evidenziata.

Personalizzare le barre degli strumenti

È possibile personalizzare le barre degli strumenti in molti modi, compreso scegliere quali icone 
debbano essere visibili e bloccare la posizione di una barra degli strumenti ancorata [come 
descritto nel Capitolo 1 (Introduzione a LibreOffice)], e aggiungere o rimuovere icone (comandi) 
nell'elenco di quelle disponibili su una barra degli strumenti.  Potete anche creare nuove barre 
degli strumenti. Questa sezione descrive come creare nuove barre degli strumenti e aggiungere o 
rimuovere icone su quelle esistenti.

Per arrivare alla finestra di dialogo di personalizzazione delle barre degli strumenti, eseguite una 
delle seguenti operazioni:

• Nella barra degli strumenti, fate clic sulla freccia alla fine della barra e selezionate 
Personalizza barra degli strumenti.

• Selezionate Visualizza > Barre degli strumenti > Personalizza dalla barra dei menu.
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• Selezionate Strumenti > Personalizza dalla barra dei menu e andate alla scheda Barre 
degli strumenti.

Figura 349: la scheda Barre degli strumenti della finestra di dialogo 
Personalizza

Modificare le barre degli strumenti esistenti
Per modificare una barra degli strumenti esistente:

1) Nell'elenco a comparsa Salva in, scegliete se salvare la barra degli strumenti modificata 
per l'applicazione (ad esempio Writer) oppure per un documento selezionato.

2) Nella sezione Barre degli strumenti LibreOffice [nome del programma (esempio: 
Writer)] >, selezionate dall'elenco a comparsa Barra degli strumenti la barra degli 
strumenti che volete personalizzare.

3) Potete creare una nuova barra degli strumenti facendo clic sul pulsante Nuovo, oppure 
potete personalizzare una barra degli strumenti esistente facendo clic sui pulsanti Barra 
degli strumenti oppure Modifica, e aggiungere comandi a una barra degli strumenti 
facendo clic sul pulsante Importa. Queste azioni sono illustrate di seguito.

4) Una volte terminate tutte le modifiche, fate clic su OK per salvarle.

Creare una nuova barra degli strumenti
Per creare una nuova barra degli strumenti:

1) Scegliete Strumenti > Personalizza dalla barra dei menu e andate alla pagina Barre degli 
strumenti.

2) Fate clic su Nuovo. Nella finestra di dialogo Nome, digitate il nome della nuova barra degli 
strumenti e scegliete dall'elenco a tendina Salva in dove salvare il menu modificato: per 
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l'applicazione (ad esempio Writer) oppure per un documento selezionato. Fate clic su OK.

La nuova barra degli strumenti compare ora nell'elenco delle barre degli strumenti nella finestra di 
dialogo Personalizza. Dopo aver creato una nuova barra degli strumenti è necessario aggiungervi 
dei comandi, come descritto di seguito.

Aggiungere un comando a una barra degli strumenti
Se l'elenco dei pulsanti disponibili per una barra degli strumenti non include tutti i comandi che 
desiderate su quella barra degli strumenti, potete aggiungere dei comandi. Quando create una 
nuova barra degli strumenti, è necessario aggiungervi dei comandi.

1) Nella pagina Barre degli strumenti della finestra di dialogo Personalizza, selezionate la 
barra degli strumenti nell'elenco Barra degli strumenti e fate clic sul pulsante Importa nella 
sezione Contenuto della barra degli strumenti, nella finestra di dialogo.

2) La finestra di dialogo Aggiungi comandi è identica a quella per l'aggiunta di comandi ai 
menu (Figura 348). Selezionate una categoria, quindi il comando, e poi fate clic su 
Aggiungi. La finestra di dialogo resta aperta, affinché possiate selezionare più comandi. 
Quando avete terminato di aggiungere comandi, fate clic su Chiudi. Se inserite un 
elemento che non ha un'icona associata, la barra degli strumenti mostrerà il nome 
completo dell'elemento; la prossima sezione illustra come scegliere un'icona per un 
comando di una barra degli strumenti.

3) Ritornati alla finestra di dialogo Personalizza, potete organizzare i comandi nella sequenza 
desiderata utilizzando i pulsanti freccia su e giù.

4) Una volta terminate le modifiche, fate clic su OK per salvare.

Scelta delle icone per i comandi delle barre degli strumenti
Sui pulsanti delle barre degli strumenti solitamente vi sono icone e non parole, ma non tutti i 
comandi sono associati a delle icone.

Per scegliere un'icona per un comando, selezionate il comando e fate clic su Modifica > Cambia 
icona. Nella finestra di dialogo Cambia icona potete scorrere le icone disponibili, selezionarne una 
e fare clic su OK per assegnarla al comando.
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Figura 350: finestra di dialogo Cambia icona

Per utilizzare un'icona personalizzata, createla in un programma di grafica e importatela in 
LibreOffice facendo clic sul pulsante Importa nella finestra di dialogo Cambia icona. Per ottenere 
la migliore qualità le icone personalizzate devono avere le dimensioni di 16x16 pixel e non 
contenere più di 256 colori.

Esempio: aggiungere un'icona Fax a una barra degli strumenti
È possibile personalizzare LibreOffice in modo che con un singolo clic su un'icona il documento 
corrente venga inviato automaticamente come fax.

1) Assicuratevi di aver installato il driver fax. Consultate la documentazione del vostro modem 
fax per ulteriori informazioni.

2) Scegliete Strumenti > Opzioni > LibreOffice Writer > Stampa. Apparirà la finestra di 
dialogo mostrata in Figura 351.

3) Selezionate la periferica fax dall'elenco Fax e fate clic su OK.

4) Fate clic sull'icona della freccia alla fine della barra degli strumenti Standard. Nel menu a 
comparsa, scegliete Personalizza barra degli strumenti. Apparirà la pagina Barre degli 
Strumenti della finestra di dialogo Personalizza (Figura 349). Fate clic su Importa.

5) Nella finestra di dialogo Aggiungi comandi (Figura 348), selezionate Documenti nell'elenco 
Categorie, poi selezionate Invia fax predefinito nell'elenco Comandi. Fate clic su 
Aggiungi. A questo punto è possibile vedere la nuova icona nell'elenco dei comandi.

6) Nell'elenco dei Comandi, fate clic sui pulsanti freccia su o giù per scegliere dove 
posizionare la nuova icona. Fate clic su OK e poi su Chiudi.
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Figura 351: impostare LibreOffice per l'invio di fax

A questo punto sulla barra degli strumenti compare la nuova icona per inviare il documento 
corrente come fax.

Figura 352: aggiunta del comando Invia fax a una barra degli strumenti

Assegnare combinazioni di tasti

Oltre a utilizzare le combinazioni di tasti integrate (elencate nell'Appendice A), è possibile definirne 
di proprie. Potete assegnare combinazioni di tasti alle funzioni standard di LibreOffice oppure alle 
vostre macro e salvarle per l'utilizzo con l'intero pacchetto LibreOffice.
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Attenzione

Fate attenzione nel riassegnare i tasti di scelta rapida predefiniti del vostro sistema 
operativo o di LibreOffice. Molte assegnazioni di tasti sono scorciatoie 
universalmente riconosciute, come F1 per l'Aiuto, e ci si attende che producano 
sempre determinati risultati. Sebbene sia semplice riportare le assegnazioni di tasti 
di scelta rapida a quelle predefinite di LibreOffice, modificare alcune combinazioni 
di tasti comuni può provocare confusione, specialmente se condividete il vostro 
computer con altri utenti.

Per adattare le combinazioni di tasti alle vostre esigenze, usate la finestra di dialogo Personalizza, 
come descritto di seguito.

1) Selezionate Strumenti > Personalizza > Tastiera. Si apre la finestra di dialogo 
Personalizza

2) Per avere a disposizione l'assegnazione di una combinazione di tasti in tutti i componenti di 
LibreOffice selezionate il pulsante di opzione LibreOffice.

3) Poi selezionate la funzione richiesta dagli elenchi Categoria e Funzione.

4) Ora selezionate la combinazione di tasti desiderata nell'elenco Tasti di scelta rapida e fate 
clic sul pulsante Cambia in alto a destra.

5) Fate clic su OK per accettare la modifica. A questo punto la combinazione di tasti scelta 
eseguirà la funzione scelta nel passo 3 descritto sopra, ogni qualvolta verrà premuta.

Nota

Tutte le combinazioni di tasti esistenti per la Funzione selezionata sono elencati nel 
riquadro di selezione Tasti. Se l'elenco Tasti è vuoto, vuol dire che la combinazione 
di tasti scelta è libera e può essere utilizzata. Se così non fosse, e desiderate 
riassegnare una combinazione di tasti di scelta rapida già in uso, dovete prima 
eliminare la combinazione di tasti esistente.

Le combinazioni di tasti che appaiono marcate in grigio nell'elenco della finestra di 
dialogo Personalizza, come F1 e F10,non possono essere riassegnate.

Esempio: assegnare gli stili a delle combinazioni di tasti
È possibile configurare delle combinazioni di tasti per assegnare rapidamente gli stili in un 
documento. Alcune combinazioni di tasti sono predefinite, come Ctrl+0 per lo stile di paragrafo 
Corpo del testo, Ctrl+1 per lo stile Intestazione 1, e Ctrl+2 per Intestazione 2. È possibile 
modificare i tasti assegnati e crearne di nuovi.

1) Fate clic su Strumenti > Personalizza> Tastiera. Si aprirà la pagina Tastiera della finestra 
di dialogo Personalizza.
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Figura 353: definire combinazioni di tasti per applicare gli stili

2) Per disporre dell'assegnazione di una combinazione di tasti per un solo componente (ad 
esempio Writer), selezionate il nome di quel componente nell'angolo in alto a destra della 
pagina; oppure selezionate LibreOffice per renderlo disponibile per tutti i componenti.

3) Scegliete la combinazione di tasti a cui volete assegnare uno stile. In questo esempio si è 
scelto Ctrl+9. Si attiva così il pulsante Cambia.

4) Nella sezione Funzioni nella parte bassa della finestra di dialogo, scorrete l'elenco 
Categoria fino alla voce Stili. Fate clic sul simbolo di espansione (di solito un segno + o un 
triangolo) per espandere l'elenco degli stili.

5) Scegliete la categoria di stile (questo esempio utilizza uno stile di paragrafo, ma potete 
anche scegliere uno stile di carattere o altro). L'elenco Funzione visualizzerà i nomi degli 
stili disponibili per la categoria selezionata. L'esempio mostra alcuni degli stili predefiniti di 
LibreOffice.

6) Per assegnare Ctrl+9 come combinazione di tasti per lo stile Elenco 1, selezionate Elenco 
1 nell'elenco Funzione, e poi fate clic su Cambia. Ctrl+9 compare ora nell'elenco Tasti sulla 
destra, e Elenco 1 compare accanto a Ctrl+9 nel riquadro in alto Tasti di scelta rapida.

7) Eseguite tutte le modifiche desiderate e poi fate clic su OK per salvare le nuove 
impostazioni e chiudere la finestra.
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Salvare le modifiche in un file
Potete salvare le modifiche alle assegnazioni delle combinazioni di tasti in un file di configurazione 
tasti per utilizzarlo in un secondo momento, permettendovi così di creare e applicare diverse 
configurazioni a seconda delle necessità. Per salvare le combinazioni di tasti in un file:

1) Dopo aver assegnato le vostre combinazioni di tasti, fate clic sul pulsante Salva, sul lato 
destro della finestra di dialogo Personalizza (Figura 353).

2) Nella finestra di dialogo Salva configurazione della tastiera, selezionate Tutti i file 
dall'elenco Salva come tipo.

3) Successivamente inserite un nome per il file di configurazione nel riquadro Nome file, 
oppure selezionate un file esistente dalla lista. Se necessario, sfogliate per trovare un file in 
un'altra posizione.

4) Fate clic su Salva. Se state per sovrascrivere un file esistente comparirà una finestra di 
conferma, altrimenti il file verrà salvato senza alcuna richiesta di conferma.

Caricare una configurazione di tasti salvata
Per caricare un file di configurazione tasti salvato e sostituire la configurazione esistente, fate clic 
sul pulsante Carica che si trova nella parte destra della finestra di dialogo Personalizza, poi 
selezionate il file di configurazione dalla finestra di dialogo Carica configurazione della tastiera.

Ripristino dei tasti di scelta rapida
Per ripristinare tutti i valori predefiniti delle combinazioni di tasti, fate clic sul pulsante Ripristina, 
sul lato destro della finestra di dialogo Personalizza. Fate attenzione nell'utilizzare questa 
funzionalità, in quanto non verrà visualizzato alcun messaggio di conferma; i valori predefiniti 
verranno impostati senza ulteriori notifiche o azioni da parte dell'utente.

Assegnare macro agli eventi

In LibreOffice, quando accade qualcosa, si dice che è accaduto un evento. Ad esempio, l'apertura 
di un documento, la pressione di un tasto, o il movimento del puntatore del mouse. È possibile 
associare una macro a un evento, in modo che la macro venga eseguita quando accade un 
evento. È uso comune assegnare l'evento “apri documento” all'esecuzione di una macro che 
effettua determinate funzioni d'impostazione per il documento.

Per associare una macro a un evento, utilizzate la scheda Eventi della finestra di dialogo 
Personalizza. Per maggiori informazioni, consultate il Capitolo 13 (Introduzione alle macro).

Aggiunta di funzioni con le estensioni

Un'estensione è un pacchetto che può essere installato all'interno di LibreOffice per aggiungere 
nuove funzionalità.

LibreOffice viene fornito con diverse estensioni già incorporate. Altre possono essere scaricate da 
vari siti web. L'archivio ufficiale delle estensioni si trova all'indirizzo 
http://extensions.libreoffice.org/. Queste estensioni sono gratuite.

Alcune estensioni da altri siti sono gratuite; altre sono soggette al pagamento di un contributo. 
Consultate la descrizione per sapere quali licenze e contributi si applicano a quelle che sono di 
vostro interesse.
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Installazione delle estensioni
Per installare una estensione, seguite questi passaggi:

1) Scaricate l'estensione e salvatela sul vostro computer.

2) In LibreOffice, selezionate Strumenti > Gestione Estensioni dalla barra dei menu. Nella 
finestra di dialogo Gestione estensioni fate clic su Aggiungi.

3) Si aprirà una finestra di esplorazione file. Trovate e selezionate l'estensione che volete 
installare e fate clic su Apri. Si avvierà l'installazione dell'applicazione. È possibile che vi 
venga richiesto di accettare un contratto di licenza.

4) Quando l'installazione è completa, l'estensione compare nell'elenco della finestra di dialogo 
Gestione estensioni.

Suggerimento
Per scaricare le estensioni presenti nell'archivio, potete aprire il Gestore 
estensioni e fare clic sul collegamento Ulteriori estensioni in linea link.

Nota
Per installare un'estensione condivisa, è necessario avere accesso in scrittura alla 
cartella d'installazione di LibreOffice.

Figura 354: uso del Gestore estensioni
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Appendice A  
Tasti di scelta rapida



Introduzione

È possibile utilizzare LibreOffice senza un dispositivo di puntamento, come un mouse o un 
touchpad, utilizzando i tasti di scelta rapida integrati.

Questa appendice elenca alcune delle più comuni combinazioni di tasti di scelta rapida già 
integrate, che si applicano a tutti i componenti di LibreOffice. Per le combinazioni di tasti specifiche 
per Writer, Calc, Impress, Draw, o Base, leggete la guida del rispettivo componente, o cercate 
l'Aiuto dell'applicazione.

Nota

Alcune combinazioni di tasti qui elencate potrebbero non funzionare se il vostro 
sistema operativo usa le stesse combinazioni per altri compiti.

Per risolvere eventuali conflitti, assegnate tasti differenti a queste combinazioni, 
riconfigurando LibreOffice (vedere il Capitolo 14) o il vostro sistema operativo 
(vedere la documentazione del sistema).

Suggerimento per gli utenti Macintosh
Alcuni tasti su un Mac sono diversi da quelli utilizzati in ambiente Windows e Linux. La tabella 
seguente fornisce alcune sostituzioni comuni per le istruzioni di questo capitolo. Per un elenco più 
dettagliato, vedere la Guida in linea dell'applicazione.

Windows o Linux Equivalente su Mac Effetto

Pulsante destro del 
mouse

Ctrl+clic Apre un menu contestuale

Ctrl (Control) ⌘ (Comando) Usato con altri tasti

F5 Maiusc+⌘+F5 Apre il Navigatore

F11 ⌘+T Apre la finestra Stili e Formattazione.
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Tasti di scelta rapida generali

Apertura dei menu e delle voci di menu

Tasti di scelta rapida Risultato

Alt+<?>
Apre un menu, dove <?> è il carattere sottolineato del menu che 
volete aprire. Ad esempio, Alt+M apre il menu Modifica.

Alt+<?>+<*>

Apre una voce di menu, dove <?> è il carattere sottolineato del 
menu che volete aprire e <*> è la voce all'interno del menu. Ad 
esempio, Alt+I+S apre la voce di menu Carattere speciale nel menu 
Inserisci.

Esc Chiude un menu aperto.

Controlli nelle finestre di dialogo
Quando aprite una qualsiasi finestra di dialogo, un elemento (come un pulsante, un campo di 
opzione, una voce in una casella di riepilogo, o una casella di controllo) è evidenziato o indicato 
con un riquadro tratteggiato intorno al campo o al nome del pulsante. Si dice che l'elemento è a 
fuoco.

Tasti di scelta rapida Risultato

Invio Attiva il pulsante selezionato. Nella maggior parte dei casi in cui 
nessun pulsante è selezionato, Invio equivale al clic su OK.

Esc

Chiude la finestra di dialogo senza salvare le modifiche effettuate 
mentre la finestra era aperta. Nella maggior parte dei casi, Esc 
equivale al clic su Annulla. Quando è selezionato un elenco a 
comparsa aperto, Esc chiude l'elenco.

Barra spaziatrice Inserisce la spunta su una casella di controllo vuota. Elimina la 
spunta da una casella di controllo selezionata.

Tasti freccia su e giù
Sposta il fuoco su e giù in un elenco. Aumenta o diminuisce il valore 
di una variabile. Sposta il fuoco verticalmente all'interno di una 
sezione di una finestra di dialogo.

Tasti freccia sinistra e 
destra

Sposta il fuoco orizzontalmente all'interno di una sezione di una 
finestra di dialogo.

Tab
Fa avanzare il fuoco alla sezione o all'elemento successivo di una 
finestra di dialogo.

Maiusc+Tab
Riporta il fuoco alla sezione o elemento precedente nella finestra di 
dialogo.

Alt+Freccia giù Mostra gli elementi in un elenco a comparsa.
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Ottenere aiuto

Tasti di scelta rapida Risultato

F1
Apre la finestra di dialogo Guida di LibreOffice. Nella Guida di 
LibreOffice: passa alla prima pagina di aiuto della scheda 
selezionata.

Maiusc+F1
Trasforma il cursore nel punto interrogativo Cos'è questo?. Mostra il 
suggerimento per l'elemento sotto il cursore.

Maiusc+F2 Mostra il suggerimento per l'elemento selezionato.

Esc Nella Guida di LibreOffice: va su di un livello.

Gestione dei documenti

Tasti di scelta rapida Risultato

Ctrl+F4 o Alt+F4
Chiude il documento corrente. Chiude LibreOffice quando viene 
chiuso l'ultimo documento aperto.

Ctrl+O Avvia la finestra di dialogo Apri per aprire un documento.

Ctrl+S
Salva il documento corrente. Se state lavorando su un file 
precedentemente non salvato, la scelta rapida avvia la finestra di 
dialogo Salva con nome.

Ctrl+N Crea un nuovo documento.

Maiusc+Ctrl+N Apre la finestra di dialogo Modelli e documenti.

Ctrl+P Apre la finestra di dialogo Stampa per stampare un documento.

Ctrl+Q Chiude l'applicazione.

Canc
Nelle finestre di dialogo Salva e Apri, elimina le cartelle o i file 
selezionati. Gli elementi possono essere recuperati dal Cestino.

Maiusc+Canc
Nelle finestre di dialogo Salva e Apri, elimina le cartelle o i file 
selezionati. Gli elementi vengono eliminati in modo permanente: 
essi non possono essere recuperati dal Cestino.

Backspace
Nelle finestre di dialogo Salva e Apri, mostra i contenuti della 
cartella superiore della cartella corrente.

Navigare in LibreOffice

Tasti di scelta rapida Risultato

F6 Seleziona la parte successiva della finestra (ad esempio: Barra dei 
menu, Barra degli strumenti Standard, vista documento, e così via).

Maiusc+F6 Seleziona la parte precedente della finestra.

F10 Seleziona il primo menu, normalmente il menu File.

Maiusc+F10 Apre il menu contestuale.
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Modifica

Tasti di scelta rapida Risultato

Ctrl+X Taglia gli elementi selezionati.

Ctrl+C Copia gli elementi selezionati.

Ctrl+V Incolla dagli appunti gli elementi copiati o tagliati.

Ctrl+Maiusc+V Apre la finestra di dialogo Incolla speciale.

Ctrl+A Seleziona tutto.

Ctrl+Z Annulla l'ultima operazione.

Ctrl+Y Ripristina l'ultima operazione.

Ctrl+Maiusc+Y Ripete l'ultimo comando.

Ctrl+F Apre la finestra di dialogo Cerca e sostituisci

Ctrl+Maiusc+F Esegue una ricerca per l'ultimo termine inserito nel riquadro di 
ricerca.

Ctrl+Maiusc+R Aggiorna la vista del documento.

Ctrl+Maiusc+I Mostra o nasconde il cursore nel testo in sola lettura.

Arrestare le macro

Tasti di scelta rapida Risultato

Maiusc+Ctrl+Q Ferma una macro in esecuzione.

Definire i tasti di scelta rapida

In aggiunta ai tasti di scelta rapida integrati elencati in questa Appendice, potete definire le vostre 
scorciatoie personalizzate. Vedere il Capitolo 14 (Personalizzare LibreOffice) per i dettagli.

Ulteriori letture

Per avere informazioni sui tasti di scelta rapida di LibreOffice, o sull'utilizzo di LibreOffice solo con 
la tastiera, effettuate una ricerca nella guida in linea, utilizzando parole chiave come “scorciatoia” 
oppure "accessibilità”.
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Introduzione

LibreOffice è una suite di produttività compatibile con altre suite per ufficio e disponibile su diverse 
piattaforme. È un software open source, quindi scaricabile gratuitamente, liberamente utilizzabile e 
distribuibile. Se ancora non conoscete LibreOffice, questa appendice vi darà alcune informazioni 
riguardanti la sua storia, la sua comunità e alcune delle sue specifiche tecniche.

Breve storia di LibreOffice

Il progetto OpenOffice.org è iniziato quando Sun Microsystems ha rilasciato il codice sorgente 
(“blueprint”) del suo software StarOffice® alla comunità open-source, il 13 Ottobre del 2000. La 
versione 1.0 di OpenOffice.org venne rilasciata il 30 Aprile 2002. I più importanti aggiornamenti di 
OpenOffice.org includono la versione 2.0 dell'ottobre 2005 e la versione 3.0 dell'ottobre 2008. Il 26 
gennaio 2010 Oracle Corporation ha acquisito Sun Microsystems.

Il 28 settembre 2010 la comunità di volontari che ha sviluppato e promosso OpenOffice.org ha 
annunciato un grande cambiamento nella struttura del progetto. Dopo dieci anni di fortunata 
crescita con Sun Microsystems come sponsor principale e fondatore, il progetto ha promosso una 
fondazione indipendente chiamata The Document Foundation, per realizzare la promessa di 
indipendenza scritta nell'atto costitutivo originale. Questa fondazione è la prima pietra di un nuovo 
ecosistema dove individui e organizzazioni possono contribuire alla disponibilità di una suite per 
ufficio realmente libera, nonché beneficiarne.

Impossibilitata ad acquisire il marchio registrato OpenOffice.org dalla Oracle Corporation, The 
Document Foundation ha chiamato il proprio prodotto LibreOffice. Continuando i numeri di 
versione utilizzati da OpenOffice.org, LibreOffice 3.3 è stato rilasciato nel gennaio 2011.

Nel febbraio 2012 The Document Foundation è stata registrata a Berlino come Stiftung 
(Fondazione tedesca). Ulteriori informazioni su The Document Foundation sono reperibili 
all'indirizzo: http://www.documentfoundation.org/

La comunità di LibreOffice

La missione di The Document Foundation consiste nel:

“...facilitare l'evoluzione della Comunità di OpenOffice.org in una nuova struttura organizzativa 
aperta, indipendente e meritocratica entro i prossimi mesi. Una fondazione indipendente 
corrisponde pienamente ai valori dei nostri collaboratori, dei nostri utenti e dei nostri sostenitori, 
e renderà possibile una Comunità più efficace, efficiente, trasparente e inclusiva. Tuteleremo 
gli investimenti passati costruendo sui solidi risultati ottenuti nella prima decade, 
incoraggeremo un'ampia partecipazione nella Comunità, e coordineremo le attività all'interno 
della stessa.”

Tra i nostri supporter aziendali vi sono Canonical, The GNOME Foundation, Google, Novell e Red 
Hat. Inoltre, più di 450.000 persone da ogni angolo della terra si sono unite al progetto, al fine di 
creare la miglior suite per ufficio che chiunque possa utilizzare. Questa è l'essenza della comunità 
“open-source”!

Con la sua licenza di software open source, LibreOffice è uno strumento essenziale per fornire una 
suite per ufficio disponibile per chiunque, in ogni dove, per uso commerciale o personale. Il 
software è stato tradotto in molte lingue e funziona su tutti i maggiori sistemi operativi. È possibile 
aggiungere nuove funzionalità tramite le estensioni.

La comunità di LibreOffice invita collaboratori in tutti i settori, inclusi traduttori, sviluppatori di 
software, artisti grafici, scrittori tecnici, revisori, donatori e persone in grado di aiutare gli utenti 
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finali. Qualsiasi cosa sappiate fare bene, potete fare la differenza in LibreOffice. La Comunità 
opera a livello internazionale in tutte le aree geografiche e in molte lingue, collegata tramite 
internet ai siti www.libreoffice.org e www.documentfoundation.org.

Licenza di LibreOffice

LibreOffice è distribuito sotto la Lesser General Public License (LGPL), approvata dall'Open 
Source Initiative (OSI).

La licenza LGPL è consultabile sul sito web di LibreOffice all'indirizzo: 
http://www.libreoffice.org/download/license/ 

Che cos'è l'“open source"?

I quattro diritti fondamentali del software open-source sono inseriti nella General Public License 
(GPL) della Free Software Foundation:

• Diritto a utilizzare il software per qualsiasi scopo.

• Libertà di ridistribuire il software gratuitamente o dietro compenso.

• Accesso al codice sorgente completo del programma (ossia i “blueprint”).

• Diritto di modificare qualsiasi parte del codice sorgente o usarne delle parti in altri 
programmi.

La filosofia alla base dell'open source è molto semplice: se i programmatori possono leggere, 
ridistribuire e modificare il codice sorgente di un software, quel software evolve. Alcuni lo 
migliorano, altri lo adattano, altri ancora correggono gli errori.

Per ulteriori informazioni sul software Free e Open Source, visitate questi siti web:

Open Source Initiative (OSI): http://www.opensource.org

Free Software Foundation (FSF): http://www.gnu.org

Cosa sono gli “standard aperti”?

Uno standard aperto offre il mezzo per fare qualcosa indipendentemente dal produttore o dal 
venditore, rendendo così possibile per programmi software, tra loro concorrenti, il libero utilizzo 
degli stessi formati di file. HTML, XML, e ODF sono esempi di standard aperti per i documenti.

Uno standard aperto soddisfa i seguenti requisiti:

• È ben documentato, con le specifiche complete pubblicamente disponibili, gratuitamente o 
pagando un importo minimo.

• Può essere copiato, distribuito e utilizzato liberamente. La proprietà intellettuale dello 
standard è resa irrevocabilmente disponibile su base royalty-free.

• È standardizzato e mantenuto in un forum indipendente e aperto (anche detto 
"organizzazione per gli standard"), tramite un processo aperto.
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Che cos'è il formato OpenDocument?

OpenDocument (ODF) è un formato di file basato su XML per documenti d'ufficio (documenti di 
testo, fogli elettronici, disegni, presentazioni e altro ancora), sviluppato in OASIS (http://www.oasis-
open.org/who/), un gruppo internazionale indipendente per la creazione di standard. 

Diversamente da altri formati di file, ODF è uno standard aperto. Le sue specifiche sono 
pubblicamente disponibili, esenti da diritti d'autore, e senza restrizioni legali o di altro tipo; i file 
ODF non sono quindi legati a una specifica suite per ufficio e chiunque può creare un programma 
che interpreta questi file. Per questo motivo, ODF è diventato rapidamente il formato di file 
preferito per agenzie governative, scuole e altre società che preferiscono non dipendere da un 
particolare fornitore di software.

Dalla versione 2.0, OpenOffice.org ha sostenuto lo standard aperto OASIS OpenDocument come 
proprio formato di file predefinito. LibreOffice, per impostazione predefinita, salva i documenti nel 
formato OpenDocument. LibreOffice 3 ha adottato la versione 1.2 dello standard OpenDocument. 
LibreOffice può anche aprire e salvare molti altri formati di file; vedere “Formati di file che possono 
essere elaborati da LibreOffice” in questa pagina, “Formati di file che possono essere scritti da 
LibreOffice” a pagina 430, e “Esportazione in altri formati” a pagina 432.

Estensioni dei nomi di file OpenDocument
Le estensioni più comuni dei nomi di file usate per i documenti OpenDocument sono:

*.odt per i documenti di testo

*.ods per i fogli elettronici

*.odp per le presentazioni

*.odb per i database

*.odg per le immagini (disegni vettoriali)

*.odf per le formule (equazioni matematiche)

Formati di file che possono essere elaborati da LibreOffice

LibreOffice può aprire un'ampia varietà di formati, in aggiunta a quelli OpenDocument, inclusi 
Portable Document Format (PDF), se un file ODF è incorporato nel PDF (vedere il Capitolo 10 per 
maggiori informazioni).

Apertura dei documenti di testo
Oltre ai formati OpenDocument (.odt, .ott, .oth, .odm, e .fodt), con Writer 3 è possibile aprire i 
formati usati da OpenOffice.org 1.x (.sxw, .stw, e .sxg) e i seguenti formati di documenti di testo:

Microsoft Word 6.0/95/97/2000/XP) (.doc e .dot)
Microsoft Word 2003 XML (.xml)
Microsoft Word 2007/2010 XML (.docx, .docm, .dotx, .dotm)
Microsoft WinWord 5 (.doc)
Documento WordPerfect (.wpd)
Microsoft Works (.wps)
Lotus WordPro (.lwp)
Rich Text Format (.rtf)
Testo CSV (.csv e .txt)
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Formati StarWriter (.sdw, .sgl, .vor)
DocBook (.xml)
Testo Unified Office Format (.uot, .uof)
Ichitaro 8/9/10/11 (.jtd e .jtt)
Hangul WP 97 (.hwp)
Documento T602 (.602, .txt)
AportisDoc (Palm) (.pdb)
Pocket Word (.psw)
Documento HTML (.htm, .html)

La maggior parte di questi tipi di file è riconosciuta automaticamente da LibreOffice, quindi può 
essere aperta senza dover esplicitamente selezionare il tipo di documento nella finestra di apertura 
file.

Quando si aprono file .htm o .html (usati per le pagine web), LibreOffice adatta Writer per lavorare 
con questi file.

Apertura dei fogli elettronici
Oltre ai formati OpenDocument (.ods, .ots, e .fods), con Calc 3 è possibile aprire i formati usati da 
OpenOffice.org 1.x (.sxc e .stc) e i seguenti formati di foglio elettronico:

Microsoft Excel 97/2000/XP (.xls, .xlw, e .xlt)
Microsoft Excel 4.x–5.0/95 (.xls, .xlw, e .xlt)
Microsoft Excel 2003 XML (.xml)
Microsoft Excel 2007/2010 XML (.xlsx, .xlsm, .xlts, .xltm)
Documento binario Microsoft Excel 2007/2010 (.xlsb)
Lotus 1-2-3 (.wk1, .wks, e .123)
Data Interchange Format (.dif)
Rich Text Format (.rtf)
Testo CSV (.csv e .txt)
Formati StarCalc (.sdc e .vor)
dBASE (.dbf)
SYLK (.slk)
Fogli elettronici Unified Office Format (.uos, .uof)
Documento HTML (file .htm e .html, incluse le pagine web di ricerca)
Pocket Excel (pxl)
Quattro Pro 6.0 (.wb2)

Apertura delle presentazioni
Oltre ai formati OpenDocument (.odp, .odg, .otp, e .fopd), con Impress 3 è possibile aprire i formati 
usati da OpenOffice.org 1.x (.sxi e .sti) e i seguenti formati di presentazione:

Microsoft PowerPoint 97/2000/XP (.ppt e .pot)
Microsoft PowerPoint 2007/2010 (.pptx, .pptm, .potx, .potm)
StarDraw e StarImpress (.sda, .sdd, .sdp, e .vor)
Presentazione Unified Office Format (.uop, .uof)
CGM – Computer Graphics Metafile (.cgm)
Portable Document Format (.pdf)

Apertura dei file immagine
Oltre ai formati OpenDocument (.odg e .otg), con Draw 3 è possibile aprire i formati usati da 
OpenOffice.org 1.x (.sxd e .std) e i seguenti formati di immagine:

BMP JPEG, JPG PCX PSD SGV WMF

Appendice B  Open Source, standard aperti e OpenDocument 429



DXF MET PGM RAS SVM XBM
EMF PBM PLT SDA TGA XPM
EPS PCD PNG SDD TIF, TIFF
GIF PCT PPM SGF VOR

Apertura delle formule
Oltre ai formati dei file OpenDocument Formula (.odf), con Math 3 è possibile aprire i formati dei 
file usati da OpenOffice.org 1.x (.sxm), StarMath, (.smf), e MathML (.mml).

Se all'apertura di un documento Word che incorpora un oggetto di equazione nell'editor, l'opzione 
di riferimento (da MathType a LibreOffice Math o viceversa) è selezionata in Strumenti > Opzioni 
> Carica/Salva > Microsoft Office, l'oggetto sarà automaticamente convertito in oggetto di 
LibreOffice Math.

Formati di file che possono essere scritti da LibreOffice

Il salvataggio del file in formato OpenDocument garantisce la corretta visualizzazione del file 
quando viene dato a un'altra persona o quando il file viene riaperto con una versione più recente di 
LibreOffice o con un altro programma. Si consiglia caldamente l'utilizzo di OpenDocument come 
formato di file predefinito. Comunque, se lo desiderate, potete salvare i file in altri formati.

Suggerimento

Quando volete distribuire un documento che non deve essere modificato, o non 
volete che sia modificato, l'opzione più sicura è quella di convertire il documento 
in formato PDF. LibreOffice consente di convertire i documenti in PDF in maniera 
molto semplice. Vedere il Capitolo 10 (Stampa, esportazione e invio di e-mail) in 
questa guida.

Salvataggio dei documenti di testo
Oltre ai formati OpenDocument (.odt, .ott, e .fodt), Writer 3 può salvare nei seguenti formati:

Documento di testo OpenOffice.org 1.x (.sxw)
Modello di Documento di Testo OpenOffice.org 1.x (.stw)
Microsoft Word 6.0, 95, e 97/2000/XP (.doc)
Microsoft Word 2003 XML (.xml)
Microsoft Word 2007/2010 XML (.docx)
Testo Office Open XML (.docx)
Rich Text Format (.rtf)
StarWriter 3.0, 4.0, e 5.0 (.sdw)
Modello StarWriter 3.0, 4.0, e 5.0 (.vor)
Testo (.txt)
Testo codificato (.txt)
Testo Unified Office Format (.uot, .uof)
Documento HTML (OpenOffice.org Writer) (.html e .htm)
DocBook (.xml)
AportisDoc (Palm) (.pdb)
Pocket Word (.psw)

Il supporto alla cifratura nel filtro Microsoft Word 97/2000/XP consente il salvataggio di documenti 
Microsoft Word protetti da password.
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Nota
Il formato .rtf è un formato comunemente usato per il trasferimento di file di testo tra 
le applicazioni, tuttavia potrebbe verificarsi una perdita di formattazione e di 
immagini. Di conseguenza è preferibile usare altri formati.

Salvataggio dei fogli elettronici
Oltre ai formati OpenDocument (.ods e .ots), Calc 3 può salvare nei seguenti formati:

Fogli elettronici OpenOffice.org 1.x (.sxc)
Modello di foglio elettronico OpenOffice.org 1.x (.stc)
Microsoft Excel 97/2000/XP (.xls e .xlw)
Modello di documento Microsoft Excel 97/2000/XP (.xlt)
Microsoft Excel 5.0 e 95 (.xls e .xlw)
Microsoft Excel 2003 XML (.xml)
Microsoft Excel 2007/2010 XML (.xlsx)
Foglio elettronico Office Open XML (.xlsx)
Data Interchange Format (.dif)
dBase (.dbf)
SYLK (.slk)
Testo CSV (.csv e .txt)
Formati StarCalc 3.0, 4.0, e 5.0 (.sdc e .vor)
Foglio elettronico Unified Office Format (.uos)
Documento HTML (OpenOffice.org Calc) (.html e .htm)
Pocket Excel (.pxl)

Nota
Per utilizzare i filtri dei dispositivi mobili per AportisDoc (Palm), Pocket Word e 
Pocket Excel è necessario il Java Runtime Environment.

Salvataggio delle presentazioni
Oltre ai formati OpenDocument (.odp, .otp, .fodp, e .odg), Impress 3 può salvare nei seguenti 
formati:

Presentazione OpenOffice.org 1.x (.sxi)
Modello di Presentazione OpenOffice.org 1.x (.sti)
Microsoft PowerPoint 97/2000/XP (.ppt)
Modello di documento Microsoft PowerPoint 97/2000/XP (.pot)
Microsoft PowerPoint 2007/2010 XML (.pptx, .potm)
Presentazione Office Open XML (.pptx, .potm, .ppsx)
StarDraw, StarImpress (.sda, .sdd, e .vor)
Presentazione Unified Office Format (.uop)

Con Impress è possibile inoltre esportare in MacroMedia Flash (.swf) e in un qualsiasi formato 
grafico elencato per Draw.

Salvataggio dei disegni
Draw 3 può salvare solo nei formati di Disegno OpenDocument (.odg e .otg), nei formati 
OpenOffice.org 1.x (.sxd e .std) e nel formato StarDraw (.sda, .sdd e .vor).

Tuttavia Draw può anche esportare nei formati BMP, EMF, EPS, GIF, JPEG, MET, PBM, PCT, 
PGM, PNG, PPM, RAS, SVG, SVM, TIFF, WMF e XPM.
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Writer/Web può salvare nei seguenti formati di file
Documento HTML (.html e .htm), come HTML 4.0 Transitional

Modello di documento OpenOffice.org 1.0 HTML (.stw)

Modello di documento OpenOffice.org 2.x HTML (.oth)

StarWriter/Web 4.0 e 5.0 (.vor)

Testo (LibreOffice Writer/Web) (.txt)

Testo codificato (LibreOffice Writer/Web) (.txt)

Esportazione in altri formati

LibreOffice usa il termine “esporta” per alcune operazioni sui file che comportano una modifica del 
tipo di file. Se non riuscite a trovare il tipo di file che state cercando sotto Salva con nome, 
guardate sotto Esporta per ulteriori tipi di file.

LibreOffice può esportare file in XHTML. Inoltre, Draw e Impress possono esportare in Adobe 
Flash (.swf) e in diversi altri formati immagine.

Per eseguire un'esportazione in uno di questi formati, scegliete File > Esporta. Nella finestra di 
dialogo Esporta, specificate un nome file per il documento che state esportando, poi selezionate il 
formato desiderato nell'elenco Formato file e fate clic sul pulsante Esporta.
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Fontwork  358
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barre strumenti mobili  24
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BitTorrent  20
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buste  
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Formattazione automatica  156
modifica dei dati  150
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Navigatore  131
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schede dei fogli  127
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Writer  90
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eliminare  353
categorie  351
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chiusura di LibreOffice  35
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collegamenti ipertestuali  
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modificare  370
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salvare in un file  416
tasti funzione  423
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75
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strumento riempimento  146
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creare  248
creazione delle tabelle  249
Creazione guidata rapporto  289
Creazione guidata tabella  250
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pianificare  247
registrazione  272
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Caricamento dei campi uniti  260
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Digitazione automatica  146
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disegnare  

frecce blocchi  223
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aggiungere da file  346
collegamento  347

dispatch helper  387
Disposizione testo complesso (CTL)  19, 60
dividere un documento in capitoli  87
dizionari, installazione  59
dizionario  103
dizionario personalizzato  61
Documentazione  11
documenti di testo  

apertura  428
documento  
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aprire un nuovo  27
chiudere  34
creare  27
Creazione da modello  75

Draw  242
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drawing  
banner  224
connettori  221
curva  218
frecce  216
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L'esportazione nel formato HTML  242
poligono  218
rettangoli  217
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tridimensionali (3D)  241
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e-mailing  
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 a diversi destinatari  339

editor di equazioni  294
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istruzioni testuali per le matrici  305
layout delle formule  304
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elenchi di selezione, Calc  149
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eliminazione di file  30
eliminazione effetto scalettatura (antialiasing)  42
equation editor  

dimensione del carattere  310
finestra Elementi  297
istruzioni testuali  300
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numerazione  313

equazioni matematiche e chimiche  294
errori di digitazione, correzione automatica  146
esporta direttamente come file PDF  333
esporta HTML  58
esportare  
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esportare pagina web  

documenti Writer  371, 372
Procedura guidata per la realizzazione di pagine 
web (Writer)  372

esportazione HTML  58
Esportazione in Flash  376
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estensione  

Report Builder  292
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fonti per  20
exporting  
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PDF  333

F  
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Calc  124
Impress  170
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segnalibri  120

file CSV  128, 129
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apertura  429
salvataggio  431
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filtrare le celle visibili, Calc  159
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finestra di dialogo Gestione dei modelli  73
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apertura  429
definizione  124
salvataggio  431
salvataggio come CSV  129
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inserire  137
rinomina  140
selezionare  135
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barra degli strumenti  358
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barra degli strumenti Formattazione  361
creare un oggetto  359
Galleria  359
lettere della stessa altezza  360
modificare un oggetto  360
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raggruppamento  363
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Formato OpenDocument  55
Formato OpenDocument   20
formattare le pagine  110
Formattazione automatica, Calc  156
formattazione condizionale  157
formattazione, Calc  
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formatting, Calc  

Formattazione automatica  156
temi  157
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inserimento dati  277
modifica  262
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formule chimiche  319
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framework dei comandi  392
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Free Software Foundation (FSF)  427
funzione del tasto medio del mouse  43
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aggiungere oggetti  351
apertura  349
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viste (icona/dettagli)  351
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GNU/Linux  

requisiti di sistema  20
gradienti dinamici  237
grafica raster  241
grafica vettoriale  208
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Help Agent  39

I  
i suggerimenti  185
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icone della barra degli strumenti (macro)  399
icone di navigazione  94
icone nei menu  42
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HTML  58
Il Ripristino Automatico  55
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acquisite da uno scanner  349
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collegamento  347
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immagini EPS in PDF  334
importazione dei file  428
importazione di numeri da una pagina HTML  58
impostazioni della stampante  54
impostazioni lingua  59
impostazioni locali  59
impostazioni personalizzate  54
Impress  
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indicatore delle modifiche non salvate  91
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indici analitici e bibliografie  117
inserimento dati, Calc  

condividere contenuto  150

Validare il contenuto di una cella  150
velocizzare  146

Inserisci segnalibro  121
installazione e impostazioni di  20
interfaccia utente  42
interruzione di pagina, Calc  165
intestazione  

differenze nelle pagine destre e sinistre  87
intestazioni e piè di pagina, Calc  166
invio documenti come e-mail  339
invio tramite e-mail  

Documenti di Writer come allegati  339
istruzioni testuali matematiche  300
istruzioni testuali per le matrici (Math)  305
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Java  52
Java Runtime Environment (JRE)  246
JRE (Java Runtime Environment)  20, 52

L  
La barra degli strumenti Stile e riempimento  212
layout delle formule  304
layout di pagina  110
Layout Web  371
LGPL  14
LibreOffice Basic  382
librerie delle macro  393
licenza di LibreOffice  13, 427
limiti per sommatorie e integrali  307
linee rosse  118
Linux  

Quickstart  22
requisiti di sistema  20

livello di struttura  191

M  
Mac OS X  

requisiti di sistema  20
macro  382

assegnare agli eventi  416
Calc  393
commenti  386
creare  388
eseguire  385, 398
gestione degli eventi  400
memorizzazione  395
registrazione  384
scaricare  398
scrittura  403
visualizzare  385
Voci di menu  399

macro di Calc  393
Macro LibreOffice Basic  384
Macromedia Flash  376
macros  

cartella di libreria  384
contenitori di libreria  393
DIM  387
dispatch helper  387
esempio complesso  388
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IDE  385, 391
modifica  385
moduli  393
modulo  384
Organizzazione delle macro  393
REM  386
risorse  403
subroutine  386, 393
variabili  387

Mantovani, Paolo  393
mappa immagine  354
marcatura di revisione  118
margini (Writer)  115
margini della pagina  210
margini di pagina  115
margini di testo (mostra/nascondi)  50
master di diapositiva  187, 196
memoria principale  40
memorizzare le modifiche  118
menu  

aggiungere comandi  408
creare  407
modifica  407
modificare le voci  409
personalizzazione  406

Menu contestuale  231
menu contestuali  26
menu contestuali (clic destro)  26
metodi per il layout  110
Microsoft Windows  

associazione dei file  21
Quickstart  21
requisiti di sistema  20

modalità di visualizzazione dei documenti  93
modelli  

importare  85
modello  

aggiornamento di stili di un documento a partire 
da un  78
associazione con un documento  83
cartelle  84
creazione da documento  76
creazione di un documento a partire da un  75
creazione tramite procedura guidata  77
descrizione  66
eliminare  85
esportare  85
modificare  78

modello predefinito  81
modifica dei dati, Calc  150

cambiare dati in una cella  151
eliminare dati da una cella  150
sostituire tutti i dati in una cella  151

modifica le proprietà prima di salvare  55
modifiche automatiche  146
modifiche, annulla e ripristina  33
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Calc  131
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nuovo documento  27
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raggruppamento  358

oggetti nascosti  225
Open Source Initiative (OSI)  427
opzione stato del documento  40
opzioni di caricamento e salvataggio  53
opzioni di condivisione file  48
opzioni di installazione  38
opzioni di sicurezza delle macro  49
opzioni E-mail  62
opzioni generali  39
Opzioni Internet  62
Opzioni per il controllo ortografico  61
opzioni stampa  

generale  44
ordinare i record, calc  159
orientamento della pagina  87
ottimizzazione dimensioni  56
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page layout  

orientamento  87
pagina orizzontale  87
prima pagina differente  86

Pagine Master  197
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parentesi (Math)  304
Parti dell'interfaccia utente  12
PDF  

cifratura  337
compressione e risoluzione dell'immagine  334
contrassegnati  334
esporta pagine vuote  335
esportare file in  333
immagine EPS  334
impostazioni di sicurezza  337
impostazioni interfaccia utente  336
incorpora caratteri standard  335
pagine da esportare  333
protezione con password  337
selezione visualizzazione iniziale  335
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 gestione dei diritti digitali (DRM)  337

PDF/A-1a  334



percorsi  45
Personalizza  399
personalizzazione  

barre degli strumenti  409
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posizionamento del mouse  43
posizione dei file  45
Powerpoint  
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presentation  
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presentazione  
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Presentazione guidata  181
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salvataggio  431
prima pagina differente  86
print preview  

Calc  332
Writer  332
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buste, etichette, biglietti da visita  331
Calc  327
depliant  329
libretto  329
righe o colonne in ogni pagina  164
stampati  329
Writer  326

procedura guidata  
rapporto (database)  289
ricerca (database)  280
tabella (database)  250
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procedura guidata di esportazione HTML  376
Procedura guidata Formulario  259
Procedura guidata rapporti (database)  289
proprietà VBA  56
protezione con password  29
Protezione dei PDF con password  337
punti della Griglia  234

Q  
queries (database)  

alias  286
Caricamento dei campi uniti  260
condizioni di ricerca  281

Quickstart  21
abilitare  41

R  
rapporti di database  

creare  287
relazioni (database)  256
REM  386
rettangolo, disegnare  217
RGB  213
ricerche (database)  

creare usando la Visualizzazione struttura  282
creazione usando la Procedura guidata   279

Riconosci URL  367
Riempimento  68

Riempimento, Calc  146
rientri  102
riferimenti incrociati  

inserimento di riferimenti  120
panoramica  120

righe, in Calc  
eliminare  137
fissare  141
inserire  136
selezionare  135

righelli  209
rimuovi le informazioni personali al salvataggio  49
rinomina dei file  30
ripristina modifica  34

S  
salva codice Basic originale  56
salva informazioni di Ripristino Automatico  55
Salvare URL relativi  55
salvataggio automatico  30
salvataggio dei file  29
salvataggio, versione del formato ODF  55
save as  

pagina web  371
scala (interfaccia utente)  42
scanner  349
scarica aggiornamenti automaticamente  52
schede dei fogli, Calc  127
schema colori  50
Schema di scrittura da destra a sinistra (RTL)  19
Sciogliere gruppi  240
scorciatoie da tastiera (macro)  399
scorciatoie dei tasti funzione  423
segnalibri  120
selecting  

elementi non consecutivi  96
porzione verticale di testo  97

selection, in Calc  
celle  134
colonne  135
fogli  135
righe  135

Selettore macro  398
sequenza di stili automatica  88
sicurezza  29, 48
sillabazione  

manuale  110
simboli matematici  296
sistema di aiuto  10
slide master  

applicare  198
creazione  197
informazioni sull'autore  201

slide show  
avanzi automaticamente  203
   203

sorgente dati  
collegamento  271
descrizione  246
modificare  273
registrazione  271



utilizzo nei documenti di LibreOffice  274
visualizzare  272

spazi non divisibili  101
spreadsheets  

il riferimento alla  130
navigare  130

stampa  
bianco e nero con una stampante a colori  331
Calc  161
Impress e Draw  328
interruzione di pagina, Calc  165
intestazioni e piè di pagina, Calc  166
note (Impress)  329
opzioni generali  324
ordine delle pagine, dettagli, scala, in Calc  162
orientamento della pagina  324
pagine multiple per foglio  325
selezione delle parti da stampare  326
sfumature di grigio su una stampante a colori  
331

stampa di buste  331
stampa di depliant  329
stampa di libretti  329
Stampa guidata in serie  

Invio di documenti Writer tramite posta elettronica 
339

stampa il file direttamente  322
stampa in serie  118
stili  

aggiornamento da una selezione  70
assegnare combinazioni di tasti  414
caricamento da modello o da documento  74
collegamento  72
creare nuovi  71
creazione da una selezione  72
Creazione tramite la finestra di dialogo Stile  71
creazione tramite trascinamento  72
definire una sequenza  88
descrizione  66
eliminare  75
modifica  69
modifica tramite la finestra di dialogo Stile  70
tipi supportati  66
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Stili e Formattazione  67
stili grafici  
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storia di LibreOffice  426
strumenti di disegno  356
strumento testo  188
Struttura diapositiva  198
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Aggiornamento Automatico  71
Applica Stile  69
personalizzati  71
Riempimento  68
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subroutine  393
subroutine nelle macro  386
suggerimenti  39
Sun Microsystems  426

supporto  10
Supporto Internazionale  11
Supporto lingue asiatiche  60
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T  
tabella database  

creazione tramite procedura guidata  249
tabella di sostituzione (carattere)  47
tabulazioni  101
tagliare e incollare  97
Tasti di scelta rapida  420
tavolozze di colori  213
text  

elenco puntato o numerato  191
incollandolo  190
livello di struttura  191

text box  
AutoLayout  188, 191

tipo di ordinamento (campi database)  280
toolbars  

connettori  221
curva  218
La barra degli strumenti Stile e riempimento  212
linee e frecce  216
mostrare o nascondere le icone  25

trascinamento  346
trasparenza  237
trattini (o lineette)  101
trattino (tratto d'unione) non divisibile  101
trattino corto (lineetta enne) e trattino lungo (lineetta 
emme)  101
tridimensionali (3D)  241
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unità di misura  102

V  
validare il contenuto di una cella, Calc  150
validità dei dati  150
valori separati da virgola (comma separated values - 
CSV)  128, 129
vantaggi di LibreOffice  19
variabili nelle macro  387
virgolette semplici  146
vista  41
Vista struttura (Base)  

creazione di un formulario  271
creazione ricerche  282

W  
web page export  

Fogli elettronici di Calc  376
presentazioni di Impress  376

wizard  
web  372

workspace  
Draw  209

Writer  
area di lavoro  90
barra degli strumenti di navigazione  93
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